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Preface

The SunManagement Center 3.6.1 User’s Guide provides instructions on how to use the SunTM

Management Center systemmanagement solution.

Note – The SolarisTM 10 release supports systems that use the SPARC® and x86 families of processor
architectures: UltraSPARC®, SPARC64,AMD64, Pentium, and Xeon EM64T. The supported systems
appear in the Solaris 10 Hardware Compatibility List at http://www.sun.com/bigadmin/hcl. This
document cites any implementation differences between the platform types.

In this document the term “x86” refers to 64-bit and 32-bit systemsmanufactured using processors
compatible with theAMD64 or Intel Xeon/Pentium product families. For supported systems, see the
Solaris 10 Hardware Compatibility List.

WhoShouldUse This Book
This book is intended for use by system administrators who have experience working with networks
and understand networking terminology and technology.

UsingUNIXCommands
This document does not contain information about basic UNIX® commands and procedures, such as
shutting down the system, booting the system, or configuring devices.

See one ormore of the following sources for this information:

� Solaris Handbook for Sun Peripherals
� Online documentation for the Solaris Operating System (Solaris OS) (available at

http://docs.sun.com)
� Other software documentation that you received with your system
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HowThis Book IsOrganized
This book contains the following information:

Chapter 1 provides an overview of the SunManagement Center 3.6.1 product and defines essential
concepts.

Chapter 2 explains how to use administrative domains.

Chapter 3 describes how to create individual managed objects for the SunManagement Center
topology database.

Chapter 4 explains how to automatically identify managed objects and add them to the topology
database.

Chapter 5 introduces the JavaTM user interface.

Chapter 6 describes the details window.

Chapter 7 explains how to view information about yourmanaged network.

Chapter 8 describes how tomonitor specific data properties.

Chapter 9 explains how to view information about data properties in a graphical format.

Chapter 10 describes how tomonitor and change data property attributes.

Chapter 11 explains how to work withmodules.

Chapter 12 describes how to create and respond to alarms.

Chapter 13 describes how to work with groups of managed objects rather than individual ones.

Chapter 14 describes how to work with dataviews.

Chapter 15 introduces the web-based user interface.

Chapter 16 describes how to create and respond to alarms using the web-based user interface.

Chapter 17 describes how tomonitor data property attributes in the web-based user interface.

Chapter 18 explains how to setup and administer security for this product.

Chapter 19 explains how to import and export topology information.

Chapter 20 identifies the capabilities of the command-line interface.

AppendixAcontains additional information and troubleshooting procedures that do not clearly fit
elsewhere.

Appendix B explains how routing affects networkmanagement.

Preface
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Appendix C describes information about standardmodules.

Appendix D identifies standard alarm rules.

Appendix E lists alternativemethods for accessing Java Console functions.

Appendix F lists themodules, add-ons, and commands supported by the Linux agent.

Glossary is a list of words and phrases found in this book and their definitions.

Product Information
Information about this product is available at the SunManagement Center web site at
http://www.sun.com/sunmanagementcenter/.

The SunManagement Center 3.6.1 product includes open source software. To view license terms,
attribution, and copyright statements for the open source software, see the copyright file available in
themedia.

Documentation, Support, andTraining

Sun Function URL Description

Documentation http://www.sun.com/documentation/ Download PDF andHTML
documents, and order printed
documents

Support and
Training

http://www.sun.com/supportraining/ Obtain technical support,
download patches, and learn
about Sun courses

Typographic Conventions
The following table describes the typographic changes that are used in this book.

Preface
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TABLE P–1TypographicConventions

Typeface or Symbol Meaning Example

AaBbCc123 The names of commands, files, and directories,
and onscreen computer output

Edit your .login file.

Use ls -a to list all files.

machine_name% you have mail.

AaBbCc123 What you type, contrasted with onscreen
computer output

machine_name% su

Password:

AaBbCc123 Command-line placeholder: replace with a real
name or value

The command to remove a file is rm
filename.

AaBbCc123 Book titles, new terms, and terms to be
emphasized

Read Chapter 6 in theUser’s Guide.

Perform a patch analysis.

Do not save the file.

[Note that some emphasized items
appear bold online.]

Shell Prompts in CommandExamples
The following table shows the default system prompt and superuser prompt for the
C shell, Bourne shell, and Korn shell.

TABLE P–2Shell Prompts

Shell Prompt

C shell prompt machine_name%

C shell superuser prompt machine_name#

Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt #

Preface
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Introduction to SunManagement Center

This chapter provides an overview of the SunManagement Center 3.6.1 product, its component
layers, and the relationships among the layers.

This chapter includes the following topics:

� “SunManagement Center Overview” on page 31
� “Important Changes in SunManagement Center 3.6 Software” on page 33
� “Important Changes in SunManagement Center 3.6.1 Software” on page 32
� “SunManagement CenterArchitecture” on page 34
� “SunManagement Center Concepts” on page 37
� “SunManagement CenterManagement andMonitoring Features” on page 40
� “SunManagement Center Software Environments” on page 44
� “Installing SunManagement Center Software” on page 44
� “Getting StartedWith SunManagement Center Software” on page 45
� “Additional Information” on page 46

SunManagement CenterOverview
SunManagement Center software is an open, extensible systemmonitoring andmanagement
solution.

SunManagement Center has the following features.

SystemManagement Monitors andmanages the system at the
hardware and operating system levels.
Monitored hardware includes boards, tapes,
power supplies, and disks.

Operating SystemManagement Monitors andmanages operating system
parameters that include load, resource usage,
disk space, and network statistics.

1C H A P T E R 1
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Application and Business SystemManagement Provides enabling technology tomonitor
business applications such as trading systems,
accounting systems, inventory systems, and
control systems.

Scalability Provides an open, scalable, and flexible solution
to configure andmanagemultiple management
administrative domains. These domains consist
of many systems and span across an enterprise.
Administrators can configure the software in a
centralized or distributed fashion so that the
product supports multiple users.

This solution uses Simple NetworkManagement Protocol (SNMP), the JavaTM RemoteMethod
Invocation (RMI), and theHypertext Transfer Protocol (HTTP). These tools enable Sun
Management Center to provide integrated, comprehensive enterprise-widemanagement of Sun
products and their subsystems, components, and peripheral devices.

Important Changes in SunManagement Center 3.6.1
Software

Version 3.6.1 of the SunManagement Center product includes the following significant changes:

� On Solaris 10, you can install and set up SunManagement Center inside a whole root zone. For
information about this, see “To Install and Set Up SunManagement Center Server Inside a
Whole Root Zone” in SunManagement Center 3.6.1 Installation and Configuration Guide.

� You canmonitor the hardware on x86/x64 systems using the generic X86/X64 Config Reader
add-on. For information about this, see Table 11–1 and “X86/X64 Config ReaderModule Version
1.0” on page 357.

� You can install and set up Linux agent in a Xen domain.
� SunManagement Center 3.6.1 allows consumers to subscribe to and receive fault events

occurring on the FaultManager Daemon (FMD). Consumers can be SunManagement Center
modules, partnermodules, or objects interested in getting the fault events. For information about
this, see the SunManagement Center 3.6.1 Developer Environment ReferenceManual.

� Using the Solaris ContainerManager 3.6.1 add-on, you can createmultiple copies of a zone on a
single host or a copy of a zone onmultiple hosts. For information about this, see “Copying
Non-Global Zones” in Installing and Administering Solaris ContainerManager 3.6.1.

� Solaris ContainerManager 3.6.1 supports Fujitsu Primepower systems.
� SunManagement Center 3.6.1 does not support SPARC systems running Solaris 2.6 and

Windows 98.
� SunManagement Center 3.6.1 uses PluggableAuthenticationModule (PAM) based

authentication.

Important Changes in SunManagement Center 3.6.1 Software
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� SunManagement Center 3.6.1 also supports the following hardware:
� SunUltra 45
� Sun Fire T1000

Important Changes in SunManagement Center 3.6 Software
Version 3.6 of the SunManagement Center product includes the following significant changes:

� Agent and console layers are available in LinuxOperating System (OS). The agent layer is
available for RedHat, SuSE/JDS Linux kernel version 2.4.20 and later. For a list of modules,
add-ons, and commands supported by the Linux agent, see Appendix F.

� On Solaris 10, you can handle hardware and software faults effectively. You can view a fault report
and amessage article. For information about this, see Table 11–1 and “FaultManagerModule
Version 1.0” on page 400.

� On Solaris 10, you canmonitor the services running on a host. You can view the details of a
service, enable a service, or disable a service. You can also view the processes in the selected
service. For information about this, see Table 11–1 and “ServiceManagement FacilityModule
Version 1.0” on page 410.

Note – On Solaris 10, when SunManagement Center is installed and set up, the services run as
ServiceManagement Facility (SMF) services.

� You can access the SunN1TM SystemManager server (SystemManager) from the Sun
Management Center software. You can alsomonitor a set of properties managed by this server.
For information about this, see Table 11–1 and “Volume SystemMonitoringModule Version 1.0”
on page 336.

� On Solaris 10, you can configure the agent inside a global zone.
� On Solaris 10, you can runDynamic Tracing (DTrace) scripts. For information about this, see

Guide de l’utilisateur de SunManagement Center 3.6 System ReliabilityManager.
� You can use SolarisTM ContainerManager 3.6 for resource allocation, service performance

monitoring, and accounting. For information about installing and using this add-on, see
Installing and Administering Solaris ContainerManager 3.6.

� The SunManagement Center agents can securely communicate with third-partymanagement
applications by using SNMPv3.

� Many enhancements have beenmade to the command-line interface (CLI). For information
about this, see Chapter 20.

� Documentation for SunManagement Center is not installed with the product. The documents
are available at http://docs.sun.com/app/docs/coll/810.4.

� Many bugs and requests for enhancements (RFEs) have been addressed in this release.

Important Changes in SunManagement Center 3.6 Software
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SunManagement CenterArchitecture
SunManagement Center software includes three component layers: console, server, and agent. The
product is based on themanager and agent architecture:

� The console layer provides the user interface that you use to initiate management tasks. This
layer includes a Java Console, a web console, and a command-line interface (CLI).

� The server (manager) executes management applications and sends requests to agents to
performmanagement tasks on your behalf.

� The agents that execute on themanaged nodes access themanagement information, monitor
local resources, and respond tomanager requests.

The following figure illustrates the three component layers.

Server

Agent

Console Console

AgentAgent

FIGURE 1–1 SunManagementCenter Component Layers

Themajor SunManagement Center layers and their functions are described next.

Console Layer
The SunManagement Center console layer is the interface between you and the other component
layers of SunManagement Center software. This layer includes a Java Console, a web console, and a
CLI. You can havemultiple consoles, servingmultiple users, for the same SunManagement Center
server. The consoles provide these features:

� Visual representations of themanaged objects, for example, hosts and networks
� The ability tomanipulate attributes and properties that are associated with themanaged objects,

for example, create alarm thresholds
� The ability to initiate management tasks, for example, dynamic reconfiguration

SunManagement CenterArchitecture
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Server Layer
The server layer accepts requests through the console and passes these requests to the appropriate
agent. The server then relays the response from the agent back to the console.

For example, if you request information on the number of users that are accessing a host, the server
layer receives this request from the console. The server layer then sends the request to the agent on
that host. The agent finds the answer and sends the answer back to the server, which forwards the
information to the console.

Similarly, if an error condition is created on one of the hosts, the agent on that host notifies the server.
The server forwards the information to the console as an alarm.

In addition, the server layer provides the console with a secure entry point to interface with the
agents.

The server layer includes the following components, as illustrated in Figure 1–2:

� SunManagement Center server
� SunManagement Center web server
� Topologymanager
� Trap handler
� Configurationmanager
� Eventmanager

Configuration
manager

Topology
manager

Console

Server

Remote
SNMP agent

Local
SNMP agent

SNMP SNMP

Event
manager

Trap
handler

RM

Sun Management Center server layer.

FIGURE 1–2 SunManagementCenter Server Layer
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The server component is the core of the server layer. The server component consists of two servers: a
Java server and a web server. Both the Java server and the web server aremulti-threaded. These
servers can handlemultiple data requests from various SunManagement Center users.

The topologymanager provides services that includemanaging user administrative domains and
arrangingmanaged object topology.

The trap handler is a centralized SNMP trap receptor that logs and forwards traps to interested
components. This server layer component is responsible for receiving all alarm notifications.

The configurationmanager provides security services to the server and the agents.

The event manager receives event information from the agents. These events can trigger alarms,
which are forwarded to the console.

Agent Layer
The agent layermonitors, gathers information about, andmanages objects on the nodes that the Sun
Management Center softwaremanages. The server layer uses SNMP to interact with the agent layer
to gain access to themanaged objects.

SunManagement Center agents are scalable, extensible, and SNMP-based. The agents monitor and
manage objects by loadingmodules that focus on a specific aspect of the system, as well as
application health and performance. These objects represent hardware, operating systems, and
applications.

The agents use rules to determine the status of themanaged objects.When the conditions that a rule
specifies become true, the software automatically generates alarms and performs actions as the rule
specifies.

Server Context
The server layer and agent layers together are referred to as a SunManagement Center server context.
When you start the console, you log in to a particular server context. Themanaged objects whose
agents send information to that server belong to the same server context.

Amanaged object can belong to the same server context or to a remote server context. Amanaged
object in a remote server context sends information to a different server.Amanaged object in the
same server context sends information to the server host that is connected to your console.

By default, the SunManagement Center softwaremanages an object in the same server context but
onlymonitors an object in a remote server context. Formore precise definitions of “manage” and
“monitor,” see Glossary. Formore information about server contexts and security, see “Sun
Management Center Remote ServerAccess” on page 251.
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FIGURE 1–3Console Logs Into a Server Context

SunManagement Center Concepts
The following concepts are fundamental to understanding SunManagement Center software:

� Administrative domains
� Management information base (MIB)
� Modules
� Alarms and rules

Note – In this document, “domain” refers to a SunManagement Center administrative domain. This
term should not be confused with uses of the term “domain” related to other Sun products or
documentation. See Chapter 2 formore information.

AdministrativeDomains
An administrative domain is a hierarchical collection of resources that you want tomonitor and
manage. The resources can include a complete campus, individual buildings, hosts, networks,
subnets, links, and so on. Each administrative domain consists of these resources, which can be
combined with other resources to form groups within a administrative domain. Each of these groups
can contain additional groups of resources, providing amultilevel, hierarchical administrative
domain.

You can create one ormore administrative domains that are based on your business needs. For
example, youmight create a lab administrative domain that contains all the labmachines. Similarly,
youmight create an accounting administrative domain that contains all themachines that are used
for accounting.

The SunManagement Center software displays the administrative domain and its members in a
visual representation. Figure 1–4 shows an example.
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In the following example, the host, Payroll2, belongs to the Building B group, which belongs to the
Payroll Servers 1 administrative domain.

FIGURE 1–4 Java ConsoleWindow Showing anAdministrativeDomain and ItsMembers

Linux hosts are identified by a generic Linux icon. Zone agents are identified by a generic icon having
a “Z” symbol in themiddle.

Management InformationBase (MIB)
Amanagement information base (MIB) is a hierarchical database schema that describes the data that
are available from an agent. SunManagement Center agents use theMIB to storemonitored data
that can be accessed remotely.

SunManagement CenterModules
Unlikemost agents, the SunManagement Center agents do not implement theMIB in amonolithic
code that contains a wide variety of functions in a single program. Instead, SunManagement Center
software uses several components, that are calledmodules, for each agent. Eachmodule implements
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its ownMIB. Therefore, the SunManagement Center agentMIB is the cumulative total of all the
modules and their individualMIBs, as illustrated in the following figure.

Agent
Cumulative
agent MIB

Module A
MIB

Module B
MIB

Module C
MIB

Module A

Module B

Module C

FIGURE 1–5 SunManagementCenterAgentMIB

SunManagement Centermodules monitor andmanage the resources of systems, applications, and
network devices. Themodules enable you to isolate andmonitor specific system components. For
example, separatemodules are available formonitoring the kernel, for monitoring printers, and for
monitoring processes. Themodules are primarily used tomonitor and to notify you through alarms
when error conditions occur or when performance tuning is required. Formore information about
alarms, see “Alarms and Rules” on page 39.

Eachmodule consists of one ormore properties that you canmonitor. For example, one of the
default modules that is loaded during installation is the Kernel Reader. This modulemonitors the
kernel properties. These properties include user statistics, disk statistics, file system usage, and so on.

Note – You can add or removemodules dynamically. This feature enables you to customize the
modules that are loaded on each agent (object), based on your need.

Alarms andRules
An alarm is a notification of an abnormal event. SunManagement Center software enables you to
monitor your system using alarms that have differing severities. The thresholds that generate these
alarms are defined in themodules. The software enables you to set the thresholds that trigger simple
alarms.

For example, one of the properties of the Kernel Readermodule is the number of user sessions. The
software enables you to set a threshold number of user sessions that, when exceeded, generates an
alarm. For example, youmight tell SunManagement Center software to generate a critical alarm
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when there are seven ormore user sessions. Similarly, youmight tell the software to generate a
cautionary alarmwhen there are five or six user sessions.

The software is configured with default alarm conditions. You can set and define your own alarm
thresholds for simple alarms, such as those alarms that are based on the simple rCompare
(comparison) rule.

Complex rules also generate alarms. For example, one complex rule generates an alert alarmwhen a
disk is more than 75 percent busy, the average queue length is over 10 entries, and the wait queue is
increasing. This rule combines three conditions:

� Percentage of the disk that is busy
� Average queue length
� Wait queue

Unlike simple rules, these complex rules are predefined. You cannotmodify complex rules.
Consequently, you cannot set thresholds for complex alarms.

When an alarm is generated, the software notifies you through themain console window, and
through an alarm action. The alarm action can include amessage sent to a specified email address or
activation of a script. You can also write a customized program that notifies you in other ways that an
alarm condition has occurred.

Formore information about alarms, see Chapter 12. Formore information about rules, see
Appendix D.

SunManagement CenterManagement andMonitoring
Features

SunManagement Center software includes the followingmanagement andmonitoring features:

� “AutonomousAgents” on page 41
� “User Security” on page 41
� “Discovery Feature” on page 41
� “Main ConsoleWindow” on page 42
� “Hierarchy and Topology Views” on page 42
� “Topology Import and Export Features” on page 43
� “Graph Feature” on page 43
� “Dataviews Feature” on page 43
� “Manage Jobs Feature” on page 44
� “Module Configuration Propagation (MCP) Feature” on page 44
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General Support Features
The features that are described in this section provide support formanaging andmonitoring your
environment.

AutonomousAgents
SunManagement Center agents work autonomously by actively sampling key data on host systems.
These agents can be polled through SNMP get requests for the current status of themonitored data.

When an agent gathers data for amonitored resource, the agent checks the data against the alarm
threshold set for the resource. The agent then determines whether the data values constitute an alarm
condition. If themonitored datameets the alarm threshold, the agent performs the action that is
associated with the alarm condition.Agents send asynchronousmessages (SNMP traps) to the
server, which delivers notification of the change in the status of themonitored data.

User Security
The SunManagement Center security feature authenticates user login and access control privileges
for users and groups. The software enables users to set security permissions at the administrative
domain, group, host, andmodule levels.

You can restrict access by setting different permissions. For example, youmight determine that one
group of users can view andmodify properties on a host, while another group of users can only see
the host. Formore general information about SunManagement Center security, see Chapter 18.

You can access SunManagement Center security features from theAttribute Editor within the
console or from the CLI. Formore information about theAttribute Editor, see Chapter 10. Formore
information about the CLI, see Chapter 20.

SpecificManagement andMonitoring Features
The features that are described in this section provide specificmonitoring andmanagement
functionality. These features can be accessed through the consoles. Some of these features can also be
accessed through the CLI.

Discovery Feature
The SunManagement Center includes a discovery feature. This feature enables you to automatically
find network resources for SunManagement Center tomonitor andmanage. The discovery feature
allows to specify discovery criteria based on several values such as IP range, host name, loaded
modules, operating system, hardware type, or some combination of these values. Formore
information, see Chapter 4.
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MainConsoleWindow
SunManagement Center software provides Java and web interfaces that enable you to view, monitor,
and interact with the software. You canmonitormultiple administrative domains, spanning different
locations, throughmultiple console windows. Formore information about the Java Console, see
Chapter 5. For information about the web console, see Chapter 15.

Note – Theweb console provides a subset of the functions that are available in the Java Console.Most
of this document describes the functions that are available in the Java Console. Information that is
specific to the web console is expressly identified.

Hierarchy andTopologyViews
SunManagement Center software offers the following views:

� Hierarchy and topology views for every administrative domain
� Hierarchy and contents views for every object

The hierarchy view enables you to navigate through the administrative domain or host to find the
object of interest. The topology view or contents view displays themembers of the object that is
selected in the hierarchy.

For an administrative domain, the hierarchy and topology views are displayed in themain console
window. In addition, you can customize the administrative domain topology view by adding a
background or creating a connection between objects in the administrative domain.

For an object, the hierarchy and contents views are displayed in the Details window. The Details
window consists of a series of tabs. The available tabs depend on the type of object that is selected.
For example, the following tabs would be displayed for a typical host object:

� Info
� Module Browser
� Alarms
� View Logs
� Applications
� Hardware

The View Logs,Applications, andHardware tabs are described briefly in the sections that follow. For
more information about the Details window, see Chapter 6.

View Logs Tab Overview

The View Logs tab enables you to view informational messages, including errormessages, about
your host.

SunManagement CenterManagement andMonitoring Features

SunManagement Center 3.6.1 User’s Guide • May 200642



Applications Tab Overview

TheApplications tab enables you to view and select detailed information about processes running on
the selected host or node. If you have any custom or third-party applications installed, this tab also
enables you to view detailed information about processes running in the selected applications. The
displays are continually updated.

Hardware Tab Overview

The physical view from the hardware tab provides you with photo-realistic front, back, and side
views of the host. You can click individual components of the host to see detailed information about
that component. For example, you can click a board in a server to see detailed information about that
board, such as CPUs, memory, and board temperature.

Note – Physical views are available only for some hardware platforms.

SunManagement Center software also provides a logical view of the overall hardware configuration
of the host. Similar to the physical view, you can click a single component to obtain detailed
information about that hardware component.

Note – Logical views are available only for some hardware platforms.

Topology Import andExport Features
The topology import and export features enable you to import and export the topology database
from or to anASCII file that uses XMLmarkup. These features provide a convenient way tomigrate
management domains from one SunManagement Center server to another server or to backup
information for a server. Formore information, see Chapter 19.

GraphFeature
SunManagement Center software enables you to create a two-dimensional graph of anymonitored
data property that has a numerical value. Formore information, see Chapter 9.

Dataviews Feature
TheAttribute Editor window is used to browsemanagement properties from a single agent by
selecting an individual management object type. SunManagement Center also provides a dataviews
feature that enables you to create a customized view or dashboard. In this customized view, you can
put together a screen that shows individual properties that belong to different SunManagement
Centermodules that are loaded on separate SunManagement Center hosts. Formore information,
see Chapter 14.
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Manage Jobs Feature
TheManage Jobs window enables you to create persistent jobs for topology objects. This feature
provides a way tomanage a collection of agents (or group) with the same ease as a single agent. Use
theManage Jobs window to define the objects to include, the specific tasks to run, and a schedule on
which to run the job. Formore information, see Chapter 13.

Module ConfigurationPropagation (MCP) Feature
MCP support enables you tomake a persistent snapshot of an individual agent configuration.When
you combineMCP support with theManage Jobs feature, you can easily distribute agent
configuration tomultiple agents. Formore information, see “To Create a Configuration Task”
on page 201.

SunManagement Center Software Environments
You can deploy SunManagement Center software in two different environments:

� Production environment
� Developer environment

The production environment is an active environment in which youmanage andmonitor your
hardware, including subsystems, components, and peripheral devices.

In contrast, the developer environment is a test, or demonstration, environment that developers can
use to develop and test modules to work with the SunManagement Center software.While the
developer environmentmight appear to be a production environment, its sole purpose is to be an
environment in which developers create SunManagement Centermodules.

Installing SunManagement Center Software
For information about installing SunManagement Center 3.6.1 , see the SunManagement
Center 3.6.1 Installation and Configuration Guide.

After you install SunManagement Center software, spend some timemoving among the various
windows and testing their functions. Once you explore and test the software, you will have a better
understanding of how you can customize SunManagement Center software to aid in your system
monitoring.
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Getting StartedWith SunManagement Center Software
This section describes a suggested approach to setting up and using the SunManagement Center
software. This process includes a summary of some typical tasks and the order in which you should
do them. Each task is referenced to a section in themanual, which provides detailed, step-by-step
directions. Your actual steps will vary according to your business needs.

The task sequence presumes that you explore and learn the software before you set up your actual
monitoring environment.

1. Install SunManagement Center software. See SunManagement Center 3.6.1 Installation and
Configuration Guide for more information about installing and configuring the software.

2. Identify users and privileges for using the SunManagement Center software, as described in
“UsingAccess Control” on page 252. For general information about security, see Chapter 18.

3. Start the SunManagement Center console. The console provides a graphical interface to
managing andmonitoring your network. To start the Java Console from a terminal window, type
the following command: /opt/SUNWsymon/sbin/es-start -c. For more information, see
Chapter 5. To access theWeb console, type the appropriate URL in your browser. Formore
information, see Chapter 15.

4. Define a collection of network objects for the software tomanage andmonitor, as explained in
“To CreateAdministrative Domains” on page 51.

5. Add servers, routers, and other network objects to the administrative domain in the Sun
Management Center database. For information about creating objects manually to populate the
domain, see Chapter 3. For information about using the DiscoveryManager to populate the
domain, see Chapter 4.

6. Familiarize yourself with the console window and navigate through the hierarchy and topology
views as explained in Chapter 5 or Chapter 15.

7. View detailed information about amanaged object, as explained in Chapter 6 and Chapter 7.
More information about viewing specific data properties is explained further in Chapter 8,
Chapter 9, and Chapter 10.

8. Customize themonitoring capabilities of the software by adding or removingmodule functions,
as described in Chapter 11. For information about themodules that are available within the
product, see Appendix C.

9. Define conditions that should generate and alarm and specify actions to occur when the
condition is met, as described in Chapter 12. For information about the predefined rules that
relate to alarms, see Appendix D.

10. Createmanagement andmonitoring functions that relate to a user-defined group of objects, as
explained in Chapter 13.

Note – For additional information specific to your hardware, see your supplement.
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Additional Information
This documentation includes a description of basic and advanced features that are available in the
SunManagement Center 3.6.1 product. The features that are available in your environmentmight
include additional softwaremodules or specific hardware information.

RelatedHardware Information
SunManagement Centersupports multiple hardware platforms. See the “Supported Platforms” in
SunManagement Center 3.6.1 Installation and Configuration Guide for more information about the
supported hardware platforms.

This book describes the software capability that is common to all the supported hardware platforms.
Platform-specific information is included in the platform-specific supplements available at
http://docs.sun.com.

Note – For complete information about how you can use the SunManagement Center software to
manage andmonitor yourmachines, read both this guide and the appropriate hardware
supplements.

Add-onProducts
Your SunManagement Center environmentmight be enhanced by several products. See the related
documentation formore information.

� SunManagement Center 3.6.1 Performance ReportingManager User’s Guide
� SunManagement Center 3.6 System ReliabilityManager User’s Guide
� SunManagement Center 3.5 Service AvailabilityManager User’s Guide
� Installing and Administering Solaris ContainerManager 3.6.1
� Hardware-specific documentation or platform supplements

ProductDocumentation
The documentation for SunManagement Center 3.6.1 is not available on the software DVD. The
English documents and localized documents are available at http://docs.sun.com.

Additional Information
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Using SunManagement CenterAdministrative
Domains

ASunManagement Center administrative domain is an arbitrary collection of resources that can
include a complete site, individual buildings, hosts, networks, subnets, links, and so on. The
organization of an administrative domain collection is in a hierarchy.

Note – In this document, administrative domain refers to a SunManagement Center administrative
domain. This term should not be confused with other uses of the term domain related to other Sun
products or documentation.

This chapter describes the following topics:

� “Administrative Domains Concepts” on page 47
� “To Start SunManagement Center” on page 49
� “To Set the HomeAdministrative Domain” on page 50
� “To CreateAdministrative Domains” on page 51
� “PopulatingAdministrative Domains” on page 51
� “ToView InformationAbout anAdministrative Domain” on page 52
� “To Set Security for anAdministrative Domain” on page 53
� “ToDelete anAdministrative Domain” on page 55
� “Monitoring RemoteAdministrative Domains” on page 55
� “ToView Information From a RemoteAdministrative Domain” on page 57

AdministrativeDomains Concepts
SunManagement Center software canmonitor amultitude of hosts. To enable you to perform your
monitoring tasks in an efficient manner, SunManagement Center software organizes hosts into
groups. The largest, highest-level grouping is an administrative domain.An administrative domain
is an arbitrary grouping of hosts, subnets, networks, buildings, and so on.

You can create one ormore administrative domains. Each administrative domain consists of one or
moremembers that are arranged in a hierarchy. For example, youmight decide that an
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administrative domain consists of all the hosts in one building. Or, youmight decide that an
administrative domain consists of all the hosts in a campus. Note the following characteristics that
apply to domains.

� Each domain namemust be unique.
� Domain names cannot be changed.
� Users who belong to the group esdomadm can create administrative domains, create groups

within administrative domains, and perform similar tasks. Formore information about security,
see Chapter 18.

For example, youmight set up three administrative domains, one for production, one for testing, and
one for integration testing.Alternatively youmight set up domains that are based on hardware
platform, such as a domain for x86machines and a domain for Sun Blade 1000s. If you set up a
domain for each hardware platform, youmight also set up a group within that domain for the
machines of that hardware platformwith a specific patch applied

Tip – Spend some time planning how youwant to organize your hosts into different administrative
domains.

Decide whether you need additional groups below the administrative domain to organize your hosts.
For example, if there are several hundred hosts, placing your hosts individually in one administrative
domain is impractical.

Youmight decide to break the administrative domain into a set of smaller groups, for example,
campuses. TheHeadquarters administrative domainmight consist of several campus locations. Each
of these campus locationsmight be broken into smaller groups, for example, buildings. Similarly,
each buildingmight be broken into smaller groups, such as networks, subnets, and groups. Finally,
each group contains individual hosts.

In this particular example, the hierarchical order, from highest level to lowest level, is as follows:

1. Administrative domain
2. Campus
3. Building
4. Network
5. Subnet
6. Group
7. Individual host

For detailed information about creating administrative domains, see “To CreateAdministrative
Domains” on page 51.

The home domain is the administrative domain that is displayed when you log into a specific server.
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Starting SunManagement Center Software
The SunManagement Center server software automatically starts upon completion of installation
and when the server system reboots. You use a console to access the server.

� ToStart SunManagement Center
To start the Sun Management Center console, type the following command:
% installed-root-directory/sbin/es-start -c

where the default installed root directory is /opt/SUNWsymon.

The login screen appears.

Note – You can also access some SunManagement Center features from a browser. Formore
information, see Chapter 15.

Type a valid user name, password, and server host name in the appropriate fields.

The user accountmust be listed in the /var/opt/SUNWsymon/cfg/esusers file on the Sun
Management Center server.

Tip – To change the server port number or the communications security level for this console session,
click Options.

Press the Return key, or click the Login button.

The Set HomeDomain window appears if you have not previously logged in to this server or if you
have not set a home domain. The home domain is the administrative domain that is displayed when
you log in to a specific server. This dialog box appears each time you start the console until you set a
home domain.

During installation, a default administrative domain that is namedDefault Domain is created for
you. The Default Domain initially consists of one object, your server host. To use the default
administrative domain, select Default Domain and click the Go To button. For information about
setting the home domain, see “To Set the HomeAdministrative Domain” on page 50.

At this time, youmight want to populate your administrative domain or perform other tasks.

� To create objects in your administrative domain, see “PopulatingAdministrative Domains”
on page 51.

� To explore themain console window, see Chapter 5.
� To exploremonitoring features, see Chapter 8.
� To create additional administrative domains, see “To CreateAdministrative Domains” on page

51.
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� ToClose a Sessionof SunManagement Center
Choose Close from the File menu in the main console window.

The console appears so that you can login again.

� ToSet theHomeAdministrativeDomain
To access the Set Home Domain window, choose Set Home Domain from the File menu in the main
console window.

Tip – The Set HomeDomain window appears automatically if you have not previously logged in to
this server or if you have not set a home domain.

In the Set Home Domain window, select the name of the administrative domain that you want to set
as your home domain.

The selected administrative domain is highlighted.

Click the Set Home button.

You see the followingmessage at the bottom of the Set HomeDomain dialog box.
Setting Home Domain...Please wait

When the home domain has been set, themessage changes.

Home domain successfully set.

Your default administrative domain is set as your home domain. Information about the home
domain appears in themain console window. Formore information, see “Administrative Domains
Concepts” on page 47.

Tip – Click the Go To button to use an administrative domain without setting the domain as the home
domain. The selected administrative domain appears in themain console window. In this case, your
home domain is not set, and the Set HomeDomain window appears the next time that you start the
console.

Click the Close button.

The selected home domain appears in themain console window.

◗
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CreatingAdministrativeDomains
Use the DomainManager window to create SunManagement Center administrative domains.

� ToCreateAdministrativeDomains
Choose Domain Manager from the File menu in the main console window.

TheDomainManager appears.

In the Domain Manager, click the Add button.

The Create Domain dialog box appears, as shown in the following figure.

FIGURE 2–1CreateDomainDialog Box

Type the name of the new administrative domain in the Domain Name field.

If you do not want your administrative domain to be populated now, deselect the Populate Now
check box.

The default choice is for SunManagement Center software to display a dialog box that enables you to
start the DiscoveryManager immediately after creating an administrative domain. Formore
information about the DiscoveryManager, see Chapter 4.

To create the new administrative domain, click the Create button.

To close the windowwithout creating the administrative domain, click the Cancel button.

If you do not have the proper security permissions to create an administrative domain, an error
message is displayed. See Chapter 18 formore information about security.

PopulatingAdministrativeDomains
Once you have created your administrative domains, you can begin to populate these administrative
domains and their subordinate groups.
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Note – To populate an administrative domain, youmust have esdomadm privileges. See “Sun
Management Center Groups” on page 246 formore information.

To add hosts and other resources to an administrative domain collection, use one of thesemethods:

� Populate with the DiscoveryManager
The DiscoveryManager is the default method for populating a newly created administrative
domain. DiscoveryManager searches the network for resources. The search can be
time-consuming, but you can shorten the search by setting limits. See Chapter 4 formore
information.

� Populate with the DiscoveryManager at scheduled intervals by using the Scheduling feature
The scheduling feature enables you to search periodically for newmanaged objects on the
network. You can set the search to occur hourly, daily, weekly, ormonthly. See “Making and
Modifying Discover Requests” on page 77 formore information.

� Manually populate with the Create anObject menu option
To add objects individually, use the Create anObject option. This option is useful for adding a
small number of known resources. For example, if you have installed a new host, you can use
Create anObject to add the host to the local administrative domain immediately. See Chapter 3
formore information.

ManagingAdministrativeDomains
Once you have created SunManagement Center administrative domains, you canmanage those
domains.

� ToView InformationAbout anAdministrativeDomain
You can list administrative domains through the DomainManager window or the SunManagement
Centermain console window.

Access the Domain Manager from the main console window in one of the following ways:

� Choose DomainManager from the File menu.
� Click the SunManagement CenterAdministrative Domains pull-downmenu.

The current list of administrative domains is displayed.

Select the administrative domain that you want to view.

Themain console window displays the selected administrative domain. The SunManagement
CenterAdministrative Domains button changes to display the name of the administrative domain
that you selected.
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� ToSet Security for anAdministrativeDomain
The administrative domainAttribute Editor provides additional information about the selected
administrative domain and about the rules that govern its behavior. Use theAttribute Editor to edit
security information for the administrative domain.

Note – EachAttribute Editor displays one ormore tab buttons depending on the type of selected
object.

Access the Attribute Editor in either of the following ways:

� From the hierarchy view in themain console window, press mouse button 3 on the
administrative domain icon. Then, chooseAttribute Editor from the pop-upmenu.

� From themain console window, choose DomainManager from the File menu. Then, choose an
administrative domain and click the Security button.

If not already selected, click the Security tab in the Attribute Editor window.

The security information appears in theAttribute Editor window, as illustrated in the following
figure.
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FIGURE 2–2Attribute Editor for anAdministrativeDomain

Type the names of user and administrator groups in the appropriate fields.

See Chapter 18 formore information about users and groups.

To accept your changes and close the Attribute Editor window, click the OK button.
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� ToDelete anAdministrativeDomain

Caution – When you delete an administrative domain, you also delete all themembers of that
administrative domain.

In the Domain Manager window, select the name of the administrative domain that you want to
delete.

Note – To delete an administrative domain, youmust have the appropriate security permission. For
more information about SunManagement Center security, see Chapter 18.

Click the Delete button.

The ConfirmDomainDeletion dialog box is displayed.

There are two versions of the DomainDeletion dialog box. One version is for any administrative
domain. The other version is for the administrative domain that you are currently viewing.

To verify that you want to delete the selected administrative domain, click the Delete button.

The ConfirmDomainDeletion dialog box displays the followingmessage.
Deleting domain...Please wait.

When the administrative domain has been successfully deleted, the dialog box is removed and the
DomainManager updates the list of administrative domains.

To close the Domain Manager window, click the Close button.

MonitoringRemoteAdministrativeDomains
Remote administrative domains are SunManagement Center administrative domains that are
created in a different SunManagement Center server context. See “Server Context” on page 36 for a
description of server context.

If you are interested in an object in a different server context, you can stillmonitor the remote
resource. Tomonitor the remote resource, reference the remote administrative domain in your local
administrative domain. Tomanage the remote resource, log out of your current SunManagement
Center server context and log into the remote server context. You canmanagemonitored properties
on a resource only if the agent is managed by the server to which your console is connected. By
default, SunManagement Center security gives you “read-only” privileges for remote administrative
domains. Formore information about security, see Chapter 18.
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Note – You can reference a remote administrative domain tomonitor resources in that administrative
domain. You cannotmanagemonitored properties on a remote resource.

For example, your current SunManagement Center server context might be based in the
Headquarters administrative domain.Asecond, remote SunManagement Center server context
might be based in Regional Office 1.Whenworkers are absent fromRegional Office 1, you can
monitor the regional office administrative domains fromHeadquarters by referencing these remote
administrative domains in the Headquarters server context. If an emergency occurs, administrators
in Headquarters can notify a Regional Office 1 administrator immediately.

Note –Remote administrative domains enable you tomonitor critical resources continuously.

Figure 2–3 illustrates how remotemonitoring works.Administrative DomainAmonitors objects 1
and 2, which are assigned to DomainA.Administrative DomainAremotelymonitors objects 3 and
4, which are assigned to Domain B. Note that administrative DomainAcannotmonitor objects 3 or
4 without going through remote administrative Domain B.

Domain A

Object 1 Object 2

Domain B

Object 3 Object 4

FIGURE 2–3RemoteAdministrativeDomain

Do not create an administrative domain that refers to itself. For example, do not create an
administrative domainAthat references another administrative domain Bwhich in turn, contains a
reference to administrative domainA.

If two administrative domainsmust monitor each other, avoid creating a circular domain reference.
Instead, create a domainmember, for example a group, under DomainsAand B as shown in the
following figure.
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Domain A

Object 1 Object 2

Domain B

Group 1 Group 2

Object 3 Object 4

FIGURE 2–4 SettingUp Successful Cross-Monitoring for RemoteAdministrativeDomains

Nowwhenmaking a remote reference, DomainAcan reference Group 2 under Domain B, while
Domain B can reference Group 1 under DomainA.

� ToView Information FromaRemoteAdministrative
Domain
In the main console window, choose Remote Domain Manager from the File menu.

The Remote DomainManager dialog box is displayed.

Type the name of the remote server in the Host field.

If applicable, type the port number for the remote Topology manager in the Port field

By default, the Topologymanager is installed on the server on port 164.

Click the List Domains button.

Alist of administrative domains on the remote server is displayed.

Select the administrative domain that you want to reference.

The selected administrative domain is highlighted.

Click the Reference button.

The selected administrative domain is created as a reference administrative domain in the currently
selected administrative domain in themain console window.
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ManuallyAddingObjects to the Topology
Database

This chapter describes how tomanually create objects that are added to the SunManagement Center
topology database. For information about using the DiscoveryManager to automatically populate
the topology database, see Chapter 4.

This chapter discusses the following topics:

� “ManagedObjects Concepts” on page 59
� “To Create a Node” on page 61
� “To Create aModule Object” on page 64
� “To Create a Group” on page 64
� “To Create a Composite Object” on page 66
� “To Create a Segment” on page 67
� “To Connect Objects in the Topology View” on page 68
� “To Copy anObject” on page 69
� “To Copy a Group of Objects” on page 69
� “ToModify anObject” on page 70
� “To Cut and Paste Objects” on page 71
� “ToDelete Objects” on page 72

ManagedObjects Concepts
SunManagement Center objects represent parts, or nodes, of a network. These objects include
hardware and software components such as hosts (workstations and servers), printers, routers,
modules, and so on. Even a segment of the network itself can be an object.

Note – For additional information, refer to your hardware supplement. The supplement contains
important hardware-specific information about creating an object.

Tomonitor ormanage an object, you create a node in the topology database to represent the object in
an administrative domain or group. If the group does not yet exist, youmust first create the group.
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You can create and one ormore administrative domains that contain nodes formultiple objects, such
as the workstations and other devices that are connected to the server. Once these administrative
domains exist, you canmonitor ormanage them. For information about administrative domains, see
Chapter 2.

ManagedObject Categories
SunManagement Center supports the following object categories:

� Node –Anode object generally refers to a hardware component, such as a workstation or server,
printer, or router. See “To Create a Node” on page 61.

� Composite –Acomposite object refers to a collection of related objects that you want tomonitor
as a single entity.Acomposite object can also be a service object. A service object is a specific type
of composite object that enables you tomonitor services.An example of a composite object could
refer to a hardware system onwhichmultiple instances of the Solaris operating environment are
running. See “To Create a Composite Object” on page 66.

� Group –Agroup object refers to a collection of objects that fall into one of two categories:
General or IP-based. General groups are based on geography, such as a building, whereas
IP-based groups are based on networks or subnets. See “To Create a Group” on page 64.

� Segment –Asegment object refers to portions of the network that link together the nodes or
groups. See “To Create a Segment” on page 67.

� Module –Amodule object refers to a collection ofmodules for the purpose of enabling a
commonmonitoringmethod. See “To Create aModule Object” on page 64.

Agents andMonitors
When you create a node, you can choose from the following types of monitoring approaches.

SunManagement CenterAgent –Host
Monitor andmanage a host that has an active agent that is installed and running. The status of the
agent on the host can bemonitored. The Details window of the SunManagement Center agent
host contains tabs such as Info, Browser,Alarms, and so forth. The Entity Polling Type in the Info
tab is ahost.

SunManagement CenterAgent – Platform
Formore information, see your platform supplement.

SunManagement CenterAgent -Module
Monitor andmanage amodule that has an active SunManagement Center agent that is installed
and running. The status of the SunManagement Centermodule on the agent host can be
monitored. The Details window contains Info,Module Browser, andAlarms tabs. The Entity
Polling Type in the Info tab is amod.
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SNMPProxy
Monitor andmanage the device through a SunManagement Center agent that is running a Sun
Management Center proxymodule for that device. (The proxymodulemust have been
previously loaded into the agent. See “To Load aModule” on page 162.) Communication between
the SunManagement Center Topologymanager and the agent is SNMPv2 usec. Communication
between the SunManagement Center agent and the remote device is SNMPv1, SNMPv2, or
SNMPv3, depending on the proxymodule. The ProxyMonitoringmodule data are displayed.
The Details window contains the Info and Browser tabs. The Entity Polling Type in the Info tab is
aprox.

SNMPPing
Monitor the device by using the SNMP ping command. The SunManagement Center Topology
manager communicates with the device using SNMPv1. Nomanagement capabilities are
provided for devices that aremonitored by the SNMP ping command. The availability of the
SNMPagent on the device can bemonitored. The Details window contains only the Info tab. The
Entity Polling Type in the Info tab is snmp.

ICMPPing
Monitor the device by using the Internet ControlMessage Protocol (ICMP) ping command. No
management capabilities are provided for devices that aremonitored by the ICMP ping

command. The accessibility of the device can bemonitored. The Details window contains only
the Info tab. The Entity Polling Type in the Info tab is ping.

Non-Monitored
Created node is for display only. The node status is notmonitored. No aspects of the device are
monitored. The Details window contains only the Info tab. The Entity Polling Type in the Info tab
is dummy.

CreatingObjects
The general process that you follow to create objects is similar for all categories. The specific steps
differ as described.

� ToCreate aNode
You create nodes through the Create Object function on the Edit menu in themain console window.

Note – An administrative domainmust exist before you can create a node. For information about
how to create an administrative domain, see “To CreateAdministrative Domains” on page 51.

In the hierarchy view of the main console window, select the administrative domain in which to
create the new object.
Select the lowest level group of the administrative domain where the new object should be created.
For example, to create a node in a building that is in one of the campuses of a administrative domain,
select the building in the administrative domain as the lowest level group.
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In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed. By default, the Node tab is selected.

In the upper half of the Create Object window, set up the new node.

a. Use the Monitor Via combo box to select the software or agent to monitor the new node.

There are seven categories of agents andmonitors. If an agent is not available for your selected
object, SNMPPing usually works. If you do not select an available agent or ping command, the
creation fails. The following choices are available:

� SunManagement CenterAgent –Host
� SunManagement CenterAgent – Platform
� SunManagement CenterAgent -Module
� SNMPProxy
� SNMPPing
� ICMPPing
� Non-Monitored

Note – To create an agent object, theMIB-IImodulemust be loaded. If it is not, the agent can be
created only as a ping host or as an SNMPhost.

Formore information about thesemonitoring choices, see “Agents andMonitors” on page 60.
For information about creating an object for your specific platform, see the appropriate platform
supplement.

b. If applicable, select a type from the pull-down menu in the Type field.

The Type field displays only if SNMPPing, ICMPPing, or Non-monitored is selected in the
Monitor Via field.

The following Type choices are available:

� Server
� Workstation
� PC
� Router
� Printer
� Concentrator

c. If applicable, scroll and select an object in the Create Object window.

For some types of monitoring, the right side of the Create Object window displays the set of icons
for the object you have selected. The icons are displayed in the hierarchy and topology views in
themain console windowwhen the node is created.

d. (Optional) Create a unique name in the Node Label field.

The default label is the host name.
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e. (Optional) Type a description of the node.

In the lower half of the Create Object window, type the requested information.

The questions in the lower half of the window vary with the agent ormonitor that you selected in
Step a. The Non-Monitored selection does not require further information, butmost agent or
monitor selections ask you to provide the following information:

� Node host name
� Node IP address

You can provide the host name, the IP address, or both. If there is a conflict between the host name
and the IP address, the host name takes precedence.

Other agent ormonitor selectionsmight also ask for one ormore of the following items:

� SunManagement Center agent port number (default is 161)
� Proxy host name and IP address if Monitor Via is SNMPProxy
� Read and write SNMP communities if Monitor Via is SNMPPing (The default read community

is public; The default write community is private.)
� Module name

To add the new node to your topology and close the Create Object window, click the OK button.

The followingmessage is displayed at the bottom of the Create Object window:
Creating Node... Please Wait.

� If the request is completed successfully, themain console window is updated, and the new node is
displayed.

� If the creation fails, an errormessage is displayed at the bottom of the Create Object window. The
cause of the errormight be one of the following reasons:
� You do not have permission to create this node.
� Youmust start a SunManagement Center agent on the node.
� You provided incorrect agent host or port information.

Note – When you create a node on the current SunManagement Center server context,
ownership of that node defaults to your login identity.When you create a node on a remote
server context, ownership of that node defaults to a general user identity. This situation is
normal. The general user identity is imposed for security of transactions between Sun
Management Center server contexts. Formore information, see “SunManagement Center
Remote ServerAccess” on page 251.

For information about how to change the new node, see “ChangingObjects” on page 68.
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� ToCreate aModuleObject
Tomonitor several module objects on several hosts, youmight createmodule objects for each host
and put themodule objects in a common location. For example, youmight put themodule objects in
the same group or administrative domain. The procedure for creating amodule object is similar to
the procedure for creating a node.

In the hierarchy view of the main console window, select the administrative domain in which to
create the new object.

In the main console window, choose Create Object from the Edit menu.

Select the Node tab in the Create Object window.

Select Sun Management Center Agent – Module in the Monitor Via field.

(Optional) Type a node label.

(Optional) Type a description.

Type a host name or IP address.

You can provide either the host name, the IP address, or both. If there is a conflict between the host
name and the IP address, the host name takes precedence.

Verify or change the port number.

Click the Get Modules button to view a list of modules that are currently loaded on the host.

Themodule list is displayed.

If themodule that you want to use is not loaded, see “To Load aModule” on page 162. If themodule
that you want to use is not enabled, see “To Enable aModule” on page 165.

Select the module to monitor.

Themodule list closes.

To add your module to the topology and close the Create Object window, click the OK button.

� ToCreate aGroup
You can create two types of groups: General and IP-based. General groups are based on geography,
such as campus or building. IP-based groups are based on networks or subnets.
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Note – To create a group, youmust have esdomadm privileges. See “SunManagement Center Groups”
on page 246 formore information.

In the hierarchy view of the main console window, select the administrative domain in which you
want the new group.

For example, to create a group in a building that is in a campus of an administrative domain, click the
building icon in the administrative domain.

In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed.

In the Create Object window, click the Group tab.

Change the Type field, if desired (General or IP-Based).

General groups are based on geography, such as campus or building. IP-based groups are based on
networks or subnets.

Select the object type (Building, Campus, or General).

The right side of the window is updated with an icon corresponding to the object type.

Create a new group Label.

(Optional) Type a description in the Description field.

For an IP-based group, specify the IP address and the subnet mask.

The creation of an IP-based group results in the creation of an empty network or subnet “container.”
You can populate the container as explained in Step 10.

To add the group to your topology view and close the Create Object window, click the OK button.

The followingmessage is displayed at the bottom of the Create Object window:
Creating group... Please Wait.

If the request ends successfully, themain console window is updated and the group is displayed.

If the request fails, an errormessage is displayed at the bottom of the Create Object window. The
cause of the errormight be that you do not have permission to create this group.

For information about how to change the new group, see “ChangingObjects” on page 68.

Add components to your group using one of the following methods:

� Use the Create Object window. See “To Create a Node” on page 61.
� Copy and paste objects from other groups into the new group. See “To Copy anObject” on page

69.
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� ToCreate aCompositeObject
Acomposite object is a group of related objects that you want tomonitor collectively. This term
refers to hardware withmultiple instances of the Solaris operating environment running inside a
single chassis.

In the hierarchy view of the main console window, select the Sun Management Center administrative
domain in which to create the composite object.
Select the lowest level group of the administrative domain where the new composite object should be
created.

In the main console window, choose Create Object from the Edit menu.
The Create Object window is displayed. By default, the Node tab is selected.

Click the Composite tab in the Create Object window.
The window changes to display the settings that are available for composite objects.

Select an object in the Create Object window.
For some types of monitoring, the right side of the Create Object window displays the set of icons for
the object you have selected. The icons are displayed in the hierarchy and topology views in themain
console windowwhen the composite object is created.

Create a unique name in the Label field.

(Optional) Type a description for the composite object.

In the lower half of the Create Object window, type the requested information.

� Agent Hostname
� Agent IPAddress
� SunManagement Center agent port number (the default is 161)

You can provide the host name, the IP address, or both. If there is a conflict between the host name
and the IP address, the host name takes precedence.

To add this composite object to your topology and close the Create Object window, click the OK
button.
The followingmessage is displayed at the bottom of the Create Object window:
Creating Composite Object... Please Wait.

� If the request is completed successfully, themain console window is updated and the new
composite object is displayed.

� If the creation fails, an errormessage is displayed at the bottom of the Create Object window. The
cause of the errormight be one of the following reasons:
� You do not have the permission to create this object.
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� Youmust start a SunManagement Center agent on the object.

Note – When you create a node on the current SunManagement Center server context,
ownership of that node defaults to your login identity.When you create a node on a remote
server context, ownership of that node defaults to a general user identity. This situation is
normal. The general user identity is imposed for security of transactions between Sun
Management Center server contexts. Formore information, see “SunManagement Center
Remote ServerAccess” on page 251.

For information about how to change the new composite object, see “ChangingObjects” on page
68.

� ToCreate a Segment
To complete your view of an administrative domain, you can include segments of the networks that
link the nodes in the administrative domain.Asegment object is a line in the hierarchy of the
topology view.

In the main console window, in the left window pane, select a location in the administrative domain
where the new segment should be created.
The segment is created at the selected level. For example, to create a segment in a building that is in a
campus of an administrative domain, select the building in the administrative domain.

In the main console window, choose Create Object from the Edit menu.
The Create Object window is displayed.

In the Create Object window, click the Segment tab.

Change the Type field, if desired (Bus or Ring).

Select the object type.
The list of choices (Ethernet or IPX) changes with your selection in the Type field.

Apanel in the Create Object window displays large and small icons that correspond to the type of
object you have selected. The icons are displayed in the topology view in themain console window
when the segment is created.

Type a new segment label.

(Optional) Type a description in the Description field.

Type the IP address for this segment.

Type a subnet mask for this segment.
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To add the segment to your topology and close the Create Topology window, click the OK button.
The followingmessage is displayed at the bottom of the Create Object window:
Creating segment... Please Wait

� If the request is completed successfully, the Create Object window closes. Themain console
window is updated and the view is displayed.

� If the request fails, an errormessage is displayed in the Create Object window.

For information about how to change the new segment, see “ChangingObjects” on page 68.

� ToConnectObjects in the TopologyView
Tomake the view in SunManagement Centermore closely resemble the real-world network, you can
connect objects.

Select two objects in the topology view.

To select two objects, select the first object in the topology view. Hold down the Shift key and click the
second object.

Choose Create a Connection from the Edit menu.

Alink is displayed between the objects.

ChangingObjects
Tomove an object from one location in the topology view to another location, use the Edit
commands: Cut and Paste. To copy an object into other topology views and leave the original object
in its current location, use Copy instead of Cut. The copy, cut, and paste functions are available in the
topology view. The copy and cut functions are also available in a pop-up window by clickingmouse
button 3 (typically the right mouse button) on the object.

Note – SunManagement Center 3.6.1 software does not support drag and drop as an operation for
moving objects.

For example, you can create an administrative domain that contains some of the objects that already
exist in another administrative domain. To do this, create a new administrative domain as explained
in “CreatingAdministrative Domains” on page 51. Then, copy existing objects into the new
administrative domain as described in “To Copy anObject” on page 69.

You can also copy a group, which is an object that contains other objects. In this case, the software
does not create an independent, completely new group. Rather, the software creates a symbolic link
to the existing group. Thus, every copy is a different “view” of the same group.

Formore information about themain console window, see Chapter 5.
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� ToCopyanObject
This procedure is for a single object. For information about how to copy a group, see “To Copy a
Group of Objects” on page 69.

In the main console window, select the object to copy in the topology view.

Tip – To selectmultiple objects, hold down the Shift key while using themouse button.

At the top of the main console window, choose Copy from the Edit menu, or press mouse button 3 on
the object and choose Copy from the pop-up menu.
The followingmessage is displayed at the bottom of themain console window:
Copy successful

Open the destination group or administrative domain.
The destination group is displayed in the topology view.

At the top of the main console window, choose Paste from the Edit menu.
The pasted object is displayed in the destination group or administrative domain. The following
message is displayed at the bottom of themain console window:
Paste successful

� ToCopyaGroupofObjects
In the topology view, select the objects to be copied.
To copy all objects in the topology view, choose SelectAll from the Edit menu in themain console
window.

To copy two ormore objects selectively:

a. Click the first object to select it.

b. Hold down the Shift key, and click one or more additional objects.

Choose Copy from the Edit menu in the main console window, or press mouse button 3 on one of the
selected objects and choose Copy from the pop-up menu.
When the objects are copied, the followingmessage is displayed at the bottom of themain console
window:
Copy Successful

In the hierarchy view, select the new group or administrative domain where the group is to be
placed.
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Choose Paste Into from the Edit menu in the main console window.

Alternatively, you can press mouse button 3 on the destination administrative domain and choose
Paste Into from the pop-upmenu.

Caution – If you select Paste instead of Paste Into, the objectsmight be pasted into the wrong group. If
this occurs, select the duplicate objects and choose Delete Object/Connection from the Edit menu.

� ToModify anObject
Once you have created or have copied an object, you can change the object through theModify
Object window. The changes affect only the description of the object in the SunManagement Center
server database and do notmodify the object itself.

Select the object in the main console window.

Choose Modify from the Edit menu in the main console window.

TheModify Object window is displayed. The appearance of the window varies, depending on
whether the object is a group, node, composite object, or segment.

Edit the characteristics as needed.

If you aremodifying a group object, the following characteristics are available:

� Type: General or IP-Based
� Object: Building, Campus, or General
� Group Label
� Description
� IPAddress (for IP-Based only)
� SubnetMask (for IP-Based only)

For a node, the following characteristics are available:

� Monitor Via
This field is described inmore detail in “To Create a Node” on page 61.

� Node Label
� Description
� Additional characteristics such as host name, IP address, or port might be listed, depending on

the type of node

For a segment, the following characteristics are available :

� Type: Bus or Ring
� Object: Ethernet or IPX for bus type, or FDDI for ring type
� Segment Label
� Description
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� IPAddress
� SubnetMask

For a composite object, the following characteristics are available:

� Object
� Label
� Description
� Agent host name
� Agent IP address
� Port

See your hardware supplement formore information.

Click the OK button to save your changes, or click the Cancel button to leave the characteristics
unchanged.

� ToRenameanObject
If you have changed an object’s name in the real world, you can easily modify themanaged object
name in the topology database tomatch.

In the main console window, select the object name to change.

Choose Rename Object from the Edit menu in the main console window, or press mouse button 3 on
the object, then select Rename from the pop-up menu.

The RenameObject window appears. The Current Label shows the existingmanaged object name.

Type a new name in the New Label field.

To apply the new name for this object in the topology database, click the OK button.

To exit from the RenameObject windowwithout changing the name, click the Cancel button.

� ToCut andPasteObjects
You can cut andmove, or permanently delete objects from the topology view in themain console
window.An object that is cut is saved temporarily inmemory. Then, the cut object can be pasted
immediately into one ormore areas.An object that is deleted cannot be recalled. For instructions on
deleting objects, see “ToDelete Objects” on page 72. Formore information about themain console
window, see Chapter 5.

Cut and paste functions work the same for all kinds of objects: hosts, modules, and groups.
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Note – SunManagement Center 3.6.1 software does not support “drag and drop” as an operation for
moving objects.

Select an existing object in the topology view.

If you have not selected an object, the Cut andDelete functions are unavailable and appear dimmed.

Choose Cut from the Edit menu in the main console window, or press mouse button 3 on the object
and choose Cut from the pop-up menu

Adashed line is displayed around the selected object. The object does not immediately disappear, but
remains active until it is pasted into a new location. This strategy protects objects, such as processes,
that should not be interrupted. The object remains visible until it has been successfully pasted.

Tip –To cancel a Cut operation, click the object again.

When the Cut operation succeeds, the followingmessage is displayed at the bottom of themain
console window:

Cut successful

Navigate to the destination location in the topology view.

Choose Paste from the Edit menu.

The object appears in the new location. The object disappears from the previous location.

� ToDeleteObjects
TheDelete function removes an object completely from the topology database. Tomove an object to
another location, see “To Copy anObject” on page 69 or “To Cut and Paste Objects” on page 71.

Formore information about themain console window, see Chapter 5.

Note – To delete an administrative domain, use theDelete button in theDomainManager window.
See “ToDelete anAdministrative Domain” on page 55.

Select an existing object in the topology view.

If you have not selected an object, the Delete function is unavailable and appears dimmed.

Choose Delete Object/Connection from the Edit menu in the main console window.

You are prompted to confirm or cancel the deletion.
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If the Delete operation succeeds, the object is removed. The followingmessage is displayed at the
bottom of themain console window:
Delete successful
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AddingObjects to the TopologyDatabase
Using theDiscoveryManager

You can use the DiscoveryManager to populate administrative domains automatically.
Automatically populating administrative domains is very useful if you have a large network. For
information about how to addmembersmanually with the Create Topology Object window, see
Chapter 3.

The following topics are described in this chapter:

� “DiscoveryManager Concepts” on page 75
� “To Start the Discover ObjectsWindow” on page 77
� “ToDefine and Initiate a Discover Objects Request” on page 77
� “To Set Preferences for a Discover Objects Request” on page 80
� “To Limit a Discovery Process byHardware, Software, or Object Names” on page 81
� “To Schedule a Discover Objects Request” on page 83
� “ToModify a Discover Objects Request” on page 83
� “To Start, Stop, or Delete a Discover Objects Request” on page 84
� “ToView the Discover Objects Log” on page 84

DiscoveryManager Concepts
TheDiscoveryManager can find hosts, routers, networks, and subnets as explained in “Overview of
IPAddressing” on page 329. The DiscoveryManager also discovers objects where a Sun
Management Center agent is configured to a different server context as described in “Sun
Management Center Server Context and Security” on page 251.

The DiscoveryManager can also find and group topology objects. These objects can be related either
to a single hardware platform or to a group of cooperating hardware platforms. This discovery and
grouping feature enables convenient management of the related objects. This technique is described
in the add-on supplement for thosemachine architectures that have this grouping requirement.

4C H A P T E R 4

75



Note – For additional information, refer to your platform supplement. The supplement contains
important platform-specific information about discovering objects.

You can create one ormore discover requests. Each request runs as a separate process and adds the
discovered objects to the administrative domain. The Discovery feature is supported only for
administrative domains and not for any subordinate groups. You can add requests only for an
administrative domain.

You can also schedule requests to look periodically for new hosts.

Note – Every discover request is assigned a Request ID. This ID is a unique SunManagement Center
internal identifier of the request. The Request IDsmight not be in sequential order. The Request ID
displays in the Request Details portion of the Discover RequestsWindow.

About theDiscoverObjectsWindow
TheDiscover Objects window contains the fields that are described in the following table.

TABLE 4–1 Fields in theDiscoverObjectsWindow

Field Description

Name Aname that you create for the request. You can havemultiple requests with the same
name.

Scheduled “Yes” if the request is scheduled, “No” if not scheduled

Status Reflects the current state of the discover request. The status can be one of the following
states:
� New –Anew request was added but not processed.

� Queued –Arequest has been sent to the server but processing has not yet started.

� Running – The request is currently being processed.

� Succeeded – The request has been successfully processed.

� Failed – Processing of the request has failed.

� Stopped – The user has stopped the process.

� 0HostsAdded – The request did not find any hosts that passed the filter limits.

Request Details Provides summary information about the selected discover request.

The Discover Objects window contains the buttons that are listed in the following table.
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TABLE 4–2Buttons in theDiscover RequestsWindow

Button Action

Add Create a new discover request through the NewDiscover Request window.

Modify Change the selected discover request.

Duplicate Create a copy of the selected discover request.

Delete Delete the selected discover request.

Start Start the selected discover request. The selected request must not be running andmust
not be scheduled to run.

Stop Stop running the selected discover request. The selected request must be running.

Log View a log of the results that the selected discover request generated.

MakingandModifyingDiscover Requests
This section describes how to initiate and change a discover request.

� ToStart theDiscoverObjectsWindow
Start the Discover Objects window in one of two ways:

� When you create an administrative domain through the Create Domain dialog box, select the
Populate Now option.

Formore information about creating administrative domains, see “CreatingAdministrative
Domains” on page 51.

� Select the administrative domain in the SunManagement CenterAdministrative Domains
pull-downmenu, then choose Discover Objects from the Tools menu in themain console
window.

The Discover Objects window appears.

� ToDefineand Initiate aDiscoverObjects Request
You can discover hosts by using the ping command or by using routing tables.

Before you initiate a discover request that uses routing tables, read Appendix B. The appendix
explains the basic concepts of routing, network classes, and netmasks.

◗
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Note – Youmust have esdomadm privileges to perform any operations on aDiscover Request. For
more information, see Chapter 18.

Open the Discover Objects window as explained in “To Start the Discover Objects Window” on page
77.

Click the Add button in the Discover Objects window.
TheNewDiscover Request window is displayed. The Discover tab is selected by default.

Tip – To copy an existing discover request, select the existing request and click the Duplicate button in
the Discover Objects window. For information about how to edit the settings for the new discover
request, see “ToModify a Discover Objects Request” on page 83.

Type a new name for your discover request in the Request Name field.
Multiple requests are listed in the Discover Objects window, which enables you to select a request
and to edit the related search pattern.

In the Discover Using field, select the method that should be used for discovering the network.
The discoverymethods are either Ping or Routing Table.

� If you select Ping, the discovery process uses both ICMP and SNMP ping commands. The
discovery process searches for hosts, routers, and composite objects in the specified IP address
range. The process then places the hosts in the appropriate networks and appropriate subnets
based on the netmask.

Note – Acomposite object includes various groupings of hardware and software, such as Sun
FireTM systems. These objects do not appear within a subnet or similar structure, but are instead
visible at the root level of the domain.

� If you select Routing Table, the discovery process starts from the SunManagement Center server
host . The process then goes through the specified number of hops to report subnets and hosts n
hops away. The number of hops limits the “distance” of destination hosts from the host on which
the Topologymanager or SunManagement Center server is running.

Note – Routing Table discover requests assume that you run an SNMPagent at port 161. The
agent can be a SunManagement Center agent, snmpdx, or any SNMPagent provided by your
networkmanagement package. To use a different port number, see Step 9.

Formore information about routing tables, see Appendix B.

Type the IP address from which to begin the discovery process in the Start IP Address field.

Type the IP address at which to stop the discovery process in the End IP Address field.
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Note – You only need to do this step if you selected Ping as the discoverymethod.

Type a netmask value in the Netmask field.

Note – You only need to do this step if the following criteria apply:

� You selected Ping as the discoverymethod.
� You need to use a netmask other than the default value (255.255.255.0).

Type a number in the Number of Hops field.

The term hop refers to the number of routers through which a packet passes before the packet
reaches its destination. For example, a value of 0 (zero) would limit the discovery process to the
current subnet.

Note – You only need to do this step if the following criteria apply:

� You selected Routing Table as the discoverymethod.
� Youwant to limit the size of the discovery process.

To use a port number other than the default (161), enter a port number in the Also Check Port field.

Tip – To check only the port number that you enter, deselect Use Default Port.When you select Use
Default Port and you add a number in the field, the discovery process checks both the default port
number and the port number that you provide.

Tip – If SunManagement Center agent runs on non-default port, say 1161, and non SunManagement
Center agent runs on default port (161), deselect Use Default Port. Otherwise, the discovery process
discovers the non SunManagement Center agent and ignores the SunManagement Center agent.

To start the discovery process, click the OK button.

Aconfirmation window appears.

To customize your discover request, see the following sections:

� “To Set Preferences for a Discover Objects Request” on page 80
� “To Limit a Discovery Process byHardware, Software, or Object Names” on page 81
� “To Schedule a Discover Objects Request” on page 83

To run the discover request immediately, click the Yes button.

When you start the discovery process, the following events occur:
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� The discovery process finds all nodes that are running the SunManagement Center agent,
including agent nodes that belong to another SunManagement Center server context. Nodes
that are running SunManagement Center agents in a remote SunManagement Center server
context are included. Extensive information is gathered for SunManagement Center agent
nodes.

� The discovery process finds all nodes that are running an SNMPagent. Limited information is
gathered for SNMPagent nodes.

� The discovery process finds all nodes that are running neither a SunManagement Center agent
nor an SNMPagent. These are listed as ping hosts. Very little information is gathered for ping
hosts.

If a Sun Management Center server or agent is incorrectly reported to be a ping host or is not
discovered, rerun the discovery process with larger timeout and retry values.

Note – If a host is extremely busy, a discovery process that is gathering data for that hostmight time
out. If a timeout occurs for a host that is a SunManagement Center agent, the host might be reported
as a ping host .Alternatively, the host might not be discovered at all. If a timeout happens, youmight
want to increase the ping and SNMP timeout periods and re-initiate the discovery process. See “To
Set Preferences for a Discover Objects Request” on page 80 formore information.

� ToSet Preferences for aDiscoverObjects Request
In the New Discover Request window or the Edit Discover Request window, click the Preferences tab.

To stop writing discover request information to a log file, deselect the Log Discover Request Progress
check box.

By default, information is written to a log that you can access from the Discover Objects window. For
more information, see “ToView the Discover Objects Log” on page 84.

If you disable the log feature, information about the discover request process status still appears in
themain Discover Objects window.

If needed, edit the information in the Timeout field in the Ping section of the Preferences.

This field enables you to increase the amount of time in seconds that the DiscoveryManager waits
for a response to a ping request. By default, the DiscoveryManager waits for one second for a
response before the DiscoveryManager times out.

If needed, edit the information in the Retries field in the Ping section of the Preferences.

This field enables you to increase the number of times that the DiscoveryManager sends a ping
request to a potential managed object. By default, the DiscoveryManager pings each potential object
one time.
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If needed, edit the information in the Timeout field in the SNMP section of the Preferences.
This field enables you to increase the amount of time in seconds that the DiscoveryManager waits
for a response to an SNMP request. By default, the DiscoveryManager waits for three seconds for a
response before the DiscoveryManager times out.

If needed, edit the information in the Retries field in the SNMP section of the Preferences.
This field enables you to increase the number of times that the DiscoveryManager sends an SNMP
request to a potential managed object. By default, the DiscoveryManager sends one SNMP request
to each potential object.

If needed, edit the information in the Community String field in the SNMP section of the preferences.
This field enables you to change the default community string for SNMP. The default value is public.
To change this value, add one ormore character strings separated by a pipe (|) character.

If needed, edit the value in the Maximum Hosts field in the General section of the preferences.
This field enables you to limit the number of objects that can be added to the topology database. The
default value is 256.

If needed, edit the value in the Maximum Time field in the General section of the preferences.
This field enables you to limit the amount of total time that the discovery process runs. The default
value is 1000000 seconds, or approximately 280 hours or slightly more than 11 days.

Click the OK button.
Your preferences are applied. The NewDiscover Request window closes. The discovery process
starts.

� To Limit aDiscovery Process byHardware, Software,
orObjectNames
You can choose to include or excludemanaged objects by host name, operating system, or platform
type. Filtering uses the grep command to search for the supplied value.

In the New Discover Request window, click the Filters tab.

To filter managed objects based on the object name, select Host Name or Label.

a. Type a text string in the Host Name or Label field.

b. Click the Add button to add the text string to the filtering criteria.

c. Determine whether to include managed objects that contain this string.
To include objects that contain this string, click the Include button.
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To exclude objects that contain this string, click the Exclude button.

To remove a name filter, click the text string in the list on the right, then click the Remove button.

To filter managed objects based on the object platforms, select Platform Types.

Platforms include both hardware objects and composite objects that contain a logical grouping of
hardware and software.

a. In the Platform Types list on the left, select a platform type on which to filter .

b. Click the Add button to add the platform type to the filtering criteria.

c. Determine whether to include managed objects for this platform.

To include objects for this platform, click the Include button.

To exclude objects for this platform, click the Exclude button.

To remove a platform types filter, select the platform type in the list on the right, then click the
Remove button.

To filter managed objects based on the operating environment, select Operating Systems.

a. In the Operating Systems list on the left, select an operating environment on which to filter.

b. Click the Add button to add the operating environment to the filtering criteria.

c. Determine whether to include managed objects for this operating environment.

To include objects for this operating environment, click the Include button.

To exclude objects for this operating environment, click the Exclude button.

To remove an operating environment filter, select the operating environment in the list on the right,
then click the Remove button.

To filter managed objects based on the Sun Management Center modules that reside on those
objects, select Modules.

a. In the Modules list on the left, select a module on which to filter.

b. Click the Add button to add the module to the filtering criteria.

c. Determine whether to include managed objects for this module.

To includemanaged objects for this module, click the Include button.

To excludemanaged objects for this module, click the Exclude button.

To remove amodule filter, select themodule in the list on the right, then click the Remove button.
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Click the OK button.

Your filters are applied. The NewDiscover Request window closes. The discovery process starts.

� ToSchedule aDiscoverObjects Request
In the New Discover Request window, click the Schedule tab.

To define a schedule, select Schedule Discovery Request.

To set the request to run on a day other than today, provide a date in the Start Date field.

You can edit the information in the Start Date fieldmanually, or you can click a date in the calendar
to select the date.

Select an hour and minutes from the Start Time pop-up menus.

Hours are based on a 24–hour clock. For example, 16:30 is the same as 4:30 PM.

Choose how often the request should run from the pop-up menu next to Repeat Interval.

Choosing a Repeat Interval enables you to automatically update the database according to your
defined schedule. For example, if your network environment changes often, youmight want to run
your discover request on a weekly basis to keep your database current.

To exit from the New Discover Request window, click the OK button.

The discover request is placed in a queue according to your defined schedule

� ToModify aDiscoverObjects Request
If you have previously created a periodic discover request, you can change the parameters for that
discover request through the Edit Discover Request window.

Choose Discover Objects from the Tools menu in the main console window.

TheDiscover Objects window is displayed.

Select the name of the discover request that you want to modify.

Click the Modify button.

The Edit Discover Request window is displayed. The top bar of the window displays the ID of the
request, and the Request Name field displays the name of the request.

Select the Discover, Preferences, Filters, and Scheduling tabs and change settings as needed.

Settings are the same as the settings that you created or changed when you defined the discover
request. Formore information, see:
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� “ToDefine and Initiate a Discover Objects Request” on page 77
� “To Set Preferences for a Discover Objects Request” on page 80
� “To Limit a Discovery Process byHardware, Software, or Object Names” on page 81
� “To Schedule a Discover Objects Request” on page 83

To exit from the Edit Discover Request window and to accept any changes that you made, click the OK
button.

Adialog box appears, offering several choices for running themodified discover request.

� To start the discover request and to run the request immediately, click the Yes button.
� To schedule the discover request but not run the request immediately, click the No button.
� To cancel the running of the discover request entirely, click the Cancel button.

� ToStart, Stop, orDelete aDiscoverObjects Request
If you have previously created a discover request, you can start, stop, or delete the request through
the Discover Objects window.

Choose Discover Objects from the Tools menu in the main console window.

TheDiscover Objects window is displayed.

Select the name of the discover request that you want to start, stop, or delete.

Click the Start, Stop, or Delete button.

� ToView theDiscoverObjects Log
In the Discover Objects window, select the name of the discover request whose log you want to view.

Click the Log button.

The log file appears in a read-only window.

Tip – If the log file is longer than the visible part of the window, use the side scroll bar to view the rest
of the file.

If the request is running, click the Refresh button to update the log file view.

To exit from the log file, click the Close button.
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ManagingObjects in SunManagement Center

Note – This chapter provides an overview of the Java Console.Although some tasks are described,
most of the procedures used tomanage andmonitor your system are described elsewhere in this
document. For information about logging into the Java Console, including logging in automatically
by using a configuration file, see the “Starting the Console” in SunManagement Center 3.6.1
Installation and Configuration Guide.

The following topics are described in this chapter:

� “Overview ofMain ConsoleWindow” on page 86
� “ToUse theMenu Bar” on page 86
� “ToAccess a Pop-UpMenu” on page 87
� “ToView a Tool Tip” on page 87
� “To Find aManagedObject” on page 88
� “ToView aDifferentAdministrative Domain” on page 88
� “Administrative Domain View” on page 88
� “ToNavigate the Hierarchy View” on page 90
� “ToNavigate the Topology View” on page 91
� “To Change the Topology Layout” on page 92
� “To Provide a Background Image for the Topology View” on page 92
� “To Remove the Background Image From the Topology View” on page 93
� “To Connect Objects in the Topology View” on page 93
� “To Remove a Connection BetweenManagedObjects” on page 94
� “Administrative Domain Status Summary” on page 94
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OverviewofMainConsoleWindow
Themain console window is the primary user interface for SunManagement Center. The window
provides the following features:

� Visual representations of themanaged objects, for example, hosts and networks
� Ability tomanipulate attributes and the properties that are associated with themanaged objects,

such as creating alarm threshold conditions

The features that are shown in the following figure arementioned in this chapter.

FIGURE 5–1MainConsoleWindow

� ToUse theMenuBar
Themenu bar at the top of the console window provides access to common SunManagement Center
features and tools. If a menu name or function appears dimmed, that option is not available for you
to use. This state mightmean that you need to select an appropriate managed object first.

To access a menu, click the menu label.
Themenu contents appear.
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Tip – Once you have displayed amenu, you can scroll or use the right and left arrow keys on your
keyboard tomove among themenus.

To choose a menu option, click the menu option label.

� ToAccess a Pop-UpMenu
Pop-upmenus are available for all objects in the hierarchy and topology views. The contents of a
menu vary according to the capability of the selected object.

Press mouse button 3 (typically the right mouse button) on the object.

The pop-upmenu is displayed.

To choose a menu item, click mouse button 1 (typically the left mouse button).

The following list describes the common items in the approximate order in which the items are
displayed in the pop-upmenus. Some items are not displayed in all menus.
Cut Cuts the selected object. The cut object is enclosed in a dashed box until the

object is pasted into a new location. To cancel the cut operation, click the object.

Copy Copies the selected object.

Rename Displays the RenameObject window.

Modify Displays theModify Object window.

Attribute Editor Displays theAttribute Editor. Formore information, see Chapter 10.

LoadModule Displays the LoadModule dialog box. Formore information, see “To Load a
Module” on page 162.

Details Displays the Details window. Formore information, see Chapter 6.

AlarmAction Displays theAlarmAction window in which you can define actions to take
when an alarm occurs. Formore information, see Chapter 12.

� ToViewaTool Tip
As youmove themouse cursor over various areas in themain console window, tool tips are displayed
momentarily.A tool tip is a description of the selected object or a description of a property and value
column of any data property table. Data property tables are described in Chapter 8. Property tables
provide information about themonitored property. These tables are described in Appendix C.

To see a Tool Tip, place your mouse cursor over an object.

After a brief delay, a tool tip provides a short description of that object.
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� To Find aManagedObject
From the main console window, click the Search icon or choose Search from the Go menu.

The Search window appears.

To find a specific object name, type the managed object name to find in the Object Label field.

You can provide a complete name or a partial name.

To find a managed object based on filtering criteria, click the button next to Filter Name. Then, select
a filter from the Filter Name menu.

You define a filter using the filteringmechanism in theManage Jobs window. To access theManage
Jobs window, selectManage Jobs from the Tools menu in themain console window. Formore
information, see “Using Filters” on page 205.

Click the Search button.

Alist of matching names is displayed in the Search Results section.

To see information about a managed object, select the name from the Search Results list. Then, click
the Go To button.

The topology view of themain console window changes to show information about the selected
object.

� ToViewaDifferentAdministrativeDomain
In the main console window, click the Sun Management Center Administrative Domains button.

The current list of administrative domains appears.

Select the administrative domain that you want to view.

Themain console window updates to show the selected administrative domain. The Sun
Management CenterAdministrative Domains button changes to display the name of the
administrative domain that you selected.

Formore information about defining and working with administrative domains, see Chapter 2.

AdministrativeDomainView
Once you have created an administrative domain and have populated it with objects, you can see the
administrative domain and its objects in the hierarchy (tree) view and the topology (regional) view of
this administrative domain.
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The administrative domain view enables you to build collections of objects that support your
monitoring andmanagement tasks. You can group your host sets by buildings, subnets, or other
group objects. You can view all objects in the administrative domain, or view only selected objects,
such as the servers that support a specific function that interests you.

The administrative domain view shows you the objects that are contained in an administrative
domain. The objects are the administrative domain, and any groups and hosts that are contained in
the administrative domain.

The following figure illustrates an example of an administrative domain. In this example, Payroll
Servers 1 represents an administrative domain that consists of all the host machines in the Payroll
office. The host machines are found in two geographic sites: CampusAand Campus B. Campus B
has one building (Building B), which contains two host machines, Payroll 1 and Payroll 2.

FIGURE 5–2 SampleAdministrativeDomain

You can choose to create a similar type of administrative domain. For example, you can group your
machines by subnet, rather than by building. You should create an administrative domain and its
subordinate groups in a hierarchy that best supports yourmonitoring activities.

Formore information about administrative domains, see Chapter 2.
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Themain console window displays two views of an administrative domain and its members. The left
side of the administrative domain view is the hierarchy view. The right side is the topology view.

� Hierarchy (tree) view
The hierarchy view displays the relationship between an administrative domain and its members.
Some objects in the hierarchy view contain other objects that can be a group of objects or a single
object.
In Figure 5–2, Building B is an object that is contained in the Headquarters administrative
domain, but is also a group. Building B contains the network 194.150.151.52, the subnet
mpk12-238-n, GROUPA, and hosts machineA and machineB.
Formore information, see “Hierarchy View” on page 90.

� Topology view
The topology view displays themembers of an object selected in the hierarchical tree.
Formore information, see “Topology View” on page 91.

HierarchyView
Two types of windows contain hierarchy views:

� Domain view in themain console window, as illustrated in Figure 5–1
� Browser view in the Details window, as illustrated in Figure 6–7

The administrative domain hierarchy view displays the administrative domain and its members.

The Browser hierarchy view displays the host and its modules. This view is part of the Browser
Details window, which is described in Chapter 7.

Both the administrative domain hierarchy view and the Browser hierarchy view behave in the same
manner. In both windows, the hierarchy view is on the left side of the window.

� ToNavigate theHierarchyView

To view details about a host, double-click the host icon in the main console window.

� If the selected object is a host, the Details window appears.
� If the object contains othermanaged objects, the topology view displays themembers of the

selected object.

To view the contents of a managed object, click the expansion icon to the left of the object icon.

The icon looks like a handle. The icon changes to a darker color, and the subordinate objects appear
in the hierarchy view.
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If an object has an expansion icon next to it, the object contains additional information. You can
obtainmore information about the object by examining its subordinate objects.

To view more information about a managed object, double-click the object icon.

� If themanaged object is a container icon, such as a domain or group object, and is not expanded,
the icon changes to a darker color. The hierarchy view and the topology view expand to display
the contents of the object.

� If themanaged object is a container icon and is expanded, the hierarchy view and the topology
view compress so that the subordinate contents are removed.

� If themanaged object is a lowest-level icon, for example, a host, the Details window appears. This
window providesmore information about themanaged object. Formore information, see
Chapter 6.

To access the pop-up menu for an object, press mouse button 3 on the object icon.

Formore information about pop-upmenus, see “ToAccess a Pop-UpMenu” on page 87.

TopologyView
The topology view displays themembers of the object selected in the hierarchy view. You can
customize the topology view in the following ways:

� Change the way in which an object is displayed, as described in “To Change the Topology
Layout” on page 92. For example, you can view an object as a grid, a network, or a ring.

� Connect objects together, as described in “To Connect Objects in the Topology View” on page
93.

� Add a background picture or amap, as described in “To Provide a Background Image for the
Topology View” on page 92.

There are two types of windows that contain topology views:

� Domain view in themain console window, as illustrated in Figure 5–1
� Browser contents view in the Details window, as illustrated in Figure 6–7

Both the administrative domain and the browser contents views behave in the samemanner.

� ToNavigate the TopologyView

To view details about a host, click or double-click the host icon.

� If the selected object is a host, the Details window appears.
� If the object contains othermanaged objects, the topology view expands to display themembers

of the selected object.
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To access the pop-up menu for an object, press mouse button 3 on the object icon.

Formore information about pop-upmenus, see “ToAccess a Pop-UpMenu” on page 87.

To select an object, click the object icon.

� ToChange the Topology Layout
In the topology view, you can choose to view an object using one of several layout types. For example,
you can simply view the objects as a list, or you can view the objects as a ring network.

To change the topology layout, choose Topology Layouts from the View menu in the main console
window.

Aselection list appears.

Click the layout that you want to use.

You can choose one of the following layout types:

� Network (default) – Shows the objects arranged in one of the following ways:
� Across the window in the order in which the objects were discovered or added to the database
� As arranged by the console user

� Grid – Shows the objects arranged in an organized grid in the order in which the objects were
discovered or were added to the database

� List – Shows the objects in a vertical list in the order in which the objects were discovered or were
added to the database

� Bus – Shows the objects linked together by a series of lines that mirror the view of a network bus
� Star – Shows the objects in a star to indicate the parent object is a star network
� Spoked Ring – Shows the objects in a ring to indicate the parent object is a ring network

The topology layout changes within a few seconds of when you select a type.

� ToProvide aBackground Image for the TopologyView
You can select background images to place yourmanaged objects in the approximate locations where
the physical network components exist. This ability can be useful if you havemanaged objects that
are located in various states or countries. Once you have set the backgrounds and placed the objects
where they reside, if a problem occurs, you would be able to respondmore quickly because you know
where themanaged object is.

To choose a background for the current topology view, choose Set Topology Background from the
View menu in the main console window.

The Set Topology Backgroundwindow appears.

Click the name of the geographical location that you want to use.
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Tip – Use the scroll bar at the right side of the window tomove up and tomove down in the list.

Determine how many instances of the background image to display.

� To apply just a single instance of the background image, make sure that Tile with this image is not
selected.

� To applymultiple instances of the background image, make sure that Tile with this image is
selected.

To apply your changes and close the Set Topology Background window, click Set.

� ToRemove theBackground ImageFrom theTopologyView

To remove a background for the current topology view, choose Set Topology Background from the
View menu in the main console window.

The Set Topology Backgroundwindow appears.

Click the Unset button.

The Set Topology Backgroundwindow closes. The topology view is redrawnwithout any topology
background image.

� ToConnectObjects in the TopologyView
Tomake the topology view of your networkmore realistic, you can create a representation of the
network connections between objects.

In the topology view, click the icon for the first managed object that you want to connect.

Aselection box appears around the selected object.

Press the Shift key, and click the icon for the second managed object that you want to connect.

Aselection box appears around the selected object.At this point, both objects should have selection
boxes.

To create the connection, choose Create Connection from the Edit menu in the main console window.

The Create Connection window appears.

In the Create Connection window, click the type of network connection to use.

Values include the following types:

� General – Indicates either that you do not know the type of network connection or that the
connection does not fit any other category

� RS–232 – Indicates an RS-232 connection
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� T1 – Indicates a T1 connection
� T3 – Indicates a T3 connection

Type a label for the connection.

For example, Print Client-Print Server.

(Optional) Type an additional description for the connection.

To create the connection and close the Create Connection window, click OK.

Aline appears in the topology view, connecting the objects.

� ToRemoveaConnectionBetweenManagedObjects

Click the line that indicates the connection in the topology view.

Caution – Make sure to click the connection line carefully. If you also select an object, youmight
inadvertently remove that object.

Choose Delete Object/Connection from the Edit menu in the main console window.

The topology view updates.

AdministrativeDomain Status Summary
The administrative domain status summary displays the number of managed objects that have
unacknowledged open alarms, by level of severity, in the selectedAdministrative Domain.An
example is shown in Figure 5–3.

Note – If a host hasmultiple alarms at several different severity levels, the host is represented at only
the highest severity level for that host.

Formore information about the administrative domain status summary, see “ToViewAlarms From
theMain ConsoleWindow” on page 176.

FIGURE 5–3Domain Status Summary
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ViewingDetailed InformationAbout a
ManagedObject

The SunManagement Center Details window provides detailed information about a selected object.
The following subjects are described in this chapter:

� “Overview of the DetailsWindow” on page 95
� “To Start the DetailsWindow” on page 109
� “Info Tab” on page 96
� “Module Browser Tab” on page 97
� “Alarms Tab” on page 98
� “ModuleManager Tab” on page 98
� “View Logs Tab” on page 98
� “ToView the System Log FileMessages” on page 110
� “To Filter Your Log Request” on page 111
� “ToMonitor LogMessages” on page 112
� “To Find a LogMessage” on page 113
� “ToView the SunManagement Center Log FileMessages” on page 113
� “To Refresh LogMessages” on page 114
� “ToViewOther Log FileMessages” on page 114
� “Applications Tab” on page 99
� “Hardware Tab” on page 102

Overviewof theDetailsWindow
The details view is a subset of the Domain view. The highest hierarchical object in a details view is the
host machine ormodule object. Formore information aboutmodule objects, see “To Create a
Module Object” on page 64. Unlike the administrative domain view, the details view enables you to
seemodules and the variousmonitored properties and statistics contained in themodules.

The Details window displays several tabs. The commonly seen tabs are shown in Table 6–1.

Click a tab to view the named information.
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The tabs that appear in the Details window depend on the type of selected object. For example, the
Hardware tab appears only if the Config-Readermodule is supported on your system. For additional
information about the tabs for your specific hardware object, see your platform supplement.

TABLE 6–1CommonDetailsWindowTabs

Tab Description

Info Provides general information about themanaged object including name, IP address,
polling type, and so on. This information is collected at the time the object is created.
Info is the default view if themanaged object is beingmonitored through SNMPor
ICMPor if the object is in a non-monitored status.

Module Browser Enables you to navigate through the hierarchy and contents views of the hardware,
operating system, local applications, and remote systems.Module Browser is the
default view if themanaged object is beingmonitored through a SunManagement
Center agent.

TheModule Browser is described in Chapter 7.

Alarms Displays alarm statusmessages and the alarm controls for the current host or node.
Enables you to acknowledge or delete alarms.

Alarms are described in Chapter 12.

ModuleManager Displays available modules and identifies whichmodules are loaded, scheduled, and
enabled.Also indicates anymodules that aremulti-instancemodules. Enables you to
load, enable, disable, and unloadmodules.

View Logs Displays information from log files, including errormessages, for your host. Enables
you to search, monitor, and examine system, SunManagement Center, and other log
messages.

Applications IfAdvanced SystemMonitoring add-on is installed, displays a list of applications.
These applications can include the processes that are running on the host, other
installed applications, and hardware information. Process information appears only if
the Solaris Process Details module is loaded. Hardware information appears only if the
Hardware Diagnostics Suite software is enabled. Formore information about the
Hardware Diagnostic Suite, view its online help.

Hardware Displays hardware configuration information about your host for selected hardware
platforms. Configuration informationmight include the physical and logical view of
your host. This tab appears only if the hardware platform is supported by the
Config-Readermodule.

Info Tab
The Info tab shows the properties table for the currentmanaged object. The properties table is the
only information that is available from the Details window for objects that aremonitored through
SNMPor ICMP. The general properties are listed in the following table.

Overview of theDetailsWindow
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TABLE 6–2 General Properties in the Info Tab of theDetailsWindow

Property Description

Entity Desc Label you selected when you created the node.

Entity Full Desc Optional description that you entered when you created the node.

Hostname Machine name 1

IPAddress IP address 2

Netmask Netmask associated with the host

Operating System Operating system type and version

Entity Family Hardware architecture

Entity Trap
Destination

Host IP address of SunManagement Center server that receives this host’s trap
information

Entity Event
Destination

Host IP address of SunManagement Center server that receives this host’s events
information

Entity Polling Type Agent or SNMP

Target Hostname Host name of the target

Target IPAddress IP address of the target

Agent Version The version number for the agent software, or 0.0 if polling type is SNMP

Time zone The time zone in which themanaged object resides
1 The host name in this property table does not change if you change the host name on the host device. To update the information, either
modify the host object, or delete the existing host object and re-create the object with the new name. See “ToModify anObject”
on page 70.

2 When a SunManagement Center entity is added to the topology, the TopologyAgent queries the entity for its configured IP address
and port for the TrapHandler and EventManager components. However, the information stored in the topology will be incorrect if the
entity is ever reconfigured to correct amisconfiguration or to change the entity server-context. If the information that is shown here for
the TrapHandler and EventManager is compared with the expected configuration of the entity and does notmatch, remove the entity
from the topology and re-enter it.

ModuleBrowser Tab
TheModule Browser tab displays the hierarchy and contents views formanaged objects that are
monitored through SunManagement Center agents. These objects represent hardware, operating
system, local applications, and remote systems.

See Chapter 7 for detailed information about using theModule Browser tab.
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Alarms Tab
TheAlarmsDetails window displays the alarms for the host. For detailed information about using
the SunManagement CenterAlarmManager, see Chapter 12.

ModuleManager Tab
TheModuleManager tab displays the loadedmodules. This tab also lists thosemodules that are
available to your system but are not currently loaded or scheduled to be loaded. You can perform the
following tasks:

� Unload amodule
� Load amodule
� Edit module parameters
� Enable amodule
� Disable amodule
� Displaymodule rules
� Schedule amodule for loading at a later time

For detailed information about using theModuleManager tab, see Chapter 11.

ViewLogs Tab
The View Logs tab enables you to view several types of messages:

� System logmessages stored in the /var/adm directory
� SunManagement Center errormessages
� Othermessages

By default, only the system logmessages in /var/adm are displayed. File names for these system log
messages start with the word messages.

If you select the SunManagement Center Log option on the Log File menu, a list of log file choices is
displayed.

The View Logs window has two scrollable panes:Messages For andMonitoredMessages.

� TheMessages For area contains the filteredmessages that you select using the Filter button. You
can locate specificmessages in this area by using the FindMessage feature.

� TheMonitoredMessages area contains themessages that you select using theMonitor button.
Newmessages in this field are highlighted.

Overview of theDetailsWindow
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Note – If nomessagesmatch the Filter criteria, the followingmessage appears at the bottom of the
View Logs window.

No matches found for this log file

Applications Tab
TheApplications tab enables you to view and select detailed information about processes running on
the selected host or node. If you have any custom or third-party applications installed, this tab also
enables you to view detailed information about processes running in the selected applications. The
displays are continually updated.

ViewProcesses
The View Processes application in Figure 6–1 enables you to view and select detailed information
about processes running on the selected host or node.

The Solaris Process Details modulemust be loaded to use the Process Viewer. For instructions, see
“To Load aModule” on page 162. If the Solaris Process Details module is not loaded when you click
theApplications tab, youmust do the following:

1. Close the Details window.
2. Load the Solaris Process Details module.
3. Reopen the Details window.

Overview of theDetailsWindow
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FIGURE 6–1ProcessViewer

The following table lists the properties that are available in the Process Viewer.

TABLE 6–3ProcessViewer Properties

Property Description

PID Process Identifier

PPID Process ID of the parent process

UID Effective user ID number

User Effective user login name

EUser Effective user ID

Overview of theDetailsWindow
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TABLE 6–3ProcessViewer Properties (Continued)
Property Description

Group ID Group ID of the user

EGroup Effective group ID of the user

Session ID Process ID of the session leader

PGroup Process ID of the process group leader

Tty Terminal that controls the process.Aquestionmark (?) is printed when there is no
controlling terminal.

Start time Time that the process started, in hours, minutes, and seconds. The start time for a
process that is more than 24 hours old is given inmonths and days.

Time Cumulative execution time for the process

State State of the process

Wait Channel Address of an event for which the process is sleeping. If blank, the process is running.

Class Scheduling class of the process

Address Memory address of the process

Size Size in pages inmainmemory for the image of the swappable process

Priority Priority of the process

Nice Decimal value of the system scheduling priority of the process

CPU% Ratio of CPU time used recently to CPU time that was available in the same period,
expressed as a percentage

Memory% Ratio of the process’s resident set size to the physical memory on themachine,
expressed as a percentage

Command Command name

CommandLine Full command name and its arguments, up to a limit of 80 characters

Process Statistics Window

TheOutput For Process IDwindow displays the statistics for either pmap, pstack, pfiles, or pldd
for any highlighted process in the Process Viewwindow.

pmap Prints the address spacemap of each process

pstack Prints a stack trace for each lightweight process (lwp) in each process

pfiles Reports fstat and fcntl information for all open files in each process

pldd Prints dynamic libraries for the process
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Process Summary Field

The Process Summary field lists statistics for all processes, active or inactive.

Customor Third-PartyApplications

Note – To develop custom applications, you need the SunManagement Center Developer
Environment and documentation. See your Sun authorized sales representative formore
information.

If you have any custom or third-party applications installed on your system, they are listed below
Applications - View Processes in the left side of theApplications Details window. Select the
application if you do not want to view process detail information for a host or node.

After you select an application, the selected properties for the application are displayed in the right
side of theApplications Details window. The properties that are shown depend on the application
that is selected.

Hardware Tab

Note – TheHardware tab does not appear if this feature is not supported on your system.

TheHardware Details window, which is shown in Figure 6–2, provides three choices for system
information:

� Hardware Summary
� Physical View
� Logical View

Note – For additional information about theHardware tab for your specific hardware object, see your
platform supplement.
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FIGURE 6–2HardwareDetailsWindow

The Viewsmenu provides access to the available hardware information.

Hardware Summary
The SunManagement Center software displays a table of hardware resources of the selected host.
The following list shows some typical values displayed in the Hardware Summary.

Total Disks Total number of disks that are connected to the host

TotalMemory Total amount of memory that is connected to the host

Total Processors Total number of processors that are connected to the host

Total Tape Devices Total number of tape devices that are connected to the host

Your summarymight appear different. The resources vary, depending on the type of object that is
displayed in the detail view.

Note – The Total Disks field displays the number of internal disks only. This number does not include
the disks that are part of enclosures.

Physical View
When you select the Physical view - system option, the software displays a photo-realistic picture of
the selected host, if available. Pictures are not available for some system types.
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Note – This feature is usable only if the host is monitored by a SunManagement Center agent.

As youmove themouse pointer over the picture of the system being viewed, some of the
components are highlighted. The detailed component information displays in the right section of the
viewing window. The path name of the component is displayed in the Component field at the bottom
of the window.

If a component has an alarm, a colored line appears around the component to indicate the alarm
severity. This line enables you to identify quickly the faulty component.

FIGURE 6–3 Hardware Configuration Physical ViewWithComponentDetails (Property/ValueView)

Rotate Current View Menu

For some systems, you can select alternate front, rear, and side views through the Rotate Current
View pull-downmenu. Pictures are not available for some system types.

For some systems, pictures of components such as CPU boards and I/O boardsmight also be
available.As youmove themouse pointer over the system picture, the pointer changes from an arrow
to a hand icon when there is an individual component picture.
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Click a highlighted component to display the detailed picture of the component.When you are
finished viewing component details, click Up to return to the parent system view.

Physical View When a Sun StorEdge Device is Connected

If a Sun StorEdgeTMA5000,A5100,A5200, or T3 system is connected to the selected component, the
Views pull-downmenu lists the devices that are connected. The connected devices are listed under
the system to which they are connected. The Sun StorEdgeA5000-series devices are displayed on this
menu as sena(0), sena(1), and so on.

You can select and view any of these storage devices from the Viewsmenu.

History Menu

Use theHistory pull-downmenu to revisit a view that you had selected previously.

Refresh Details Button

Click the Refresh Details button to update the Property/Value information in the right side of the
Details window for the selected physical component. Otherwise, the information does not change
fromwhen you first opened the physical view.

Dynamic Reconfiguration Button

TheDynamic Reconfiguration button appears in the physical view and in the logical view only for
certain platforms. Refer to your hardware supplement formore information.

Logical View
The software displays a logical view configuration of a host, if the host is monitored by a Sun
Management Center agent, as illustrated in the following figure. Logical views are not available for
ping hosts.
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FIGURE 6–4HardwareConfiguration Logical View

Search Button

Click the Search button to display the Search window. Use the Search window to search for
components in the Logical View topology on the left side of the viewing window. The located
component is highlighted in the topology view. The name of the component displays in the
Component field in the bottom right section of the screen.

The Search function is case-sensitive. If the search does not locate the component in your system, the
following errormessage appears at the bottom of the Details window.

Node not found
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The Search function stops at the first instance found. For example, if you enter the word board,
Search always stops at board(0). To find the next hit, click the Next button. To find a specific
instance of a name, type amore complete name. For example, board(2).

ExpandAll

Click the ExpandAll/Recover Default button to decompress and recompress all the component icons
in the topology area (left side) of the window. The compressed view is shown in the following figure.

FIGURE 6–5 Compressed Topology of Components in Logical View

Press the ExpandAll button to display the expanded topology view, as shown in the following figure.
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FIGURE 6–6 ExpandedTopology of Components in Logical View

The button label toggles to Recover Default.When you press Recover Default, the topology
recompresses all the component icons in the topology area of the window.

Refresh Details and Dynamic Reconfiguration

The Refresh Details andDynamic Reconfiguration features in the Logical View are the same as the
features described for the Physical View in “Refresh Details Button” on page 105 and “Dynamic
Reconfiguration Button” on page 105.
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Navigating theDetailsWindow
Some tabs can displaymany levels of detail. Double-click icons in the Details window to see
additional levels of information.Acategory can havemany subcategories.

If information in a table cell is too long to display completely, hold themouse pointer in the cell for
several seconds. The complete text that is contained in that cell appears in a pop-up window.

To expand or compress the hierarchy, use the expansion icon.The hierarchy is compressed when the
icon “handle” is pointing right. The hierarchy is expanded when the icon “handle” is pointing down.

� ToStart theDetailsWindow
Start the Details window in either of the following ways:

� Double-click an object icon in either the hierarchy view or the topology view.
� Press mouse button 3 on an object icon, and choose Details from the pop-upmenu.

Tip – Be sure to select an object, not an administrative domain. TheDetails window is not available for
administrative domains.

The Details window appears, as illustrated in the following figure.

1
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FIGURE 6–7DetailsWindow for a SelectedObject

Click a tab to view detailed information for that category.

Viewing LogFiles
You can view log files or portions of log files. You can alsomonitor logmessages as themessages are
added to the log files.

� ToView the SystemLogFileMessages

In the Details window, click the View Logs tab.

Choose System Log from the Log File menu.

Click the Log File field, and select Syslog.

The System Logmessages are displayed.
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To refresh the display and view any newmessages, click Reload.

� To FilterYour LogRequest
You can apply a filter to display only thosemessages that match the date range and text pattern that
you specify. In addition, you can limit the size of the search by specifying themaximumnumber of
matches to report.

With the View Logs tab selected in the Details window, click the Filter button.

TheMessage Filter Options dialog box is displayed, as shown in the following figure.

FIGURE 6–8Message FilterOptionsDialog Box

Select the start date for the first log message that you want to view.

Select the start time for the first log message that you want to view.

1

2

3

Navigating theDetailsWindow

Chapter 6 • ViewingDetailed InformationAbout aManagedObject 111



Select the end date for the last log message that you want to view.

Select the end time for the last log message that you want to view.

Type the text pattern to be matched in the Text Pattern to Match field.

Use a text pattern that is unique to the type of message in which you are interested.

Select Forward or Backward to specify the direction of the message search through the log file.

To begin searching from the end of the log file, select Backward. To search from the beginning, select
Forward.

(Optional) Type the maximum number of log messages that should be matched in the Maximum
matches to report field.

If you enter zero (0), all matchingmessages are reported, up to amaximum of 100messages.

To filter and reload your log messages and close this window, click the OK button.

� ToMonitor LogMessages
Monitoring enables you to view new logmessages as themessages occur. Each newmessage that
arrives is highlighted.

Click the Monitor button on the View Logs screen.

TheMonitor Filter Options dialog box is displayed, as shown in the following figure.

FIGURE 6–9Monitor FilterMessagesDialog Box

Select Enable Log File Monitoring to enable log file monitoring.

To display only currently monitored log messages, select Clear Old Monitored Messages.

4

5

6

7

8

9

1

2

3

Navigating theDetailsWindow

SunManagement Center 3.6.1 User’s Guide • May 2006112



Type the text pattern to be matched in the Text Pattern to Match field.

You can use a UNIX regular expression. For information about regular expressions, refer to the
regex(1F)man page.

Use a text pattern that is unique to the type of message in which you are interested.

To monitor your log messages and close this window, click the OK button.

� To Find a LogMessage
You can search for a specific character sequence within a set of messages after the set has been loaded
and displayed in theMessages For area.

Click the View Logs tab in the Details window.

Type the specific character sequence that you want to find in the Find field.

Note – Wildcard searches using an asterisk (*) character, are not supported in the View Logs find
feature. To search for amessage that contains the asterisk character, precede the character with a
backslash (\), for example, \*.

Press Return to search the log messages for that sequence.

The first matchingmessage is highlighted.

Click the down arrow or up arrow to continue your search and find additional occurrences of the
matching sequence.

� ToView the SunManagement Center Log FileMessages

With the View Logs tab selected in the Details window, choose Sun Management Center Log from the
Log File menu.

Alist of log files displays as a submenu.

Select the Sun Management Center log file that you want to view.

Themessages for the selected log file are displayed.

To apply filters to the information, click the Filter button. Then, provide the filter parameters in the
Message Filter Options dialog box.

The information is displayed using the filter that you selected.
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� ToRefresh LogMessages

To refresh and reload the currently filtered set of log messages, click the Reload button.

� ToViewOther Log FileMessages

With the View Logs tab selected in the Details window, choose Other Log from the Log File menu.

Note – TheOther Log option is available only if the LogviewACLmodule (LocalApplications) is
loaded.

To filter the log information, click the Filter button. Then, provide the filter parameters in the
Message Filter Options dialog box.

The information is displayed using the filter that you selected.

ViewingApplication andProcess Information
You can view information about an application. You can also view information about a specific
process, such as the amount of memory or CPU currently in use.

Note – The Solaris Process Details modulemust be loaded to view process information. For
instructions, see “To Load aModule” on page 162.

� ToView InformationAbout a SpecificApplication

From the Details window, click the Applications tab.

TheApplications panel appears showing a list of available applications. By default, if the Solaris
Process Details module is loaded:

� The View Processes application is selected in the left side of the window.
� Process information appears in the right side of the window.

To view information about another application, click on the application name in the list on the left
side of the window.

For example, you could view information about the Hardware Diagnostic Suite. The right side of the
window is updated with the selected application.
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� ToDisplayAdditional Properties in theProcess Table
By default, the View Process table displays the following information:

� Process identifier (PID)
� User that is running the process
� Amount of CPU used for the process
� Amount of memory that is used for the process
� Command line for the process

To add additional information to the table, follow these steps:

In the Details window, click the Applications tab.

If the Solaris Process Details module is loaded, the View Process table appears.

Click the View Columns button above the Process table to see a list of available process properties.

Acheckmark appears next to columns that currently are in the table.

To add information about a property to the table, select the property that you want to add.

The selected property appears in a new column to the right of the existing columns in the table.

To add more properties to the table, repeat the preceding steps.

Tip – To view all process properties, select theAll button at the bottom of the ViewColumns list.

� ToSort Columns in theProcess Table
You can sort the processes (rows) by the properties (column headers) in ascending or descending
order. For example, you can sort the CPU% column starting with either the smallest or the largest
value first.

To sort columns in ascending order, click the property in the table column header.

The processes (rows) are updated in ascending order for that property.

To sort columns in descending order, click the property in the table column header while holding
down the Shift key.

The processes (rows) are updated in descending order for that property.

� ToReorder Columns in theProcess Table
You can rearrange the order of columns.

To select a column, press mouse button 1 on a column header.
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To move the column, drag the column header to the desired position and release the mouse button.

ViewingHardware Information

Note – If you load or unload the Config-Reader or Dynamic Reconfigurationmodules while the
Details window is open, youmust close and reopen the Details window to see the results.

� ToViewaHardwareConfiguration

In the Details window, click the Hardware tab.

TheHardware panel appears and displays a summary of hardware information.

Select the configuration in which you are interested.

The window is updated, and the selected feature is displayed.

� ToReconfigure the System

Open the Details window for the selected system.

Select the Module Manager tab in the Details window, and verify that the Dynamic Reconfiguration
(dr) module is loaded.

Load themodule if necessary. For information about loadingmodules, see “To Load aModule”
on page 162.

Select the Hardware tab in the Details window.

From the Views Menu, choose “system” in either the Physical View or the Logical View category.

The view changes, and a Reconfiguration button appears at top of the display.

Click the Reconfiguration button.

� If the Reconfigurationmodule is not loaded, a pop-up window displays an errormessage.
� If the Reconfigurationmodule is loaded, the Dynamic Reconfiguration pop-up window appears.

Select a board slot or memory bank.

Dynamic Reconfiguration buttons are not available for operations that are not permitted for the
selected board ormemory and appear dimmed.

Click the desired function button for the selected memory or board.
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Function Action

Configure Adds the selected board ormemory to the system configuration. Turns on power to the
board, if the board was not previously in the Connected state.

Unconfigure Removes the selected board ormemory from the system configuration. Electrical
power to the board is maintained.

Connect Turns on electrical power to the board. Basic tests of the board are run, but the board is
not automatically added to the system configuration.

Note –TheConfigure function includes this function.

Disconnect Turns off power to the board. The board is ready to remove when the yellow Service
LED is lit, and the Power and Cycling LEDs are off.

TestMemory Tests the selectedmemory.

Note – Memory tests can be time-consuming. These testsmight last an hour or longer
for large-capacity DIMMs.
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Browsing InformationAbout aManagedObject

This chapter describes the following topics:

� “Overview ofModule Browser Tab” on page 119
� “ToApply theAlarms Filter toAll Tables” on page 124
� “To Set Security for a Host orModule” on page 124

OverviewofModuleBrowser Tab
When you open the Details view for a host managed object, theModule Browser tab is selected. The
Module Browser tab shows the hierarchy and contents view for a host. These views provide
additional information about the host hardware, operating system, local applications, and remote
systems.

Tip – To see alarm status information for a node, hold themouse pointer over the object in the right
side of the screen for several seconds.A tool tip shows alarm status information about the object.
Tool tips are also displayed for data property table cells and are useful if information in a table cell is
too long to display completely.

You can expand or compress the hierarchy view by using the expansion icon. The hierarchy is
compressed when the “handle” is pointing right. The hierarchy is expanded when the “handle” is
pointing down.

SunManagement Center software usesmodules tomonitor hosts. Modules are software components
that monitor data pertaining to the health indicators and resources of systems, applications, and
network devices. The information that theModule Browser tab provides depends on themodules
that are loaded for that host. The SunManagement Centermodules belong to one of the four
categories that are shown in theModule Browser tab view. Formore information aboutmodules, see
Appendix C.
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Note – Depending on how your system is configured, youmight not have access to all of themodules
described in this section.

Figure 7–1 is an example of the host view. The left side of the host view is the hierarchy (tree) view
and the right side is the contents view. The host hierarchy view displays the relationship between the
host and its modules. In this example, the loaded operating systemmodules are theMIB-II System
(Simple) and the Kernel Reader (Simple) modules.

Through the Browser Details window, you can set alarm thresholds and view and graphmonitored
data properties for your host.

FIGURE 7–1BrowserDetailsWindow
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HardwareMonitoring
Depending on themodules that are loaded on the system, you canmonitor the following
information about the hardware environment of the host:

� Config-Readermodule
The Config-Readermodulemonitors the host configuration. This configuration includes
information and status for power supplies, key switch, fans, remote console, the system in
general, and so on. There are different Config-Readermodules for different hardware platforms.
If your system is supported by a Config-Readermodule, that module is loaded automatically
during installation. Formore information about the Config-Readermodule for your hardware
platform, refer to your platform supplement and Appendix C.

� Sun StorEdgeA5x00 system
� Sun StorEdge T3 system

Formore information about specific hardware features, see the platform supplement for your
system.

Operating SystemMonitoring
Depending on themodules that are loaded on the system, you canmonitor the following
information about the operating environment of the host:

� Directory SizeMonitoring
� FileMonitoring
� Kernel Reader (Simple)
� Kernel Reader
� MIB-II Instrumentation
� NFS File Systems
� NFS Statistics
� SimpleMIB-II
� Solaris Process Details

LocalApplicationsMonitoring
Depending on themodules that are loaded on the system, you canmonitor the following
information about the local applications on the host:

� Agent Statistics
� Data Logging Registry
� Dynamic Reconfiguration
� File Scanning
� HealthMonitor
� Print Spooler
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� ProcessMonitoring

Remote SystemsMonitoring
Depending on themodules that are loaded on the system, you canmonitor the following
information about the remote systems that the host recognizes:

� MIB-II ProxyMonitoringmodule
� HP JetDirect module, whichmonitors HPprinters equipped with a JetDirect card

Browser Icons
The Browser Details window includes a row of icons at the top of the panel. These icons provide
access to additional functions.

Module Icon
Click themodule icon to see a list of module-related functions:

� LoadModule adds amodule to the host. If a host is not selected, this option is unavailable and is
dimmed. Formore information, see “To Load aModule” on page 162.

� EditModule enables you to changemodule parameters. If a module is not selected, this option is
unavailable and is dimmed. Formore information, see “ToModifyModule Parameters” on page
168.

� EnableModule enables amodule. If a module is not selected, this option is unavailable and is
dimmed. Formore information, see “To Enable aModule” on page 165.

� DisableModule disables amodule. If a module is not selected, this option is unavailable and is
dimmed. Formore information, see “ToDisable aModule” on page 165.

� UnloadModule unloads amodule from the host. If a module is not selected, this option is
unavailable and is dimmed. Formore information, see “ToUnload aModule” on page 166.

Options Icon
Click the options icon to view a list of the following functions:

� Copy enables you to copy amodule. You can paste the copiedmodule in the topology or
hierarchy view of themain console. The copy function enables you tomonitor themodule
properties without having the Details window open. Formore information, see “To Create a
Module Object” on page 64.

� Copy to Dataview Clipboard enables you to copy a data property to a clipboard, and then paste
into a dataviewwindow.

� Create Dataview opens an automatically populated dataviewwindow.

Overview ofModule Browser Tab
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� Copy ToGraph Clipboard enables you to add another data property with the same units to an
existing graph. This function is used withAdd FromGraph Clipboardmenu item in graphing
window. See “To Create a Graph of Two orMore Data Properties” on page 139.

� Alarms Filter Enabled enables you to apply global filters to alarms on the Details windowAlarms
tab. See Chapter 12 formore information.

� Add Row adds a row to a data property table. See “ToAdd a Row to a Data Property Table”
on page 133.

� Edit Row enables you to edit information for a row in a data property table.
� Disable Row disables a row in a data property table.
� Delete Row deletes a row in a data property table.

Attributes Icon
Click the attributes icon to display theAttribute Editor for the selected object. TheAttribute Editor
provides additional information about the selected object and about the rules that govern its
behavior. Use theAttribute Editor to edit information about the object. Formore information about
theAttribute Editor, see Chapter 10.

Set PropertyValue Icon
Click the set property value icon to add property values to amulti-instance task.

Graph Icon
Click the graph icon to create a graph of the selectedmonitored data property. Formore information,
see Chapter 9.

Probe Icon
Click the probe icon to run selected commands on themonitored data property.

Refresh Icon
Click the refresh icon to update the information in the displayed data property table.

Note – When the command is not appropriate for the selected object, the icons are unavailable and
are dimmed.

Alarms Filter
You can use alarm states to filter tables. For example, you can choose to see only rows that are in a
critical (red) state. These filter settings apply only to the currentModule Browser tab in the current
session. The settings do not persist across sessions.

Overview ofModule Browser Tab
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The default state for theAlarms filter is that all options are selected, andAlarms Filter Enabled is set
to On.

� ToApply theAlarms Filter toAll Tables

In the Details window, click the Module Browser tab.

From the Options menu, choose Alarms Filter Enabled.
Aselected check box indicates that filters apply to all tables.Ablank check box indicates that filters
apply only to the specific table for which the alarm filter is defined.

Host Security
In the Details window, SunManagement Center software offers security at two levels: the host and
themodule. Youmight set security at the host level only. In this case, anyone with the appropriate
security can loadmodules, set alarm thresholds, acknowledge alarms, and so on.

Youmight also set security permissions at themodule level. In this case, only those users with the
appropriate module permissions can perform actions on themodule.Module security can be used as
a subset of host security.

For example, at the host level, you can set security permissions so that usersA, B, and C can load
modules and create alarm thresholds. UserA loads the HealthMonitormodule and creates
customized alarm thresholds. However, users B and C can change userA’s work unless security
permissions have also been set at the HealthMonitormodule level, enabling only userAto set alarm
thresholds for that module.

Note – When security is set at both levels, the security permissions at themodule level take
precedence over the security permissions at the host level.

Formore information about security, see Chapter 18.

� ToSet Security for aHost orModule
Open the Attribute Editor for a host or module in either of the following ways:

� Press mouse button 3 on the host ormodule and chooseAttribute Editor from the pop-upmenu.
� Click theAttributes button.

Click the Security tab.

Type the names of user and administrator groups in the appropriate fields.

Formore information about the security fields, see Chapter 18.
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To accept your security settings and close the window, click the OK button.4
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MonitoringData Properties

The SunManagement Center product enables you tomonitor specific data properties for your
managed objects. You can view these properties in tabular format or in graphical format. This
chapter describes how to use tables tomonitor data properties. The chapter includes the following
information:

� “Data Property Concepts” on page 127
� “ToDisplay a Data Property” on page 130
� “To Refresh DisplayedData” on page 130
� “To Select a Row” on page 131
� “To SelectMultiple Contiguous Rows” on page 131
� “To SelectMultiple RowRanges” on page 131
� “ToMonitor Directory Size” on page 132
� “ToAdd a Row to a Data Property Table” on page 133
� “ToAdd a Printer to BeMonitored” on page 134
� “To Probe a Property” on page 135

For information about how use graphs to view data properties, see Chapter 9.

DataProperty Concepts
Use the Details window to view the current values for specific data properties, such as the amount of
memory being used on a host. You navigate through the hierarchy (tree) view to find the appropriate
data property. The lowest-level object in the host hierarchy is themonitored property. By default,
information about amonitored data property is displayed in table form. For information about
viewing that information in a graph, see Chapter 9.

Once the data has been displayed, you can refresh the view. In addition, you can simultaneously
graph up to five data properties. These actions are described in the following sections.
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Standard Table Features
SunManagement Center property tables use a standard format to display information. The format
includes the following elements:

� Aproperty table label
� Column headings
� Individual table cells organized into rows and columns

Editable andNoneditable Cells
SunManagement Center tables contain two types of cells: editable and noneditable.

� Information in an editable cell can be changed. This type of cell has a white backgroundwith
black text.
If you edit information in the cell and you provide an invalid value, an error window appears.
Click OK to close the error window. Then, re-enter an appropriate value in the table cell.

� Information in a noneditable cell is display-only. This type of cell has a colored backgroundwith
black text. The default background color for noneditable cells is light gray.

Cell Editors
Editable cells have one of the following types of cell editors:

� Text Cell Editor
The text cell editor is invoked if the cell is a string type. Once the cell is selected, the text cursor is
activated at the end of the text string. If there is no text, the cursor is aligned left in the cell. To
save the information in the cell, press Return.

� Check Box Cell Editor
Acheck box is a component with only two choices:
� On
� Off

� Combo Box Cell Editor
The combo box cell editor has a drop-downmenu that displays an associated list of options. The
current choice appears in the combo box.As youmove the cursor over the list, each option is
highlighted. The option that you choose from the list replaces the current selection.

Modules That EnableYou toManipulate Rows
For selectedmodules, the software enables you to add, delete, enable, or disable rows for the data
property tables.When thesemodules are initially loaded, the data property tables are empty, except
the Directory SizeMonitoring and Print Spooler modules. For the FileMonitoring, File Scanning,
andDirectory SizeMonitoringmodules, youmust add a row tomonitor the data property. The
following table lists themodules that allow you to add rows.

Data Property Concepts
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TABLE 8–1 SunManagement CenterModules toWhichYouCanAddRows

Module Name Description

Directory Size
Monitoring

Enables you to define another directory formonitoring

FileMonitoring Defines the file to bemonitored

File Scanning Defines the pattern that must bematched within themonitored file

Print Spooler Enables you to define another printer for spooler monitoring

ProcessMonitoring Defines the pattern that must bematched from all the processes that are running on the
agent object

Formore information about the directory sizemonitoring, file monitoring, file scanning, print
spooler, and process monitoringmodules, see Appendix C.

RowContextMenu
The row context menu provides access to various row-related functions, such as enabling you to add
rows to a table that allows this behavior. To activate a row context menu, press mouse button 3 in the
appropriate row.

Table Sorting
Information in tables can be sorted by column. If a column header has a triangle that points up or
down, you can change the order of the table display based on that column. Depending on the data in
the column, the sort uses one of the following keys:

� Alphabetical string
� Numeric
� Date

To change between an ascending and descending sort, double-click the header of the sorted column.

WorkingWith LargeDataProperty Tables
In large data property tables, you can see only one page of rows at a time. To navigate through
additional pages of the table, use the icons that are displayed above the table.

The icons enable you to navigate as follows:

� Return to the first page
� Return to the previous page
� Go to the next page
� Go to the final page

In addition, a pull-downmenu to the right of these icons enables you to go to a specific page.
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ProbingProperties
On selectedmodule properties, the software enables you to use predeterminedUNIX commands
including list files, the vmstat command, and so on. The Probe button is available only for selected
properties. Otherwise, the button is unavailable and is dimmed.

Note – The available Probe commands can sometimes be difficult to distinguish.As an example,
consider the FilesystemUsage properties in the Kernel Readermodule. The FindAll Recent Files
probe commands find only files that were created ormodified less than 24 hours ago. The FindAll
Files probe commands find all files regardless of the date and time that the files were created or
modified. Formore information about the FilesystemUsage properties, see “File SystemUsage
Table” on page 369.

WorkingWithDataProperty Tables
This section describes how to display andmanipulate data property tables.

� ToDisplay aDataProperty

Note –The following example uses the Kernel Readermodule.

In the Browser Details window, double-click the Operating System icon in the hierarchy (tree) view.

The operating systemmodules are displayed in both the hierarchy and topology views.

Double-click the Kernel Reader icon in the topology view, or click the expansion icon next to the
Kernel Reader icon in the hierarchy view.

The Kernel Reader statistics are displayed.

Double-click the System Load Statistics icon in either the hierarchy or the topology view.

Themonitored properties are displayed in a property table.

� ToRefreshDisplayedData
To refresh displayed data, use either of the following methods:

� Press mouse button 3 in the data property table row and choose Refresh from the pop-upmenu.
� Click the Refresh Now button.

The current table is updated with the latest information.
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Note – You can also set up a refresh interval that tells the SunManagement Center software to update
yourmonitored data at your designated time interval. For information about accomplishing this
task, see “To Set a Refresh Interval” on page 152.

� ToSelect a Row
Press mouse button 1 in the first cell of the row that you want to select.

When you select a row, the anchor cell has the focus.

The color of the cells in a row is determined by whether the cell is editable or noneditable. The
maximumnumber of rows that can appear on one page in a table is 20.

� ToSelectMultiple ContiguousRows
Click in the first target row to highlight the entire row.

Select additional rows in one of the following ways:

� Drag to the last row that you want to select and release themouse button.
� Move your cursor to the last row that you want to select, press the Shift key and click again.

All rows between the last and first anchor points are selected.

� ToSelectMultiple RowRanges
Select the first range of a single or contiguous group of rows by completing the procedure “To Select
Multiple Contiguous Rows” on page 131.

Place the cursor in a row and press the Control key.

This step adds a new row to the selection.

To extend the range of selected rows, press the Shift key.

This step extends the range from the row that you selected with the Control key in the previous step.

◗
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Example Procedures
The following procedures provide examples of typical data property tasks.

� ToMonitorDirectory Size
The following example procedure uses the Directory SizeMonitoringmodule. This module enables
you tomonitor the size and size change rate of a directory and its subdirectories. If this module is not
loaded, see “To Load aModule” on page 162.

In the Browser Details window, double-click the Operating System icon in the hierarchy (tree) view.

The operating systemmodules are displayed in both the hierarchy and topology views.

Double-click the Directory Size Monitoring icon in the topology view, or click the expansion icon next
to the Directory Size Monitoring icon in the hierarchy view.

TheDirectory SizeMonitoring Status folder is displayed.

Double-click the Directory Size Monitoring Status folder in either the hierarchy or the topology view.

TheDirectoryMonitoring property table is displayed.

Add a row to the table in one of the following ways:

� Press mouse button 1 in a table row or column header, and choose NewRow from the pop-up
menu.

� Select the table. Then choose NewRow from theOptions iconmenu.

The RowAdder window is displayed.

Type the appropriate information in the text fields.

a. In the Instance field, type a name that uniquely identifies this instance of the Directory Size
Monitoring module.

b. In the Directory field, type the complete path to the directory that you want to monitor.

To add the row to the table and close the Row Adder window, click the OK button.

The added row is displayed in the topology view.
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� ToAddaRow to aDataProperty Table

Note – You can use the steps in this procedure to add a row to theDirectory SizeMonitoring, File
Monitoring, File Scanning, and ProcessMonitoringmodules.

The following example procedure uses the FileMonitoringmodule which enables you tomonitor a
file’s size, modification date, and rate of growth. If this module is not loaded, see “To Load aModule”
on page 162.

In the Browser Details window, double-click the Operating System icon in the hierarchy (tree) view.

The operating systemmodules are displayed in both the hierarchy and topology views.

Double-click the File Monitoring icon in the topology view, or click the expansion icon next to the File
Monitoring icon in the hierarchy view.

The FileMonitoring Status folder is displayed.

Double-click the File Monitoring Status folder in either the hierarchy or the topology view.

An empty property table is displayed.

Add a row to the table in either of the following ways:

� Press mouse button 3 in a table row or column header, and choose NewRow from the pop-up
menu.

� Select the table. Then choose NewRow from theOptions iconmenu.

The RowAdder window is displayed.

Type the appropriate information in the text fields.

Note – This example shows the fields for the FileMonitoringmodule. Fields differ depending on the
module that you aremodifying.

� Name is a unique name for this instance of the FileMonitoringmodule.

The name should be a single word that might contain alphanumeric characters and an
underscore (_).

� Description is a text description for this particular instance.
� Filename is the complete path to the file that you want tomonitor.

To add the table row and close the Row Adder window, click the OK button.

The added row is displayed in the topology view.
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� ToAddaPrinter toBeMonitored
The Print Spooler module enables you tomonitor the status of the printer daemon, print queues, and
other printer devices on your network. The following example procedure uses the Print Spooler
module. If this module is not loaded, see “To Load aModule” on page 162.

In the Details window with the Module Browser tab selected, double-click the Local Applications icon
in the hierarchy (tree) view.

The local applicationsmodules are displayed in both the hierarchy and topology views.

Double-click the Print Spooler icon in either the hierarchy or the topology view.

Three property tables are displayed: Lpsched Status, Printer Devices Table, and Printer Queues
Table.

FIGURE 8–1Print Spooler Property Tables

Add a printer device row to the table in either of the following ways:
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� Press mouse button 3 in the Printer Devices table row, and choose the NewRow command from
the pop-upmenu.

� Click the Printer Devices table, and choose NewRow from theOptions pop-upmenu at the top
left of the Details window.

TheAdd Rowwindow is displayed.

Type the name of the printer and a description for the printer in the appropriate fields.

To add the printer to the table and close the Add Row window, click the OK button.

The added row is displayed in the topology view.

� ToProbe aProperty
This example procedure explains how to probe a property in the Directory SizeMonitoringmodule.
If you have not done so already, load this module by following the procedure “To Load aModule”
on page 162.

In the Browser Details window, double-click the Operating System icon in the hierarchy (tree) view.

The operating systemmodules are displayed in both the hierarchy and topology views.

Double-click the Directory Size Monitoring icon in the topology view, or click the expansion icon next
to the Directory Size Monitoring icon in the hierarchy view.

TheDirectoryMonitoring Status folder is displayed.

Double-click the Directory Monitoring Status folder icon in either the hierarchy or the topology view.

Themonitored data properties are displayed in a property table.

List or recursively list files in either one of the following ways:

� Press mouse button 3 in the DirectoryMonitoring table row and choose the List Files or
Recursively List Files command from the pop-upmenu.

� Click the Probe icon, select the appropriate command in the Probe Select dialog box, and click
the OK button.

Awindow appears that displays the files.
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ViewingData Properties in a Graph

The SunManagement Center product enables you tomonitor specific data properties for your
managed objects. You can view these properties in tabular format or in graphical format. This
chapter describes basic capabilities that SunManagement Center provides for using graphical
formats tomonitor data properties. The chapter includes the following information:

� “Overview of Graphs” on page 138
� “To Create a Graph of aMonitored Data Property” on page 138
� “To Create a Graph of Two orMore Data Properties” on page 139
� “To Save Graphing Parameters” on page 141
� “ToView an Existing Graph” on page 140
� “ToApply a Graph Template” on page 141
� “To Change Graph Type” on page 142
� “ToAdd orModify Legends and Labels” on page 142
� “To Change X-Axis andY-Axis Values” on page 143
� “ToModify the Border for the Graph or the Data Section of the Graph” on page 144
� “ToModify the Data View” on page 144
� “To Enlarge anArea of a Graph” on page 145
� “To Translate a Graph” on page 145

The Performance ReportingManagement (PRM) product provides advanced graphing features,
such as saving graph definitions formultiple hosts and properties, saving graphs as images, and
creating graphs that are based on historical data. Formore information, see SunManagement
Center 3.6.1 Performance ReportingManager User’s Guide.

For information about viewing data properties in a table, see Chapter 8.
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OverviewofGraphs
Use the Details window to view the current values for specific data properties, such as the amount of
memory being used on a given host. You can navigate through the hierarchy (tree) view to find the
appropriate managed object. The lowest-level object in the host hierarchy is themonitored property.

By default, information about amonitored data property is displayed in table form. In some
instances, viewing that information in a graph can be useful. For example, to see whenmemory
usage is highest, youmight create a graph of thememory usage as a function of time.

WorkingwithGraphs
SunManagement Center software enables you to create graphs formost monitored data properties.

� ToCreate aGraphof aMonitoredDataProperty
From the Details window, display the Graphing window in either of the following ways:

� Press mouse button 3 in any table cell that contains a data property, and choose OpenGraph
from the pop-upmenu.

� Select the desired data property, and click the Graph button at the top of the Details window.

The Graphing window opens. The values of the property are plotted as a function of time. The
plotting is dynamic. Values continue to be plotted even if youminimize the Graphing window.
Plotting stops, however, if the window is closed.

The following figure shows a typical Graphing window.

◗
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FIGURE 9–1 Graph of SystemLoad StatisticsAverageOver the Last FiveMinutes

� ToCreate aGraphof TwoorMoreDataProperties
Click in the data property table cell.

For example, if you followed the hierarchy fromOperating System to Kernel Reader (Simple) to
System Load Statistics, you could select the LoadAverages Over the Last 1Minute table cell.

Copy the cell to the graph in one of the following ways:

� Clickmouse button 3 in the table cell, and choose the Copy to Graph Clipboard command from
the pop-upmenu.

� In the Details window, choose Copy to Graph Clipboard from theOptions iconmenu.

Note – The Copy to GraphClipboard commandworks only when the units of the data item are the
same.Also, Copy to Graph Clipboard places the data on a clipboard. The data is not actually placed
on the graph until you complete the following steps.

Go to the graphing window in which you want the additional property to be plotted.
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Choose Add From Graph Clipboard from the Graph menu.

The second data property is added, as shown in Figure 9–2.

Note – You can graph up to five data properties at one time on a single graph.

FIGURE 9–2 LoadAveragesOver the Last One and FiveMinutes

� ToViewanExistingGraph
Choose Open Saved Graph from the Graph menu in the Graphing window.

TheOpenGraph dialog box appears.

Select a saved graph from the list.

To view the selected graph, click the OK button.

Note – When you save a graph request, the graph parameters are saved but not the data. Thus, when
you open a graph, the graph starts plotting fresh data.
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� ToSaveGraphingParameters
The Save Graph RequestAs function enables you to save the host name and the data property or
properties that have been graphed. Once saved, a graph of this property on this host can be pulled up
quickly from inside the Graphing window. You can also access a saved graph from the Tools menu in
themain console window.Anewly opened graph starts plotting fresh data.

To save properties for your graph, choose Save Graph Request As from the Graph menu in the
Graphing window.

Type the name for this graph in the Enter Graph Name field.

Click the Save button.

� ToDefineaGraphTemplate
You use graph templates to define the appearance of graphs. To create a graph template, you define
the visuals for one graph and save the template for that graph.When you save the graph template,
only the data properties, host information and the template gets saved. The actual graph state at the
time of saving is not saved. To apply that template to new graphs so that they have the same look, see
“ToApply a Graph Template” on page 141.

Save the properties for a graph as explained in “To Save Graphing Parameters” on page 141.

To save the custom features that you have applied to your graph, choose Save Template from the
Graph menu in the Graphing window.
The Save Template function enables you to save any custom features that you have added to your
graph. These features can include axis labeling, headers, footers, legend, and so on.

Type the name for this template in the Enter Template Name field.

Click the Save button.

� ToApply aGraphTemplate
You use graph templates to define the appearance of the graphs. Once you have defined a graph
template as described in “ToDefine a Graph Template” on page 141, you can apply that template to
multiple graphs.

Choose Apply Template from the Graph menu in the Graphing window.
TheApply Template dialog box is displayed. This dialog box enables you to apply saved custom
features to the current graph.

Select a saved template from the list.
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To apply the template to the current graph, click the OK button.

� ToChangeGraphType
By default, a graph displays as a line graph. You can choose to view data in a bar chart or area graph.

In the Graphing window, choose Chart Type from the Edit menu.

Select the type of graph to display.

� For a bar chart, select Bar.
� For an area chart, selectArea.
� For a line chart, select Line.

Click the OK button.

TheGraphing window shows the data using the selected graph type.

� ToAddorModify Legends and Labels
In the Graphing window choose Main Titles from the Edit menu, then choose the appropriate label to
modify.

Choose from the following options:

� To add ormodify the header, choose Header.
� To add ormodify the footer, choose Footer.
� To add ormodify the data legend, choose Legend.
� To add ormodify the label for the X-Axis along the bottom of the graph, choose X-Axis Title.
� To add ormodify the label for the Y-Axis along the side of the graph, choose Y-Axis Title.

Each option provides a dialog box that enables you to set similar parameters.

To adjust the title text, type or modify the information in the Text field.

To change the style of the title, select the style that you want to use in the Style section.

By default, most text is in plain style. You can also choose to have the text appear in bold or italic.

To choose the font family type to apply to the title, select the font family description in the Name
section.

By default, most titles appear in a Serif font. You can also choose SansSerif orMonospaced.
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To choose the size of the title, select the size in the scrolling list in the Size section.

Default sizes differ by title type.Many sizes are in the 10–14 point range. However, you can choose
sizes anywhere from 6 to 26.

To change the orientation of the title, select the appropriate box in the Orientation section.

The default orientation differs by title type. For example, an X-Axis title is most likely to be oriented
horizontally. You can choose any of the following orientations:

� Horizontal – Reads left-to-right
� Upsidedown – Reads right-to-left and flipped
� Vertical – Left-facing, reads bottom-to-top
� Verticalflip – Right-facing, reads top-to-bottom

To provide a border around the title, choose a style from the Border Style menu.

� ToChangeX-Axis andY-Axis Values

Caution – When you edit axes, be careful to choose the correct values. If you choose values forMin
andMax that are impossible to plot, the dialog box usually gives you an errormessage that describes
the problem. However, if you choose values that are possible but that result in the plotted points no
longer being visible, no errormessage appears.

To modify the values to be used for the X-axis, choose Axes from the Edit menu in the Graphing
window.

TheAxes Editing window appears.

To disable automatic X-axis values, deselect Auto-Scaling.

Numbers replace the wordAuto in the window fields.

Provide appropriate values in the Minutes to display, Tick Spacing, and Grid Spacing fields.

To modify the values to be used for the Y-axis, from the Axes Editing window, click the Y-Axis tab.

To disable automatic Y-axis values, click the check box next to Auto-Scaling.

Numbers replace the wordAuto in the window fields.

Provide appropriate values in the Range Min, Max, Major Tick, Minor Tick, and Grid Spacing fields.

To apply your changes and close the Axes Editing window, click the OK button.
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� ToModify theBorder for theGraphor theData Section
of theGraph
To access the Border window, choose Border from the Edit menu in the Graphing window.
The Border window that appears has two sections:

� ChartArea applies to a border around the entire graph.
� PlotArea applies to a border around the data portion of the graph.

To modify the border on the entire graph, select a border type from the Border Type list in the Chart
Area section.
There are several types of borders available.

To modify the border on the data portion of the graph, select a border type from the Border Type list
in the Plot Area section.
There are several types of borders available.

To apply your border changes and close the Borders window, click the OK button.

� ToModify theDataView
The Viewmenu in the Graphing window enables you to show or hide various graph components and
to change the display of your data.Although the following steps are presented sequentially, you can
show or hide components in any sequence you desire.

To enable or disable the display of live (current) data, select or deselect Live Data in the View menu in
the Graphing window.

� If live data is enabled, the graph continually updates as new data is provided.
� If live data is disabled, the graph is static. The graph does not update with new data until you

re-enable live data.

To show or hide the header, select or deselect Show Header from the View menu in the Graphing
window.

To show or hide the footer, select or deselect Show Footer from the View menu in the Graphing
window.

To show or hide the X-axis and Y-axis titles, select or deselect Show Axis Titles from the View menu in
the Graphing window.

To show or hide the X-axis and Y-axis labels, select or deselect Show Axes from the View menu in the
Graphing window.
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To show or hide the grid lines, select or deselect Show Grids from the View menu in the Graphing
window.

To show or hide the data legend, select or deselect Show Legend from the View menu in the Graphing
window.

To rotate the graph, follow these steps:

a. Choose Rotate Graph from the View menu in the Graphing window.

b. Select the appropriate rotation value from the secondary menu.

To change the order of the data display, follow these steps:

a. Choose Flip from the View menu in the Graphing window.

b. Select either X-Axis or Y-Axis from the secondary menu

When you flip the X-axis, the Y-axis moves to the other side of the graph. The time sequence
reverses. In other words, instead of the oldest data appearing on the left of the graph, the newest data
appears on the left of the graph.

When you flip the Y-axis, the X-axis moves to the top of the graph. The data sequence reverses. In
other words, smaller values appear at the top of the graph rather than on the bottom of the graph.

To reset the rotation and flip values, choose Reset View from the View menu in the Graphing window.

� ToEnlarge anAreaof aGraph
To zoom in on a specific section of a graph, choose Zoom from the Tools menu in the Graphing
window.

Hold down the Shift key and drag mouse button 1 to outline the area to zoom.

Release the mouse button to view the enlarged area.

To restore the graph to its original, unzoomed view, choose Restore from the Tools menu in the
Graphing window.

� ToTranslate aGraph
Graphs typically show the current information. You can translate information on the graph, for
example, to show information from an earlier time.
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To translate a specific section of a graph, choose Translate from the Tools menu in the Graphing
window.

Hold down the Control key and drag mouse button 1 to outline the area to translate.

Release the mouse button to enable the translation.

To restore the graph to its original, untranslated view, choose Restore from the Tools menu in the
Graphing window.
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MonitoringData PropertyAttributes

This chapter describes the following topics:

� “Overview ofAttribute Editor” on page 147
� “Info Tab in theAttribute Editor” on page 148
� “Alarms Tab in theAttribute Editor” on page 148
� “Actions Tab in theAttribute Editor” on page 149
� “Refresh Tab in theAttribute Editor” on page 150
� “History Tab in theAttribute Editor” on page 151
� “ToOpen theAttribute Editor for a Specific Data Property” on page 151
� “ToOpen theAttribute Editor for a Data Property Column” on page 152
� “To Set a Refresh Interval” on page 152
� “To Set a History Interval” on page 153

OverviewofAttribute Editor
Themodule data properties provide additional information about SunManagement Center
modules. TheAttribute Editor enables you to customize the followingmonitoring criteria for these
properties:

� Set alarm thresholds for defined alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the screen
� Define schedules for creating log files of historical data points

TheAttribute Editor has one ormore tabs at the top of the window that enable you to switch between
different panels. These tabs differ depending on the selected object. The following tabs are available
and are described in the identified sections:

� Info – “Info Tab in theAttribute Editor” on page 148
� Alarms – “Alarms Tab in theAttribute Editor” on page 148
� Actions – “Actions Tab in theAttribute Editor” on page 149
� Refresh – “Refresh Tab in theAttribute Editor” on page 150
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� History – “History Tab in theAttribute Editor” on page 151

Info Tab in theAttribute Editor
The Info panel shows additional information about the selected object. The specific information
differs depending on the selected object.

Alarms Tab in theAttribute Editor
TheAlarms tab enables you to set alarms thresholds only for those data properties that have
associated simple alarms. Simple alarms use the rCompare rule, which is described in Appendix D.
For information about simple alarms, see Table 10–1.

Simple alarms are based on thresholds.Amonitored data property is greater than, less than, not
equal to, or equal to a single threshold value. By contrast, complex alarms occur when a set of
conditions becomes true. Formore information about defining, acknowledging, and working with
alarms in SunManagement Center, see Chapter 12.

Note – You need the appropriate security permission to set an alarm threshold. See Chapter 18 for
more information.

The following table shows common simple alarm limits formonitored properties. The alarm limits
are also displayed in the Parameter Description field. You can set thresholds for one ormore of these
alarm limits for selected data properties.

TABLE 10–1 Common SimpleAlarmLimits in SunManagement Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if a value exceeds the limit in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if a value exceeds the limit in this
field.

Caution Threshold (>) Caution (blue) alarm occurs if a value exceeds the limit in this
field.

Critical Threshold (<) Critical (red) alarm occurs if a value is below the limit in this
field.

Alert Threshold (<) Alert (yellow) alarm occurs if a value is below the limit in this
field.

Caution Threshold (<) Caution (blue) alarm occurs if a value is below the limit in this
field.
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TABLE 10–1 Common SimpleAlarmLimits in SunManagement Center Software (Continued)
Alarm Limit Description

AlarmWindow Alarm occurs only during this time period. For example, if you
type day_of_week=fri, an alarm occurs only if the alarm
condition exists on a Friday. If an alarm condition exists on
Tuesday, no alarm is registered.

Actions Tab in theAttribute Editor
TheActions tab appears only if you can define alarm actions for the current data property. The
Actions panel enables you to instruct the software to perform a predetermined action if an alarm
occurs.

Note – Acceptable actions include sending an email or executing scripts that are stored in the
/var/opt/SUNWsymon/bin directory. These scripts execute with root permissions.

For example, youmight define an action so that an email is sent to a system administrator whenever
a critical alarm is generated for the LoadAverage Over the Last FiveMinutes data property.

As illustrated in Figure 10–1, you can define specific actions to occur in any of the following
instances:

� When a particular alarm severity (critical, alert, caution, or intermediate) occurs
� When an alarm closes
� When any change in alarm condition happens

Note – The check boxes to the right of theAction buttons enable you to specify automatic ormanual
execution of a specific alarm action. By default, all actions are set for automatic execution.

Overview ofAttribute Editor

Chapter 10 • MonitoringData PropertyAttributes 149



FIGURE 10–1 Attribute EditorActions Panel for aMonitored Property

When you click theActions button, theActionDialog Selection window appears. This window
enables you to create ormodify the registered alarm actions. You can perform one of the following
actions:

� Send an email
� Execute a script
� Clear the alarm

Formore information about defining an alarm action, see “To Register anAlarmAction” on page
185.

Refresh Tab in theAttribute Editor
The Refresh panel enables you to set the refresh interval for the selected object. The refresh interval is
the interval between the times when the SunManagement Center agent samples themonitored
property.

Overview ofAttribute Editor
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Note – Only some data properties enable you tomodify the refresh interval.

For information about setting the refresh interval, see “To Set a Refresh Interval” on page 152.

History Tab in theAttribute Editor
TheHistory panel enables you to save older data for amonitored property. For example, a history of
data points could be recorded every 120 seconds, as specified in the Sample Interval field. You can
store this information in one of two places:

� Disk file
There are two types of disk files: circular and text. These files are located in the
/var/opt/SUNWsymon/log directory.

� Memory cache
If you store information in thememory cache, youmust also indicate howmany data points
should be saved in theMax Size (sample) field.

Note – You can view the history data in a graph by opening the graph for the selectedmonitored
property. If you have selectedmemory cache, the graph is displayed with the historical data.

Using theAttribute Editor
TheAttribute Editor provides features that support various activities. Some of these activities use
other features in addition to theAttribute Editor. Information about performing simpleAttribute
Editor-only functions, such as defining intervals for history logs and screen refreshes, is provided
here. Detailed information about alarm-related functions is provided in Chapter 12.

� ToOpen theAttribute Editor for a SpecificData
Property
You can open theAttribute Editor for a specific data property value. For some data properties, you
can also access theAttribute Editor for a column of values. Formore information, see “ToOpen the
Attribute Editor for a Data Property Column” on page 152.

Navigate through the topology or hierarchy view until you have accessed a data property table.

Place your cursor in the value section of the table and use either of the following methods:

� Press mouse button 1 and chooseAttribute Editor from the pop-upmenu.
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� Click theAttributes icon.

TheAttribute Editor window shows specific information about the selected data property. The
displayed tabs depend on the specific data property that you selected.

For information about defining alarm thresholds for the selected data property, see “Managing and
ControllingAlarms” on page 181 and “AlarmManagement Examples” on page 188.

� ToOpen theAttribute Editor for aDataProperty
Column
Choosing a data property column, rather than a specific data property value, enables you to define
attributes for all values in that column. For example, consider the CPUUtilization Table. If you open
theAttribute Editor for the column%CPUUser Time, you could define alarm thresholds and
actions for all CPUs. If you open theAttribute Editor for a specific %CPUUser Time value, such as
the value that applies to CPU 1, any alarm threshold or action that you defined would apply only to
that specific CPU.

Navigate through the topology or hierarchy view until you have accessed a data property table.

Click the column heading for the column in which you are interested.

To access the Attribute Editor, use one of the following mechanisms:

� Press mouse button 1 and chooseAttribute Editor from the pop-upmenu.
� Click theAttributes icon.

TheAttribute Editor window shows specific information about the selected data column. For
information about defining alarm thresholds for the selected data column, see “Managing and
ControllingAlarms” on page 181 and “AlarmManagement Examples” on page 188.

� ToSet aRefresh Interval
The refresh interval indicates, in seconds, how frequently an agent acquires data. The following
example illustrates how to set a refresh interval for a property in the System Load Statistics module.

Click the Module Browser tab in the Details window.

Click the expansion icon next to the Operating System icon in the hierarchy tree view.

TheOperating Systemmodules are displayed.

Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.
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Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed.

Select the table cell for Load Averages Over the Last 5 Minutes.

Click the Attributes button.

TheAttribute Editor window is displayed.

Click the Refresh tab button.

The refresh panel is displayed.

Type a value in seconds in the Refresh Interval field or click the Advanced button.

For example, 300 seconds equates to fiveminutes.

To apply the refresh interval and close the Attribute Editor window, click the OK button.

Data for System Load Statistics are acquired every fiveminutes.

Note – The agent uses less CPU cycles if you provide a larger refresh interval.

� ToSet aHistory Interval
Open the Attribute Editor for the data property on which you want to set the history information.

For example, follow these steps to access theAttribute Editor for LoadAverages Over the Last 5
Minutes:

a. Click the Module Browser tab in the Details window.

b. Click the expansion icon next to the Operating System icon in the hierarchy tree view.

c. Click the expansion icon next to the Kernel Reader icon.

d. Double-click the System Load Statistics icon.

e. Select the table cell for Load Averages Over the Last 5 Minutes.

f. Click the Attributes button.

Click the History tab.

The history panel is displayed.
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Type a value in seconds in the Sample Interval field or click the Advanced button.

For example, to collect a history data point every twominutes, type 120 in the Sample Interval field.

Select Save History as Disk File or Save History in Memory Cache.

To save history as a disk file:

a. Determine the file type, either circular or text.

� Acircular file has a predefined length of 1000 lines. If the amount of data that is written to the
file exceeds that length, then the file rewrites from the beginning.

� Aflat text file has no predefined length. Information is appended to the flat file until you stop
the process or until the disk space is exceeded. Use this feature if you need to keep history files
for data warehousing purposes.

b. For a text file, type the file name in the Text File Name field.

If you do not choose a file name for your text file, data are saved automatically in the
/var/opt/SUNWsymon/log/agent_default.history file.

The file name cannot contain special characters, such as / or #.

To save history in a memory cache, type the number of history data points in the Max Size (sample)
field.

For example, if you set this field to 1000, only themost recent 1000 data points are stored in the
memory cache.Any older data points are discarded. These data points can be graphed. See “To
Create a Graph of aMonitored Data Property” on page 138 formore information.

To apply your history file changes and close the History panel, click the OK button.
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ManagingModules

This chapter describes the following topics:

� “SunManagement CenterModule Concepts” on page 155
� “ToViewModule Status” on page 161
� “To Load aModule” on page 162
� “To Return aModule to Its Default Settings” on page 163
� “To Set aModule Schedule” on page 163
� “To Load a ScheduledModule” on page 164
� “To Enable aModule” on page 165
� “ToDisable aModule” on page 165
� “ToUnload aModule” on page 166
� “To Set Security Permissions for aModule” on page 166
� “ToViewModule Rules” on page 167
� “ToModifyModule Parameters” on page 168
� “MonitoringModules as a Group” on page 168

SunManagement CenterModule Concepts
SunManagement Centermodules are responsible for collecting data from specificmonitored
resources. Thesemodules can be dynamically loaded, enabled, disabled, and unloaded into a Sun
Management Center agent.

� When you load amodule, themodule icon appears in the Browser Details window. In addition,
themodulemanaged object and its data properties are defined. Data acquisition for that module
begins. The data properties for themanaged object are displayed in the Details window. The data
display is periodically refreshed.

� When you enable amodule, data acquisition restarts if themodule was disabled previously. The
data display for themanaged object periodically refreshes in the Details window.

� When you disable amodule, data acquisition stops temporarily for themanaged object until the
module is enabled.While amodule is disabled, the data is not refreshed.Also, the data does not
trigger an alarm even if you do amanual refresh.Alarms are not triggered until themodule is
re-enabled.
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� When you unload amodule, data acquisition stops for themanaged object. Themanaged object
and data properties are undefined. Themodule icon is removed from the Browser Details
window.

Note – Somemodules, such as the File ScanningModule, can be loadedmore than once on a host.
Thesemodules are referred to asmulti-instance modules. If themodule is amulti-instancemodule, a
special icon is displayed in the Details window.

DefaultModules
Some or all of the followingmodules are loaded by default when you install the software:

� Agent Statistics
� Kernel Reader (Simple)
� SimpleMIB-II
� Config-Reader (for supported hardware platforms only)
� File Scanning [System Log]

Module List
Table 11–1 lists generic modules that you can load and use. The list of modules that is displayed for
your system depends on your platform type and any add-on products that you have installed. See
your supplement formore information about platform-specificmodules, including the
Config-Reader andDynamic Reconfigurationmodule. For information about the other Sun
Management Centermodules, see Appendix C.

TABLE 11–1 SunManagementCenterModules

Module

Module
Version
Number Add-on Description

Agent Statistics 2.0 Provides information about the health of the agent
installed on a host bymonitoring the objects,
processes, and execution of processes by the agent.

Agent Update 1.0 Enables you to use theAgent Update process to
update software on agent systems.

Config-Reader 1.0 Config-Reader Provides the hardware configuration of the host.
This module is available only if the hardware
platform is supported and either theWorkgroup or
Desktop add-on products are installed. Both the
physical view and the logical view require that this
module be loaded.
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TABLE 11–1 SunManagementCenterModules (Continued)

Module

Module
Version
Number Add-on Description

Data Logging
Registry

2.0 Provides information about agent data logging,
such as log destination, module name, logging
interval, and buffer length.Multiple copies of this
module can be loaded.

Directory Size
Monitoring

2.0 Advanced System
Monitoring

Enables you to isolate andmonitor the size of any
directory and its subdirectories on a host where a
SunManagement Center agent is installed.Multiple
copies of this module can be loaded, or you can add
additional directories formonitoring by adding a
row in the properties table.

Dynamic
Reconfiguration

2.0 Dynamic
Reconfiguration for
Sun Fire High-End
andMidrange
Systems

Enables you to perform dynamic reconfiguration
operations onDR-enabledmonitored hosts.

FaultManager 1.0 Advanced System
Monitoring Note –Thismodule can be installed only on Solaris

10.

Handles hardware and software faults effectively.
Displays a detailed fault report or amessage article
for the selected fault. For instructions about viewing
a fault report and amessage article, see “ToView a
Fault Report” on page 401 and “ToView aMessage
Article” on page 402

FileMonitoring 2.0 Advanced System
Monitoring

Monitors selected files on a host. Monitored
parameters include file size and timestamps.
Multiple copies of this module can be loaded. This
module requires you to add rows in the data
property table. Formore information, see “ToAdd a
Row to a Data Property Table” on page 133.

File Scanning 2.0 Advanced System
Monitoring

Scans files on a host for specified patterns. This
module also scansmulti-line fault messages that are
written to the syslog file. Multiple copies of this
module can be loaded. This module requires you to
add rows in the data property table. Formore
information, see “ToAdd a Row to a Data Property
Table” on page 133.

HP JetDirect 2.0 Advanced System
Monitoring

Monitors the status of HP printers that are
equipped with a JetDirect card.Multiple copies of
this module can be loaded.
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TABLE 11–1 SunManagementCenterModules (Continued)

Module

Module
Version
Number Add-on Description

HealthMonitor 2.0 Advanced System
Monitoring

Enables you tomonitor various resources usage in
your host such as CPU, disk, NFS, and SNMP.

Kernel Reader 2.0 Advanced System
Monitoring

Provides kernel statistics, such as CPU details,
system call, faults, streams, disk information, and
page information.

Kernel Reader
(Simple)

1.0 Provides kernel statistics, such as load statistics,
swap statistics, and streams statistics.Also, provides
software rules information.

LogviewACL 1.0 Advanced System
Monitoring

This module supports viewing andmonitoring of
the system log, SunManagement Center log, and
other log files, using theModules tab on the Details
window.

MIB-II
Instrumentation

1.0 Advanced System
Monitoring

Provides the system, interfaces, IP, Internet Control
Message Protocol (ICMP), Transmission Control
Protocol (TCP), andUser Datagram Protocol
(UDP)Management Information Base (MIB-II)
group information of themonitored host.

MIB-II Proxy
Monitoring

2.0 Advanced System
Monitoring

Provides proxymanagement of hosts that are
running non-SunManagement CenterMIB-II
SNMP agents. Multiple copies of this module can be
loaded.

MIB-II (Simple) 1.0 Provides the systemGroup, interfaces Group, IP
Forwarding, IP Route Table information of the
standardMIB-II (Management Information Base)
group information of themonitored host. This
module is a scaled-down version of theMIB-II
Instrumentationmodule.

Note –TheMIB-IImodule identifies an agent. If this
module is not loaded, the agent can be created only
as a ping host or as an SNMPhost.

NFS File Systems 2.0 Advanced System
Monitoring

Provides information about the NFS file systems on
monitored hosts bymonitoring the amount of disk
space occupied bymounted or unmounted file
systems and the amount of used and available space
as well as the file system’s remaining total capacity.
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TABLE 11–1 SunManagementCenterModules (Continued)

Module

Module
Version
Number Add-on Description

NFS Statistics 2.0 Advanced System
Monitoring

Monitors the number of NFS calls and RPC (remote
procedure calls) received by the server, and
monitors the status of the transaction activity on the
monitored host. Multiple copies of this module can
be loaded.

Print Spooler 3.0 Advanced System
Monitoring

Monitors the status of the printer daemon, the print
queue, and the printer devices that are installed on
themonitored host.

ProcessMonitoring 2.0 Advanced System
Monitoring

Monitors one ormore processes on the host.
Specifiesmonitored processes bymatching
patterns.Multiple copies of this module can be
loaded. This module requires you to add rows in the
data property table. Formore information, see “To
Add a Row to a Data Property Table” on page 133.

ServiceManagement
Facility

1.0 Advanced System
Monitoring Note –Thismodule can be installed only on Solaris

10.

Monitors and displays the services running on a
host. This module also displays dependencies for
the selected service and displays services that
depend on the selected service. This module also
displays the processes in the selected service. For
more details, see “ServiceManagement Facility
Module Version 1.0” on page 410.

Solaris Process
Details

2.0 Advanced System
Monitoring

Displays detailed information of Solaris processes
running on a host where the SunManagement
Center agent has been installed. The Process Details
window requires that this module be loaded.

StorageA5x00 1.0 Monitoring and
Management of
A5x00 and T3
Devices

Enables you tomonitor the state ofA5000, 5100,
and 5200 storage devices, andmanage alarms on
these devices.

Sun StorEdge T3 1.0 Monitoring and
Management of
A5x00 and T3
Devices

Enables you tomonitor the state of T3 storage
devices, andmanage alarms on these devices.
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TABLE 11–1 SunManagementCenterModules (Continued)

Module

Module
Version
Number Add-on Description

Volume System
Monitoring

1.0 Volume System
Monitoring The agent layer of this add-on can be installed only

on hosts that has the SunN1 SystemManager server
(SystemManager) installed. In addition, the setup
of this add-on requires the root user to be a valid
SystemManager user with permissions to create
and delete SystemManager event notifications.

Monitors a set of attributes managed by the System
Manager agent and displays them in theModule
Browser. This module also listens for traps from the
SystemManager agent and performs appropriate
actions. This module also generates warning, error,
or information alarms based on the values of
specific attributes.

You can also access the SystemManager server from
this module. However, you have to log in and
authenticate explicitly with the SystemManager
server. For instructions about accessing the System
Manager server through the web console and
through SSH, see “ToAccess the SystemManager
Server ThroughWebConsole” on page 336 and “To
Access the SystemManager Server Through SSH”
on page 336.

X86/X64 Config
Reader

1.0 X86/X64 Config
Reader Monitors the hardware on x86/x64 systems that run

Solaris 9, Solaris 10, or Linux kernel 2.6. This
module provides the hardware summary view,
logical view, and physical view of the system in the
Hardware tab of the Details window. This module
provides these views only if this add-on is installed
on both the server and the agent. Formore details,
see “X86/X64 Config ReaderModule Version 1.0”
on page 357.

Formore information aboutmodules, see Appendix C.

Note – TheConfig-Reader andDynamic Reconfigurationmodules are supported only on specific
hardware platforms. Formore information, refer to your platform supplement.

Depending on your system hardware, additional modules might be supported. Formore
information, refer to the SunManagement Center web site at
http://www.sun.com/sunmanagementcenter/.
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WorkingWithModules
The procedures in this section describe how to load, unload, enable, and disable modules. These
procedures also explain othermodule-related tasks.

� ToViewModule Status
You can find out whatmodules are loaded or are scheduled to be loaded on a given agent or server
system. In addition, you can find out what othermodules are available on that system and if any of
the currently loadedmodules are disabled. To view the status of modules on a given system, follow
these steps.

Select a server or agent managed object.

Open the Details window for the selected object.

From the Details window, click the Module Manager tab.

Themodules status view appears. This view has twomain sections:

� The “Modules with Load Status” section lists modules that are loaded or are scheduled to be
loaded on the host. For eachmodule, this section identifies the following information:
� Themodule name, including a specific instance identifier if applicable
� Whether themodule is loaded
� Whether themodule is scheduled to be loaded
� Whether themodule is enabled

� The “AvailableModules” section lists modules that can be loaded for this host. This section
includesmodules that are listed in the “Modules with Load Status” section when there can be
more than one instance of that module on the host. For eachmodule, this section identifies these
characteristics:
� Themodule name
� Whether themodule can be loadedmore than once on the host (also referred to as a

multi-instance module)

For information about how to change the status of amodule, see the following sections:

� “To Load aModule” on page 162
� “To Load a ScheduledModule” on page 164
� “To Enable aModule” on page 165
� “ToDisable aModule” on page 165
� “ToUnload aModule” on page 166
� “ToViewModule Rules” on page 167
� “ToModifyModule Parameters” on page 168
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� To LoadaModule
To select the host machine on which the module will be loaded, click the host machine icon.

Note – If you attempt to load amodule without selecting a host, you cannot access the LoadModule
option in the Tools menu.

To open the Load Module dialog box, use one of the following mechanisms:

� Press mouse button 1 on the selected host icon, and select LoadModule from the pop-upmenu
in the hierarchy view or the topology view.

� In themain console window, choose LoadModule from the Tools menu.
� Open the Details window, and choose LoadModule from theModulemenu (the first icon at the

top left of theModule Browser window).
� Open the Details window, click theModuleManager tab, select amodule to load from the list of

AvailableModules, and click the Load button.

Note – In this case, theModule Loader window appears. Go to Step 5.

The LoadModule dialog box appears.

The LoadModule dialog box provides a list of SunManagement Centermodules.Anumber next to
themodule name indicates the number of existing instances of that module on your host.

Note – Somemodules can havemultiple instances loaded on a host.

Select the name of the module that you want to load.

Click the OK button.
TheModule Loader window appears. The contents of theModule Loader window depend on the
selectedmodule.

Tip – You can also double-click amodule name in the LoadModule dialog box to load thatmodule.

If there can be more than one instance of this module, type the instance name in the Instance field.
The instance name is used within the SunManagement Center agent to identify uniquely a particular
module or a rowwithin amodule. Youmust specify a unique name for each instance whenmultiple
instances of the samemodule are loaded.

An instance name is a single word or alphanumeric string. The only special character allowed in an
instance name is the underscore (_).

If you do not type information for a necessary field, the software responds with an errormessage and
themodule is not loaded.
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(Optional) Type or change the information in the Description field.

For somemodules, the Description field is the only field that you can edit.

Decide whether to load the module now or at a scheduled time.

� To accept the Load Parameters and load themodule immediately, click OK.
� To set a time to load and enable themodule, click the Schedule tab and follow the instructions in

“To Set aModule Schedule” on page 163.

� ToReturn aModule to ItsDefault Settings
You can change information for amodule and later return themodule to its default or original
settings. For example, if you deleted some rows from the File Scanningmodule for the system log,
you could reload that module to retrieve the deleted default rows. If youmodified some alarm
thresholds or defined alarm actions in amodule, you could return those attributes to their default
values.

Select the module to load.

If there can be more than one instance of this module, provide any required information in the
Module Loader window.

Information that you provide in theModule Loader windowmust exactly match the original
module. For example, in the case of the File Scanningmodule for the system log, you would need to
supply the instance name syslog, the file name /var/adm/messages, and the description System

Messages.

In the Module Loader window, click the Default Settings button.

The selectedmodule will reload with all default information.

� ToSet aModule Schedule
You can set a schedule that determines when amodule should be active. For example, youmight
schedule amodule to run between 8:00AM and 5:00 PM every day.At all other times, themodule is
inactive, even if an alarm condition exists.

From the Module Loader window, click the Schedule tab.

To set the load schedule, select Scheduler next to the Module Load Schedule field.

a. To load this module starting on a day other than today, select a Start Date.

You can edit the information in the Start Date fieldmanually, or you can click on a date in the
calendar to select the date.
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b. Select an hour and minute for the Start Time.
Hours are based on a 24–hour clock. For example, 16:00 is the same as 4:00 PM.

c. Select an hour and minute for the End Time.

d. (Optional) To set this module to load more than once, choose how often the module should load
from the Repeat Interval menu.
For example, to schedule amodule to load weekly, you would selectWeekly.

e. (Optional) To prevent a module from loading indefinitely at the specified interval, type a number
in the Repeat Limit field.
For example, to load this module weekly for onemonth, you would type 4 in the Repeat Limit
field.

Note – Themodule loads indefinitely if you do either of the following:

� You select a Repeat Interval of One Time and you do not provide an End Time.
� You select a Repeat Interval other thanOne Time and you do not provide a value in the

Repeat Limit field.

f. Click OK to set this schedule, or click Cancel to exit from the scheduler window.

To set the module enable schedule, select Scheduler next to the Module Enable Schedule field.
The Scheduler works the same for this feature as other schedulers throughout the product. See the
preceding step formore information.

To load and enable the module as specified, click OK.
If you need to enter load parameters and have not done so, an errormessage tells you what youmust
do.

� To LoadaScheduledModule
In the Details window, click the Module Manager tab.

Select a module that is currently scheduled but not loaded from the Modules with Load Status list.

Tip – Look for a “No” in the Loaded column and a “Yes” in the Scheduled column.

Click the Load Now button.
The LoadNow confirmation dialog box appears.

Determine whether to load the module at the scheduled time.
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� To load themodule now and at the scheduled time, click Preserve Schedule. Then click the OK
button.
Themodule loads. The Loaded column changes to Yes and the Scheduled column remains Yes, so
that themodule loads again at the scheduled time.

� To load themodule now, but not at the scheduled time, click Clear Schedule. Then click the OK
button.
Themodule loads. The Loaded column changes to Yes and the Scheduled column changes to No.

� ToEnable aModule
Open the Details window for the host on which the module is loaded.

Enable a currently loaded but not enabled module in one of the following ways:

� Click theModuleManager tab, select amodule from theModules with Load Status list, and click
the Enable button.

� Press mouse button 1 on themodule that you want to enable, and choose EnableModule from
the pop-upmenu.

When themodule has been enabled, the followingmessage is displayed at the bottom of the window.

Module successfully enabled.

� ToDisable aModule
Open the Details window for the host on which the module is loaded and enabled.

Disable a currently loaded and enabled module in one of the following ways:

� Click theModuleManager tab, select amodule from theModules with Load Status list and click
the Disable button.

� Press mouse button 1 on themodule that you want to disable, and choose DisableModule from
the pop-upmenu.

When themodule has been disabled, a small icon with an X attaches to themodule icon. The
followingmessage is displayed at the bottom of the window.

Module successfully disabled.

If the disabledmodule is the Solaris Process Details module, the followingmessage is displayed at the
bottom of the Details window.

Solaris Process Details module disabled. Process data may not be current.
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Caution – Because data is not being refreshed for a disabledmodule, the data does not trigger an alarm
until you re-enable themodule. The data does not trigger an alarm even if youmanually refresh the
data.

� ToUnloadaModule
Open the Details window for the host on which the module is loaded.

Unload a currently loaded module in one of the following ways:

� Click theModuleManager tab, select themodule that you want to unload from theModules with
Load Status list, and click the Unload button.

� Press mouse button 1 on themodule that you want to unload, and choose UnloadModule from
the pop-upmenu.

The ConfirmModule Unload dialog box is displayed.

To remove the module, click the Unload button in the Confirm Module Unload window.

Themodule is unloaded.

� ToSet Security Permissions for aModule
You can set security permissions for some individual modules. The security permissions for a
module override the default security permissions for its parent object or host. For example, if a user
has administrator privileges for amodule, but only general privileges for the host, the user still
retains administrator privileges for themodule. For further information about privileges, see
Chapter 18.

Open the Details window for the host on which the module is loaded. Then, select the Module
Browser tab.

Use one of these methods to access the Attribute Editor for the module on which you want to set
security:

� Select amodule in the left side of the browser. Then, click theAttribute Editor icon (the first icon
above the right side of the window).

� Select a specific data property in the right side of the window, press mouse button 1 and choose
Attribute Editor from the pop-upmenu.

Click the Security tab.
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Note – The Security tab is not available if you cannot set security on the selectedmodule.

Type the names of user and administrator groups in the appropriate fields.

To accept your security changes and close this window, click the OK button.

� ToViewModuleRules
In the Details window, click the Module Manager tab.

In the Modules with Load Status list, select the module of interest and click Rules.

The Threshold Summary ofModule screen is displayed, containing the name of the selectedmodule
after the colon (:). In this example, the Kernel Reader (Simple) module is shown.

FIGURE 11–1Threshold Summary ofModule Screen

Amodule rules window contains the following information:

Attribute Name Identifies the data property.

Rule Name Shows the rule name. If the rule is simple, the threshold value appears. If
the rule is complex, a “-” appears. Click on the “-” to view threshold
values in the Threshold list at the bottom of the window.
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Critical Themost severe alarm state.

Alert Themid-point alarm state.

Caution The least severe alarm state.

Rule Description Displays a rule description for the selected attribute.

Thresholds Displays threshold values for the selected attribute.

Parameter Description Describes the parameters that are shown in the Thresholds field.

After you view the information, click Close to return to the Module status screen.

� ToModifyModule Parameters
Open the Details window for the host on which the module is loaded.

To change information about a module, such as its description, perform one of the following:

� Click theModuleManager tab, select themodule that you want to change, and click the Edit
button.

� Press mouse button 3 on themodule that you want to change, and choose EditModule from the
pop-upmenu.

TheModule Parameter Editor appears.

To change the module information, type new information in the editable fields.

For somemodules, the only information that can be changed on this screen is themodule
description.

Tip – Aeditable field has a white background, while a read-only (not editable) field has a gray
background.

To accept the changes that you made and close the Module Parameter Editor window, click the OK
button.

MonitoringModules as aGroup
Tomonitor one type of module on several hosts, you can createmodule objects for each host and
place these objects in the same group or administrative domain. To create amodule object, see “To
Create aModule Object” on page 64.
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ManagingAlarms

An alarm is a notification that is triggered by an abnormal event, such as exceeding a certain
percentage of memory usage. TheAlarmManager softwaremonitors your hardware and software
and triggers alarms when defined conditions occur.

This chapter describes the following topics:

� “AlarmConcepts” on page 170
� “Alarms Table” on page 174
� “ToViewAlarms From theMain ConsoleWindow” on page 176
� “ToAccess anAlarm for a SpecificManagedObject” on page 177
� “ToAccessAlarms From the DetailsWindow” on page 177
� “To Sort the Domain StatusAlarms” on page 178
� “To Sort theAlarms Table” on page 179
� “ToUpdate theAlarms Table” on page 179
� “To Filter theAlarms Table” on page 179
� “ToView a Log ofAlarmActivity” on page 180
� “ToAcknowledge NewAlarms” on page 181
� “ToDeleteAlarms” on page 181
� “ToAdd anAlarmNote” on page 182
� “ToView andAdd Suggested Fixes” on page 182
� “To Select anAction” on page 186
� “ToNotify UsersWhen aHost orAgent Is Down” on page 183
� “To Register anAlarmAction” on page 185
� “To Run a RegisteredAlarmAction” on page 186
� “ToModify PendingAlarmActions” on page 186
� “ToDefine anAlarmAction Script” on page 187
� “Example: ToDefine and Respond to anAlarm” on page 188
� “Example: To Send an Email” on page 189
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Note – Themessages in theAlarms page of the Details window are always in English. Thesemessages
are not translated into other languages. However, the text in all dialog boxes and in suggested fixes is
internationalized.

AlarmConcepts
TheAlarmManager software displays alarm information formanaged objects. You can view object
alarm information in an administrative domain in themain console window and in the Details
Alarmwindow.

Note – The SunManagement Center agent is configured so that only one server receives alarm
information from that agent.

The SunManagement Center 3.6.1AlarmManager enables you to do the following tasks:

� View alarms in pages from a database
� Manually run the currently registered action after an alarm has been triggered
� Set and change the currently registered action from a list of all installed actions
� Sort alarms
� Read the factory default suggested fix for a rule
� Create a new user-suggested fix for a rule
� Keep a running record of user notes for an alarm instance
� Acknowledge alarms when they occur
� Delete closed alarms from the database

AlarmDefinitions
An alarm is a notification that is triggered by an abnormal event. SunManagement Center has two
types of alarms:

� Predefined alarm conditions included in the softwaremodules, such as notification when the
CPU usage exceeds a certain percentage. These alarms are triggered by conditions outside of a
preset range or by SunManagement Center rules. Default alarm conditions and rules are
included in themodules. For some predefined alarms, you can change the threshold at which the
alarm is triggered. In addition, you canmodify the action to take when the alarm occurs and add
information to the suggested fixes. For a list of SunManagement Center rules, see Appendix D.

� User-defined alarm conditions. You define what causes an alarm to occur, what action to take,
and a suggested fix, if desired.

AlarmConcepts
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Alarm Indicators
TheAlarmManager software uses several different methods to alert you to an unacknowledged open
alarm condition:

� Colored icons in the Domain Status Summary on themain console
� Colored icons in the hierarchy (tree) view
� Colored icons in the topology (contents) view
� Colored relevant row or relevant column in the property table (contents view)

The type and color of alarm icon identify the severity of the alarm. For example, a red alarm icon
indicates that a critical condition has developed and that corrective action is required immediately.
By contrast, a blue alarm icon indicates a potential or an impending service-affecting fault.

You can acknowledge, delete, andmanage the object alarms by using theAlarmsDetails window. For
more information, see “Managing and ControllingAlarms” on page 181.

Figure 12–1 shows an unacknowledged, open critical alarm in the Swap Statistics properties table
Used KB row. The row is red, which indicates a critical alarm. The alarm information propagates up
the hierarchy tree view, from the individual module up to the host. You would also see a red alarm
icon on the following objects:

� Swap Statistics properties table
� Kernel Readermodule
� Operating System
� Host

You also see a red alarm icon on the corresponding host, group (if any), or administrative domain in
themain console window. The only exception would occur if an unacknowledged open black alarm
of higher severity exists.
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FIGURE 12–1 Swap StatisticsAlarm in theDetailsWindow

You can select CriticalAlarms,AlertAlarms, and CautionAlarms simultaneously for amodule table.
A tickmark appears when these alarms are selected.

Note – Unacknowledged alarms take precedence over acknowledged alarms. If the hierarchy has two
ormore types of alarms, the color of themore severe unacknowledged alarm is propagated up the
tree. For example, if there is a yellow unacknowledged alarm in CPU usage and a red
unacknowledged alarm inDisk Statistics, only the red alarm icon propagates. However, if there is a
yellow unacknowledged alarm in CPU usage and a red acknowledged alarm inDisk Statistics, only
the yellow alarm icon propagates.

AlarmSeverity Levels
The following alarm severities are supported:

DownAlarms

Adown alarm indicates that a service-affecting condition has occurred
that requires immediate corrective action.An example of this condition is
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the following:Arequired resource that is defined by amanaged object has
gone out of service.Aspecific example of this condition is amodule that
has gone down.

CriticalAlarms

Acritical alarm indicates that a service-affecting condition has
developed that requires an urgent corrective action.An example of this
condition occurs when a severe degradation in the capability of an object
has occurred and you need to restore the object to full capability.

AlertAlarms

An alert alarm indicates that a non-service-affecting condition has
developed. Corrective action should be taken to prevent amore serious
fault.

CautionAlarms

Acaution alarm indicates the detection of a potential or impending
service-affecting fault before any significant effects have occurred. You
should diagnose further if necessary and correct the problem before it
becomes a serious service-affecting fault.

Off/DisabledAlarms

Adisabled alarm indicates that a resource for amanaged object is
disabled. For example, a module is disabled.

Indeterminate State
Objects with black star icons are objects with indeterminate states, not to be confused with alarms.A
black star or “splat” icon in themain console windowmeans that a data acquisition failure occurred
in that object. The failure is not the result of a rule infraction, so no alarm is associated with the
failure.

Note – When you view the data property table for an object, a pink row also indicates an
indeterminate object state.

Domain Status Summary
TheDomain Status Summary section of themain console window provides a brief view ofmanaged
object status. The colored icons designate the severity of the alarms.

Tip – To see a definition for a status summary icon, place your cursor over the icon.
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Numbers next to the alarm icons in the Domain Status Summary indicate themanaged objects for
which the highest severity open, unacknowledged alarm is represented. For example, a 1 next to the

alert alarm icon (center) indicates that there is onemanaged object for which the highest
severity alarm is alert.

The Domain Status Summary displays the number of managed objects in the administrative domain
that have at least one unacknowledged open alarm of a specific severity.

Note – If multiple types of alarms exist in the host, the icon that indicates themore severe
unacknowledged open alarm appears in the Domain Status Summary.

If themost severe alarm on one host is critical and themost severe alarm on another host is alert

, a 1 appears on both alarm icons.

Alarms Table
The alarms table contains a statistical summary of all alarm data for themanaged object that you
select.

Note – If the object is a platform, see your platform supplement formore information.

You can filter and sort this table to display only the alarms that you want to see in a preferred
sequence. You filter and sort alarms from the alarms table. For additional details, see “To Filter the
Alarms Table” on page 179 and “To Sort theAlarms Table” on page 179.

AlarmDisplay Pages
Themaximumnumber of alarms that can be displayed on a page is 20. The current page number and
total number of alarms for the selected object in the database are displayed at the top of the table.

When new alarms occur, the currently displayed alarms table does not change, even if these alarms
affect the current page. Instead, the Refresh button displays a two-state icon. This icon indicates that
new alarms have arrived, and you should update the table to include the new alarms soon.

When you delete alarms, the table is updated immediately. The deleted alarms no longer appear in
the table.When another user deletes alarms, youmight see blank rows in the alarms table.Arefresh
request recomputes the pages and updates the table to remove the deleted alarms. Only one page of
alarms is displayed per request. You can see additional pages by using the page navigation buttons
above the alarms table.
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Navigation for theAlarmTable Page
TheAlarmsDetails window contains navigation buttons that enable you tomove through the alarm
pages. Informational messages inform youwhen the first and last pages of the table are displayed.A
scrollbar enables you to scroll through each page of the table.

AlarmCategories
The alarms table presents different categories of detailed alarm information. The following
information always appears in the alarms table.

Severity Indicates the severity of the alarm. Black is most severe. Grey is least severe.Agreen
checkmark in this column indicates that the alarmwas acknowledged.

Start time Date and time that the alarm occurred

State Indicates the state of the alarm: open, a “ringing” bell icon, or closed, a “silent”bell
icon

Action Indicates the action taken by the user or the program in response to the alarm
condition

Message Abbreviatedmessage that describes the alarm

The following information appears on the bottom of the page when an alarm row is selected. This
information is only displayed for closed or acknowledged alarms.

Alarm EndedOn Date and time that the alarm condition was fixed

AlarmAcknowledgedOn Date and time that the alarmwas acknowledged, and the user ID of
the person who acknowledged the alarm

Select an alarm row to display any available additional information that is associated with the alarm.
The additional information includes the following data:

� The alarm end time
� The acknowledgment date and time
� The user ID of the user who acknowledged the alarm

AlarmStates
Abell icon in the State column of the alarms table indicates the state of each alarm. Each alarm has
two states: open and closed.

An open alarm is an alarm for which the condition that caused the alarm still exists.Aclosed alarm
means the condition no longer exists. Open alarm icons show a “ringing” bell. Closed alarm icons
show a “silent” bell.
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AlarmAction Status
TheAction column of the alarms table indicates the status of each alarm.

Each alarm can have one of three action conditions:

� No action –An action has not been registered for that alarm.
� Pending action – The action is manual. Click the Run button to execute the action.
� Executed – The action is automatic. TheAlarmManager software has already performed the

action.

ViewingAlarm Information
TheAlarmManager software displays alarm information formanaged objects. You can view object
alarm information in an administrative domain in themain console and the DetailsAlarmwindows.

� ToViewAlarms From theMainConsoleWindow
When an alarm condition occurs, a colored alarm indicator appears in the console window. Formore
information about the alarm indicators, see “Alarm Severity Levels” on page 172.

To viewmore information about an alarm:

To see a summary of current alarms, click one of the Domain Status Summary buttons in the main
console window.

Alist of objects appears in the Domain Status Details window. This list includes those objects that
have at least one open, unacknowledged alarm for which the highest severity matches the icon on the
button. Formore information about these icons, see “Alarm Severity Levels” on page 172.

From the Domain Status Details window, you can do the following tasks:

� Change the sort order of the displayed alarms, as described in “To Sort the Domain Status
Alarms” on page 178.

� Access detailed information about a specific alarm, as described in Step 2.
� Update the Domain Status Details window by clicking the Refresh Now button.

To view details about a specific alarm, use one of the following methods:

� Double-click the desired row in the Domain Status alarm table.
� Click the desired row to select the row, and then click the Details button.

The Details window for the applicable managed object appears with theAlarms tab selected and
alarm information displayed. From this window, you can do the following tasks:

� Acknowledge the alarm, as described in “ToAcknowledge NewAlarms” on page 181.

1

2

ViewingAlarm Information

SunManagement Center 3.6.1 User’s Guide • May 2006176



� View andmodify the suggested fix for the alarm, as explained in “ToView andAdd Suggested
Fixes” on page 182.

� View and add user notes about the alarm, as described in “ToAdd anAlarmNote” on page 182.
� Modify a defined alarm action, as explained in “ToModify PendingAlarmActions” on page 186.
� Delete the alarm, as described in “ToDeleteAlarms” on page 181.

� ToAccess anAlarm for a SpecificManagedObject
When an alarm icon appears next to amanaged object icon in themain console window, you can
view the alarms for that specific object.

Double-click the managed object icon.

TheDetails window for that managed object appears with theModule Browser tab selected.

Click the Alarms tab.

TheDetails window changes to show all open alarms for the currentmanaged object.

� ToAccessAlarms From theDetailsWindow
Press mouse button 3 on a host icon in the main console window, and choose Details from the pop-up
menu.

TheDetails window appears.

Click the Alarms tab.

TheAlarmsDetails window appears.

Note – Abold header identifies the column onwhich the alarms table is sorted.Adown or up arrow
indicates the order on which the column is sorted. For example, the alarms table shown in Figure
12–2 is sorted in descending order (newest to oldest alarm) based on the start date and time. This
order is the default sort order for the table.
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FIGURE 12–2AlarmsDetailsWindow

For information about changing the sort order, see “To Sort theAlarms Table” on page 179.

� ToSort theDomain StatusAlarms
By default, alarms in the Domain Status Details window are sorted from newest to oldest.

In the Domain Status Details window, click the Sort button.

The Sort Options window appears.

Determine whether to sort the alarms alphabetically or by time received:

� To sort alphabetically by statusmessage, click StatusMessage (alphabetically).
� To sort the alarms by time received, newest to oldest, click Time (newest to oldest).

Click the OK button.

TheDomain Status Details window updates with any order changes as appropriate.
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� ToSort theAlarms Table
Double-click any column header in the alarms table.

� If the alarms table is currently sorted in ascending order, the table is redisplayed immediately in
descending order, based on the column that you select.

� If the alarms table is currently sorted in descending order, the table is redisplayed immediately in
ascending order, based on the column that you select.

If the table containsmany alarms, changing the sort ordermight take several seconds.

The column headers have an down or up arrow to the right of the header. These arrows indicate the
order in which the table is sorted, descending (down arrow) or ascending (up arrow). The arrow
indicator and the selected column header are boldface to identify current sort order. The following
list identifies the default sort order for each column heading in the alarm table.

Severity Alarms are sorted from highest severity (down) to lowest severity (off or disabled).

Start Time Alarms are sorted from newest to oldest.

Action Alarms are sorted as follows:
a. Alarms that have completed and executed actions
b. Alarms that have pending actions
c. Alarms that have no actions

State Alarms are sorted from open to closed.

Message Alarms are sorted alphabetically.

� ToUpdate theAlarms Table
As new alarms are entered into the database, the currently displayed alarms table does not change.
This behavior is true regardless of whether these alarms affect the currently displayed page.As
existing alarms are deleted, the alarms table is updated automatically.

To update the alarms table, click the Refresh button.

The alarms table is updated to reflect the new alarms. The program recomputes the division of pages
to add the new alarms. The date and time of refresh are displayed in the Last Refresh field.

� To Filter theAlarms Table
With the Alarms tab selected in the Details window, choose View Alarms from the Options menu.

The View SpecificAlarms dialog box appears.

◗

◗
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FIGURE 12–3ViewSpecificAlarmsDialog

To select the items to include in the alarms table, click the boxes next to the items.

Acheckmark is displayed in each box that you select. You can select the severity, state, and
acknowledgement status of the alarms displayed in the table.

Accept your selections.

� To accept your selections and close the View SpecificAlarms dialog box, click the OK button.
� To accept your selections and continue to display the View SpecificAlarms dialog box, click the

Apply button.

The alarms table is filtered. The table is redisplayed to reflect your selections.

� ToViewaLogofAlarmActivity
The SunManagement Center software can show alarm activity in a log file. To view the log, follow
these steps:

In the Details window for the Sun Management Center server, click the View Logs tab.

From the Choose Log File Type menu (the left-most icon at the top of the page), select Sun
Management Center Log.

From the Sun Management Center Log list, select eventHistory.log.

The eventHistory.log file contents display in the window.
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Managing andControllingAlarms
You canmanage and control the alarms displayed in the alarms table.

� ToAcknowledgeNewAlarms
If you acknowledge alarms when the alarms occur, you canmore easily track new alarms.
Unacknowledged alarms continue to be displayed in several locations:

� Domain Status Summary
� Hierarchy (tree) view
� Contents view
� Topology view
� Relevant row or relevant column in the property table (contents view)

In the Details Alarms window, select the appropriate alarm row.

The selected row is highlighted.

Tip – To select multiple rows in the table, use the Shift key or drag the cursor. To select multiple,
non-contiguous rows from the table, use the Control key.

Click the acknowledge button, which looks like a check mark.

The user ID, date, and time of acknowledgment are registered.Agreen checkmark appears next to
the alarm icon in the Severity column. Information appears in theAlarmAcknowledgedOn section
of theAdditionalAlarm Information pane.

� ToDeleteAlarms
You should delete closed alarms to conserve space and to keep the alarms database current.

You can delete open alarms. If you delete open alarms, alarm information in theAlarms windows
might differ from alarm information in the hierarchy and topology views. The alarms are removed
from the view in the alarms table, but the alarm conditionmight still exist. You should delete open
alarms only if those alarms are orphaned. An example of when this actionmight be required would be
in the case of an unloadedmodule. If themodule has triggered alarms that were not closed before the
module was unloaded, the alarms are orphaned. If orphaned alarms remain in view, you need to be
delete those alarmsmanually.

Caution – You should only delete open alarms when there is no other way to remove these alarms.
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To delete all closed alarms, choose Delete All Closed Alarms from the Options menu.

To delete only specific alarms:

a. With the Alarms tab selected in the Details window, click the appropriate rows in the alarms
table.

Tip – To select multiple rows in the table, use the Shift key or drag the cursor. To select multiple,
non-contiguous rows from the table, use the Control key.

b. Choose Delete Alarms from the Options menu.

Aconfirmation alert appears.

� ToAddanAlarmNote
You can track the history of an alarm by adding notes to an expanding list of notes for a specific
alarm.

With the Alarms tab selected in the Details window, choose Edit Note from the Options menu.

The EditAlarmNote window appears. The window shows any existing notes.

Click the Add button.

TheAddwindow appears.

Type your note in the text field of the Add window.

Click the OK button to accept your changes and close the Add window.

The EditAlarmNote window displays the following information:

� The date and time that you added the note
� The login identity that added the note
� The text of the note

� ToViewandAddSuggested Fixes
Adefault suggested fixmight be displayed when a specific alarm is selected in the alarms table. You
can also provide your own suggested fix to accompany the default suggestion.

With the Alarms tab selected in the Details window, select an alarm in the alarms table.
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Choose Edit Suggested Fix from the Options menu.

The Edit Suggested Fix window appears. If a SunManagement Center suggested fix exists for this
alarm, it is listed without a user identifier in the operator field.

To view the suggested fix, select the suggested fix in the Add window. Then, click the View Alarms
button.

Aread-only window appears that displays the text for the suggested fix. To close this window, click
the Cancel button.

To add your own suggested fix for this alarm, click the Add button in the Edit Suggested Fix window.

TheAddwindow appears.

Type your suggested fix in the text field of the Add window.

The length of the suggested fix text is limited to 4000 bytes.

Click the OK button to accept your changes and close the Add window.

� ToNotifyUsersWhenaHost orAgent IsDown
By default, the SunManagement Center software checks whether a host or agent is not responding.
However, no default action is defined in response to these conditions.

Select the managed object on which you want this action performed.

Tip – To apply this action to all children of amanaged object, select the parentmanaged object. For
example, to apply the action to all objects within a particular subnet, select the subnet.

Press mouse button 3 and select Alarm Action from the pop-up menu.

TheAlarmAction window appears.

To define an action for host not responding, click the Actions button next to Host Not Responding.

TheAction Selection window appears. To select or define an action, see “To Select anAction”
on page 186.

Tip – TheActions buttons are at the right side of the window. If you havemade your window smaller
than expected, youmight need to scroll to the right or enlarge the window to access the button.

To define an action for agent not responding, click the Actions button next to Agent Not Responding.

TheAction Selection window appears. To select or define an action, see “To Select anAction”
on page 186.
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(Optional) If the current managed object is the child of an object for which an alarm action has been
defined, choose whether to include group actions.

By default, host not responding and agent not responding actions apply to all children. You can
choose that a particular child should not share the group action. Click the appropriate checkbox to
disable the inherited action.

Note – The Include GroupActions section of theAlarmActionwindow appears only for applicable
childmanaged objects.

(Optional) To set the alarm action to apply only during certain times (for example, during business
hours only), click the Scheduler button.

a. To run the alarm action starting on a day other than today, provide a date in the Start Date field.

You can edit the information in the Start Date fieldmanually, or you can click on a date in the
calendar to select the date.

b. Select an hour and minute from the pop-up menus next to Start Time.

Hours are based on a 24–hour clock. So, 16:00 is the same as 4:00 PM.

c. Select an hour and minute from the first pop-up menus next to End Time.

d. To allow this alarm action to occur more than once, choose how often it can occur from the
Repeat Interval pop-up menu.

For example, to permit an alarm action to occur only on weekdays, selectMon-through-Fri.

e. (Optional) To limit how long the alarm action can be repeated, type a number in the Repeat Limit
field.

For example, to run this alarm action for amonth, type 4 in the Repeat Limit field when the word
next to the field says “Weeks.” The word next to the Repeat Limit field depends on your Repeat
Interval choice.

Note – The alarm action is available indefinitely if you do both of the following:

� You select a Repeat Interval other thanOne Time.
� You do not provide a value in the Repeat Limit field.

f. Click OK to set this schedule, or click Cancel to exit from the Scheduler window.

To complete the alarm action definition and exit from the Alarm Action window, click the OK button.
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� ToRegister anAlarmAction
Although alarms are defined, you need to tell SunManagement Center what to do when the alarm
condition is met. For example, youmight want to have the software send email notification to
appropriate system administrators.

Note – You need to perform this procedure on themanaged object (host) that you aremonitoring, not
on system running the SunManagement Center server layer.

In the Attribute Editor, click the Actions tab.

TheAttribute EditorActions window is displayed.

Click the Actions button next to the action to be registered.

TheAction Selection dialog box is displayed.

Select the type of alarm action that you want to register.

� To send an email, follow these steps:
a. Select the Email button. Then, type the user name or alias to which to send themessage.

Tip – To send tomore than one user name, separate the user names with a space.

b. Type themessage text.
� To perform an action other than sending an email, follow these steps:

a. Define a script that specifies the action. Formore information, see “ToDefine anAlarm
Action Script” on page 187.

b. Select the Other button.
c. Choose a script to run from the list of available scripts.
d. Type any parameters that the script needs into theArguments field.

� To clear the alarm, select Clear.

To set the action as you defined and close the Action Selection window, click the OK button.

Click the OK button to accept the entries and close the Alarm Action dialog box.

The entry is displayed in the correspondingAction field of theActions dialog box.
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� ToRunaRegisteredAlarmAction
You can initiate some alarm actionsmanually after an alarm occurs.

Select one or more alarms with pending actions in the alarms table and click Run.

The currently registered alarm actions for the alarm are started. The action state in the alarms table
changes from pending to executed. For additional details, see “ToModify PendingAlarmActions”
on page 186.

Note – Several seconds can be needed for the action state in the alarm table to update.

� ToModify PendingAlarmActions
For alarms with no registered actions, a “no action” icon is displayed in theActions column of the
alarms table. For alarms with amanual action, the “pending” icon is displayed until the user runs the
action. Then, the “executed” icon is displayed. For alarms with an automatic action, the “executed”
icon is always displayed.

With the Alarms tab selected in the Details window, select an alarm that has a pending action in the
Alarms table.

Choose Modify Action from the Options menu.

TheAction Selection dialog box is displayed. Only alarms that are pendingmanual action can be
modified.

Select the action that you want to modify and make the necessary changes as described in “To Select
an Action” on page 186.

� ToSelect anAction
When an alarm condition is met, you can choose to send an email, perform some other action, or
clear the alarm.

To send an email, follow these steps:

a. Select the Email button.

b. Type the user name or alias to which to send the email message in the To field.

Tip – To send tomore than one user name, separate the user names with a space.
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c. Type the message text in the Message field.

To perform an action other than sending an email, follow these steps:

a. Select the Other button.

b. Select a script to run from the list of available scripts.

For information about creating a script to run, see “ToDefine anAlarmAction Script” on page
187.

c. Type any parameters that the script needs into the Arguments field.

To set the alarm to be cleared as the action, select the Clear button.

To set the action as you defined and close the Action Selection window, click the OK button.

� ToDefineanAlarmAction Script
The following procedure describes how to customize an alarm action to notify a user when an alarm
condition occurs.

Create your custom alarm action script, using the following optional arguments:

%statusfmt The alarm severity, such asWarning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. For example: Critical:
MachineAKernel Reader Number of User Sessions > 10.

At the command-line level, become superuser.
# su -

Install the script in the home Sun Management Center directory.

The default is the /var/opt/SUNWsymon/bin/ directory. For example:
# cp custom-alarm-script /var/opt/SUNWsymon/bin/

Click the Module Browser tab in the Details window.

Set the alarm threshold.

Formore information, see “Example: ToDefine and Respond to anAlarm” on page 188.

Open the Attribute Editor for the property to which you want this script to apply.
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Click the Actions tab.

The action rows are displayed.

Type custom-alarm-script %statusstringfmt in the Critical Action field of the Actions panel.

Ensure that the Automatic check box on the Critical Action line is selected.

By default, your script will execute automatically.

To apply this action script and close the Attribute Editor window, click the OK button.

AlarmManagement Examples
There aremanymethods that you can use to define andmanage alarms. Here are a few examples to
better illustrate how youmight perform these functions in your environment.

� Example: ToDefineandRespond to anAlarm
This example illustrates how to create and acknowledge a simple critical alarmwhen thememory
usage on the specified system exceeds 50%.

Access the Details window for the managed object on which you want to define the alarm.

Click the Module Browser tab in the Details window.

Click the expansion icon next to the Operating System icon in the hierarchy tree view.

TheOperating Systemmodules are displayed.

Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

Double-click the Memory Usage Statistics icon.

TheMemory Usage Statistics properties table is displayed in the contents view.

Select the table cell for % Memory Used.

Tip – If theAttributes button is unavailable and is dimmedwhen you select the table cell, verify that
you selected the data cell not the label cell.

Click the Attributes button.

TheAttribute Editor window is displayed.
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Click the Alarms tab.

TheAlarms panel appears on which you can define threshold values for Critical, Caution, andAlert
alarms.

Type 50 in the Critical Threshold (>) field.

Acritical alarmwill be generated when thememory usage exceeds 50% on the selectedmanaged
object.

Note – This example uses a low threshold to create an alarm immediately. Normally, youmight
generate alarms according to the following criteria:

� An alert alarmwhen the usage exceeds 50%
� Acaution alarmwhen the usage exceeds 65%
� Acritical alarmwhen the usage exceeds 80%

Click the OK button to apply your changes and close the Attribute Editor window.

Almost immediately, the %Memory Used data field in the table turns red. In addition, red alarm
icons are displayed on the Operating System, Kernel Reader, andMemory Usage Statistics folders
and icons. If the red icon does not appear, verify whether your system has an open, unacknowledged
black alarm.

Click the Alarms tab in the Details window.

The alarm that you created is listed in the alarms table. See Chapter 12 formore information.

Click the Acknowledge button to acknowledge this alarm.

Tip –TheAcknowledge button looks like a checkmark.

Create additional alarm thresholds, and familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that another Sun
Management Center software user cannot change your alarm thresholds. Formore information
about security, see Chapter 18.

Note – You do not need to fill in alarm information for all alarm thresholds. For example, youmight
choose to create only a critical alarm threshold.

This example illustrates creating a situation where an alarm is registered if a value exceeds the alarm
limit. Table 10–1 lists other common alarm limits in the software.

� Example: To SendanEmail
This example sets up an email to be sent when the system load average exceeds the threshold.
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When an alarm condition is met, sending an email message is a good solution inmost situations.
However, if a router or an uninterruptible power supply (UPS) is down, your email message would
not be sent.

Youmight consider setting up a pager alarm to send an alarmmessage to a terminal and to a pager
through amodem for such failures. Formore information, investigate quick paging or instant paging
solutions.

Click the Module Browser tab in the Details window.

Click the expansion icon next to the Operating System icon in the hierarchy tree view.

TheOperating Systemmodules are displayed.

Click the expansion icon next to the Kernel Reader icon.

The Kernel Reader properties are displayed.

Double-click the System Load Statistics icon.

The System Load Statistics properties table is displayed in the contents view.

Select the table cell for Load Averages Over the Last 5 Minutes.

Click the Attributes button.

TheAttribute Editor window is displayed.

Click the Actions tab.

TheAction Selection screen appears.

Click the Email radio button to activate the To and Message fields.

Type the usernames in the To field and the message in the Message field.

Click OK to accept the changes that you made and close this window.

The following email is sent to the usernames whenever the load averages alert alarm occurs.
Date: Wed, 30 Jun 2000 15:25:39 -0800

From: root@MachineB (0000-Admin(0000))

Subject: Sun Management Center - Alert Alarm Action

Mime-Version: 1.0

Sun Management Center alarm action notification ... {Alert:

machineB Kernel Reader Load Average Over The Last 5 Minutes > 0.01Jobs}

BeforeYouBegin
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ManagingGroup-related Jobs

TheManage Jobs function enables you to define a task request or collection of attribute settings that
applies to a user-defined group of objects. The following topics are described in this chapter:

� “JobManagement Concepts” on page 191
� “ToDefine a Job” on page 192
� “ToView Job Status” on page 194
� “Using Filters” on page 205
� “ToDefine a Task” on page 196
� “To Create aModule Task” on page 197
� “To Create a Data Property Task” on page 199
� “To Create aModule Table Task” on page 200
� “To Create a Configuration Task” on page 201
� “ToUpdate the File Set for a Configuration Task” on page 203
� “To Create anAgent Update Task” on page 203
� “To Schedule a Job” on page 194
� “ToModify a Task” on page 204
� “ToModify a Filter” on page 207
� “To Suspend a Running Job Request” on page 195
� “ToDelete a Job Request” on page 196
� “ToDelete a Task” on page 205
� “ToDelete a Filter” on page 207

JobManagement Concepts
A job consists of a task or activity and a set of filtering criteria used to define the objects to which that
task applies. You can submit a job to run when you define the job.Alternatively, you can schedule a
job to run at a specific time or on a repeating schedule. For example, youmight define a job that sets
several attributes for several data properties that apply to several modules.Another example of a job
might be to set a single attribute for several hosts within a domain. The remainder of this chapter
describes how to define, schedule, andmanage jobs.
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Manage JobsWindow
You use theManage Jobs window to define and schedule jobs. For any defined jobs, theManage Jobs
window displays the following information:

� Job name
� Date and time that the task was added to the server database
� Domain to which the job applies
� Name of any filter that applies to the job
� Indication of whether the job is run at user request or according to a periodic schedule
� Current state of the job

Features in theManage Jobs window enable you to define andmodify jobs. Formore information,
see the following tasks:

� “ToDefine a Job” on page 192
� “Using Filters” on page 205
� “ToDefine a Task” on page 196
� “To Create aModule Task” on page 197
� “To Create a Data Property Task” on page 199
� “To Create aModule Table Task” on page 200
� “To Create anAgent Update Task” on page 203
� “To Schedule a Job” on page 194
� “ToModify a Task” on page 204

Creating andManaging Jobs
Ajob consists of a task or activity and a set of filtering criteria used to define the objects to which that
task applies. This section describes how to define, schedule, suspend, and delete jobs.

� ToDefinea Job

Note – This procedure describes themain steps that you follow to create a job request. Individual
steps are explained in further detail in the referenced procedures.

Choose Manage Jobs from the Tools menu in the main console window.

Type a unique name for the job in the Job Name field.
The name should describe the job. For example, if the job is to load the DirectoryMonitoring
module, the name could be LoadDirectoryMonitoring.

Specify the initial set of managed objects to which this job applies.
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� To apply this job to all objects within the current domain, selectAll Objects in Domain.
� To select objects manually, select Selected Objects inMainWindow.

Note – You can select objects before you define the job.Alternately, you can go to the topology area
of themain console window to select the objects now. In either case, youmust select topology
objects before you submit this job.

� To use objects that were selected previously for this job, select Objects Previously Selected in
MainWindow.

Note – This feature applies only to jobs that are beingmodified. For new jobs, this feature is
unavailable and is dimmed.

To limit the managed objects even further, specify a filter.

� Click the New Filter button to limit this task to objects that use a specific operating system
version, platform, or other specified criteria.

The New Filter window appears fromwhich you define the filter. See “Using Filters” on page 205
formore information.

� Choose a defined filter from the Filter menu.

To see what objects would be selected by the defined filter, click Preview Objects.

Specify the action for the job to execute.

� Click NewTask to define a task.

The NewTask window appears fromwhich you define the task. See “ToDefine a Task” on page
196 formore information.

� Choose a defined task from the Taskmenu.

Determine whether to run the job immediately or to schedule the job.

� To run this job when you have finished defining it, click the radio button next to Run Job
Immediately.

� To schedule this job to run, click the radio button next to Schedule Job, then click Set Schedule to
access the scheduling function.

Formore information about scheduling a job, see “To Schedule a Job” on page 194.

To complete the definition of this job, click Add Job.

Tip –To clear all fields in the job, click Reset Form.
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� ToView JobStatus
The Jobs section of theManage Jobs window shows a brief status for current jobs.

To view more detailed job status, select the job from the Jobs section of the Manage Jobs window.

Click the View Log button.

Awindow appears that displays detailed information about the selected job.

Tip – If the View Logwindow ismostly empty, the job probably has not finished. Exit from the View
Log window.Wait until the status in theManage Jobs window no longer says “Running” before you
reopen the View Log window.

The View Log window provides the following information about the selected job:

� The name, type, and description for the task
� The domain in which the job was run
� The date and time that the job was run
� The overall job status
� The length of time it took for the job to run
� The user name of the user that requested the job
� Alist of managed objects to which the job applies
� For eachmanaged object in the job, information about job activities and status

To view more information about the job status for a specific managed object, select the object in the
Domain Object Status section of the View Log window.

Specific information about the job status as it relates to the selected object appears in the Domain
Object Status Details section of the window.

� ToSchedule a Job
Asimilar Scheduler window is used for defining schedules formodule loading and enabling,
group-related jobs, alarmmonitoring, andDiscovery requests.

To set this job to begin on a day other than today, type a date in the Start Date field.

To select a date from the calendar, click the date. To change themonth, use the left and right arrows at
the top of the calendar.

Select an hour and minutes from the Start Time menu.

Hours are based on a 24–hour clock. For example, 16:00 is the same as 4:00 PM.
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Note – You cannot schedule two jobs withMCP configuration tasks at the same time. If you are
scheduling a job with anMCP configuration task, make sure the scheduled time is different from any
previously scheduled jobs withMCP configuration tasks. If you schedule two jobs for the same time,
the job scheduled first is executed. The second job scheduled for the same time is ignored.

(Optional) Choose how often the action should occur from the Repeat Interval menu.

You can schedule a task to occurmore than once. For example, to schedule a task to run weekly, you
would selectWeekly.

Note –Repeat Interval values differ by scheduling activity.

(Optional) Select an appropriate time reference from the Repeat Interval menu. Then, type a number
in the Repeat Interval field.

You can run the action for a specific number of repeated intervals. For example, to run a task for the
next twomonths, selectMonths from the Repeat Interval menu and type 2 in the Repeat Interval
field.

Note – Some time intervals, such asWeekly, do not allow you to specify Repeat Intervals. In those
cases, you cannot type a value in the Repeat Interval field.

Click OK to set this schedule.

� ToSuspendaRunning JobRequest
You can stop a job from running and restart the job later. For example, if you havemajor system
maintenance that is going to be performed, youmight want to temporarily disable some alarm
processing.

In the Manage Jobs window, select the task request that you want to suspend from the list of jobs.

Click the Suspend Job button.

� If the job is running, the value in the State column changes to Suspended.
� If the job is not running (for example, the current State is Queued), nothing appears to happen.

To restart a suspended job, select the job and click the Resume Job button.
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� ToDelete a JobRequest
In the Manage Jobs window, select the job that you want to delete from the list of jobs.

Click the Delete Job button.

ADelete confirmation window appears to remind you that deleting the job is a permanent action.

To permanently delete the job, click the Delete button.

Creating andModifying Tasks
A task is the actual action that you want to have performed for the job. This section describes how to
create, change, and delete tasks.

� ToDefineaTask
Choose Manage Jobs from the Tools menu in the main console window.

TheManage Jobs window appears.

Click New Task.

TheNewTask window appears.

Type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to load a specific
module, the task name might be Load Directory Monitoring Module.

Select the type of task that you want to create from the Task Type menu.

The task type that you select determines the remaining information on the NewTask window.

Follow the steps as appropriate for your task type.

The following task types are available:

� Module task – Load, enable, disable, unload, or change security settings formodules. See “To
Create aModule Task” on page 197.

� Data Property task – Set alarm thresholds and actions, set intervals for refreshing data or write
the data to history logs. See “To Create a Data Property Task” on page 199.

� Module Table task –Add, remove, or change information inmodule tables. See “To Create a
Module Table Task” on page 200.

� Configuration task – Copy a set of module configuration files and scripts from a source host to
others. See “To Create a Configuration Task” on page 201.
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� Agent Update task –Update agents by using an update image file. See “To Create anAgent
Update Task” on page 203.

(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.
You remain in the NewTask window to define additional tasks.

To redefine the task, click Clear Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToCreate aModule Task
Amodule task enables you to schedule the following actions for a group ofmodules:

� Load
� Unload
� Enable
� Disable
� Change security settings

Note – Asinglemodule task can includemodule actions for several modules.

In the New Task window, type a name for the task in the Task Name field.
The task name should describe the task. For example, if you are defining a task to load a specific
module, the task name might be Load Directory Monitoring Module.

Choose Module from the Task Type menu.

Choose a module name from the Module menu.

If the selectedmodule is amulti-instancemodule, a window appears in which you type themodule
instance name.

The instance name is used within the SunManagement Center agent to identify uniquely a particular
module or a rowwithin amodule. Youmust specify a unique name for each instance whenmultiple
instances of the samemodule are loaded.

An instance name is a single word or alphanumeric string. The only special character allowed in an
instance name is the underscore (_).

Choose an action to perform for this module from the Module Action menu.

The following actions are available, depending on the current state of the selectedmodule:

� None – Enables you tomodify the security for the selectedmodule
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� Load – Loads themodule
� Enable – Enables themodule
� Disable – Disables themodule
� Unload –Unloads themodule

The action that you choose determines which buttons to the right of themodule task table are active
(bold font) or inactive (grayed out). In addition, the Load Parameters window appears automatically
when you choose to load amodule.

� Load Parameters –Active only if Load is the selectedAction
� Set Schedule –Active if Load or Enable is the selectedAction
� Set Security –Active if Load or None is the selectedAction
� Delete Entry –Always active

To define the load parameters for the module, click the Load Parameters button.

TheModule Loader window appears.Appropriate information is displayed for the selectedmodule.
Formore information, see Chapter 11.

Note – This button is active only if Load is the selected action.

To set a time to perform the requested module action, click the Set Schedule button.

The Scheduler window appears, in which you define the schedule for loading and enabling this
module. Formore information, see “To Schedule a Job” on page 194.

Note – You can also set the schedule for when the overall task is to be performed in theManage Jobs
window. The Scheduler window differs slightly when scheduling amodule task as opposed to
scheduling a job. For amodule task, youmust specify an end time.Also, you use slightly different
Repeat Interval values for themodule task.

This button is active only if the selected action is either Load or Enable.

To define security parameters for the selected module, click the Set Security button.

TheAttribute Editor window appears. Current security information is displayed for this module. For
additional information about theAttribute Editor, see Chapter 10. Formore information about
security, see Chapter 18.

Note – This button is active only if the selected action is either Load orNone.

(Optional) Because a module task can include actions for several modules, repeat the preceding five
steps until you have identified all the modules and their associated actions for this task.

Tip – To remove amodule and its associated actions from themodule list for this task, select the
module and click Delete Entry.
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(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.

You remain in the NewTask window to define additional tasks.

To clear the data for the existing task so that you can define another task, click Reset Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToCreate aDataProperty Task
Adata property task enables you to set a threshold for a particular data property, for example alarm
thresholds and actions, across a group of objects.

In the New Task window, type a name for the task in the Task Name field.

The task name should describe the task. For example, if you are defining a task to set some alarm
thresholds, the task name might be Set threshold for memory usage alarm.

Choose Data Property from the Task Type menu.

Click Select Property.

The Select Property window appears.

Select a data property from the list.

Note – The initial list of data properties is a hierarchical list. You need to expand the list several levels
to get to an individual selectable data property.

The content of the Select Property window differs according to the property that you select. The next
series of steps explains the different possible items that youmight need to specify.

a. If there can be more than one instance of this module, type the instance name in the Module
Instance field.

The instance name is used within the SunManagement Center agent to identify uniquely a
particular module or a rowwithin amodule.

An instance name is a single word or alphanumeric string. The only special character allowed in
an instance name is the underscore (_).

b. If the data property can apply to more than one object of the same type, determine whether the
task applies to all indices of the selected property or only to a specific index value of the selected
property.
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c. To apply the task to a Specific Property Index, provide a unique value in the property index field.
The labels and fields beneath the selection buttons differ according to the specific data property.
In some instances, youmight have one field in which you can enter one index. In other instances,
youmight havemultiple fields in which to enter a range of index values.

For example, if you choose the CPUNumber data property and you have an environment in
which you have several CPUs, youmight want to apply the task only to a specific CPU number. If
you do not specify an index, the property updates on all CPUs.

On the other hand, if you choose the TCPConnection property, you have four fields in which to
enter data. Youmust supply values in all four fields to enable this task.

When you have provided all the information for this data property, click Apply.
Continue to add properties until you have identified all the data properties that you want to use.

To close the Select Property window, click Close.
The data properties are added to the selected properties table. The Select Property window closes.
You return to the NewTask window.

To define additional attributes for the specified data properties, select the data property entry in the
table in the New Task window. Then, click Set Attributes.
TheAttribute Editor appears. You can define alarm, alarm action, refresh interval, or history log
behavior. Formore information, see Chapter 10 and Chapter 12.

To remove a data property from the selected properties table, select the data property entry in the
table. Then, click Delete Entry.
Aconfirmation window appears fromwhich you can accept or reject the removal.

(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.
You remain in the NewTask window to define additional tasks.

To clear the data for the existing task so that you can define another task, click Reset Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToCreate aModule Table Task
Some SunManagement Centermodules can onlymonitor an entity once the data parameters for
that entity have beenmade known to themodule. For example, for the FileMonitoringmodule to
function appropriately, you need to identify several specific items:

� The name of the file to bemonitored
� Adescription of the file
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� Atable row index for displaying that information in the FileMonitoring table

Amodule table task enables you to add entries as table rows to a group ofmodule tables.

In the New Task window, type a name for the task in the Task Name field.
The task name should describe the task. For example, if you are defining a task tomonitor specific
file, the task name might be Add monitoring for .cshrc file.

Choose Table from the Task Type menu.

Select the module to which this task applies from the Module Table menu.
If the selectedmodule is amulti-instancemodule, a window appears in which you type themodule
instance name.

Add a row, or modify or delete a row.

� To add a row to a table, chooseAdd Row from the TableActionmenu, and provide required
values in theAdd Rowwindow as needed.
For example, youmight need to provide a Name (for example, CheckLog), Description (for
example, log file), and a Filename (for example, /var/opt/SUNWsymon/cfg/sfix.log).

� Tomodify a row in a table, choose Edit Row from the TableActionmenu andmodify values in
the Edit Rowwindow as needed.
For example, youmight need to change the name of the file that is beingmonitored.

Note – The index value that you provide heremustmatch an index value for an existing row in the
table. If the value does notmatch, nothing will match to bemodified.

� To remove a row, choose Delete Row from the TableActionmenu.
In the Delete Rowwindow, provide name, description, and file name information that exactly
matches the row as the row currently exists in the table.

(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.
You remain in the NewTask window to define additional tasks.

To clear the data for the existing task so that you can define another task, click Reset Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToCreate aConfiguration Task
AConfiguration task enables you to copy scripts andmodule configuration files from one host to
another host or to a group of hosts.
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Note – To copy these files, youmust be authorized as anModule Configuration Propagation (MCP)
user. By default, any server esadm groupmember is anMCPuser. To limit script propagation through
MCP to specific users, you need to add users to the es-mcp-users file. To add users to the file, use the
following command on the agent systems:

# es-config -m

In the New Task window, type a name for the task in the Task Name field.
The task name should describe the task. For example, if you are defining a task to copy just scripts
from one host to several, the task name might be Copy scripts from myhost.

Choose Configuration from the Task Type menu.
TheNewTask window changes to display appropriate information for a Configuration task.

Type the source host from which you want to copy in the Source Host Name field.
The source host must be an agent in the current server context. You can identify the source host
either by its name as known to the server or by its IP address.

To define the files to be copied, click Edit File Set.
TheNew File Set window appears.

a. To add the configuration files for a specific module to be copied, select the module name from the
list of Available Modules. Then, click Add.
The selectedmodule namemoves from the list ofAvailableModules to the list of Selected
Modules.

b. To add a script to be copied, select the script name from the list of Available Scripts, then click
Add.
The selected script namemoves from the list ofAvailable Scripts to the list of Selected Scripts.

c. When you have added all the modules and scripts that you want included in this set of files, click
OK.

To specify which parts of the source configuration are to be copied, click Set Options.
The Set Options window contains a series of radio buttons, grouped by related pairs. You can select
one option of a related pair. For example, you can use themodule security settings either from the
source host or the destination host, but not both.

By default, the following options are selected:

� Deploy to all destination hosts
� Load on all destination hosts
� Usemodule parameters on destination host
� Usemodule schedule on source host
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� Usemodule security settings on source host

When you have set the options, click OK to close the Set Options window.

(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.
You remain in the NewTask window to define additional tasks.

To clear the data for the existing task so that you can define another task, click Reset Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToUpdate the File Set for a Configuration Task
The data in the file set that is defined for a configuration task is stored on the server. Over time, the
various files that comprise a file set on a given source host might change.

From the Manage Jobs window, click New Task.

Select the Configuration task for the source host for which you want to update data.

Click the Synchronize File Set Content button.

Note –This button is disabled until a file set is defined.

The file set on the server is resynchronized with the file set on the source host.

Note – Resynchronizing the file set does not propagate the changed contents. To distribute the
changed file set to the target hosts, youmust re-run the task.

� ToCreate anAgentUpdate Task
AnAgent Update task enables you to define and schedule software updates to agent systems.

Create an Update Image file.
Use the es-imagetool or es-gui-imagetool utilities as described in SunManagement Center 3.6.1
Installation and Configuration Guide.

In the New Task window, type a name for the task in the Task Name field.
The task name should describe the task. For example, if you are defining a task to install the latest
version of the software on all agents, the task name might be Update agents to latest management
center software.
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Choose Agent Update from the Task Type menu.

Choose an image file from the Image File menu.

Note – If choices in thismenu are unavailable, there are noUpdate images defined. See Step 1.

When you chose an image file, information about its contents appears in the Image Contents section
of the NewTask window.

(Optional) Type a description for this task.

To confirm the definition of this task, click Add Task.

You remain in the NewTask window to define additional tasks.

To clear the data for the existing task so that you can define another task, click Reset Form.

When you have finished defining your tasks, click Close to close the New Task window.

� ToModify a Task
In the Manage Jobs window, select New Task.

In the New Task window, select the name of the task that you want to change in the Tasks list.

Make the necessary changes.

The task types are described in the following sections:

� “To Create aModule Task” on page 197
� “To Create a Data Property Task” on page 199
� “To Create aModule Table Task” on page 200
� “To Create a Configuration Task” on page 201
� “To Create anAgent Update Task” on page 203

To save your changes, click Update Task.

To close the New Task window, click Close.

To apply the changed task, click Update Job in the Manage Jobs window.
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� ToDelete a Task
In the Manage Jobs window, click New Task.

In the New Task window, select the task that you want to delete from the list of Tasks.

Click the Delete Task button.

ADelete confirmation window appears to remind you that deleting the task is a permanent action.

To permanently delete the task, click Delete.

To exit from the New Task window, click Close.

Using Filters
Filters enable you to act on objects according to some criteria that you define, rather than having to
explicitly select those objects.

� ToDefinea Filter
Click the New Filter button in the Manage Jobs window.

TheNew Filter window appears.

Type a name in the Filter Name field.

This name should describe the filter, such as Solaris8.

The next several steps explain how to define various filtering criteria. These criteria are used together
to select the objects. For example, if you define a platform filter and an operating system filter, the
managed object would need tomatch both criteria to be selected.

To choose objects based on their labels, select Filter on Object Label and type a text string to be
matched.

To control the level of matching that occurs, use one of the following keywords:

� Contains – Equivalent to *text*, matches any object whose label contains the specified string.
Contains is the default behavior.

� Starts with – Equivalent to text*, matches any object whose label starts with the specified string.
� Ends with – Equivalent to *text, matches any object whose label ends with the specified string.
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Tip – For an exactmatch, type the text string, then click ExactMatch.

To choose objects based on the hardware platform, select Filter on Platform Types.

a. Select the platform type from the list on the left.

b. To add this type to the filtering criteria, click the Add button.

c. To exclude rather than include objects based on the platform type, select Exclude.

d. To remove a platform filter, select the platform type in the list on the right, then click the Remove
button.

To choose objects based on the operating environment, select Filter on Operating Systems.

a. Select the operating environment from the list on the left.

b. To add this operating environment to the filtering criteria, click the Add button.

c. To exclude rather than include objects based on the operating environment, select Exclude.

d. To remove an operating environment filter, select the operating environment from the list on the
right. Then, click the Remove button.

To choose objects based on the modules that are loaded on that system, select Filter on Modules
Loaded.

a. Select the module from the list on the left.

For example, to include all systems on which the Kernel Reader is loaded, select Kernel Reader
(Simple).

b. To add this module to the filtering criteria, click the Add button.

c. To exclude rather than include objects based on the loaded modules, select Exclude.

d. To remove a module filter, select the module from the list on the right, then click Remove.

To choose objects based on their IP addresses, click the box next to Filter on IP Addresses.

a. Type an IP address from which to start including objects.

For example, to include only those objects whose IP address is between 186.255.255.240 and
186.255.255.254, you would type 186.255.255.240.
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b. Type an IP address at which to stop including objects.

For example, to include only those objects whose IP address is between 186.255.255.240 and
186.255.255.254, you would type 186.255.255.254.

(Optional) Type a description for this filter.

To confirm the definition of this filter, click Add Filter.

You remain in the New Filter window to define additional filters.

To clear the data for the existing filter so that you can define another filter, click Reset Form.

When you have finished defining your filters, click Close to close the New Filter window.

� ToModify a Filter
In the Manage Jobs window, click the New Filter button.

In the New Filter window, select the filter that you want to change in the Current Filters list.

Make the necessary changes.

See “Using Filters” on page 205 formore information about filters.

To save your changes, click Update Filter.

To close the New Filter window, click Close.

To apply the changed filter, click Update Job in the Manage Jobs window.

� ToDelete a Filter
In the Manage Jobs window, click New Filter.

In the New Filter window, select the task that you want to delete from the list of Current Filters.

Adeletion confirmation window appears to remind you that deleting the filter is a permanent action.

To permanently delete the filter, click Delete.
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Dataviews

This chapter provides the following information:

� “Dataview Contents” on page 209
� “Creating a Dataview” on page 210
� “WorkingWith Dataviews” on page 212
� “Navigating Through a DataviewWindow” on page 210
� “Types of Dataviews” on page 213

OverviewofDataviews
Dataviews are customized data property tables. You can create dataviews for any of the following
data:

� One type of data from several different hosts within a single domain
� Several types of data from one host
� Several types of data from different hosts within a single domain

An example of the first concept is a dataview that monitors CPU usage in group of hosts.An example
of the second concept is a dataview that monitors disk space and CPU usage on one host.

Note – Dataviews allow you to combine information from different hosts within a SunManagement
Center domain; however, you cannot create a dataview that combines data from different domains.

DataviewContents
The data that is used to create a dataview is copied from different sources, including:

� Tables
� Modules
� Hosts
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Dataviews are an excellent way ofmonitoring a collection of unrelated information. Because these
views are presented in a table, a variety of data can be easily compared. Dataviews are created once
and are refreshed automatically. Dataviews have all the features of module tables, except that cells
cannot be edited. In dataviews, alarm status is correctly propagated. Cells that have triggered a
critical alarm appear in red.

When you create a dataview, the dataview is stored in the database. The dataview persists until you
explicitly delete the dataview. In addition, because dataviews are stored in the database, dataviews
can be shared.Any dataview that is built on a particular SunManagement Center server can be
viewed by all authorized users on that server.

Navigating ThroughaDataviewWindow
The dataviewwindow contains the followingmainmenu items:

� File, which enables you to save the current dataview to a name or to close the current dataview
� Edit, which enables you to paste a dataview from the clipboard or to delete selected rows
� Tools, which provides direct access to theAttribute Editor for the selected cell
� Help, which displays online help

Creating aDataview
From the Details and console windows, there are two options to create a dataview:

� Create a Dataview
� Copy to the Dataview Clipboard

� ToCreate aDataviewFrom theContext Pop-upMenu
Open the Details window for the host in which you are interested.

TheModule Browser view appears in the Details window.

Click the expansion icon next to the items in the hierarchy down to the desired data property.

Press mouse button 3 on a row or cell in the data property table. Then, choose Create Dataview from
the pop-up menu.

Select Cell or Row(s) as appropriate.

An automatically populated dataviewwindow appears.
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� ToCreate aDataviewFrom theOptionsMenu
Open the Details window for the host in which you are interested.

TheModule Browser view appears in the Details window.

Click the expansion icon next to the items in the hierarchy down to the desired data property.

In the data property table, select a row or a cell.

From the Options icon menu, choose Create Dataview.

Tip – TheOptions iconmenu is the second from the left icon above the hierarchy view. This icon
looks like a list with a checkmark.

Select Cell or Row(s) as appropriate.

An automatically populated dataviewwindow appears.

� ToCopy to theDataviewClipboard From theDetails
Window
Press mouse button 3 on a row or data cell in a data property table. Then, choose Copy to Dataview
Clipboard from the pop-up menu.

Select Cell or Row(s) as appropriate.

To add the copied information to an existing dataview, follow these steps:

a. Open an existing dataview as explained in “To Open an Existing Dataview” on page 213.

b. From the Edit menu, choose Paste from Clipboard.

To add the copied information to a new dataview, follow these steps:

a. In the Details window, click the Dataview icon.

Tip – TheDataview icon is the third icon from the right above the data property table.

An empty Dataviewwindow appears.

b. From the Edit menu, choose Paste from Clipboard.
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� ToCopy to theDataviewClipboard From theConsole
Window

Select a row or data cell in a data property table.

Press mouse button 3 and choose Copy to Dataview Clipboard from the pop-up menu.

Select Cell or Row(s) as appropriate.

To add the copied information to an existing dataview, follow these steps:

a. Open an existing dataview as explained in “To Open an Existing Dataview” on page 213.

b. From the Edit menu, choose Paste from Clipboard.

To add the copied information to a new dataview, follow these steps:

a. In the Console window, choose Dataview Manager from the Tools menu.

TheDataviewManager window appears.

b. Click the Create button.

An empty Dataviewwindow appears.

c. From the Edit menu, choose Paste from Clipboard.

WorkingWithDataviews
The procedures in this section explain how to open, save, or delete a dataview.

� ToOpenanEmptyDataviewWindow

In the console window, choose Dataview Manager from the Tools menu.

TheDataviewManager window appears.

Click the Create Button.

An empty Dataviewwindow appears.

1

2

3

4

5

1

2

Creating aDataview

SunManagement Center 3.6.1 User’s Guide • May 2006212



� ToOpenanExistingDataview

In the Dataview Manager window, select the name of the dataview that you want to open.

Click the Open button.

� ToDelete aDataview

In the Dataview Manager window, select the name of the dataview that you want to delete.

Click the Delete button.

Note – ADelete confirmation window appears to remind you that deleting a dataview is a permanent
action.

� ToSave aDataview

In the Dataview window, choose Save from the File menu.

The Save Dataviewwindow appears. You can type an optional description in the Description field.

Click the Save Dataview button.

Note – If the name that you have chosen for this dataview exists, aWarning window appears.

Types ofDataviews
There are two types of Dataviews:

� Scalar
� Vector

ScalarDataviews
Ascalar dataview is created from scalar data items, which are single cells from scalar or vector tables.
Ascalar dataview includes the following three columns:

� Host Name
� Data Property Name
� Value
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Note – TheData Property Name column contains the name of the property for the data item in
the following format:module/object/property.

� ToCreate a ScalarDataview
The following example uses the CPUUtilization table.

In the Details window, navigate to the CPU Utilization table.

Select a data cell in the table.

Copy the data cell to the dataview clipboard in either of the following ways:

� From theOptionsmenu, choose Copy to Dataview Clipboard Cell(s) or Create Dataview Cell(s).
� In the Details window, press mouse button 3 on the table and select Copy to Dataview Clipboard

Cell(s) from the pop-upmenu.

For additional information about the Copy to Dataview Clipboard and the Create Dataview options,
see “Creating a Dataview” on page 210.

VectorDataviews
The vector dataview contains one ormore rows from a vectormodule table. You can simultaneously
select one row ormultiple rows from a vector table. You can select multiple rows that are not
contiguous. For example, you could select the following rows:

� Row number 1
� Row number 3
� Row number 4
� Row number 6

You cannot select partial rows.

Caution – Do not paste rows from vector and scalar tables into the same dataviewwindow.

� ToCreate aVectorDataview
The following example uses the CPUUtilization table.

In the Browser Details window, navigate to the CPU Utilization table.

Select a row in the table.
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Tip – To selectmultiple rows in the table, use the Shift key. To select multiple, non-continuous rows
from the table, use the Control key.

To copy the data rows to the dataview clipboard, proceed with one of the following:

� From theOptionsmenu, choose Copy to Dataview Clipboard Row(s) or Create Dataview
Row(s).

� In the Details window, press mouse button 3 on the table and select Copy to Dataview Clipboard
Row(s).

For additional information about the Copy to Dataview Clipboard and the Create Dataview options,
see “Creating a Dataview” on page 210.

Caution – You can only paste compatible data types. If you try to paste an incompatible data type, an
error dialog box appears.
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ManagingObjects Using theWebConsole

The SunManagement Center web console providesmany of the same host management functions as
the SunManagement Center Java Console provides. You can use the web console tomonitor and
manage alarms andmodules. You can also use the web console to navigate themanaged object
topology. This chapter covers the following topics:

� “Web Console Features and Functions” on page 217
� “Overview ofMainWeb Console Page” on page 218
� “To Start the SunManagement CenterWeb Console” on page 220
� “ToViewDetailed InformationAbout a Host” on page 221
� “To Load aModule” on page 222
� “ToView a Specific Log File” on page 223
� “Host Details Browser Page” on page 223
� “Attribute Editor in theWeb Console” on page 225

WebConsole Features andFunctions
The SunManagement Center web console is a web-basedmanagement interface for the Sun
Management Center platform. This host management system uses the secure HTTPS protocol to
provide easy access to SunManagement Centermanagement information. You can access the web
console across the firewall tomonitor andmanage SunManagement Center information from any
location. You can use widely available browsers, such asMozillaTM1.4 or higher, Netscape
NavigatorTM 4.5.1 or higher, and Internet Explorer 5.0 or higher.

The web console is an optional SunManagement Center component. The web console depends on
the SunManagement Center server for retrieving andmanipulatingmanaged objects. For
information about configuring the web server, see SunManagement Center 3.6.1 Installation and
Configuration Guide.

The following table identifies the functions that the web console provides and relates the functions to
the Java Console.
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TABLE 15–1WebConsole Functions

Function Web Console Information Related Java Console Information

View the objects in the database “Overview ofMainWeb
Console Page” on page 218

Chapter 5

View details about a specificmanaged object “Host Details Browser Page”
on page 223

Chapter 6

Viewmore information about a specific
managed object

“Info Tab in theWeb Console”
on page 223

“Info Tab” on page 96

Browse information aboutmodules for a
managed object

“Browser Tab in theWeb
Console” on page 224

“Module Browser Tab”
on page 97 and Chapter 7

View system logs “Log Tab in theWeb Console”
on page 225

“View Logs Tab” on page 98

Define and respond to alarm conditions Chapter 16 Chapter 12

View andmodify data property attributes Chapter 17 Chapter 10

Load, unload, enable, or disable modules “Modules Tab in theWeb
Console” on page 224

Chapter 11

OverviewofMainWebConsole Page
Themain web console page provides similar features to themain Java Console window. The left side
of the page provides the hierarchy (tree) view for the current administrative domain. The right side
of the page provides additional details about the item that is selected in the tree view.

From themain console page, you can perform the following tasks:

� Select another administrative domain tomonitor ormanage by choosing a domain from the
Domain pop-upmenu.

� View a summary of current alarms in the Status Summary section of the page.
� Expand the hierarchy to view additional levels of information within the current domain. For

more information, see “ToView and Expand the TopologyHierarchy” on page 221.
� Access detailed information about the currently selectedmanaged object. Formore information,

see “ToViewDetailed InformationAbout a Host” on page 221.
� Set options for automatically updating the contents of themain page by choosing from theAuto

Refresh pop-upmenu.
� Manually update the contents of themain console page by clicking the Refresh button.
� Exit from the web console by clicking the Logout button.
� View online information about the web console by clicking the Help button.
� Define and access alarms for a specificmanaged object. Formore information, see Chapter 16.

Overview ofMainWebConsole Page
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� View and edit attributes for a specific data property. Formore information, see Chapter 17.

By default, the object hierarchy tree for the Default Domain is displayed. Each tree node represents a
managed object in the topology.All tree nodes are displayed with their associated icons, such as a
topology type icon, an alarm icon, or an expansion icon for a group object.A triangle next to a node
indicates that themanaged object contains additional child objects. To view those child objects, click
the triangle.

If any alarms apply to the domain, a status icon for the domain alarm state is displayed next to the
domain icon.A timestamp display above the domain name shows when the current page was loaded
from the server.

When you select a host object in the hierarchy view, information about that object appears in the
right side of the page. The right side of the page displays general information about the selected host,
including the state of themachine and a timestamp. To view additional information about the host
object, click the Go to Details link. TheHost Details page provides additional object andmodule
monitoring information andmanagement capabilities. Formore information, see “Host Details
Browser Page” on page 223.

The following table lists the buttons on themain console andHost Details pages and describes their
functions.

TABLE 15–2 Buttons on theMainConsole andHost DetailsWindows

Button Function

Auto Refresh Disables and enables the auto refresh feature. TheAuto Refreshmenu contains the
following choices:
� Disable
� 1Minute
� 2Minutes
� 3Minutes
� 5Minutes
� 10Minutes

The display refreshes according to the item that is selected. These options can be
configured on the server through a configuration file.

Refresh Refreshes the page display immediately.

Main Page Redisplays themain console page.

Logout Close the SunManagement Center application.After logging out, the Login page
reappears.

Help Displays the online help for this panel in another browser window.

Overview ofMainWebConsole Page
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Status Summary
The status summary displays the number of managed objects that have unacknowledged open alarms,
by level of severity, in the selected administrative domain.

If a host hasmultiple alarms at several different severity levels, the host is represented at only the
highest severity level for that host.

Formore information about he status summary, see “ToViewAlarms From theMain Console
Window” on page 176.

Using theWebConsole
This section provides information aboutmain console tasks. Detailed procedures for working with
alarms and data properties are in Chapter 16 and Chapter 17.

Note – SunManagement Center 3.6.1 uses PAMbased authentication.

� ToStart the SunManagement CenterWebConsole
Start your browser.

Note – You do not have to be superuser to run the SunManagement Center from your browser.

Go to the Sun Management Center web server at http://server-name:8080.

The SunManagement Center server and web server are on the same host. By default, the server runs
on port 8080. However, when you achieve secure access, the secure port changes to 8443.

The SunManagement Center Login page appears.

Type a user ID and password, then click the Login button.

This accountmust be listed in the /var/opt/SUNWsymon/cfg/esusers file on the SunManagement
Center server.

After you log in successfully, themain console page appears and displays the Default Domain.

Note – Theweb console pop-upwindows are designed to be viewed using a 12–pixel font. Because the
web console runs in your browser, you can change the font size. However, if you select a very large
font, some pop-up windowsmight be too small to display all contents correctly. You can enlarge the
windows to display them properly.
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Tip – To reload the page and all frames, click the browser Reload button.

� ToViewandExpand the TopologyHierarchy
The topology view for the web console appears along the left side of themain console page.

If necessary, select a domain from the Domain menu.

When you first open the web console page, the Default Domain displays.

To expand information about a managed object, click the right-facing triangle next to the managed
object.

The topology view expands to show any children of themanaged object and the triangle changes to
an upside-down triangle.

When the topology is fully expanded, you see a list of managed objects for which you can view
detailed information. Formore information, see “ToViewDetailed InformationAbout a Host”
on page 221.

To collapse information about a managed object, click the upside-down triangle next to the
managed object.

The topology view collapses and the triangle changes to a right-facing triangle.

� ToViewDetailed InformationAbout aHost
If necessary, select a domain from the Domain menu.

When you first open the web console page, the Default Domain displays.

If necessary, expand the hierarchy until you see the object that you want.

Tip –Click the triangle to show an object’s child nodes.

Click the name of the host for which you want to see more information.

The right side of the page displays the general information and the system status for the selected
managed object.

Click the Go to Details link.

By default, the Host Details page replaces theMain Console page.
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Tip – Many browsers enable you to open a link in a newwindow, instead of replacing the current page.
For example, in Netscape Navigator, press mouse button 3 on a link. Then, choose “Open Link in
NewWindow” from the pop-upmenu.

For amanaged object on which a SunManagement Center agent is installed, the default Details view
is themodule Browser view. In addition, the following links display at the top of the page: Info,
Browser (disabled when currently shown),Alarms,Modules, and View Log. For othermanaged
objects, the default Details view is the Info view. These tabs have the same basic functions as the
Details window for the Java Console, which is described in Chapter 6.

� ToViewAdditionalHost Properties
Click the Info link at the top of the Host Details page.

The Info page displays general information about the object, such as IP address and operating
system. The Info page provides the same information as the Details Info window for the Java
Console, which is described in “Info Tab” on page 96.

� ToViewAlarms for aHost
Click the Alarms link at the top of the Host Details page.

TheHost DetailsAlarms page is similar to the Java Console functionality that is described in
Chapter 12. TheAlarms page enables you to perform the following tasks that are described in
Chapter 16:

� View current alarms for the selected host
� Acknowledge open alarms for the current host
� Define or run an action for an alarm
� Delete a specific alarm or all closed alarms
� Add a note or a suggested fix to an alarm
� View additional alarm information for an alarm

� To LoadaModule
On the Host Details page, click the Modules link.

TheModules page appears. From this page, you can do the following tasks:

� Load a newmodule.
� Enable a loaded, but not enabled, module.
� Disable a currently enabledmodule.
� Unload amodule.

◗

◗
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To load a module, click the appropriate Load link in the Action column of the Modules Available for
Loading table.

TheModule Loader dialog box appears.

Click OK to load the selected module.

� ToViewaSpecific Log File
The SunManagement Center product maintains several types of log files.

On the Host Details page, click Log.

The Log page appears. By default, the System Log is displayed.

To view another log file, choose a log file to view from the Log File Type pop-up menu.

The Log page updates with the selected log file.

To limit the information displayed from the selected log file, click Filter.

The Filter dialog box appears. Use the following criteria to limit information:

� Specific dates and times
� Specific text
� Sequence in which the log file displays
� Number of entries to display

HostDetails Browser Page
For anymanaged object on which the SunManagement Center agent is installed, you can view the
information described in the following sections:

� “Info Tab in theWeb Console” on page 223
� “Browser Tab in theWeb Console” on page 224
� “Alarms Tab in theWeb Console” on page 224
� “Modules Tab in theWeb Console” on page 224
� “Log Tab in theWeb Console” on page 225

Formanaged objects that do not have the agent installed, the only choice is the Info tab.

Info Tab in theWebConsole
The Info page displays general information about the object, such as IP address and operating
system. This page provides the same information as the Details Info window for the Java Console,
which is described in “Info Tab” on page 96.
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Browser Tab in theWebConsole
The Browser tab enables you to browse information about themodules that are loaded for the
currentmanaged object. This information is similar to theModule Browser window, which is
described in Chapter 7.

This page hasAuto Refresh, Refresh,Main Page, Logout andHelp buttons, which are described in
Table 15–2.

Alarms Tab in theWebConsole
TheAlarmManager for the web console is similar to theAlarmManager that is described in
Chapter 12.

TheHost DetailsAlarms page enables you to perform the following tasks:

� View current alarms for the selected host
� Acknowledge open alarms for the current host
� Define or run an action for an alarm
� Delete a specific alarm or all closed alarms
� Add a note or a suggested fix to an alarm
� View additional alarm information for an alarm

For details about performing these tasks, see Chapter 16.

Modules Tab in theWebConsole
TheModules page displays all available modules and their status. The followingmodule status values
can appear:

� Loaded
� Unloaded
� Enabled, only applies if Loaded
� Disabled, only applies if Loaded

Note – Only authorized users can performmodule actions. Youmust have the appropriate security
permission to load, unload, enable, or disable amodule. Formore information, see Chapter 18.

TheHost DetailsModules page is similar to theModuleManager window that is described in
“WorkingWithModules” on page 161. In some cases, you can edit information on theHost Details
Modules page.

This page also hasAuto Refresh, Refresh,Main Page, Logout andHelp buttons, which are described
in Table 15–2.
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LogTab in theWebConsole
The Log page displays system log information. The Log page contains the following features:

� Log File Typemenu that enables you to choose the log to view
� Text area that displays the content of the selected log file
� FilteredMessages button that enables you to filter themessages in the text area by criteria such as

starting and ending date and time

The Log page is similar to the View Logs window for the Java Console, which is described in
“Viewing Log Files” on page 110.

Attribute Editor in theWebConsole
Themodule data properties provide additional information about themodules. TheAttribute Editor
enables you to view additional information about the data properties and to customize the following
monitoring activities:

� Set alarm thresholds for simple alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the page
� Define schedules for creating log files of historical data points

TheAttribute Editor contains some or all of the following tabs: Info,Alarms,Actions, Refresh, and
History. Formore information about working with theAttribute Editor in the web console, see
Chapter 17.

Note – Some of themore advanced features of theAttribute Editor in the Java Console are not
provided by theAttribute Editor in the web console.

Attribute Editor in theWebConsole
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ManagingAlarmsUsing theWebConsole

You use the web console tomanage alarms inmuch the same way as you use the Java Console, which
is described in Chapter 12. However, some functions are different. Some advanced functions, such as
alarm sorting, are not available in the web console. This chapter describes the functional differences,
and provides additional instructions for using the web console tomanage alarms.

This chapter covers the following topics:

� “AlarmConcepts for theWeb Console” on page 227
� “ToView a Summary ofAlarms” on page 229
� “ToViewAlarms for a SelectedHost” on page 229
� “ToDisplay a Subset ofAlarms for a Host” on page 230
� “To SeeWhen anAlarm Ended orWasAcknowledged” on page 230
� “To Create anAlarmCondition” on page 231
� “ToAcknowledge OpenAlarms” on page 232
� “ToAdd aNote to anAlarm” on page 232
� “ToView or Provide a Recommended Response to anAlarm” on page 232
� “ToDeleteAlarms” on page 233

AlarmConcepts for theWebConsole
This section describes the web console status summary panel, alarm categories, and alarm table
navigation.

Status SummaryPanel
The Status Summary panel displays the number of managed objects in the selected domain that have
at least one unacknowledged open alarm of a specific severity. This panel is similar to the Domain
Status Summary that is described in Chapter 12. However, the web console icons are not buttons.
You cannot click these icons to display the Domain Status page.
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FIGURE 16–1 MainWebConsole with Status Summary Panel

AlarmCategories in theWebConsole
TheHost DetailAlarms page presents a table of different categories of detailed alarm information.
Except for the first column, the categories and information are the same as the categories that are
described in “AlarmCategories” on page 175.

The first column in theHost DetailsAlarms page enables you to select the alarm row. You can select
multiple alarm rows by holding down the Control key and clicking in this column.Acheckmark
indicates that the column is selected.

Some alarm information is always displayed in the alarms table.Additional information is displayed
on the bottom of the page when an alarm row is selected. This information is only displayed for
closed or acknowledged alarms.

AlarmConcepts for theWebConsole
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Alarms TableNavigation
Almost all alarm actions on theHost DetailsAlarms page function the same as the actions on the
AlarmsDetails page described in Chapter 12. However, you cannot sort the alarms table by
double-clicking on the column headers.Aconfirmation request is displayed when you delete an
alarm.

NotifyingUsersWhenaHost orAgent IsDown
You can configure the SunManagement Center software to send an email notification if a host or
agent is down. However, to define this notification, youmust use the Java Console rather than the
web console. Formore information, see “ToNotify UsersWhen aHost orAgent Is Down” on page
183.

ViewingAlarm Information in theWebConsole
Alarms information is displayed in the alarms table on theHost DetailsAlarms page. For additional
details, see Chapter 12.

� ToViewaSummaryofAlarms
To see a summary of alarms in another domain, choose a domain from the Domainmenu.

Open the main console page.

The Status Summary section shows the number of alarms for the current domain. For each severity
level, the summary indicates howmany unacknowledged open alarms exist.

Note – If a host hasmultiple alarms at several different severity levels, the host is represented at the
highest severity level for that host.

Formore information about the status summary, see “ToViewAlarms From theMain Console
Window” on page 176.

� ToViewAlarms for a SelectedHost
Click a host icon in the main console page.

The host description and status are displayed in the right side of themain console page.

Click the Go to Details link.

TheHost Details Browser page appears.

◗
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Click the Alarms link.

TheHost DetailsAlarms page appears. From this page, you can do the following tasks:

� See all current alarms for the selected host, or view a subset of alarms, as explained in “ToDisplay
a Subset ofAlarms for a Host” on page 230.

� Acknowledge open alarms for the current host, as described in “ToAcknowledge OpenAlarms”
on page 232.

� Delete a specific alarm or all closed alarms, as described in “ToDeleteAlarms” on page 233.
� Add a note or a suggested fix to an alarm, as illustrated in “ToAdd aNote to anAlarm” on page

232 and “ToView or Provide a Recommended Response to anAlarm” on page 232.
� View additional alarm information for an alarm, as explained in “To SeeWhen anAlarm Ended

orWasAcknowledged” on page 230.

� ToDisplay a Subset ofAlarms for aHost
From the Host Details Alarms page, choose View Alarms from the Options menu, and click the Go
button.

The View SpecificAlarms dialog box appears. By default, all open alarms are selected.

Click the boxes next to the items to select or deselect the items.

Acheckmark is displayed in each box that you select.

Click OK to accept your changes and close the dialog box.

The alarms table is filtered. The table is redisplayed to reflect your selections.

� ToSeeWhenanAlarmEndedorWasAcknowledged
From the Host Details Alarms page, click the first column of the alarm that you want to view.

Acheckmark is displayed in the first column.

Note – You can view additional information only for one alarm at a time.

Choose Additional Alarm Information from the Options menu, and click the Go button.

TheAdditionalAlarm Information section at the bottom of the page updates with appropriate
information, if applicable.

� If the alarm has been acknowledged, theAlarmAcknowledged field indicates who acknowledged
the alarm. This field also tells you when the alarmwas acknowledged.

� If the alarm has ended, theAlarm Ended field indicates when the alarm ended.
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Creating andResponding toAlarms
This section illustrates how to work with simple alarms in the web console. To work withmore
complex alarm conditions, use the Java Console functions described in Chapter 12.

� ToCreate anAlarmCondition
The following example procedure shows how to create a simple alarm. This example creates an alarm
condition when the system load over the past fiveminutes exceeds a specified value.

Select a data property table from the Host Details Browser page.

For this example, select the System Load Statistics table in the Kernel Reader (Simple) module.

Choose a specific data property in the data property table.

For this example, select the value for the LoadAverage Over Last 5Minutes property.

TheAttribute Editor appears for the selected data property.

Click on the Alarms tab in the Attribute Editor window.

TheAlarms page appears.

In the Critical Threshold (>) field, type an appropriate value.

For this example, type .050. This value is probably lower than what you would normally use, but will
most likely generate an alarm to illustrate the process.

Click OK to apply your changes and close the Alarms tab page.

In a fewmoments, the LoadAverage Over the Last 5Minutes data field in the System Load Statistics
data properties table turns red. In addition, red alarm icons appear on the following folders and
icons, unless your system has an open, unacknowledged black (down) alarm:

� Operating System
� Kernel Reader
� System Load Statistics

Click Reset to reset theAttribute Editor to the default parameters.

Click the Host Details Alarms tab.

The alarm that you created is reflected in the alarms table when the table is refreshed.

Acknowledge this alarm.
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Create additional alarm thresholds. Then, familiarize yourself with their operation.
Once you have created these alarms, you can set up security permissions so that another Sun
Management Center software user cannot change your alarm thresholds. Formore information
about security, see Chapter 18.

Tip – You do not need to fill in alarm information for all alarm thresholds. For example, you can
choose to create only a critical alarm threshold.

� ToAcknowledgeOpenAlarms
Open the Host Details Alarms page for the managed object.

Select the alarm that you want to acknowledge.

Click the Acknowledge button.

� ToAddaNote to anAlarm
Alarm notes contain an expanding list of notes for a specific alarm. You can add notes over the life of
the alarm to track its history.

Open the Host Details Alarms page for the managed object.

Select the alarm to which you want to add the note.

Choose Add Note from the Options menu, and click the Go button.
TheAddNote window appears.

Type text in the note.

Click OK to close the Add Note window.
The note that you entered displays

� ToViewor Provide aRecommendedResponse to an
Alarm
The Suggested Fix feature enables you to provide a recommended correction to an alarm condition.

Open the Host Details Alarms page for the managed object.

Select the appropriate alarm.
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Choose Suggested Fix from the Options menu, and click the Go button.

The Suggested Fix window appears.Any default software-provided information appears in the
Suggested Fix section of the window.Any existing user-provided information appears in the User
Suggested Fix section of the window.

Type your recommendation for responding to the alarm condition in the User Suggested Fix section
of the window.

To close the Suggested Fix window, click OK.

� ToDeleteAlarms
To conserve space and to keep the database current, you should delete alarms after the alarms have
been closed.Aclosed alarmmeans that the condition no longer exists.

Open the Host Details Alarms page for the managed object.

Select the alarm that you want to delete.

Choose Delete Alarms from the Options menu, and click the Go button.

Tip – To delete all closed alarms, choose DeleteAll ClosedAlarms from theOptionsmenu, and click
the Go button.
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ManagingData PropertyAttributes Using the
WebConsole

This chapter explains the following topics:

� “Overview ofModule Data Properties” on page 235
� “ToAccess Specify Data PropertyAttributes” on page 239
� “ToDefine anAlarmCondition” on page 240
� “ToDefine a Response for anAlarm” on page 241
� “ToDefine andUse anAlarmAction Script” on page 242
� “ToModifyAlarmActions” on page 243
� “To Specify HowOften the Data Display Updates” on page 239
� “To ChangeHowOftenHistory Data is Collected” on page 240

OverviewofModuleDataProperties
Themodule data properties provide additional information about themodules. TheAttribute Editor
in the web console provides the same capabilities as theAttribute Editor in the Java Console, which is
described in Chapter 10. You can use theAttribute Editor to customize themonitoring criteria for
themodule data properties. Specifically, theAttribute Editor enables you to perform the following
tasks:

� Set alarm thresholds for defined alarms
� Specify actions to take when alarm conditions occur
� Change the interval at which data updates on the screen
� Define schedules for creating log files of historical data points

TheAttribute Editor in the web console has one ormore tabs at the top of the page that enable you to
switch between different panels. These tabs differ depending on the selected object. The possible tabs
are described in the following sections:

� “Info Tab in theWeb ConsoleAttribute Editor” on page 236
� “Alarms Tab in theWeb ConsoleAttribute Editor” on page 236
� “Actions Tab in theWeb ConsoleAttribute Editor” on page 237
� “Refresh Tab in theWeb ConsoleAttribute Editor” on page 238
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� “History Tab in theWeb ConsoleAttribute Editor” on page 238

Note – EachAttribute Editor displays one ormore of these tabs, depending on the specific object to
which an instance of theAttribute Editor applies.

Info Tab in theWebConsoleAttribute Editor
TheAttribute Editor Info page provides additional information about the selected object, such as:

� Module name, version, and description for the selectedmodule
� Host name for the host on which themodule resides
� Other information about the specificmodule, such as folder and variable in which data property

information is stored

Alarms Tab in theWebConsoleAttribute Editor
TheAlarms tab enables you to set alarm thresholds only for those data properties that have
associated simple alarms. These simple alarms use the rCompare rule, which is described in
Appendix D. TheAttribute EditorAlarms page enables you to set alarm thresholds for simple alarms
only.

Note – To set an alarm threshold, youmust have the appropriate security permission. Formore
information, see Chapter 18.

The alarmmanagement software offers you the following flexibility in setting your alarms:

� Determine the thresholds that trigger an alarm of a particular severity
� Determine when alarms are sounded, for example, only on weekdays

Simple alarms are based on thresholds.Amonitored data property is greater than, less than, not
equal to, or equal to a single threshold value. By contrast, complex alarms are based on a set of
conditions. Formore information about alarm rules, see Appendix D.

The following table lists common simple alarm limits formonitored properties. The alarm limits are
also displayed in the Parameter Description field. You can set thresholds for one ormore of these
alarm limits for selected data properties.

Overview ofModule Data Properties
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TABLE 17–1 Common SimpleAlarmLimits in SunManagement Center Software

Alarm Limit Description

Critical Threshold (>) Critical (red) alarm occurs if the value exceeds the limit that is
entered in this field.

Alert Threshold (>) Alert (yellow) alarm occurs if the value exceeds the limit that is
entered in this field.

Caution Threshold (>) Caution (blue) alarm occurs if the value exceeds the limit that is
entered in this field.

Critical Threshold (<) Critical (red) alarm occurs if value is below the limit entered in
this field.

Alert Threshold (<) Alert (yellow) alarm occurs if value is below the limit entered in
this field.

Caution Threshold (<) Caution (blue) alarm occurs if value is below the limit entered in
this field.

AlarmWindow Alarm occurs only during a specified time period. For example, if
the value is day_of_week=fri, an alarm occurs only if the alarm
condition exists on a Friday. If an alarm condition exists on
Tuesday, no alarm is triggered.

Actions Tab in theWebConsoleAttribute Editor
TheAttribute EditorActions page enables you to instruct the software to perform a predetermined
action if an alarm occurs.

Note – Acceptable actions include scripts that are stored in the /var/opt/SUNWsymon/bin directory.
These scripts execute with root permissions.

For example, you can provide the name of a script in the critical action field. This script might send
an email to a system administrator whenever a critical alarm is generated for the LoadAverage Over
the Last 5Minutes data property.

You can set separate actions for different alarm conditions. You can also define a single action to
occur when any change happens to any of the alarm conditions. To define actions, you use theAction
buttons on theActions page.

Note – The check boxes that are to the right of theAction buttons enable you to specify automatic or
manual execution of a specific alarm action. By default, all actions are set formanual execution. Only
manual actions can bemodified.

Use theAlarmActionModification dialog box tomodify the registered alarm actions. Two buttons
in the dialog box (Email andGeneric) allow you to choose one of two options for an alarm action.
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Email Enables you to specify an address, subject, andmessage to be sent as email

Generic Enables you to select generic shell scripts that are installed on themanaged node

Refresh Tab in theWebConsoleAttribute Editor
Use the Refresh page in theAttribute Editor to set the refresh interval for this object. The refresh
interval is the interval between the times when the SunManagement Center agent samples the
monitored property. Formore information, see “To Specify HowOften the Data Display Updates”
on page 239.

History Tab in theWebConsoleAttribute Editor
Use theHistory page in theAttribute Editor to save older data for amonitored property. For
example, youmight choose to record a history of data points every 120 seconds as identified in the
sample interval. You can also specify whether to store this information in a disk file or in thememory
cache.

The two types of disk files are circular, which has amaximum of 1000 lines, and text. These files are
located in the /var/opt/SUNWsymon/log directory in the file that is specified in the Text File Name
field.

Acircular disk file is automatically saved under the name history.log. If you do not choose a file
name for your text file, data are automatically saved under the name agent_default.history.

If you select memory cache, youmust indicate in theMax Size (sample) field the number of data
points to save. For example, if you set this field to 1000, only themost current 1000 data points are
stored in thememory cache.Any older data points are discarded. These data points can be graphed.
See Chapter 9 formore information.

Note – You can view history data in a graph by opening the graph for the specificmonitored property.
If you have selectedmemory cache, the graph is displayed with historical data.

Using theAttribute Editor in theWebConsole
The procedures in this section explain how to view specific attributes, change the refresh interval,
andmodify history information in the web console attribute editor.
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� ToAccess SpecifyData PropertyAttributes
Navigate through the hierarchy to a data property table.

For example, to view information about thememory on a host, follow these steps:

a. Select a managed object in the main console page.

b. Click the Go to Details link.

TheHost Details page appears.

c. In the Host Details page, click the expansion icon to the left of Operating System.

d. Click the expansion icon to the left of Kernel Reader (Simple).

e. Click Memory Usage Statistics.

The data property table forMemory Usage Statistics appears.

Select the value in the data property table whose attributes you want to view or modify.

TheAttribute Editor appears in a separate window.

� ToSpecifyHowOften theDataDisplayUpdates
The following example shows how to set a refresh interval in the System Load Statistics module.

Select a data property, for example, System Load Statistics, on the Host Details Browser page.

Select the Value column for Load Averages Over the Last Five Minutes.

TheAttribute Editor Info page is displayed.

Click the Refresh tab.

The Refresh page is displayed.

Type a value in seconds in the Refresh Interval field.

For example, if you type 300, the page updates every fiveminutes.

To change the refresh interval and exit from the Attribute Editor, click the OK button.

When the properties table for System Load Statistics is displayed, the values in the table are refreshed
every fiveminutes.

Tip – The agent uses less CPU cycles if you use a larger refresh interval.
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� ToChangeHowOftenHistoryData is Collected
The Sample Interval on theHistory page controls how frequently history data is captured.

Select a data property, for example, System Load Statistics, on the Host Details Browser page.

Select the Value column for a specific property, for example, Load Averages Over the Last Five
Minutes.

TheAttribute Editor Info page is displayed.

Click the History tab.

TheHistory page is displayed.

Type a value in seconds in the Sample Interval field.

For example, to collect a history data point every twominutes, you would type 120 in the Sample
Interval field.

Click the OK button to set the history interval and exit from the History page.

WorkingWithAlarms in theWebConsoleAttribute Editor
The procedures in this section explain how to create and respond to alarms using the web console
attribute editor.

� ToDefineanAlarmCondition
The following example procedure shows how to create a simple alarm. This example creates an alarm
threshold in the Kernel Readermodule.

Select a data property, for example, System Load Statistics, from the Host Details Browser page.

Click the Alarms tab.

TheAlarms page is displayed.

In the Critical Threshold (>) field, type a value that is less than the current value.

Providing this value creates a critical alarm.
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Click OK to apply your changes and close the Alarms page.

In a fewmoments, the LoadAverage Over the Last OneMinute data field in the data properties table
for System Load Statistics turns red. In addition, red alarm icons are displayed on the following
folders and icons unless your system has an open, unacknowledged severity one black alarm:

� Operating System
� Kernel Reader
� System Load Statistics

Click the Host Details Alarms tab.

The alarm that you created is reflected in the alarms table when the table is refreshed. Formore
information about this subject, see Chapter 16.

Click the acknowledge button, which looks like a check mark, to acknowledge this alarm.

Create additional alarm thresholds. Then, familiarize yourself with their operation.

Once you have created these alarms, you can set up security permissions so that another Sun
Management Center software user cannot change your alarm thresholds. Formore information
about security, see Chapter 18.

Note – You do not need to fill in alarm information for all alarm thresholds. For example, you can
choose to create only a critical alarm threshold.

� ToDefineaResponse for anAlarm
The following procedure describes how to define an action to take when an alarm occurs.

Select a data property, for example, System Load Statistics, from the Host Details Browser page.

Select an appropriate item in the Value column, for example, the value associated with Load Average
Over Last Five Minutes .

TheAttribute Editor Info page is displayed.

Click the Actions tab.

TheActions page is displayed.

Click the Action button for the alarm level for which you want to define the action.

Awindow appears on which you choose the type of action and provide appropriate information.

� To notify users through an email, click the Email radio button. Type a comma-separated list of
email addresses and amessage.
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� To run a script, click the Other radio button. Choose a script from the list of available scripts.
Then, supply appropriate arguments as needed. See “ToDefine andUse anAlarmAction Script”
on page 242.

� To clear the alarm, click the Clear radio button.

Click OK to apply your changes and close this page.

If you choose to send an email, a message is sent to the specified users whenever the specified alarm
occurs. This messagemight be similar to the followingmessage.
Date: Wed, 30 Jun 1999 15:25:39 -0800

From: root@MachineB (0000-Admin(0000))

Subject: Sun Management Center - Alert Alarm Action

Mime-Version: 1.0

Sun Management Center alarm action notification ...

{Alert: machineB Kernel Reader Load Average Over The Last 5 Minutes > 0.01Jobs}

� ToDefineandUse anAlarmAction Script
The following procedure describes how to customize an alarm action to automatically notify a user
when an alarm condition occurs.

Create the script using the following arguments:

%statusfmt The alarm severity, such asWarning, Critical, and so on.

%statusstringfmt The complete alarm string, including severity. (For example: Critical:
MachineAKernel Reader Number of User Sessions > 10)

At the command-line level, become superuser.
# su -

Install the script in the home Sun Management Center directory.

The default is the /var/opt/SUNWsymon/bin/ directory. For example:
# cp custom-alarm-script /var/opt/SUNWsymon/bin/

Click the Host Details Browser tab.

Set the alarm threshold.

Formore information, see “ToDefine anAlarmCondition” on page 240.

Click the System Load Statistics icon.

The properties table for System Load Statistics is displayed in the contents view of the Host Details
Browser page.
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Select the Value column for Load Average Over Last Five Minutes.

TheAttribute Editor Info page is displayed.

Click the Attribute Editor Actions tab.

TheActions page appears.

Click the Action button for the Critical Actions field.

TheAlarmActionModification dialog box appears.

Click the Other button.

Select custom-alarm-script from the Available Scripts menu.

Type the following string in the Arguments field:

%statusstringfmt

Click OK to apply your changes and close this page.

The script file name is displayed in the CriticalAction field on theActions page.

� ToModifyAlarmActions
Click the Action button for the alarm action that you want to modify.

TheAlarmActionsmodification dialog box is displayed.

Select the type of alarm action that you want to modify (Email or Other).

Make your changes in the fields of the selected action.

Click OK to accept the changes and close the page.

The change is displayed in the correspondingAction field of theActions page.
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SunManagement Center Security

This chapter discusses security features, users and groups, and their privileges. The chapter describes
the following topics:

� “SunManagement Center Security Concepts” on page 245
� “Access Control Categories” on page 246
� “Default Privileges” on page 249
� “Access Control Definitions and Limitations” on page 250
� “ToAdd SunManagement Center Users” on page 252
� “To ControlAccess to aModule” on page 253
� “ToAdd aUser-DefinedGroup to anACL” on page 254
� “ToGrant a User esadm, esops, or esdomadm Privileges” on page 254
� “ToDelete SunManagement Center Users” on page 255
� “ToOverride DefaultAgent Privileges” on page 255
� “SNMPEncryption (Privacy)” on page 255
� “SNMPCommunication” on page 258
� “SNMPv3” on page 259

SunManagement Center Security Concepts
Security in SunManagement Center software is based on JavaTM security classes and SNMPv2usec
(SNMPversion 2, user-based securitymodel) security standards.

The software offers the following layers of security:

� Only valid SunManagement Center users can operate the software.
� The software enables you to set security permissions or access control list (ACL) categories. The

security features provide control at the administrative domain, group, host, andmodule levels.
� The software authenticates users and access control for individual managed properties.
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Access Control Categories
The software offers the followingACLcategories:

� Admin, like the superuser (root) in UNIX
� Operator, as an operator who runs andmonitors the system
� General, like guest access with read-only viewing privileges

To understandACLcategories, you first need to understand SunManagement Center software users
and groups. The following sections explain users and groups.

SunManagement CenterUsers
SunManagement Centerusers are valid UNIX users on the server host.As such, the system
administrator has to add valid users into the file /var/opt/SUNWsymon/cfg/esusers. If a user’s
name is not in this file, that user cannot log into the SunManagement Center software.

General Users
The administrator has to add the list of user IDs for all users who need to log into SunManagement
Center software.All users in this file have general access privileges, by default, unless the users are
given additional privileges using the procedures described in “ToGrant a User esadm, esops, or
esdomadm Privileges” on page 254.

Any user who is part of the esusers file is known as a general user. SunManagement Center general
users can, by default, perform the following functions:

� Log into the software
� View the administrative domains, hosts, andmodules that are created
� View events
� Triggermanual refreshes
� Run ad hoc commands
� Graph data

Sun Management Center Superuser
The SunManagement Center superuser automatically belongs to all the groups that are described in
the following sections. The SunManagement Center superuser has administrator privileges as
described in “SunManagement CenterAdministrators or esadm” on page 247.

SunManagement CenterGroups
The following groups are created by default on the server host during the SunManagement Center
server setup:

� esops

� esadm

� esdomadm

SunManagement Center Security Concepts
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In addition, all the SunManagement Center users belong to a hypothetical group, called ANYGROUP.

The listed groupsmust be defined on themachine where the SunManagement Center server layer is
running. These groups do not need to be defined on othermachines. These groups are described in
greater detail in the sections that follow.

Note –The listed groups are defined in the /etc/group file.

Sun Management Center Operators or esops

SunManagement Center software users that belong to the group esops are usually operator users.
These operators run, monitor, and to some extent, configure parameters on themanaged systems.
esops can perform operations, including some operations that are allowed for general users:

� Disable or enablemodules
� Set alarm limits
� Set rule parameters
� Run alarm actions
� Run ad hoc commands
� Set the refresh interval
� Acknowledge, delete, or fix events
� Enable or disable history logging
� Set logging history parameters

Sun Management CenterAdministrators or esadm

Software users that belong to the group esadm can perform administrator operations.Administrator
operations are a superset of the operations that can be performed by operator users as described in
“SunManagement Center Operators or esops” on page 247. In addition to all the operations that
operator users (esops) can perform, these administrator users (esadm) can perform the following
operations:

� Load or unloadmodules
� SetACLusers and groups
� View administrative domains, hosts, or modules

Sun Management Center DomainAdministrators or esdomadm

The users that belong to the group esdomadm can perform the following domain administrator
operations:

� Create administrative domains
� Create groups within administrative domains
� Add objects to groups or administrative domains
� View administrative domains, hosts, or modules

SunManagement Center Security Concepts
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Note – Other than the privileges listed above, a user that belongs to esdomadm is just a general user,
unless configured otherwise.

Administrator, Operator, andGeneral Functions
The following table lists the different types of functions that users can do by default.Amark in a
given cell indicates that the specified user can perform the listed function.

This table applies to all modules. Individual modules can also have specific restrictions, which are
under the control of themodule.

TABLE 18–1 DomainAdmin,Admin,Operator, andGeneral Functions

Function Domain Admin Admin Operator General

Loadmodules x

Unloadmodules x

Create administrative domains x

Create groups within
administrative domains

x

Add objects to groups or
administrative domains

x

View administrative domains,
hosts ormodules

x x x x

SetACLusers or groups x

Disable or enablemodules x x

Set module active time window x x

Set alarm limits x x

Set rule parameters x x

Run alarm actions x x

Run ad hoc commands x x

Set the refresh interval x x

Manually trigger a refresh x x x x

Enable or disable history logging x x

Set logging history parameters x x
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TABLE 18–1 DomainAdmin,Admin, Operator, andGeneral Functions (Continued)
Function Domain Admin Admin Operator General

Acknowledge, delete, or fix events x x

View events x x x x

In SunManagement Center software, the above categories maintain inclusive relationships. This
means that a user who has esadm privileges can do anything that a user who has esops privileges can
do.An administrator can change the default permissions so that a user who has esops privileges can
domore than a esadm user. Inclusive relationshipsmean that there is nothing in the software that
makes one of esops, esadm, or esdomadmmore powerful than either of the others.

Formore information about how to override default privileges, see “ToOverride DefaultAgent
Privileges” on page 255.

Default Privileges
Administrative domains aremanipulated by the Topologymanager. This section describes the
default privileges for the Topologymanager, for other agents, and for othermodules.

Default Privileges for the TopologyManager
The default privileges for Topologymanager, where administrative domains aremaintained, are
listed in the following table.

TABLE 18–2Default Privileges for TopologyManager

Topology Manager Default Privileges

List ofAdminUsers

List of Operator Users

List of General Users

List ofAdmin SNMPCommunities

List of Operator SNMPCommunities

List of General SNMPCommunities public

List ofAdminGroups esdomadm

List of Operator Groups esops

List of General Groups ANYGROUP
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Other SunManagement Center Component andModuleDefault
Privileges
The default privileges for components andmodules not in the Topologymanager are listed in the
following table.

TABLE 18–3 SunManagement Center Component andModuleDefault Privileges

Components and Modules Default Privileges

List ofAdminUsers

List of Operator Users

List of General Users

List ofAdminGroups esadm

List of Operator Groups esops

List of General Groups ANYGROUP

List ofAdmin SNMPCommunities

List of Operator SNMPCommunities

List of General SNMPCommunities public

The keyword ANYGROUP is not a true UNIX group, but is a special keyword that means that any user
who can log into SunManagement Center software is given general access to the objects.

Access Control Definitions and Limitations
The esadm group can specifyACL features for users and groups for the following components:

� Administrative domains
� Groups within administrative domains
� Hosts
� Modules

Admin,Operator, andGeneralAccess
AnACLspecification consists of establishing or defining one ormore of the following parameters:

� Administrator users and administrator groups –A list of users and groups who can perform
administrator operations. By default, these users are esadm or esdomadm, wherever applicable.

� Operator users and operator groups –A list of users and groups who can perform operator
operations. By default, these users are esops.
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� General users and general groups –A list of users and groups who can perform general
operations. By default, this category is a hypothetical group that is called ANYGROUP.

� Communities for administrators (SNMP) –Alist of SNMP communities that can perform
administrator operations that use SNMP.

� Communities for operators (SNMP) –Alist of SNMP communities that can perform operator
operations that use SNMP.

� Communities for general (SNMP) –Alist of SNMP communities that can perform general
operations that use SNMP.

SunManagement Center Remote ServerAccess
Users can access and view data from sessions that are running on remote SunManagement Center
servers.When a user tries to gain access to such information, that user is provided access as a general
user with read-only privileges. The behavior of SunManagement Center sessions that are running on
different servers is defined in terms of each session’s server context. See “SunManagement Center
Server Context and Security” on page 251 formore information.

As a user, you can access and set up a different server context for a variety of reasons:

� To enable each server context to have different users and different administrators, and yet remain
accessible to each other

� To allow for physical separation between elements, as in the context of a wide area network
(WAN)

� To increase performance by enablingmany hosts to be handled by one set of central components

By linking to a different server context, you can view the top level status of the objects in the other
server context.

SunManagement Center Server Context andSecurity
Aserver context is a collection of SunManagement Center agents and the particular server layer to
which the agents are connected. The agents and hosts within a server context share a single set of the
following central components:

� SunManagement Center server
� Topologymanager
� Eventmanager
� Trap handler
� Configurationmanager

Every SunManagement Center component or agent is configured at installation to know the
location of its trap handlers and eventmanagers. SunManagement Center software identifies the
trap handlers and the eventmanagers by their IP and port addresses. To determine whether you are
within your server context, you need to know the respective IP and port addresses of the servers that
you access. Different server contexts have different port numbers.

Access Control Definitions and Limitations
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Aremote server context refers to a collection of remote agents and a particular server layer with
which the remote agents are associated.

An agent receives security configuration from the server layer. This information enables the agent to
authenticate themanagement request that is sent to the agent. Then, the agent can perform access
control on the requested operation as part of themanagement request.

LimitationsWhenCrossing Servers
Some security restrictions apply when a user tries to communicate across server contexts.

In the current SunManagement Center environment, you can access information from another
server with a few limitations:

� If you try to access a remote server context, the server give you general user access. Thus, you can
access data but cannotmodify or use the objects within the different server. You are restricted to
viewing only the remote server objects.

� You can view data in another context as a general user, but you cannot perform control actions,
such as setting alarm thresholds and other similar functions.

� Edit functions work differently in a remote server. For example, you can copy and paste between
contexts. You cannot cut and paste between contexts.

Note – In the console, the fact that you are accessing a different server contextmight not be obvious.
To identify whether you are accessing a different server, check the server’s IP port number or address
in the Info tab of the Details window.

UsingAccess Control
The following sections describe how to perform the following key access control functions:

� “ToAdd SunManagement Center Users” on page 252
� “To ControlAccess to aModule” on page 253
� “ToAdd aUser-DefinedGroup to anACL” on page 254
� “ToGrant a User esadm, esops, or esdomadm Privileges” on page 254
� “ToDelete SunManagement Center Users” on page 255
� “ToOverride DefaultAgent Privileges” on page 255

� ToAddSunManagement CenterUsers
Become superuser on the Sun Management Center server host.
% su -

Edit the file /var/opt/SUNWsymon/cfg/esusers.

1
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Add the user name on a new line.

Make sure that the user name is the user name of a valid UNIX user.

Save the file and exit the editor.

Users that are added to the users list have default privileges. See “Default Privileges” on page 249 and
“ToOverride DefaultAgent Privileges” on page 255 formore information.

� ToControlAccess to aModule
Access the Attribute Editor in either of the following ways:

� Press mouse button 3 on the selected object, and chooseAttribute Editor from the pop-upmenu.
� ChooseAttribute Editor from the Tools menu in themain console window.

TheAttribute Editor is displayed. The buttons at the bottom of the window are inactive, with the
exception of the Cancel andHelp buttons. The remaining buttons become active when youmodify
any field in the window.

Select the Security tab in the Attribute Editor window.

Change the values as required.

The following list explains the data in each field and provides sample values.
Administrator Users A list of users. jim is a user who can perform administrator

operations.

Operator Users A list of operators. john and others are users who can perform
operator operations. Note that their entries are separated by
one ormore spaces.

General Users A list of general users. nick and richie are users who can
perform general operations.

Administrator Groups All the users that belong to administrator groups can perform
administrator operations. By default, the users are esadm or
esdomadm, as applicable.

Operator Groups All users that belong to esops can perform operator
operations.

General User Groups ANYGROUP is a hypothetical group that can perform general
operations.All SunManagement Center users belong to this
hypothetical group.

Communities forAdministrators This field is empty, denoting that there is no SNMP
community that can perform administrator operations that
use SNMP.
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Communities for Operators This field is empty, denoting that there is no SNMP
community that can perform operator operations that use
SNMP.

Communities for General Users By default, public is an SNMP community that can perform
general operations that use SNMP.

Use spaces or commas betweenmultiple entries as illustrated in the entries for “Operator” under
“Users.”

Formore information about security privileges, see “Access Control Categories” on page 246.

� ToAddaUser-DefinedGroup to anACL
Become superuser on the Sun Management Center server host.

Use the groupadd command to create a group.
# /usr/sbin/groupadd groupname

Add users to the newly created group.

a. In the /etc/groupfile, add users to the group.

b. Save the file and exit the editor.

Add the new group to the ACL.

See “To ControlAccess to aModule” on page 253 formore information.

� ToGrant aUser esadm, esops, or esdomadmPrivileges
Become superuser on the Sun Management Center server host.

If needed, add the user name to the /var/opt/SUNWsymon/cfg/esusers file.

In the /etc/groupfile, add the user to one of the following lines as applicable: esadm, esops, or
esdomadm.

Save the file and exit the editor.
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� ToDelete SunManagement CenterUsers
Become superuser on the Sun Management Center server host.

In the file /var/opt/SUNWsymon/cfg/esusers, delete the line corresponding to the user name you
want to delete.

Save the file and exit the editor.

Delete the user names from Sun Management Center groups.

Note – After a user is deleted from the list of SunManagement Center users, the user can no longer
log into the SunManagement Center server. Make sure to delete that user from all theACLs.

� ToOverrideDefaultAgent Privileges
In SunManagement Center software, only administrators can override default privileges using the
Attribute Editor tomodify theACL lists for that particular object.

Access the Attribute Editor for the specific managed object on which you need to change the
privileges.

To view and change security information, click the Security tab in the Attribute Editor window.

Change the information as needed.

To apply the security changes and close the Attribute Editor window, click OK.

To leave theAttribute Editor window open and apply the security changes, clickApply.

SNMPEncryption (Privacy)
SunManagement Center supports encryption of SNMP communications between server and agent
components of SunManagement Center. SNMP encryption support uses the CBC-DES symmetric
encryption algorithm.

You can enable SNMP encryption on SunManagement Center servers using the es-config script.
By using this script, you can turn on or off the auto-negotiate feature. For details, see “Enabling
SNMPEncryption” on page 257.
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EncryptiononSolaris 9 or Earlier
For systems running Solaris 9 or earlier, encryption is based on the package SUNWcry.

Note the following conditions for systems that run Solaris 9:

� SNMP encryption on both the SunManagement Center server and agent hosts depends on the
SUNWcry package, which contains the /usr/lib/libcrypt_d.so encryption library. Youmust
install this package separately.

� SNMP encryption is not supported on SunManagement Center 3.5 and earlier servers and
agents even if SUNWcry is installed.

� SNMP encryption support is automatically configured during agent or server setup if the
SUNWcry package is detected.

EncryptiononSolaris 10
For systems running Solaris 10, encryption is based on Public Key Cryptographic Standard
(PKCS#11).

PKCS#11 specifies anAPI, called Cryptoki, to devices which hold cryptographic information and
perform cryptographic functions. Formore information on the RSAdefined PKCS#11, see
http://www.rsasecurity.com/rsalabs.

Note the following conditions for systems that run Solaris 10:

� SNMP encryption on both the SunManagement Center server and agent hosts depends on the
SUNWcsl package, which contains the /usr/lib/libpkcs11.so encryption library. This package
is installed by default.

� SNMP encryption is not supported on SunManagement Center 3.5 and earlier servers and
agents even if SUNWcsl is installed.

� SNMP encryption support is automatically configured during agent or server setup if the
SUNWcsl package is detected.

Encryptionon Linux
For systems running Linux, encryption is based on Public Key Cryptographic Standard (PKCS#11).

SNMP encryption depends on the PKCS11_API.so encryption library. This library is not installed by
default. Youmust provide this library in /usr/lib/pkcs11 and enable the pkcs_slot daemon to
enable encryption.

SNMPEncryption (Privacy)
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Auto-Negotiate Feature
SunManagement Center 3.6.1 servers that support encryption can be set up to support agents
dynamically regardless of whether those agents support encryption. This feature is called
auto-negotiate and can be set to on or off.

When you set the auto-negotiate feature to off, you ensure that the server always uses encryption
when initiating communication with agents. Environments with strict security policies might prefer
this set up. If you set auto-negotiate to off:

� If the agent supports encryption, the agent understands the encrypted SNMPmessages.
� If the agent does not support encryption, the agent does not understand the encryptedmessage.

Thus, a timeout occurs and a consolemessage states, “Agent is not responding.” The timeout is
recorded in the agent log.

When you set the auto-negotiate feature to on, the server encrypts its SNMP communication with an
agent only if the agent supports encryption.As a result, one of the following events occurs:

� If the agent supports encryption, the agent understands the encrypted SNMPmessages.
� If the agent does not support encryption, the SNMPmessages are only authenticated and not

encrypted.

Enabling SNMPEncryption
To find the current state of SNMP encryption, run the es-config commandwith no arguments.

� ToEnable SNMPEncryption for Server Installations

Check whether the package is installed.

� (For systems running Solaris 9 or earlier) Make sure the SUNWcrypackage, which contains the
/usr/lib/libcrypt_d.so encryption library, is installed on the system by typing:
% pkginfo | grep SUNWcry

If the package is installed, the system shows:

application SUNWcry

Note – The SUNWcry package is part of the Solaris Encryption Kit. To obtain the Solaris Encryption
Kit, see your Sun sales representative. For important information about administering secure
systems, see your Solaris system administration documentation.
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� (For systems running Solaris 10) Make sure the SUNWcslpackage, which contains the
/usr/lib/libpkcs11.so encryption library, is installed on the system by typing:
% pkginfo | grep SUNWcsl

If the package is installed, the system shows:

application SUNWcsl

� (For systems running Linux) Make sure you provide the PKCS11_API.so encryption library in
/usr/lib/pkcs11 and enable the pkcs_slotdaemon.

Type the following command as superuser from the server host:
# es-config -r

The system detects the presence of the appropriate package and automatically stops all Sun
Management Center components. The script then asks for the security seed.

Type the security seed.

The script asks for the SNMPv1 community string.

When asked whether you want to initiate encrypted communication, type y to initiate encrypted
communication or n to decline.

When asked whether you want to enable the auto-negotiate feature, type y to enable or n to decline.

For details on the auto-negotiate feature, see “Auto-Negotiate Feature” on page 257.

SNMPCommunication
SunManagement Center agents can communicate with the server using SNMPv1, SNMPv2c, and
SNMPv2usec. These communications are enabled by default. You can disable the SNMPv1 and
SNMPv2c communications by editing the domain-config.x file. However, you cannot disable the
SNMPv2usec communication.

� Disabling SNMPv1Communication
Become superuser on the Sun Management Center agent.

% su -

Open the file /var/opt/SUNWsymon/cfg/domain-config.x.
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Add the following lines to the file.
agent =

{

agentServer = "agentHostName"
snmpPort = "161"

SNMPv1 = off

}

Where agentHostName is the host namewhere the agent is installed.

� Disabling SNMPv2cCommunication
Become superuser on the Sun Management Center agent.

% su -

Open the file /var/opt/SUNWsymon/cfg/domain-config.x.

Add the following lines to the file.
agent =

{

agentServer = "agentHostName"
snmpPort = "161"

SNMPv2c = off

}

Where agentHostName is the host namewhere the agent is installed.

SNMPv3
SNMPv3 is an industry-standard protocol that was introduced to overcome the limitations of
SNMPv2usec. SNMPmessages that are generated by SNMPversion 3, user securitymodel (SNMPv3
usm) aremore structured than themessages generated by SNMPv2usec.

SunManagement Center 3.6.1 software supports SNMPv3. SNMPv3 enables SunManagement
Center agents to communicate with third-partymanagement applications securely.
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Importing and Exporting Topology Information

The topology import and export utilities enable you to import and export the topology database
from or to anASCII file that uses XMLmarkup. The import utility enables you to read data from a
file and update the topology database and the data of the topology agent object. The export utility
reverses this operation.

This chapter explains the following topics:

� “Topology Import and Export Concepts” on page 261
� “Topology Import and ExportArchitecture” on page 262
� “Exporting Topology Information” on page 263
� “Importing Topology Information” on page 264
� “Import and Export CLI Interface” on page 265
� “Import and Export File Contents” on page 270

Topology Import andExport Concepts
The topology import and export utilities are used to do the following tasks:

� Dump the topology data as backup regularly.
� Transfer data between different topology servers.
� Restore the data from backup if the topology data is damaged.
� Convert the data into another file format, and load the data into anothermanagement system in a

third-partymanagement platform.

You can access these functions from the SunManagement Center consolemain window or the CLI.
Youmust specify the complete topology data and the domains to be imported or exported. The tool
supports several methods of data handling, including overwrite and append.

� The import and export utilities support domain level operation. You can specify one domain to
export or the whole topology hierarchy.

� You can recover backup data through the import utility.
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� You can import objects of any domain to one domain.
� You can back up existing data through the export utility.
� You can export data in incremental mode.
� You can export topology information from themain console window only when the current

topology hierarchy contains data.

Topology Import andExportArchitecture
The topology import and export utilities communicate with the SunManagement Center server
through clientAPIs. The import and exportASCII file resides on the console system. This file
provides information through the clientAPIs to the server. The server sends that information to the
topology agent which interacts with the topology database. The following figure shows the software
structure that supports these utilities.

import/export tool

Client APIs xml.jar

import/
export file

Sun Management Center Server

Topology Agent

RMI

SNMP

Console side
Server side

Database

FIGURE 19–1 Software Structure for Importing and Exporting Topology

For export, twomodes are provided:Append andOverwrite. In Overwrite mode, the dumped data
replaces the contents of an existing file. InAppendmode, the dumped data is added to the end of the
file.

For import, twomodes are provided to process the domain information that is contained in the
dumped file. The first mode is to ignore the domain information.All objects are created in the
specified or home domain. The secondmode is to import domain information together with all
other objects. In this case, new domains can be created.All nondomain objects are created in the
corresponding domain.

Topology Import and ExportArchitecture
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Exporting Topology Information
You can start the topology export utility from themain console window or the CLI, which is
described in “Import and Export CLI Interface” on page 265.

� ToExport TopologyData From theMainConsole
Window

Choose Export Topology from the Tools menu in the main console window.

The Export Topology dialog box appears.

Select a domain from the Export Domain Name list.

The list shows all domainsmanaged by the topology agent. You can select one domain to export. To
export multiple domains, you can repeat the preceding operation to export another domain in the
appendmode.

Type the name of the file to be exported, or select an existing file by using the Browse button.

To export a file, youmust have permission to write to the file or to create the file. Otherwise, an error
message is displayed and the operation exits.

Determine whether to append data to or overwrite data in an existing file.

Appendmode appends the data at the end of the file. Overwrite mode overwrites the file.When
Appendmode is used in the export, a more restrictive check is performed on the file. The existing file
must be a valid import and export data file.Avalid data file is a well-formed XMLfile with correct
import and export file document type declaration (DTD).

Choose the number of days for which the data is valid from the Valid for Days menu.

You can choose from the following values:

� 7 days
� 15 days
� 30 days
� 90 days

By default, topology export data is valid for an unlimited number of days.

(Optional) Provide comments about this export function.

Click OK to export the data to the specified file and close the Export Topology window.
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Importing Topology Information
You can start the topology import utility from themain console window or the CLI, which is
described in “Import and Export CLI Interface” on page 265.

� To Import TopologyData FromaFile
Select Import Topology from the Tools menu in the main console.

The Import Topology window appears.

Type the full path name to the file that contains topology data to import.

Tip – You can also use the Browse button to find the file.

Determine whether to import everything in the topology or only groups and entities.

� Follow – Imports groups and domain information. The groups and entities are created in the
domain contained in the file.

� Ignore – Ignores the domain information and imports only groups and entities to the target
domain that you specify.

Select the domain to which to import the data from the Name list.

All data is imported into the home domain by default.

Note – You can specify the location in the topology hierarchy to which the data will import only if you
chose the Ignore option in the previous step.

Click OK to import the data and close the Import Topology window.

The import utility updates the topology database. Therefore, a warning dialog box allows you to
confirm the operation before the data is imported.

The warning dialog box tells you when the input file was generated and who generated the file. This
warning helps you to ensure that the correct data file is being used.

Several additional checks are performed:

� Exported data files include information about the validity time of the file. If you are trying to
import an out-of-date file, you receive an errormessage and the operation stops.

� The import utility checks that the file exists and that the file is readable. If these checks fail, you
receive an errormessage, and the operation stops.

� For the import utility to analyze the import file, the file formatmust be correct. If the file is
formatted incorrectly, the import utility generates an errormessage.
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� If the entity exists in the current topology hierarchy, another warning dialog box asks whether the
entity should be replaced. Select one of the following options:

Replace Replaces the conflicting data with new values.

ReplaceAll Replaces all conflicting data. The dialog box does not appear when the data
conflict occurs again, and the old value is replaced

Ignore Do not update the conflicting data.

IgnoreAll The dialog box does not appear when another data conflict occurs.All
conflicts are ignored and are left unchanged.

Cancel Import Stops the import operation.

Import andExport CLI Interface
You can invoke the import and export utilities fromCLI with the following commands:

# /opt/SUNWsymon/sbin/es-cli

> login

Host: servername
Login: username
Password: password
Login successful!

> export parameter
> import parameter

See “Import Command Parameters” on page 265 and “Export Command Parameters” on page 268
for information about appropriate command parameters.

Topology ImportUtility
The import command retrieves previously exported topology data for the specified domain from a
file.

Import CommandParameters
The import command takes the following parameters:

domain The value of the domain parameter is the name of the domain whose topology is to
be imported. If no domain is specified, all domains are imported.

domainmode The value of the domainmode parameter determines whether new domains are
created from the imported topology. If the value is follow, then group and domain
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topology are imported into the current topology, and new domains can be created.
If the value is ignore, then only groups and entities are imported to the specified
target domain.

filename The value of the filename parameter is the name of the file fromwhich the topology
information should be retrieved.

nodemode The value of the nodemode parameter determines whether the imported topology
replaces the existing topology. If the value of the nodemode parameter is replace,
then conflicting data is replaced with the imported values. If the value of the
nodemode parameter is ignore, then conflicting data is not updated.

The explicit assignment in the command line overrides the same assignment in the parameter file.
For example, if mode=ignore is assigned in the command line and mode=follow is assigned in the
parameter file, then mode=ignore is used.

EXAMPLE 19–1 Importing TopologyData from a File

In the following example, previously exported topology is imported from the file
/home/examples/snapshot. New domains are created as necessary, and conflicting data is replaced
by the imported topology.

> import filename=/home/examples/snapshot domainmode=follow \

nodemode=replace

ConfirmationMessages
The import utility prompts you to answer the following items before the operation is done or when
the data conflicts:

� Warningmessage for confirmation – The followingmessage asks you to confirm the import
operation.

The data being used is exported by <user name> on <mm/dd/yyyy>.

The import operation will modify your topology database, are you sure you want to do this?

[Yes/No]

Enter y for Yes or n for No.

OutputMessages for the Import Command
This section describes themessages that might appear as a result of the import command.
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import: Results 1/1

State=Success

Message=The topology data is successfully imported.

Cause:Success.

Description:The operation completed successfully.

filename: No such file.

Cause: File does not exist.

Description: The specified file does not exist. The command linemight use two files: a data file that
provides the import data source, and a parameter file that provides a parameter list.

import: Cannot open filename.
Cause:Permission denied.

Description: The file cannot be opened for reading.

import: File format is not supported.

Cause: Formatwrong.

Description: The source file is not a valid database file for exporting data.

import: File out-of-date (xx days).

Cause:Data out-of-date.

Description:You are using out-of-date data.

import: Authentication failed.

Cause:Authentication failed.

Description: The current user has no authority to create objects in the topology hierarchy.

import: Wrong parameter file.

Cause:Parameter file error.

Description: The parameter file should be a list of name = value pairs. If the format is not correct,
the application generates an errormessage and stops.

import: illegal parameter - <para>.
Use -h option to get usage.

Cause: Illegal parameter.

Description: An illegal parameter has been passed to the import operation. Use import -h to view
the available options and the available parameters.
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Topology ExportUtility
The export command saves the topology data for a domain, or for all domains, to a file.

Export CommandParameters
The export command takes the following parameters:

comment The value of the comment parameter is an annotation to be included in the file.

domain The value of the domain parameter is the name of the domain whose topology is to be
exported. If no domain is specified, all domains are exported.

filename The value of the filename parameter is the name of the file to which the topology
information should be exported.

mode The value of themode parameter determines how the topology information is
incorporated into the file. If the value is append, then the data is appended to the
contents of the file. If the value is overwrite, then the previous contents of the file are
replaced by the new data.

validity The value of the validity parameter is the length of time in days for which the data is
valid. The following values are legal values for the validity parameter:
� Unlimited

� 7

� 15

� 30

� 90

EXAMPLE 19–2 ExportingDefault Domain Topology to a File

In the following example, the Default Domain is saved to a file that is named snapshot. The original
contents of snapshot are overwritten by the new data. The new data is assumed to be valid for an
unlimited period of time. The comment specifies that this data is for the system testing group.

> export filename=/home/examples/snapshot \

domain="Default Domain" mode=overwrite validity=Unlimited \

comment="System Test Group"

OutputMessages for the Export Command
The following list shows themessages that might appear as a result of the export command.
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Export: Results 1/1

State=Success

Message=The topology data is successfully exported.

Cause:Success.

Description:The operation completed successfully.

export: Cannot open file.
Cause: File does not exist.

Description: The parameter file does not exist.

filename: Permission denied.

Cause: File error.

Description: The file cannot be created or be opened for writing.

export: File format not supported.

Cause: Formatwrong.

Description: The error occurs when appending the export data to a file that is not a valid export
data file.

export: The domain <domainname> does not exist

Cause:Object error.

Description: The domain that youwant to export does not exist.

export: Wrong parameter file.

Cause:Parameter file error.

Description: The parameter file contains a list of name = value pairs. If the file format is not correct,
the application notifies you and stops.

export: The current user is different from the last one.

Cause:User conflict.

Description: The error occurs when you try overwrite or append the data to an existing data file
created by others. You cannotmodify or overwrite export data that another user created.

export: Data is out-of-date.

Cause:Data is too old.

Description: You are using an out-of-date export file. Thismessage only occurs when you export
data in appendmode.
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export: illegal parameter - <para>.
Please use -h option to get usage.

Cause: Illegal parameter.

Description: An illegal parameter was passed to the export operation.

Import andExport File Contents
The following list identifies the topology data that the import and export utilities process.

Entity information The record information about every domain, group and host.

Adornment information The adornment information about domains and groups. The
adornment information contains only the layout and background
index instead of the background content. For example, the
information about background only contains the GIF file name, not
the GIF file.

Relationship information The relationship information describes the topology hierarchy, entity
background and layout.

File FormatDescription
The Import/Export file describes the import and export data. You can use any text editor to edit this
file. The file includes information about every entity in the topology hierarchy. Because the append
export mode can appendmore object information to the file, the format is easy to extend and
analyze. The exported data is saved in XML format.

File FormatDesign
The file is separated into four parts:

� Magic information
� DTD (Document Type Declaration)
� Header information
� Data blocks

Magic Information
Themagic information identifies that the file is an XML format file. Typically, this information
appears as follows:

<? XML version = 1.0 ?>
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DTD (Document TypeDeclaration)
TheDTD information defines the structure of the document. The DTD of an export file resembles
the following example.

EXAMPLE 19–3 Import and Export FileDTD

<!ELEMENT ENTITY (ENTITY* ADORNMENT*)>

/* Entity element describes a entity. If it is a group, it may

contain groups and adornment. */

<!ATTLIST ENTITY /* Entity attributes */

desc CDATA

full_desc CDATA

hostname CDATA

ip CDATA

netmask CDATA

architecture CDATA

family CDATA

polling_type CDATA

url CDATA

x_coord CDATA

y_coord CDATA

topology_type CDATA

event_dest CDATA

trap_dest CDATA

target_host CDATA

target_ip CDATA

read_info CDATA

write_info CDATA>

<!ELEMENT ADORNMENT>

<!ATTLIST ADORNMENT

x_coord CDATA

y_coord CDATA

type CDATA

configuration CDATA>

]>

Header Information
The header information is used to record the general information, such as the following:

� User
� Data
� Version
� Platform
� Product
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DataBlocks
Data blocks contain the topology hierarchy architecture and entities.

Topology andExport File Example
The following figure illustrates the topology for theMyNew domain.

FIGURE 19–2MyNewTopology Example

EXAMPLE 19–4Export File forMyNewDomain

This example shows a topology export file for theMyNew domain.

<?xml version="1.0" encoding="UTF-8"?>

<DOCUMENT>

<HEAD>

<USER>jkang</USER>

<DATE>1/7/1999</DATE>

<VALIDITY>7 days</VALIDITY>

<PRODUCT>Sun Management Center</PRODUCT>

<VERSION>3.6.1</VERSION>

<COMMENTS>This is an example.</COMMENTS>

</HEAD>

<DOMAIN name="my new">

<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"

family="sun4u-Sun-Ultra-2" fulldesc="wizard" hostname="wizard"

ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"
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EXAMPLE 19–4 Export File forMyNewDomain (Continued)

netMask="255.255.255.0" pollType="ahost" readInfo="" targetHost=""

targetIp="" targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"

type="" writeInfo="" xCoord="23" yCoord="39"

/>

<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-2"

family="sun4u-Sun-Ultra-2" fulldesc="" hostname="u30-1"

ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"

netMask="255.255.255.0" pollType="ahost" readInfo=""

targetHost="" targetIp=""

targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"

type="" writeInfo="" xCoord="75" yCoord="39"

/>

<ENTITY arch="" config="" desc="campus" entityId="e-3" family="campus-view"

fulldesc="" hostname="" ipAddr="" isPoll="true" isSoftGroupLink="false"

netMask="" pollType="aview" readInfo="espublic" targetHost="" targetIp=""

targetUrl="snmp://129.158.168.63:164/mod/topology+view-101"

type="" writeInfo="" xCoord="27" yCoord="111">

<ENTITY arch="" config="" desc="building" entityId="e-1"

family="building-view" fulldesc="" hostname="" ipAddr=""

isPoll="true" isSoftGroupLink="false" netMask="" pollType="aview"

readInfo="espublic" targetHost="" targetIp=""

targetUrl="snmp://129.158.168.63:164/mod/topology+view-102"

type="" writeInfo="" xCoord="" yCoord="">

<ENTITY arch="SunOS 5.8" config="" desc="Wizard" entityId="e-1"

family="sun4u-Sun-Ultra-2" fulldesc="" hostname="wizard"

ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"

netMask="255.255.255.0" pollType="ahost" readInfo=""

targetHost="" targetIp=""

targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"

type="" writeInfo="" xCoord="" yCoord=""

/>

<ENTITY arch="SunOS 5.8" config="" desc="aaa" entityId="e-2"

family="sun4u-Sun-Ultra-2" fulldesc="" hostname="wizard"

ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"

netMask="255.255.255.0" pollType="ahost" readInfo=""

targetHost="" targetIp=""

targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"

type="" writeInfo="" xCoord="" yCoord=""

/>

<ENTITY arch="SunOS 5.8" config="" desc="atom" entityId="e-3"

family="sun4u-Sun-Ultra-2" fulldesc="" hostname="u30-1"

ipAddr="129.158.168.113" isPoll="false" isSoftGroupLink="false"

netMask="255.255.255.0" pollType="ahost" readInfo=""

targetHost="" targetIp=""

targetUrl="snmp://129.158.168.113:161/sym//base/mibman/modules"
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EXAMPLE 19–4 Export File forMyNewDomain (Continued)

type="" writeInfo="" xCoord="" yCoord=""

/>

</ENTITY>

</ENTITY>

<ENTITY arch="" config="" desc="129.158.0.0" entityId="e-4"

family="network-view" fulldesc="129.158.0.0" hostname="129.158.0.0"

ipAddr="129.158.0.0 isPoll="true" isSoftGroupLink="false"

netMask="255.255.255.0" pollType="aview"

readInfo="espublic" targetHost="129.158.0.0" targetIp="129.158.0.0"

targetUrl="snmp://129.158.168.63:164/mod/topology+view-103" type=""

writeInfo="" xCoord="38" yCoord="181">

<ENTITY arch="" config="" desc="129.158.168.0" entityId="e-1"

family="subnetwork-view" fulldesc="129.158.168.0"

hostname="129.158.168.0" ipAddr="129.158.168.0"

isPoll="true" isSoftGroupLink="false" netMask="255.255.255.0"

pollType="aview" readInfo="espublic" targetHost="129.158.168.0"

targetIp="129.158.168.0"

targetUrl="snmp://129.158.168.63:164/mod/topology+view-104"

type="" writeInfo="" xCoord="" yCoord="">

<ENTITY arch="SunOS 5.8" config="" desc="wizard" entityId="e-1"

family="sun4u-Sun-Ultra-2"

fulldesc="SUNW,Ultra-2" hostname="wizard" ipAddr="129.158.168.63"

isPoll="false" isSoftGroupLink="false" netMask="255.255.255.0"

pollType="ahost" readInfo="public" targetHost="" targetIp=""

targetUrl="snmp://129.158.168.63:1100/sym//base/mibman/modules"

type="" writeInfo=""

xCoord="" yCoord=""

/>

</ENTITY>

</ENTITY>

<ENTITY arch="" config="" desc="myworkstation" entityId="e-5"

family="nonagent-sun4u-Sun-Ultra30" fulldesc="" hostname="wizard"

ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"

netMask="" pollType="snmp" readInfo="public" targetHost=""

targetIp="" targetUrl="snmp://wizard:1100/oid//1.3.6.1.2.1.1.7.0"

type="" writeInfo="private" xCoord="52" yCoord="253"

/>

<ENTITY arch="SunOS 5.8" config="" desc="System Group" entityId="e-6"

family="base-agent" fulldesc="MIB tree branch" hostname="wizard"

ipAddr="129.158.168.63" isPoll="false" isSoftGroupLink="false"

netMask="255.255.255.255" pollType="amod" readInfo=""

targetHost="wizard" targetIp="129.158.168.63"

targetUrl="snmp://129.158.168.63:1100/mod/mib2-simple/system"

type="" writeInfo="" xCoord="52" yCoord="329"

/>
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EXAMPLE 19–4 Export File forMyNewDomain (Continued)

<ADORNMENT Config="bus" Id="adorn-7" Type="layout" XCoord="0" YCoord="0" />

</DOMAIN>

</DOCUMENT>
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Using the Command-Line Interface

The SunManagement Center command-line interface (CLI) is a lightweight, character-driven
console alternative to the Java and web console graphical interfaces formonitoring andmanaging
your system.

The following topics are discussed in this chapter:

� “Overview of the SunManagement Center CLI” on page 277
� “CLI Parameters” on page 282
� “CLI Commands” on page 286
� “CLI Output” on page 307
� “CLI Procedures” on page 309

Overviewof the SunManagement Center CLI
The SunManagement Center command-line interface (CLI) is a character-driven console
application formonitoring andmanaging your system. The CLI offers several useful features:

� Low overhead –Although the CLI providesmost of the functionality of the Java Console and
web console, the CLI does not require bitmapped graphics. The CLI therefore can run on simple
data terminal equipment over low-bandwidth connections. However, features that require a
GUI, such as physical views or graphing, are unavailable through the CLI.

� Batchmode processing – The CLI supports a basic scripting functionality that enables the CLI
to take command input from a file in batchmode.

� Configurable output format –You can configure the format of CLI output. The plain-text
output is compatible with other text-based tools. For extended commands, you can specify
output in XMLandHTML.

� Help –Online help for CLI commands is available fromwithin the CLI.

You can use the CLI to perform the following tasks:

� Create topology objects such as domains, groups, and entities, and retrieve topology information
about these objects.
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� Retrieve andmanipulate managed object properties or attributes.
� Load, unload, enable, and disable modules on SunManagement Center agents.
� Set and run alarm actions, retrieve alarm information, and acknowledge or delete alarms on Sun

Management Center agents.

Note – (On Solaris and Linux) You can automatically log in to the console using the parameters file. If
the parameters file contains user name and password, the permission for that file must be 400.
Otherwise, automatic login through CLI is not possible.

SystemRequirements
You can access the CLI from a user terminal session on one of the following system configurations:

� UNIX® workstation running the Solaris 7, Solaris 8, Solaris 9, or Solaris 10 version of the Solaris
Operating System.

� UNIXworkstation running RedHat, SuSE/JDS Linux kernel version 2.4 and 2.6.
� PC runningWindows 2000,Windows XP, orWindowsNT

CLI InteractionModes
The CLI supports the following two interactionmodes:

� Sessionmode – Sessionmode is interactive. Once you log in to the SunManagement Center
server, you can enter commands and receive output until you explicitly log out of the server.

� Batchmode – The CLI connects to the server and executes the commands contained in filename,
where filename is the name of a file that contains CLI commands. CLI can be run in batchmode
as a non-root user.

ConfiguringCLI BatchMode
CLI batchmode can be configured bymodifying the cli.properties file located at
/opt/SUNWsymon/cli. This file contains nine configurable parameters.

Table 20–1 describes the configurable parameters.
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TABLE 20–1Parameters toConfigureCLI BatchMode

Parameter Description Default Value

process_time_out When this time expires, CLI back
end processes will be removed from
the system.

Process time-out 24 hrs

process_time_out = 86400 (in

seconds)

uds_dgram_wait_time DGRAM client will be waiting for
response from the CLI back end
process. If the client does not receive
any response within the specified
time, an errormessage “Error
receiving data fromBackend” is
displayed.

UDS DGRAM wait time in seconds

uds_dgram_wait_time = 300

uds_stream_wait_time STREAM client will be waiting for
response from the CLI back end
process. If the client does not receive
any response within the specified
time, an errormessage “Error
receiving data fromBackend” is
displayed.

UDS STREAM wait time in seconds

uds_stream_wait_time = 180

out_file This file contains the details of the
currently running CLI back end
processes. The format of this file is

<user>:<hostname>:<C Process
ID>:<Java Process ID>

User & process information file

out_file =

/var/opt/SUNWsymon/cli/

process-file

socket_pathclnt This file contains the path of the
client broker UDS file. The output of
the processed CLI commands is sent
to this file.

Path to uds file

socket_pathclnt =

/var/opt/SUNWsymon/cli/

broker_uds_client_file

cli_log_path This file contains the path of the CLI
log files.

Location of CLI log file

cli_log_path =

/tmp/sunmclog/cli

cli_log_file Name of the CLI log file. Location of backend(broker) log

file

cli_log_file =

/tmp/sunmclog/cli/

cli-batch-mode-log

uds_file_path This path contains the location of the
STREAM andDGRAMUDS files.

Path of the uds files

uds_file_path =

/var/opt/SUNWsymon/cli/
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TABLE 20–1 Parameters to Configure CLI BatchMode (Continued)
Parameter Description Default Value

log_level Specifies the logging level to be used.
Set the log level to ERROR for the
production environment. Set the log
level to INFO for the debugging
environment.

Batch mode log level [options :

INFO|ERROR]

log_level=ERROR

CLI CommandandParameterOverview
This section provides an overview of CLI commands and parameters.

CLI CommandOverview
CLI commands can be divided into two types: basic commands and extended commands.

� Basic commands are commands that modify the environment in which other CLI commands
are executed. You use basic commands to set parameter values, define command aliases, check
command status, or log in and log out of the server. Basic commands always execute in the
foreground.

� Extended commands are commands that interrogate ormodify the topology ofmanaged
objects, their properties, and their attributes. You use extended commands to perform several
functions:
� Locatemanaged objects in themanaged object topology
� Enable or disable modules
� Acknowledge or delete alarms

By default, extended commands run in the background. You can configure extended commands
to run in the foreground.

In sessionmode, commands execute in either the foreground or the background.

� Foreground – Commands that execute in the foreground run to completion. These commands
send their output directly to the screen unless otherwise redirected. Only one command at a time
can run in the foreground. Basic commands can only run in the foreground. Extended commands
run in the background by default, but can be configured to run in the foreground.

� Background – Commands that execute in the background run asynchronously and by default
send no output or diagnostic messages to the screen. Output is buffered and can be displayed
later by explicit request. Unlike the UNIX shells, only one extended command can run in the
background at a time.While this command is running in the background, any number of basic
commands can run in the foreground. By default, extended commands run in the background,
although you can specify that extended commands run in the foreground. Basic commands
cannot run in the background.

The CLI also supports aliases. You can define a shorthand term or pseudonym for amore
complicated command and its parameters. User-defined aliases persist across different CLI sessions.
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CLI ParameterOverview
CLI parameters are name-value pairs: each parameter has a name and a value. Some parameters are
built-in to the CLI. Their names and the significance of their values are predefinedwithin the CLI.
You can define other parameters, also known as variables. Some parameters are global in scope.
Global parameters affect the execution of all CLI commands that are run in a particular session.
Other parameters are specific to a certain command or group of commands.

Input andOutput Capabilities
The CLI provides several capabilities for input and output.

� Input
� In sessionmode, the CLI accepts commands interactively from the keyboard.
� In batchmode, the CLI executes commands that are contained in a CLI command file whose

name is specified on the shell command line.
� Output

� For basic commands, output appears on the screen by default.
� For extended commands, output is buffered in the background by default until you request

that output.
� The output of both basic and extended commands can be redirected to a file that you specify.
� Commands and parameters can be saved in a log file that can later be used as input to the CLI

in batchmode.

Note – To use a log file as input to the CLI in batchmode, youmust edit the file. Remove the
time stamps and anymessages that appear before the actual commands and parameters in the
log file.

� Format
� You can specify the number of lines for the output display.
� Formulti-column output, you can specify which columns to display.
� In addition to plain-text output, for some commands you can specify XMLandHTML

output.

CLI CommandHelp
The CLI provides online help for each CLI command. CLI help is available fromwithin the CLI. CLI
help does not require a GUI. For each command, the help provides a synopsis of command usage
and a list of the parameters associated with that command.
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CLI Parameters
Most CLI parameters are name-value pairs: each parameter has a name and a value. A few
parameters have names but no values. These parameters are known as flags.

Scopeof Parameters
You can specify parameter values at several points in a CLI session:

� CLI startup –You can specify parameters at the command line when you start the CLI.
Parameters that are specified at startup are global to the session. Global parameters retain their
values unless overridden with the set command or removed from the current session with the
unset command.

� CLI commands –You can specify parameters for individual CLI commands executed during a
session.Avalue specified as part of a command temporarily overrides the value of a global
parameter for the duration of that command.

� Input file – Parameter definitions can be stored in an external file and can be invoked at any time
in a CLI session. Parameter values that are defined in an external file are overridden by global
parameters and by individual command parameters.

Parameter Syntax
Parameters are specified as name=value pairs:

file=/home/examples/example1

where the parameter name is file and the parameter value is /home/examples/example1. There
must be no whitespace between the equals sign (=) and the parameter name or parameter value. If the
value contains whitespace such as a space or tab character, the valuemust be enclosed in
double-quote characters (ASCII character 0x22):

moduleDesc="Local File Scanning"

Parameter values can be a list of comma-separated values. Theremust be no whitespace between the
comma-separated values, as shown in the following example.

severity=DIS,DWN,ERR

Aparameter list is a sequence of parameters separated by whitespace, as shown in the following
example.

m=kernel-reader moduleDesc="My Kernel Reader"

Examples ofAcceptable andUnacceptable Parameter Syntax
The following parameters have acceptable syntax:
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ok1="This is just a test"

ok2=hello

ok3=hello,hi,aloha

ok4="hello,hi,aloha"

The following parameters do not have acceptable syntax:

broken1="How are you?","Who are you?"

broken2="Testing",1,2,3

broken3="Hello

broken4=Hello"

Parameter Input File Format
Parameters can be stored in a file and read when needed. You can create asmany parameter files as
needed. Use the built-in i parameter to specify the name of the desired parameter input file.

PredefinedParameters andFlags
This section describes parameters that have predefinedmeanings within the CLI.

Note – Several predefined parameters have single-letter names. Some examples include such as a, f,
and o.

-b When included at the command line when the CLI is started, this flag instructs the
CLI to run in batchmode. This flag is ignored in sessionmode.

-h When this flag is used as a parameter to a command in sessionmode, it instructs the
CLI to display the help text for the command.

-l When this flag is used as a parameter to an extended command in sessionmode, it
instructs the CLI to retain the parameters from the last extended commandwhile
executing the current command. If the -l flag is specified, any additional parameters
specified for the current command are ignored. This flag has no effect on basic
commands. The following example illustrates usage of the -l flag:

> getLoadModules a=myHostName

...

...

> getAlarms -l

When the getAlarms command is executed, the command uses the value of
parameter a (myHostName) from the previously executed getLoadModules command.

a The value of the a parameter is an agent, which is specified as the agent host and
(optional) port number. If you specify the port number, separate the number from the
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host name by a colon (:). The general syntax is a=agentHost[:agentPort]. For
example, to specify an agent running on host example_host and listening to port
12345, you would use the following syntax:

a=example_host:12345

The value of the a parameter can also be a comma-separated list of agent
specifications: a=agent[,agent]*.

about The about parameter is used with the help command. This parameter displays the
version information for CLI.

append The value of the append parameter is the name of a file to which the output of a
command should be appended. If this file does not exist, the file is created. If you set
the append parameter globally, all command output for that session is appended to
the specified file. You can also set this parameter for a specific command, as shown in
the following example.

append=/home/examples/cli_output

If both the append and o parameters are set, append takes precedence over o. Only
command results are recorded in the specified file. The actual command is not
recorded. Use the log parameter to record command information.

columns The value of the columns parameter is the name of one ormore columns of command
output to be displayed by the print command. Column names are case sensitive.
Multiple column names are separated by commas. The following example uses several
column names.

columns="Alarm Id,Node URL,Target Host,Severity"

f The value of the f parameter determines the format of command output. The current
formats are plain and html. See “CommandOutput Format” on page 307 formore
information. To set the format to HTML, use the following syntax:

f=html

height The value of the height parameter is the number of lines of command output to
display on the screen. The following example sets the height to approximately the
height of a standard terminal screen:

height=24

history The value of the history parameter is the number of commands to be stored in the
command history. The command history allows the user to view the previously
executed commands. This parameter is used by the set command.

history=10
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i The value of the i parameter is the name of an input file that contains parameter
definitions to be included in the current session.Within the input file, each parameter
definition should be on a separate line. For example, assume that the following lines
are in a /home/examples/myParams file:

more=off

serverHost=myserver

a=myagent:161

You could include these parameters in the current CLI session by using the following
line:

i=/home/examples/myParams

log The value of the log parameter is the name of a file that records all CLI commands and
the time that the commands were executed. Note that the log file records only
command names and time of execution. Command output is logged in files specified
by the a or o parameters. Once the parameter is set, all subsequent commands are
appended to the file. If this file does not exist, the file is created. Because the log file is
not overwritten when logging is turned on, specify a different file if you want a
different log. To turn logging off, use the unset commandwith the log parameter. The
following example starts a log, then later stops the log.

> log=/home/examples/sunmc-log

...

...

> unset log

logmode The value of the logmode parameter can be detailed, command, or from n. The value
of detailed stores detailed information of commands in the command log file. The
value of command stores only the commands and the respective parameters in the
command log file. The value of from n appends all the entries (starting from the nth
entry) in the command history to the command log file. The default value of the
logmode parameter is detailed.

m The value of them parameter is the name of a SunManagement Centermodule. The
value can also be a comma-separated list of modules.

m=kernel-reader

more The value of themore parameter controls paging of command output on your display.
Possible values are on and off. Ifmore is set to on, all subsequent output to the
terminal is displayed one screen at a time. The size of a screen is defined by the height
and width parameters. Default values are off for batchmode and on for sessionmode.

more=on
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ncols The value of the ncols parameter is themaximumnumber of columns of command
output to be displayed by the print command.

o The value of the o parameter is the name of a file to which command output should be
written. If this file exists, the file is overwritten. You can use the o parameter to capture
the output of a particular command by specifying the o parameter to that command.
You can also set the parameter globally using the set command to write all
subsequent output to a file.

If both the append and o parameters are set, append takes precedence over o. Output is
appended to the specified file. Only command output is written to the file. The actual
command is not recorded. Use the log parameter to record command information.
The following example defines a file into which command output is written.

o=/home/examples/sunmc-output

prompt The value of the prompt parameter is used to set a different CLI prompt.

serverPort The value of the serverPort parameter is the server port for login. This global
parameter cannot be set after a login session is established. If this parameter is not set,
the default port of 2099 is used.

style The value of the style parameter determines the style of command output. The
allowed values of this parameter are table, list, and <custom>. The table value
displays the output in a tabular format. The list value displays the output in a list
with the columns separated by a comma. The <custom> value ensures that the output
is displayed in a user-defined format. Each column is represented by %a. The custom
value can contain special characters such as :, \t, and \n.

t The value of the t parameter is the name of an object that is managed in the topology
agent. The object can be a domain, a view group, or an entity. The object name is the
fully qualified name at the domain level, for example, /domain/group/host.

CLI Commands
See “CLI Command and Parameter Overview” on page 280 for an overview of command types and
concepts. For details about the parameters used by the basic CLI commands, refer to “Predefined
Parameters and Flags” on page 283.

Basic CLI Commands
The following list describes the basic CLI commands.

alias Description
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The alias command creates an alias for frequently used commands or for commands
that have complicated parameters.An alias cannot have the same name as an existing
CLI command.Whitespace in an alias definitionmust be enclosed in double-quotes (",
ASCII character 0x22).

When the user quits a CLI session, the aliases that the user has specified are stored in a
file in the aliases directory. These aliases will be available when the user logs in to the
CLI session.

Syntax

alias [<pseudonym>="command [parameters]"]

Examples

> alias assign=set

> alias alarms="getAlarms severity=dwn"

If called without arguments, the alias command prints a list of defined aliases and
their values. The following example shows the result of the alias commandwhen the
command is called without arguments.

> alias

assign - set

alarms - getAlarms severity=dwn

attrib Description

The attrib command retrieves the attributes of a topological object.

Syntax

attrib [group=groupName [name=attribName] [-key]]

browse Description

The browse command activates the browsingmode of the topology.

Syntax

browse

cd Description

The cd command changes the current topological path. If no path is specified, the
current path will be set to the default domain. If a number (n) is specified, the current
path will be set to the nth child path, as shown by the list command.

Syntax
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cd [path|number]

clear Description

The clear command removes all parameters that were set during the current session.
However, this commandwill not remove parameters that were set from the command
line. This command is similar to the unset command but does not require parameter
names as arguments.

Syntax

clear

data Description

The data command shows the details of a topological object. If a number (n) is
specified, the path will be set to the nth child path, as shown by the list command.

Syntax

data [path|number|-key]

end Description

The end command deactivates the browsingmode of the topology.

Syntax

end

exit Description

The exit command terminates your server connection and the CLI session.

Syntax

exit [-onError]

Parameter

onError

The onError parameter is used to terminate the CLI session if an exception occurs in
the execution of the previous command. This parameter is used only in batchmode.

Note –The exit command and the quit command are identical.

goto Description
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The goto command navigates to a topological path that matches the case-sensitive
pattern. If more than onematching path is found, the user is asked to choose a path.

Syntax

goto <pattern>

help Description

The help command displays information about CLI commands and their parameters.
The help information is suitable for displaying on a terminal screen that is not
bitmapped.When help is executed without an argument, the help displays an
alphabetical list and a brief description of available CLI commands. Basic commands
are listed first, followed by extended commands.

Syntax

help [-e][-h] [<command>|about|legal]

Parameters

-e, -h, command, about, and legal

-e displays the help text in extensivemode. The following format is also supported:
<command> -e.

-h displays the help text in normalmode. The following format is also supported:
<command> -h.

command displays information specific to that command.

about displays the version information about CLI.

legal displays the licensing terms of the CLI.

Example

The following example shows help for the getAlarms command.

> help getAlarms

getAlarms [a=host[,host]+] [alarm_filter_list]

- Get alarm information on an agent or a list of agents under a

set of filter conditions. If no agent is provided, all alarms will

be obtained. All the filter conditions are "ANDED" to provide the

result. The filter conditions as specified in alarm_filter_list

comprises:

domain=domain and/or

m=module[+instance] and/or

managed_object=managed_object and/or
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property=property and/or

property_instance=property_instance and/or

qualifier=qualifier and/or

severity=[DIS,DWN,ERR,OFF,INF,IRR,WRN] and/or

state=[C,F,O] and/or

ack=[A,N]

history Description

The history command lists or executes the previously entered commands in the CLI
session.When the history command is called without any argument and history was
set earlier, all the previously entered commands will be listed.When the history
command is called with a numerical argument and history was set earlier, the
command that matches this argument will be executed.

Syntax

history [num]

kill Description

The kill command terminates any commands that are running in the background.

Syntax

kill

list Description

The list command lists the objects under a path. If a number (n) is specified, the path
will be set to the nth child path as shown by this command.

Syntax

list [path|number]

locate Description

The locate command finds all the topological paths that match the specified pattern.
The pattern is case sensitive.

Syntax

locate <pattern>

login Description

The login command establishes a connection to a SunManagement Center server. You
can specify the serverHost and, optionally, serverPort parameters as arguments. If no
host is specified, you are prompted for a host. If no port is specified, 2099 is used. The
login command also prompts you for your user name and password.
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Syntax

login [serverHost=host] [serverPort=portNumber] [user=userName]

[password=userPassword]

Parameters

serverHost, serverPort, user, and password

logout Description

The logout command terminates your connection to the SunManagement Center
server, but does not terminate the CLI session.

Syntax

logout

print Description

The print command directs the output of the last extended command in the specified
format to the specified destination. By default, print directs this output to the terminal
screen in plain text format. If the parameters append or o are set, the output is directed
to the file that is specified by those parameters. The output is not shown on the screen. if
ncols is not specified, the default number of columns is set to 4.

Note –The print command is not saved in the command history.

Syntax

print [f=plain|xml|html] [style=table|list|<custom>] [columns=

columnList] [ncols=num] [o=outputFile | append=appendFile]

Parameters

f, style, columns, ncols, o, and append

quit Description

The quit command disconnects from the server and terminates the CLI session.

Note – There is no difference between the quit and the exit commands.

Syntax

quit

reset Description
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The reset command restores the values of all parameters that are specified at the
command line to the values that were specified at the beginning of the CLI session.
Parameters that were defined during the session but not at the command line remain
unchanged. If a specific parameter name is supplied as an argument to reset and the
parameter was specified at the command line, that parameter’s value is restored to its
original value. Otherwise, the parameter’s value remains unchanged.

Note –The reset command is not saved in the command history.

Syntax

reset [<parameter>]*

set Description

The set command enables you to specify parameter values or to display parameter
values. Parameters whose values are specified with the set command are global to the
current session. Global commands are available to all commands during that session. If
you execute setwith no arguments , the value of all parameters that are defined during
the current session are displayed. If you execute setwith a parameter that is specified as
an argument, the value of that parameter is displayed.

Syntax

set [<parameter>[=value]]* [height=num] [history=num] [log=file]

[logmode=detailed|command|"from n"] [more=on|off] [prompt=prompt]

Example

The following example shows all three variations of this command.

> set height=10

> set

height=10

> set height

height=10

status Description

The status command displays the status of any commands that are running in the
background.

Syntax

status

unalias Description
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The unalias command removes the alias or a list of aliases that was specified as an
argument.

Syntax

unalias [<pseudonym>]*

unset Description

The unset command removes the specified parameter(s) from the current session.

Syntax

unset [<parameter>]*

Note –The unset command is not saved in the command history.

where Description

The where command displays the current topological path.

Syntax

where

ExtendedCLI Commands
Several types of extended commands that are available in the CLI are described in these sections:

� “Module Extended Commands” on page 293
� “ObjectAttribute Extended Commands” on page 296
� “Alarm Extended Commands” on page 298
� “Topology Extended Commands” on page 301
� Topology import and export commands in “Import and Export CLI Interface” on page 265

Module ExtendedCommands
Seven extended commands are available formanagingmodules.

Parameters for the Module Command

The following parameters can be used by themodule commands. For details about the a andm
parameters, refer to “Predefined Parameters and Flags” on page 283.

moduleName The internationalized name of themodule

moduleDesc The text description of themodule
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moduleParams The comma-separated list of module parameters

-default The default settings of themodule

Module Commands

disableModule Description

The disableModule command disables amodule ormodules in an agent or
agents.

Syntax

disableModule a=host[:port][,host[:port]]*

m=module[+instance][,module[+instance]]*

Parameters

a andm

enableModule Description

The enableModule command enables amodule ormodules in an agent or
agents.

Syntax

enableModule a=host[:port][,host[:port]]*

m=module[+instance][,module[+instance]]*

Parameters

a andm

getLoadedModules Description

The getLoadedModules command obtains a list of loadedmodules in an
agent or agents.

Syntax

getLoadedModules a=host[:port][,host[:port]]*

Parameter

a

getModule Description

The getModule command obtains information for a particular module in an
agent or agents.
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Syntax

getModule a=host[:port][,host[:port]]* m=module[+instance]

Parameters

a andm

getModules Description

The getModules command obtains a list of all available modules in an agent
or agents.

Syntax

getModules a=host[:port][,host[:port]]*

Parameter

a

loadModule Description

The loadModule command loads amodule in an agent or agents.

Syntax

loadModule a=host[:port][,host[:port]]* m=module[+instance]

[moduleName= name] [moduleDesc=description] [moduleParams=

key=value[,key=value]*] [-default]

Parameters

a,m,moduleName,moduleDesc,moduleParams, and -default.

unloadModule Description

The unloadModule command unloads one ormoremodules in an agent or
agents.

Syntax

unloadModule a=host[:port][,host[:port]]*

m=module[+instance][,module[+instance]]*

Parameters

a andm
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Module Command Examples

To determine whichmodules are loaded on a host whose agentHost name is seattle, you would type
the following command at the CLI prompt:

> getLoadedModules a=seattle

To load the kernel-readermodule on the host seattle at port 1776, you would type the following
command:

> loadModule a=seattle:1776 m=kernel-reader

ObjectAttribute ExtendedCommands
There are four extended commands formanaging object attributes and attribute values.

Parameters for the ObjectAttribute Command

The following parameters can be used by the object attribute commands. For details about the a and
m parameters, refer to “Predefined Parameters and Flags” on page 283.

mgtObj The value of themgtObj parameter is the name of themanaged object whose
attributes and properties are being set or retrieved.

property The value of the property parameter is the name of the property whose attributes and
values are being set or retrieved.

propInst The value of the propInst parameter is the name of the instance of the property whose
attributes and values are being set or retrieved.

rowValues The value of the rowValues parameter is a comma-separated list of name-value pairs.
name is the name of a column in the row. value is the value in that column.

attribute The value of the attribute parameter is a comma-separated list of attribute names that
belong to the property whose attributes and values are being set or retrieved.When
used with the setAttributes command, each attribute name in the attribute
parametermust have a corresponding value in the value parameter.

value The value of the value parameter is a comma-separated list of values that correspond
to the attributes that are specified in the attribute parameter.When used with the
setAttributes command, theremust be a value for each attribute specified.

ObjectAttribute Commands

You can set and retrieve object attributes and attribute values with the following commands:

addRow Description

The addRow command adds a rowwith the specified values to a table.
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Syntax

addRow a=host[:port][,host[:port]]* m=module[+instance]

mgtObj=managedObject [property=property]

[propInst=propertyInstance] rowValues=name=value[,name=value]

Parameters

a,m,mgtObj, property, propInst, and rowValues.

delRow Description

The delRow command deletes a rowwith the specified values from a table.

Syntax

delRow a=host[:port][,host[:port]]* m=module[+instance]

mgtObj=managedObject [property=property]

[propInst=propertyInstance] rowValues=name=value[,name=value]

Parameters

a,m,mgtObj, property, propInst, and rowValues.

getAttributes Description

The getAttributes command retrieves the information for a property or
retrieves specified attributes from an agent or a list of agents.

Syntax

getAttributes a=host[:port][,host[:port]]* m=module[+instance]

mgtObj=managedObject property=property [propInst=propertyInstance]

[attribute=attribute[,attribute]*]

Parameters

a,m,mgtObj, property, propInst, and attribute.

setAttributes Description

The setAttributes command sets a property or sets values to the specified
attributes in an agent or a list of agents. You can also reset the value of a specified
attribute to null.

Syntax

setAttributes a=host[:port][,host[:port]]* m=module[+instance]

mgtObj=managedObject property=property [propInst=propertyInstance]

[attribute=attribute[,attribute]*] value=value[,value]*
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Parameters

a,m,mgtObj, property, propInst, attribute, and value.

For each attribute specified in the attribute parameter, theremust be a
corresponding value in the value parameter.

Examples for the ObjectAttribute Command

The following command retrieves all attributes for the size property in the totalstatsmanaged
object in the agent-statsmodule at port 1161 on host haiku:

> getAttributes a=haiku:1161 m=agent-stats mgtObj=totalstats \

property=size

The following command sets the attribute alarmlimits.error-gt to the value of 2 in the size
property specified in the previous example:

> setAttributes a=haiku:1161 m=agent-stats mgtObj=totalstats \

property=size attribute=alarmlimits.error-gt value=2

The following command deletes the row that is specified in rowValues from themanaged object that
is specified inmgtObj:

> delRow a=haiku:1161 \

m=filemon mgtObj=filemonstats/filemonTable/filemonEntry \

rowValues="name=test,desc=this,filename=/etc/passwd"

AlarmExtendedCommands
There are five extended commands formanaging alarms.

Alarm Command Parameters

The following parameters can be used by the extended commands for alarms. For details about the a
andm parameters, refer to “Predefined Parameters and Flags” on page 283.

ack The value of the ack parameter is a comma-separated list of values that indicate whether
the alarms beingmanaged have been acknowledged. Legal values for the ack parameter
are ACK (Acknowledged) and NOACK (NotAcknowledged).

command The value of the command parameter is the alarm action to be performed.

domain The value of the domain parameter is the name of the SunManagement Center domain
for which alarms are to bemanaged. If no domain is specified, the Default Domain is
used.
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mgtObj The value of themgtObj parameter is the name of themanaged object for which alarms
are to bemanaged.

note The value of the note parameter is a text annotation for the command being run.

property The value of the property parameter is the name of the property for which alarms are to
bemanaged.

propInst The value of the propInst parameter is the name of the specific property instance for
which alarms are to bemanaged.

qualifier The value of the qualifier parameter is the name of the qualifier that is associated with
themanaged property whose alarms are to bemanaged.

severity The value of the severity parameter is a comma-separated list of severity values for the
alarms beingmanaged. The following values are allowed for the severity parameter:
� ERR—Error
� WRN—Warning
� INF—Informative
� IRR—Irrational
� DWN—Down
� DIS—Disabled
� OFF—Off

state The value of the state parameter is a comma-separated list of state values for the alarms
beingmanaged. Legal values for the state parameter are Open, Closed, and Fixed.

Alarm Commands

You can examine alarm values and set alarm actions with the following commands:

ackAlarms Description

The ackAlarms command acknowledges alarms in an agent or a list of agents.

Syntax

ackAlarms a=host[:port][,host[:port]]* [domain=domain]

[m=module[+instance][mgtObj=managedObject [property=property

[propInst=propertyInstance] [qualifier=qualifier]]]]

[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN] [state=OPEN|CLOSED|FIXED]

[note=reason]

Parameters

a, domain,m,mgtObj, property, propInst, qualifier, severity, state, and note.

If no value is specified for the state parameter, state defaults to Open.

delAlarms Description
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The delAlarms command deletes alarms in an agent or a list of agents.

Syntax

delAlarms a=host[:port][,host[:port]]* [domain=domain]

[m=module[+instance][mgtObj=managedObject [property=property

[propInst=propertyInstance] [qualifier=qualifier]]]]

[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN] [state=OPEN|CLOSED|FIXED]

[ack=ACK|NOACK] [note=reason]

Parameters

a, domain,m,mgtObj, property, propInst, qualifier, severity, state, ack, and note.

If no value is specified for the state parameter, state defaults to Closed.

getAlarms Description

The getAlarms command retrieves alarm information for an agent or a set of
agents.

Syntax

getAlarms a=host[:port][,host[:port]]* [domain=domain]

[m=module[+instance][mgtObj=managedObject [property=property

[propInst=propertyInstance] [qualifier=qualifier]]]]

[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN] [state=OPEN|CLOSED|FIXED]

[ack=ACK|NOACK]

Parameters

a, domain,m,mgtObj, property, propInst, qualifier, severity, state, and ack.

If no parameters are specified, getAlarms returns all alarm information.

runAlarmAction Description

The runAlarmAction command runs amanual or delayed alarm action for all
alarms under a domain of an agent or a list of agents.

Syntax

runAlarmAction a=host[:port][,host[:port]]* [domain=domain]

[m=module[+instance][mgtObj=managedObject [property=property

[propInst=propertyInstance] [qualifier=qualifier]]]]

[severity=DIS|DWN|ERR|INF|IRR|OFF|WRN] [state=OPEN|CLOSED|FIXED]

[ack=ACK|NOACK]

Parameters
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a, domain,m,mgtObj, property, propInst, qualifier, severity, state, and ack.

setAlarmAction Description

The setAlarmAction command sets amanual or delayed alarm action for all
alarms under a domain of an agent or a list of agents.

Syntax

setAlarmAction a=host[:port][,host[:port]]* command=command

[domain=domain] [m=module[+instance][mgtObj=managedObject

[property=property [propInst=propertyInstance]

[qualifier=qualifier]]]] [severity=DIS|DWN|ERR|INF|IRR|OFF|WRN]

[state=OPEN|CLOSED|FIXED] [ack=ACK|NOACK]

To set up email alerts for an alarm, the command format can either be

command="email.sh:<email-id>:<message>" or

command="email:<email-id>:<message>"

Parameters

a, command, domain,m,mgtObj, property, propInst, qualifier, severity, state,
and ack.

Alarm Command Examples

The following command retrieves all alarms with severity of ERR or DWN from the host haiku:

> getAlarms a=haiku severity=ERR,DWN

Topology ExtendedCommands
There are nine extended commands formanaging topology.

Topology Command Parameters

The following parameters can be used by the extended commands for topology. For details about the
a and t parameters, refer to “Predefined Parameters and Flags” on page 283.

agentPort The value of the agentPort parameter is the agent port number. If agentPort is not
specified, the default value of 161 is used. The agentPort parameter is optional.
This parameter is only specified if the url parameter is not specified and if you do
not want the default port.

arch The value of the arch parameter is the architecture of the topology object.
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domain The value of the domain parameter is the name of the SunManagement Center
domain that youmust specify for the setCurrentDomain command.

domainmode The value of the domainmode parameter can be follow or ignore. If the value is
follow, the import command imports both the group and domain information
from the file to the specified target domain. If the value is ignore, the import
command ignores the domain information.

family The value of the family parameter is the object family of the topology object. If this
is not specified, this will be automatically obtained.

filename The value of the filename parameter is the name of the file. This parameter is used
by export and import commands to export and import topology data.

fullDesc The value of the fullDesc parameter is a text description of the entity or group
being created.

isPolled The value of the isPolled parameter can be true or false. If the value is true, the
entity polls for status information according to the polling type (pollType). The
default value is true.

mode The value of themode parameter can be append or overwrite. If the value is
append, the export command adds the topology data to the end of the file. If the
value is overwrite, the export command overwrites the file with the topology
data.

nodemode The value of the nodemode parameter can be replace or ignore. If there is a
mismatch of data in the file and in the domain, the replace value replaces the data
in the domain with data in the file. The ignore value ignores anymismatch of data.

pollType The value of the pollType parameter is the type of polling for this entity. The
following values are allowed for the pollType parameter:
� agroup – Identifies a group onwhich an active agent is installed and running
� ahost – Identifies a host on which an active agent is installed and running
� amod – Identifies amodule that has an active agent
� aprox – Identifies an agent that is running an SNMPproxymodule
� dummy – Identifies a device that is notmonitored
� ping – Identifies a host to bemonitored using the ICMP ping command
� snmp – Identifies a host to bemonitored using the SNMP ping command

readInfo The value of the readInfo parameter is the name of the SNMPv1 read community
for SNMPpolled objects.

targetHost The value of the targetHost parameter is the name of the target host.

targetIp The value of the targetIP parameter is the IP address of the target host.

topoCfg The value of the topoCfg parameter is configuration information for the
topological representation of amanaged entity.
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topoType The value of the topoType parameter is the topological representation type of a
managed entity.

url The value of the url parameter is the URLof the entity to be polled. The value of the
url parameter can be specified in the following formats:

ping://hostname
snmp://hostname:port/oid/#.#.#.#
snmp://hostname:port/[mod,sym]/path

validity The value of the validity parameter is the duration (in days) you want the exported
topology data to be valid. The value of the validity parameter can be Unlimited, 7,
15, 30, or 90.

writeInfo The value of thewriteInfo parameter is the name of the SNMPv1 write community
for SNMPpolled objects.

Topology Commands

There are nine extended commands formanaging topology.

createEntity Description

The createEntity command creates amanaged entity.

Syntax

createEntity t=topoObject

pollType=ahost|amod|aprox|dummy|ping|snmp [fullDesc=text]

[targetHost=host] [agentPort=port] [targetIp=ip]

[family=family] [isPolled=true|false] [topoType=text]

[topoCfg=text] [readInfo=text] [writeInfo=text] [url=url]

Parameters

t, pollType, fullDesc, targetHost, agentPort, targetIp, family, isPolled,
topoType, topoCfg, readInfo,writeInfo, and url.

If the url or agentPort parameters are specified, the default port of 161 is
not used.

createGroup Description

The createGroup command creates a topology domain or group.

Syntax

createGroup t=topoObject

[family=base|building-view|campus-view|

network-view|subnetwork-view] [fullDesc=desc]
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Parameters

t, family, and fullDesc.

If the entity being created is a group, the family parameter is mandatory.

If the entity being created is a domain, the family and fullDesc parameters
are ignored.

delTopoObject Description

The delTopoObject command deletes amanaged topology object in the
managed topology hierarchy.All objects under the specified topology
object are deleted as well.

Syntax

delTopoObject t=topoObject

Parameter

t

export Description

The export command exports topology data in a domain or domains to a
file.

Syntax

export filename=filename domain=domain|"All Domains"

mode=append|overwrite validity=Unlimited|7|15|30|90

[comment=text]

Parameters

filename, domain,mode, validity, and comment.

getAgentPort Description

The getAgentPort command returns a port number of the Sun
Management Center agent running on the specified host in a topology
domain. If there aremultiple agents, a list of port numbers is returned.

Syntax

getAgentPort a=host[,host]* [t=topoObject]

Parameters

a and t.
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If the t parameter is not specified, the default domain is used.

getAllTopoObjects Description

The getAllTopoObjects command returns a list of all managed objects in
themanaged topology hierarchy that satisfy conditions specified by the
arch, family, or pollType parameters.

Syntax

getAllTopoObjects t=topoObject [arch=os] [family=platform]

[pollType=aview|ahost|amod|aprox|dummy|ping|snmp]

Parameters

t, arch, family, and pollType.

getCurrentDomain Description

The getCurrentDomain command returns the name of the current
domain.

Syntax

getCurrentDomain

Parameters

None

getDomains Description

The getDomains command returns a list of all managed domains in the
current server context.

Syntax

getDomains

Parameters

None

getTopoObject Description

The getTopoObject command returns a list of managed topology objects
directly under the topology object specified by parameter t that satisfy
conditions specified by the arch, family, or pollType parameters.

Syntax
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getTopoObject t=topoObject [arch=os] [family=platform]

[pollType=aview|ahost|amod|aprox|dummy|ping|snmp]

Parameters

t, arch, family, and pollType.

import Description

The export command imports topology data from a file to a domain.

Syntax

import filename=filename domainmode=follow|ignore

nodemode=replace|ignore [domain=domain]

Parameters

filename, domainmode, nodemode, and domain.

setCurrentDomain Description

The setCurrentDomain command sets the home domain to the value
specified in the domain parameter.

Syntax

setCurrentDomain domain=domainName

Parameter

domain

Topology Command Examples

The following command returns a list of all SunManagement Center agent hosts on the sun4u family
in group building12 in the menlo_park domain that are running SunOS 5.7 software:

> getTopoObject t=/menlo_park/building12 pollType=ahost \

arch="SunOS 5.7" family=sun4u

The following command creates a group that is named building19 under an existing domain that is
named headquarters_test:

> createGroup t=/headquarters_test/building19 \

fullDesc="test headquarters domain" family=building-location

The following command creates amanaged entity that is named myHost in the group building12 in
the domain test_domain. The topology object is a host with the agent running in port 1161.
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> createEntity t=/test_domain/building12/myHost \

fullDesc="my test host" family=ultra-2 topoType="" \

topoCfg="" isPolled=false pollType=ahost readInfo="" \

writeInfo="" targetHost=osftserv targetIp="" agentPort=1161

CLIOutput
The CLI provides the following output options:

� Log command execution to a file
� Log command output to a file
� Control appearance of command output on the screen
� Specify output as plain text, XML, or HTML

Note – All commands and log files are available only in English. However, command descriptions and
help text follow the Java internationalization guidelines for languages other than English.

CommandOutput Format
The output of basic commands is available only in plain text. Refer to “CLI Command and
Parameter Overview” on page 280 for an explanation of basic and extended commands.

The output of extended commands is available in three formats:

� Plain text
� XML
� HTML

To specify the output format, set the f parameter to the value of the desired format. Currently
supported values are plain, xml, and html.

You can define a logical screen size for command output by setting the height parameter to a desired
value. You can set themore parameter to display output one screen at a time. See “Predefined
Parameters and Flags” on page 283 for an explanation of these parameters.

EXAMPLE 20–1PlainTextCommandOutput

The following example shows the partial output of the getLoadedModules command in plain text.

== getLoadedModules: Results 1/16 ===============================

Module Name=Dynamic Reconfiguration

Module Key=dr

Description=Dynamic Reconfiguration (Sunfire)

Agent Name=myhost-dev86

CLI Output

Chapter 20 • Using the Command-Line Interface 307



EXAMPLE 20–1Plain Text CommandOutput (Continued)

Agent Port=161

Version=2.0

== getLoadedModules: Results 2/16 ===============================

Module Name=Config-Reader(sun4u/sun4d)

Module Key=Config-Reader4u

Description=Config Reader (sun4u/sun4d)

Agent Name=myhost-dev86

Agent Port=161

Version=1.0

...

== getLoadedModules: Results 15/16 ==============================

Module Name=DNS Synthetic Transaction [dns]

Module Key=dnsST+dnstest

Description=DNS Synthetic Transaction

Agent Name=myhost-dev86

Agent Port=161

Version=1.0

================================================================

CLI Log File
To record CLI commands in a log file, set the log parameter to the name of the file in which to record
the commands. To pass the log file to CLI in batchmode for execution, set the logmode parameter to
detailed, command, or from n. For more details, see log and logmore in “Predefined Parameters and
Flags” on page 283.

The log file has the following format:

DATE & TIME;duration or message;command and parameters

EXAMPLE 20–2Partial CLI Log File

The following example is an excerpt of the log of the command sequence fromwhich the previous
getLoadedModules command output was obtained.

Fri Dec 21 14:15:12 PST 2001;0 second;set o=\

/home/examples/output.3c23b455

Fri Dec 21 14:15:23 PST 2001;0 second;set f=plain

Fri Dec 21 14:15:45 PST 2001;0 second;set a=smtg-dev21

Fri Dec 21 14:16:08 PST 2001;== START OF THREAD ==;getLoadedModules

Fri Dec 21 14:16:08 PST 2001;2 seconds;getLoadedModules

Fri Dec 21 14:16:12 PST 2001;9 seconds;print

Fri Dec 21 14:21:28 PST 2001;== START OF THREAD ==;getAgentPort

Fri Dec 21 14:21:28 PST 2001;0 second;getAgentPort
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EXAMPLE 20–2Partial CLI Log File (Continued)

Fri Dec 21 14:21:31 PST 2001;0 second;print

Fri Dec 21 14:22:01 PST 2001;0 second;exit

Accessing theCLI
es-cli Description

The es-cli command is used to access the CLI.

Syntax

es-cli [-h] [-b <filename> -i <parameter-filename>] [-i <parameter-filename>]

For an explanation of the parameters to es-cli, see “CLI Parameters” on page 282.

Note – If no option is specified, the CLI runs in sessionmode.

CLI Procedures
This section describes some commonCLI procedures.

� ToAccess theCLI in the Solaris or LinuxOperating
Environment

Note – If the console is not installed in the default /opt directory, the CLI application will not start. In
this case, start the CLI application by either of the following ways:

� After installation, change the location of the add-ons in the cli.properties file to correctly
point to the installed location.

� Create the /opt/SUNWsymon/cli/addons directory.

To begin an interactive session, type the command /opt/SUNWsymon/sbin/es-cli followed by any
desired global parameters.

Type login in response to the CLI prompt (>).

Type the name of the host to which you wish to connect in response to the Hostprompt.

BeforeYouBegin
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Type your login name and password in response to the Login and Passwordprompts.

The result of steps 1-4 resembles the following example:
/opt/SUNWsymon/sbin/es-cli parameters
> login

Host: myhost
Login: mylogin
Password: mypassword
Login is successful.

>

Tip – You can run the CLI in batchmode using a previously prepared file of CLI commands as input
by using the following command: /opt/SUNWsymon/sbin/es-cli -b file.

� ToAccess theCLI inMicrosoftWindows Environments
After you have installed the Sun Management Center console layer, double-click es-cli in the CLI
folder.

The CLI screen is displayed.

Type the login command.

The login process prompts you to specify the desired host name and your login name.

In the following example, seattle is the host, and susan is the login name:
> login

Host: seattle

Login: susan

Password:

>

� ToAccess CLIOnlineHelp
To obtain a list of all available CLI commands, type help at the CLI prompt.

To obtain a more detailed explanation of a particular command, type help followed by the name of
the command.

For example, to obtain additional help about the getLoadedModules command, you would type:
> help getLoadedModules
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� ToControl CommandOutput Screen Size
Define a screen size by setting the heightparameter to the number of lines to display.

For example, to define a screen 20 lines high, you would type:
> set height=20

To enable output to be viewed one page at a time, set themoreparameter to on.
> set more=on

� ToRecordCLI Commands in a LogFile
Set the logparameter to the name of the file in which to record the commands.
> set log=/home/examples/log.3c254030

Once the log parameter is set, all subsequent commands are appended to the file. If this file does not
exist, the file is created.

The file is not overwritten, somake sure a new file is created if you want a new set of records.

To stop recording, use the unset command with the logparameter.
> unset log

� ToRecordCommandOutput in a File
To record command output in a file, set the oparameter to the name of the output file.
> set o=/home/examples/output.3c254030

To stop recording, use the unset commandwith the o parameter.

> unset o

� ToTerminate aCLI Session
To terminate a CLI session, type exit.
> exit
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Miscellaneous SunManagement Center
Procedures

This appendix describes several procedures that do not readily fit into other sections of this
document. Specifically, this appendix includes the following information:

� “Monitoring TopologyManager and EventManager” on page 313
� “To Create a Server Component as aMonitoredObject” on page 314
� “To Increase the Critical Threshold for the Virtual Size Data Property in the TopologyManager”

on page 315
� “To Change the Default Values for Smart Delete in the EventManager” on page 316
� “Reading SunManagement Center Log Files” on page 317
� “Adding CustomizedMenu Items” on page 318
� “SNMPMIBs for SunManagement CenterModules” on page 321
� “When anAgent Exits During Startup” on page 322
� “HangingMain ConsoleWindow” on page 323
� “Database Backup and Recovery” on page 325

Monitoring TopologyManager andEventManager
There are five components in the server layer:

� SunManagement Center server
� Topologymanager
� Trap handler
� Configurationmanager
� Eventmanager

With the exception of the server, the other four components are SunManagement Center agents that
are loaded with specializedmodules.

The default configuration for the Topologymanager and the Eventmanager and all other Sun
Management Center agents is defined by theAgent Statistics module. This module includes features
that guard against errors that can bring down the host. The default action is for the software to
terminate the Topologymanager process if predefined thresholds are exceeded. See “Agent Statistics
Module Version 2.0” on page 391 formore information about theAgent Statistics module.
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� ToCreate a Server Component as aMonitoredObject
Youmight want tomonitor the Topologymanager, Trap handler, Configurationmanager, and Event
manager to determine their status. The Configurationmanager and the Trap handler are configured
so that you do not need to perform anymaintenance procedures. In addition, the default
configurations of both the Topologymanager and the Eventmanager work formost user
environments. However, you canmodify the default configurations for specialized environments.

In the main console window, choose Create Object from the Edit menu.

The Create Object window is displayed. By default, the tab is set to Node. Formore information, see
“To Create a Node” on page 61.

Choose Sun Management Center Agent - Host from the Monitor Via menu.

Type the name of the server component in the Node Label field.

(Optional) Type a description of the server component.

Type the name of the Sun Management Center server in the Hostname field.

Type the port number for the server component in the Port field.

SunManagement Center software uses the following default port values:

� Agent component : port 161
� Server trap handler: port 162
� Server eventmanager: port 163
� Server topologymanager: port 164
� Server configurationmanager: port 165

Note – The server component uses port 2099 by default. However, you cannot change the server
component port number here.

Complete this procedure with one of the following actions:

� Click OK to create the server component object and close this window.
� Click theApply button to create the server component object without closing this window.

� ToChange theRegistry PortNumber
The SunManagement Center server includes a registry feature that enables value-added products,
such as Hardware Diagnostics Suite, to register its existence with the server. By default, the registry
feature uses port 5600. If this port is being used by another application, the application will fail. To
change the registry port, follow these steps:

1

2

3

4

5

6

7

Monitoring TopologyManager and EventManager

SunManagement Center 3.6.1 User’s Guide • May 2006314



Change the ServiceRegistryPort value in the
/var/opt/SUNWsymon/cfg/javaserver.properties file.

Change the ServiceRegistryPort value in the
/var/opt/SUNWsymon/cfg/javaservice.properties file to match the value you provided in the
previous step.

Restart the Sun Management Center server.

Note – When you set up the SunManagement Center server, the installation process prompts you to
provide a different port number for the registry service, if the default port is in use.

� To Increase theCritical Threshold for theVirtual Size
DataProperty in the TopologyManager
The Topologymanager enables themain console window to present logical objects in a topology
view. The Topologymanager also provides the ability to create a logical object, such as a group,
whose status summarizes the statuses of multiple managed objects.

Managed objects include networks, hosts, hardware components, and software components. The
total number of objects and the contents of these objects determine the system resource requirement,
for example, Virtual Size, for the Topologymanager. This requirementmust be less than the defaults
set for the Topologymanager.

If the Virtual Size of the Topologymanager exceeds the default value, then the Topologymanager
exits with the following errormessage:

error excessive virtual memory use

To solve this error, increase the default virtual size as described in the following steps.

Evaluate the situation carefully.

Create the Topology manager monitored object.

See “To Create a Server Component as aMonitoredObject” on page 314.

Open the Details window using one of the following methods:

� Press mouse button 3 on the Topologymanager object icon. Choose Details from the pop-up
menu in the hierarchy view or the topology view.

� Double-click the Topologymanager icon.
� Select the Topologymanager icon in themain console window, then choose Details from the

Tools menu.
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In the Browser Details window, double-click the Local Applications icon in the hierarchy (tree) view.

Double-click the Agent Statistics icon in the contents view, or click the expansion icon next to the
Agent Statistics icon in the hierarchy view.

TheAgent Statistics folders are displayed.

Double-click the folder icon for the PA Process Statistics.

Themonitored properties are displayed in a property table.

Select the Virtual Size table cell, then open the Attribute Editor through one of the following
methods:

� Press mouse button 3 in the table row, and chooseAttribute Editor from the pop-upmenu.
� Click theAttributes button.

Click the Alarms tab button.

The alarm rows are displayed.

Type the desired value in the Critical Threshold (>) field.

Complete this procedure with one of the following actions:

� Click OK to create a newCritical Threshold value and close this window.
� Click theApply button to create a newCritical Threshold value without closing this window.

� ToChange theDefault Values for SmartDelete in the
EventManager
The Eventmanager communicates with other server components through SNMPusing the default
port 163. Similar to the Topologymanager, the Eventmanager is also loaded with theAgent Statistics
module. In addition, the Eventmanager is automatically loaded with a specialized Event
Managementmodule. The EventManagementmodule is displayed in the Browser Details window
in the LocalApplications category.

The EventManagementmodule is responsible for the overall maintenance of the event database.
This module’s responsibilities include purging deleted events, renaming the trash file, and Smart
Delete.

Smart Delete means that SunManagement Center software automatically deletes closed, fixed, and
open events from the event database after a set period of time. By default, the closed or fixed events
are removed from the database after 7 days and the open events are removed after 30 days. To change
these defaults, perform the following steps.
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Create the Event manager monitored object.

See “To Create a Server Component as aMonitoredObject” on page 314.

Open the Details window through one of the following methods:

� Press mouse button 3 on the Eventmanager icon. Choose Details from the pop-upmenu in the
hierarchy view or the topology view.

� Double-click the Eventmanager icon in the hierarchy view or the topology view.
� Select the Eventmanager icon in themain console window, then choose Details from the Tools

menu.

In the Browser Details window, double-click the Local Applications icon in the hierarchy (tree) view.

Open the Module Editor through one of the following methods:

� Press mouse button 3 on the EventManagementmodule. Choose EditModule from the pop-up
menu in the hierarchy view or in the contents view.

� Select the EventManagementmodule in the Details window, then choose EditModule from the
Modulemenu.

TheModule Parameters Editor is displayed. Formore information, see “ToModifyModule
Parameters” on page 168.

Type the new time values into the editable fields.

By default, the closed or fixed events are removed from the database after 7 days. The open events are
removed after 30 days.

To turn off Smart Delete, choose Disabled from the Smart Delete Enabled Switch menu.

Click OK to accept the changes that you made and close this window.

Reading SunManagement Center Log Files
The SunManagement Center server and agents write to various log files in the directory
/var/opt/SUNWsymon/log.

These files are circular log files.Acircular log file does not grow in size after a certain limit.As new
messages are logged into the file, the oldest messages are removed.

Use the es-run interface with the ctail and ccat commands to view these log files. The es-run
interface sets up the proper environment to run SunManagement Center utilities. The utilities ccat
and ctail display only the relevant data, after sorting the data in chronological order. The ccat and
ctail commands are similar to the UNIX cat and tail commands, but are intended for use with
SunManagement Center circular log files.

1

2

3

4

5

6

7

Reading SunManagement Center Log Files

AppendixA • Miscellaneous SunManagement Center Procedures 317



Using ccat to ReadSunManagement Center Log Files
The ccat command reads the specified log file, sorts themessages in chronologically ascending
order, and writes to the standard output. The ccat command takes one argument, which is the full
path to the circular log file.

To use the es-run interface with the ccat command, you type:

# /opt/SUNWsymon/sbin/es-run ccat path_to_file/filename

Using ctail to ReadSunManagement Center Log
Files
The ctail command reads the circular log file and by default writes the last 15 lines of the file to
standard output.

The ctail command takes four arguments:

filename The filename argument is the full path name to the circular log file. The filename
argument is mandatory.

-f The -f option is used tomonitor the growth of the log file.As the log file grows, the
messages appended to the file are also written to the standard output. The ctail -f
option is similar to the -f option for the UNIX tail command.

-l The -l option is used to print the absolute line number at the beginning of each
message.

-n The -n NumOfLines option is used to change the number of lines that are displayed. By
default, only the last 15 lines are printed.

To use the es-run interface with the ctail command, you type:

# /opt/SUNWsymon/sbin/es-run ctail [-f, -l, -n NumOfLines] path_to_file_filename

AddingCustomizedMenu Items
SunManagement Center software enables you to customize the Tools menu by adding external,
standalone applications that can be launched from themain console window. The applicationmust
be written in the Java programming language. Non-Java applications can be accommodated by the
ExampleSystemCommand Java wrapper class that executes another program or shell script in a
separate process. The application does not require a selected host object. The application has no
further interaction with SunManagement Center once the application has been launched.
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The name of the application is specified in the console-tools.cfg file. The application name is
added to the Tools menu in themain console window below the standard SunManagement Center
menu items. The application is launched in a separate window.

The console-tools.cfg file is a plain text file that resides on the SunManagement Center server
host. The filemay bemodified at any time, including while the console is running. However, changes
that are introduced by editing the files do not take effect until the es-tool script is executed and the
console is restarted. The file consists of a series of lines, each of which describes an application. Blank
lines and lines beginning with the pound sign (#) are ignored. Fields within each line are separated by
commas (,).

Each application that is implemented as a shell script or as an executable binary is defined by a line
with the following format:

menu_label,class [args]

where:

� menu label is the string that is displayed in the Tools menu. The string can be either localized or
nonlocalized text. Nonlocalized text can contain embedded spaces. Localized text must be
specified as a property-file:key pair, where:
� property-file is the name of the file containing the localizable messages for a particular locale
� key is the identifier used to locate the string that is displayed in the Tools menu in the

property file
Note that spaces are not allowed in the key.

� class is the fully qualified Java class name.
� args is the list of arguments to the class.

For example, the following file shows entries for three applications to be added to the Tools menu:
Example GUI, rlogin, and ftp.

# Format:

# menu_label, class arguments

Example GUI,exampleApp.ExampleGUITool

Rlogin,com.sun.symon.base.client.console.SMSystemCommand

"/usr/openwin/bin/xterm -e rlogin $host" "start rlogin $host"

exampleApp.ExampleSystemCommand:ftp,exampleApp.ExampleSystemCommand

"/usr/openwin/bin/xterm -e ftp $host" "start ftp $host"

Caution – Each entrymust be specified on a single line, even though the text is shownwrapped in the
example.
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The Java wrapper class SMSystemCommand enables you to execute an arbitrary shell command. This
class takes two arguments. The first argument is the shell command to execute.

� If a program name is specified, give a full path name.
� If the command contains embedded spaces, enclose the entire shell command in double quotes.

The second argument is the command to run on aMicrosoftWindows client. The following line is an
example of this command:

com.sun.symon.base.client.console.SystemCommand "<shell command>" "<windows command>"

In this case, the first argument is ignored. Variable substitution is performed on the arguments if
special variable references are present. Two variables are allowed:

� $host, which is replaced with the currently selected agent host name
� $port, which is replaced with the currently selected port number

� ToCustomize the ToolsMenu
Use a standard text editor to add a line to the /var/opt/SUNWsymon/cfg/console-tools.cfg file.

This line specifies the following items:

� Name to display on the Tools menu
� Fully-qualified Java class name for the application
� Any required class arguments

See the detailed description in the section introduction formore information.

Place the Java class files for the applications in the /opt/SUNWsymon/apps/classes directory.

Run the es-toolupdate script on the Sun Management Center server host.
# /opt/SUNWsymon/sbin/es-tool /var/opt/SUNWsymon/cfg/console-tools.cfg

Stop the console by choosing Exit from the File menu on the main console window.

Click the Exit button to exit the application.

Restart the console for the application to be added to the Tools menu.
# /opt/SUNWsymon/sbin/es-start -c

Note – Your site’s configurationmight also require you to restart the SunManagement Center server.
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SNMPMIBs for SunManagement CenterModules
SunManagement Center software publishes the Simple NetworkManagement Protocol
Management Information Bases (SNMPMIBs) for themodules. TheMIB file is anAbstract Syntax
Notation (ASN.1) specification of the data that is modeled, in this case, by the SunManagement
Centermodule. TheseMIBs can be used as the data definition by third-party SNMP-based
management stations, such as HPOpenView andUnicenterTM. SunManagement Center hasMIBs
for the followingmodules:

� file-scan.mib

� health-monitor-mib.mib

� kernel-reader-mib.mib

� nfsmon-mib.mib

� nfsstat-mib.mib

� print-spool-mib.mib

� process-details-mib.mib

� process-monitor.mib

� trap-mib.mib

The aboveMIBs are installed by default, in the /opt/SUNWsymon/util/cfg directory by the Sun
Management Center software during installation of the agent layer. In your installation, your base
directorymight be different.

� ToUse the SunManagement Center SNMPMIBs in a
Third-PartyManagement Station
Preprocess the MIBs.

Some SNMPmanagement stations can read theASN.1MIBs. Others require theASN.1MIBs to be
converted to some other format in order to be read. For example, youmight need to convert theMIB
to a Guidelines for the Description ofManagedObjects (GDMO) format or use aMIB compiler to
generate another intermediate format.

Load the MIB.

Load theASN.1MIB or a preprocessed format of thatMIB into the third-partymanagement station.
This step informs the third-partymanagement station about the layout and composition of the data
that is modeled by theMIB.

Use the MIB information to talk to the Sun Management Center agent.

Once theMIB is successfully loaded into the third-party SNMPagent, you can communicate with
the SunManagement Center agent to get the data from theMIB. TheMIB-II ProxyMonitoring
modulemust be loaded and be enabled in the SunManagement Center agent.

For example, you can start issuing the SNMP Get commands on some of the variables in theMIB.
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By default, the SunManagement Centermodules are enabled for SNMP Get commands by using the
SNMPv1 community public and SNMPv2 user name public. However, if the SunManagement
Centermodule has different settings, then you need to use the correct community name and user
name to communicate with the SunManagement Center agent.

Note – Because SunManagement Center agents operate with SNMPv2 usec-based security, SNMP
Set commands on the agent are involved. Refer to the SNMPv2 usec-related Request For Comments
(RFCs) formore information.

AccessingMultiple InstanceModules
SNMPv2 uses the term context for theMIBs that can havemultiple instances of themodule loaded
on the agent. If you use an SNMPv2-based third-partymanagement station to communicate with
this type of agent, be sure that you are using the right context information. However, if you are using
a SNMPv1-basedmanagement station, then add the context information to the SNMP community
as follows:

community:context

By adding this context information, you can access data frommultiple instances of the samemodule
running on an agent.

WhenanAgent ExitsDuring Startup
The SunManagement Center agent has the ability tomonitor itself and restrict its memory usage.
Some predefined limits have been set for thememory usage of the agent process. These limits depend
on the following criteria:

� Number of modules loaded
� Type ofmodules loaded
� Type of the system beingmanaged

On rare occasions, the limit for default memory usage is exceeded during the agent startup and when
the agent stops running. If this limit is exceeded, the default limits set for the agentmemory size are
not enough for your configuration.

To confirm that memory usage is the cause, look in the /var/opt/SUNWsymon/log/agent.log file for
one of the followingmessages:

Excessive Virtual Memory Use

Excessive Physical Memory Use

When anAgent Exits During Startup
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If you see one of thesemessages during the agent startup, reconfigure thememory usage limits on the
agent host using the following procedure.

� To IncreaseAgentMemory Size
Become superuser on the agent host.
# su -

Copy the file agent-stats-d.def to /var/opt/SUNWsymon.
# cp /opt/SUNWsymon/modules/cfg/agent-stats-d.def /var/opt/SUNWsymon/cfg/

In the /var/opt/SUNWsymon/cfg/agent-stats-d.def file, increase the alarmlimit:error-gt to
the desired value as shown in the following code segment.

The value is in Kbytes.
procstats = {

size = {

statusActions(error-gt)

= abort

statusService(abort)

= _internal

statusCommand(abort)

= abort "Excessive Virtual Memory Use"

alarmlimit:error-gt = 70000

alarmlimit:warning-gt = 60000

alarmlimit:info-gt =

}

.....

}

Save the file and restart the agent.

HangingMainConsoleWindow
This section explains how to respond to a hanging console window in certain circumstances. In this
case, themain console window hangs when users attempt to start a new console window and to
connect to the SunManagement Center server. However, existing console window connections
encounter no problems.

Themain console window can hang for the following reasons:
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� The servermemory is used up.Threads that are reading from a socket can hang when there is a
large discrepancy between the read and write rates at either end of a socket. Thememory
problem occurs when the SunManagement Center server has a large amount of buffered data
waiting to be sent to its clients. The buffered data can become so large that the server runs out of
memory while trying to write to the socket. Once the server is out of memory, the server does not
recover.

Note – If you aremonitoring the server log file, use the following command to check formessages
that the server is out of memory: /opt/SUNWsymon/sbin/es-run ctail -f
/var/opt/SUNWsymon/log/server.log

� The consolememory for the console process is used up.Youmight be able to confirm that the
console process is out of memory. Choose SunManagement Center ConsoleMessages from the
File menu on themain console window. The SunManagement Center ConsoleMessages
windowmight display one ormoremessages that the console is out of memory.

Themethod that you use to resolve a hangingmain console window depends on whichmemory is
filled:

� If the servermemory is used up, increase thememory that is available to the server process. The
default size is 64Mbytes.
For example, to double the default memory from 64Mbytes to 128Mbytes, use this command:

# es-start -s -- -Xmx128m

Note – If you typically invoke your server by using the es-start -A command or by rebooting,
you can automatically set thememory size. To customize the default memory size, change
-Xmx64m to the desired size in the /opt/SUNWsymon/classes/base/server/bin/es-server.sh
file.

� If the consolememory is used up, restart the console with a biggermemory size.
For example, to increase thememory to 100Mbytes, use this command:

# es-start -c -- -Xmx100m

This process allocates morememory to the console for the current session.

Note – To allocatemorememory automatically, change the default memory size from -Xmx64m to
the desired size in the /opt/SUNWsymon/classes/base/console/bin/es-console.sh file.

HangingMain ConsoleWindow

SunManagement Center 3.6.1 User’s Guide • May 2006324



DatabaseBackupandRecovery
Your SunManagement Center database sometimes needs to be backed up to prevent loss of data. For
example, you should back up your database before you upgrade the hardware or the operating
system. You can back up the SunManagement Center database in one of these ways:

� Shut down the product and then perform the backup (cold backup)
� Perform the backup while the product is still running (online backup)

ColdBackup
In a cold backup, you shut down the product first and then perform the backup. Before setting up the
online backup feature, perform a cold backup as a contingency.

� Performing theColdBackup

Become superuser.
# /opt/SUNWsymon/sbin/es-backup

Because the script shuts down SunManagement Center, you are prompted to confirm.

Type y and press Enter.

You are prompted for the full directory path to store the backup data files.

Press Enter to accept the default directory or type a new path.

The script creates the backup files and then restarts the product.

OnlineBackup
This procedure guides you through these tasks:

� Running a cold backup for contingency
� Enabling ARCHIVELOGMODE, which shuts down SunManagement Center and sets up archiving
� Backing up the database online

Using online backup has these advantages. You can back up the database up to the current moment
without stopping the product. You can disable or enable ARCHIVELOGmode at any time.

Note –Online backup does not shut down the product.
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� Performing theOnlineBackup

(Optional) Perform a cold backup. See “Performing the Cold Backup” on page 325.

Enable ARCHIVELOGMODE.

a. Become superuser.
# /opt/SUNWsymon/sbin/es-config -a enable

You are prompted to confirm that you want to enable archiving.

b. Type y and press Enter.

Because the script will shut down SunManagement Center, you are prompted to confirm.

c. Type y and press Enter.

The script shuts down the product and recommends a cold backup. You are prompted to confirm
that you want to set up the database in ARCHIVELOGMODE.

d. Type y and press Enter.

You are prompted for the full directory path to store the archive log files.

e. Type the full path, for example:
Enter full directory path to store the archive log files:

/var/opt/SUNWsymon/archives

The script creates the directory if it does not exist and enables ARCHIVELOGMODE. You are
prompted to start the agent and server components.

f. Type y and press Enter.

Run the online backup.

a. Type this command:
# /opt/SUNWsymon/sbin/es-backup -o

You are prompted for the full directory path to store the backup data files.

b. Press Enter to accept the default or type a different path, for example:
Enter full directory path to store the backup data files [/var/opt/SUNWsymon/backup]:

/var/opt/SUNWsymon/mybackup
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Note – If you accept the default directory and later plan to uninstall the product, your backup files
might be deleted. Before uninstalling the product, move the backup files to another location.
Alternatively, use a different path for your backup files.

� Disabling ARCHIVELOGMODE
If you do not want archiving on, you can disable archiving.

To disable ARCHIVELOGMODE, type this command:
# /opt/SUNWsymon/sbin/es-config -a disable

SunManagement Center is shut down, the archive log files are removed, and the product is restarted.

� ShuttingDown theProduct BeforeBackingUp

If you want to shut down the product before doing a backup, you have two options:

� To run the backup interactively, type this command:

# /opt/SUNWsymon/sbin/es-backup

� To run the backup in silent mode and use default answers to the script’s questions, type this
command:

# /opt/SUNWsymon/sbin/es-backup -y

The database files are saved in the directory /var/opt/SUNWsymon/backup.

If you need to periodically run the es-backup script, you can set a cron program for the script to be
run on a routine basis. In this case, use the -y option for the es-backup script so that no interaction is
needed.

Note – Both scripts shut down the SunManagement Center processes before starting the restore or
backup. These scripts also restart the processes once the recovery or backup has been completed.

� Recovering theDatabase

If your Sun Management Center database has been inadvertently corrupted due to a system failure,
run the following interactive script as superuser to restore your database:
# /opt/SUNWsymon/sbin/es-restore

For example, youmight want to follow this process if the system failure is due to a file system
problem.

◗

◗

◗
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Internet Protocol Routing

This appendix provides an overview of IP routing. The chapter describes the following topics:

� “Overview of IPAddressing” on page 329
� “Using Subnets” on page 330
� “Using Netmasks” on page 330

Overviewof IPAddressing
Internet protocol (IP) addresses are 32 bits long. Thus, there is a possibility of approximately a total 4
billion addresses for the entire Internet.An IP address is expressed as a series of octets separated by
dots. For example, the address 11111111 00000001 00000101 00001010 is written as 127.1.5.10, or
using hexadecimal notation, 7f.1.5.a0.

Because of this vast number of addresses, the network is organized hierarchically into administrative
domains. This organization led to the definition of name administrative domains and network
classes. Since each site can vary in size, IP addresses are divided into threemain types or classes.A
large site can reserve a classAaddress and receive 224 individual addresses.Asmall site can reserve a
class C address and receive 28 individual addresses.

NetworkClasses
ClassAuses the first octet for the network address, and the rest for host addresses within this
network. For example, a site whose network address is 129.0.0.0 would own the 224 addresses
between 129.0.0.0 and 129.255.255.255.

Network Host

0xxxxxxx xxxxxxxx xxxxxxxx xxxxxxxx
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Class B uses two octets for the network address, and two for the host address. For example, a site
whose network address is 129.123.0.0 would own the 216 addresses between 129.123.0.0 and
129.123.255.255.

Network Host

10xxxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Class C uses three octets for the network address, and one octet for the host address. For example, a
site whose network address is 129.123.56.0 would own the 28 addresses between 129.123.56.0 and
129.123.56.255.

Network Host

110xxxxx xxxxxxxx xxxxxxxx xxxxxxxx

Using Subnets
Subnetting divides a network into smaller segments, or subnets. This technique is imperative for
ClassAand B networks. Routers do not forward packets outside a subnet if the destination address is
within the same subnet. Thus, network traffic is decreased dramatically by segmenting a large
network. For example, suppose a class B network is segmented into 255 subnets. Unless a packet
destination is a host outside the subnet, a local packet is sent to 255 hosts instead of 256,000.

UsingNetmasks
The format of the netmask is a series of 1s followed by a series of 0s. ByANDing an IP address with a
netmask, you can get the address of the subnet.

Routers use netmasks to decide whether to forward a packet to an external subnet. For example,
suppose amachine with an IP address of 129.123.56.95 sends an email to anothermachine whose IP
address is 129.123.56.100. ByANDing both IP addresses with a netmask (255.255.255.0), the result is
129.123.56.0 for bothmachines. The router then concludes that the sourcemachine and the
destinationmachine are in the same subnet. Therefore, the router does not forward the email to
external subnets.

On the other hand, if the destination address is 129.123.67.100, then the resulting subnet address is
129.123.67.0. The router forwards the email to the external subnet (129.123.67.0).

Using Subnets
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Note – Although some of these examples only apply to Ethernet links, the principles apply regardless
of the network type.

UsingNetmasks
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SunManagement Center SoftwareModules

The SunManagement Center software usesmodules tomonitor various components of your system.
Themodules can be separated into four categories: hardware, operating environment, local
applications, and remote systems. This appendix provides additional information about themodules
that are described in Chapter 11. In addition, this chapter identifies themodules that are in the four
categories.

Formore information about othermodules that might be applicable to your particular system, see
the SunManagement Center web site: http://www.sun.com/sunmanagementcenter/.

This appendix describes the followingmodules:

� Hardware
� “Volume SystemMonitoringModule Version 1.0” on page 336
� “Sun StorEdgeA5x00ArrayModule” on page 337
� “Sun StorEdge T3ArrayModule” on page 344
� “X86/X64 Config ReaderModule Version 1.0” on page 357

� Operating System
� “FileMonitoringModule Version 2.0” on page 359
� “IPv6 InstrumentationModule Version 1.0” on page 359
� “Kernel Reader (Simple)Module Version 1.0” on page 365
� “MIB-II InstrumentationModule Version 1.0” on page 377
� “MIB-II (Simple)Module Version 1.0” on page 385
� “NFS File SystemsModule Version 2.0” on page 387
� “NFS StatisticsModule Version 2.0” on page 388
� “Solaris Process DetailsModule Version 2.0” on page 389

� Local and RemoteApplications
� “Agent StatisticsModule Version 2.0” on page 391
� “Data Logging RegistryModule Version 2.0” on page 396
� “LogviewACLVersion 1.0” on page 396
� “Print SpoolerModule Version 3.0” on page 397
� “HP JetDirectModule Version 2.0” on page 398
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� “MIB-II ProxyMonitoringModule Version 2.0” on page 399
� Advanced SystemMonitoring

� “Directory SizeMonitoringModule Version 2.0” on page 399
� “FaultManagerModule Version 1.0” on page 400
� “File ScanningModule Version 2.0” on page 402
� “Hardware Diagnostic Suite Version 2.0” on page 404
� “HealthMonitorModule Version 2.0” on page 404
� “Kernel ReaderModule Version 2.0” on page 408
� “ProcessMonitoringModule Version 2.0” on page 408
� “ServiceManagement FacilityModule Version 1.0” on page 410

OverviewofModuleRelationships
Most of the SunManagement Centermodules have default monitoring conditions that generate
alarms when system values fall outside of these conditions. You can alter these default thresholds by
creating your own alarm thresholds, as explained in Chapter 12.

Somemodules utilize theAdd Row operation to define the data properties tomonitor. These
modules start with empty tables. You have to execute anAdd Row operation to activate the specifics
formonitoring thesemodules.

The following table lists themodules described in this appendix. The table identifies the following
information for eachmodule:

� Themodule name
� The version of themodule that applies to the SunManagement Center 3.6.1 product
� An indication that themodule is loaded automatically
� An indication that more than one copy of themodule can be loaded
� An indication that themodule uses theAdd Row operation

TABLE C–1Module SummaryTable

Alphabetical Listing of Modules Version
Module Loads
Automatically

Module Loads
Multiple Times

Module Uses Add
Row Utility

Agent Statistics 2.0 X

Agent Update 1.0

Config-Reader1 1.0 X

Data Logging Registry 2.0

Directory SizeMonitoring 2.0 X X
1 Refer to your platform-specific supplement formore information about the Config-Readermodule.
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TABLE C–1Module SummaryTable (Continued)

Alphabetical Listing of Modules Version
Module Loads
Automatically

Module Loads
Multiple Times

Module Uses Add
Row Utility

Dynamic Reconfiguration
Module2

1.0

FaultManager 1.0

FileMonitoring 2.0 X X3

File Scanning 2.0 X4 X5 X6

HP JetDirect 2.0 X

Hardware Diagnostic Suite 2.0

HealthMonitor 2.0

IPv6 Instrumentation 1.0

Kernel Reader 2.0

Kernel Reader (Simple) 1.0 X

LogviewACL 1.0 X

MCPManager 1.0

MIB-II Instrumentation 1.0

MIB-II ProxyMonitoring 2.0 X

MIB-II System (Simple) 1.0 X

NFS File Systems 2.0 X

NFS Statistics 2.0

Print Spooler 3.0 X

ProcessMonitoring 2.0 X X7

ServiceManagement Facility 1.0 X

Solaris Process Details 2.0

StorageA5x00 1.0

Sun StorEdge T3 1.0
2 Refer to your platform-specific supplement formore information about the Dynamic Reconfigurationmodule.
3 Each added row defines which file tomonitor.
4 File Scanning is loaded automatically for the System Log file.
5 Each instance identifies the file to be scanned.
6 Each added row defines which pattern within themonitored file tomatch. The row needs to be added to the Scan Table table.
7 Each row defines the pattern tomatch from all the processes that are running on the agent host.
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TABLE C–1Module SummaryTable (Continued)

Alphabetical Listing of Modules Version
Module Loads
Automatically

Module Loads
Multiple Times

Module Uses Add
Row Utility

Volume SystemMonitoring 1.0 X

X86/X64 Config Reader 1.0 X

HardwareModules
When the followingmodules are loaded, thesemodules are found under the Hardware section of the
Module Browser tab in the Details window:

� “Volume SystemMonitoringModule Version 1.0” on page 336
� “Sun StorEdgeA5x00ArrayModule” on page 337
� “Sun StorEdge T3ArrayModule” on page 344
� “X86/X64 Config ReaderModule Version 1.0” on page 357

VolumeSystemMonitoringModuleVersion 1.0
The Volume SystemMonitoringmodulemonitors a set of attributes managed by the N1 System
Manager (SystemManager) agent and displays them in theModule Browser.

� ToAccess the SystemManager Server ThroughWebConsole

Navigate through the topology or hierarchy view until you have accessed the System Manager server
that has Volume System Monitoring add-on.

Press mouse button 3 and choose Launch Webconsole from the pop-up menu.

Abrowser opens at the following site:

https://<n1smservername>:<n1smserverport>

Where <n1smservername> is the host name of the SystemManager server and <n1smserverport> is
the port number on which the SystemManager server is listening.

Log in to the System Manager server with appropriate credentials.

� ToAccess the SystemManager Server Through SSH
Secure Shell (ssh) is a program for logging into a remotemachine and for executing commands on a
remotemachine. This program connects and logs into the specified hostname. The usermust prove
the identity to the remotemachine using one of several methods depending on the protocol version
used.
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Navigate through the topology or hierarchy view until you have accessed the System Manager server
that has Volume System Monitoring add-on.

Press mouse button 3 and choose SSH to Host from the pop-up menu.

The ssh program on the SystemManager server is started.

Log in to the System Manager server with appropriate credentials.

SunStorEdgeA5x00ArrayModule
Thismodule enables you tomonitor the state of Sun StorEdgeA5000, 5100, and 5200 storage
devices, andmanage alarms on these devices. The following series of tables identifies the specific
rules for each Sun StorEdgeA5x00 array.

TABLE C–2Rules for Sun StorEdgeA5x00

Rules Property

sunSmTreeProp tree prop

sunSmNodeName Name

timestamp_raw timestamp_raw

timestamp Name

status_change Number OfModel property/value changed.

This value changes when there is a difference between the previous snapshot and
the current snapshot.

TABLE C–3 Sun StorEdgeA5x00 SenaTable

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

dataFormat Instance

rowstatus Row status

box_rev Box_rev

device_count Device_count

box_id Box Id
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TABLE C–3 Sun StorEdgeA5x00 Sena Table (Continued)
Property Description

instance Instance

logical_path Logical Path

machine Machine

name Name

node-wwn Node-wwn

physical_path Physical Path

platform Platform

set_flg Set Flag

slot_count Slot_count

type Type

vendor_name Vendor_name

virtual_node Virtual_node

TABLE C–4 Sun StorEdgeA5x00 Front Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

instance Instance

TABLE C–5 Sun StorEdgeA5x00Rear Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

entry number Instance
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TABLE C–6 Sun StorEdgeA5x00Disk Backplane Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current node name

entry_no Entry number

byp_a_enabled Byp_a_enabled

byp_b_enabled Byp_b_enabled

fru fru

status Status

alarmRules rpho400

TABLE C–7 Sun StorEdgeA5x00 FanTray Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fan_fail Fan_fail

fru fru

speed Speed

status Status

alarmRules rpho401

type Type

TABLE C–8 Sun StorEdgeA5x00 LedTable

Property Description

sunSmTreeProp tree prop

sunSmNodeName Name

entry_no entry number

led-num LedNo

state State
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TABLE C–9 Sun StorEdgeA5x00 Front Slot Table

Property Description

front_slotTbl Front_slot Table

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho411

power_status power-status

alarmRules rpho414

slot-num Slot-num

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho407

TABLE C–10 Sun StorEdgeA5x00Rear Slot Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

connect_disk connect_disk_name

id Id

loop_status Loop_status

alarmRules rpho412

power_status power-status

alarmRules rpho414

slot-num Slot-num
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TABLE C–10 Sun StorEdgeA5x00 Rear Slot Table (Continued)
Property Description

status Status

temperature Temperature

temperature_status Temperature_status

alarmRules rpho408

TABLE C–11 Sun StorEdgeA5x00Disk Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

capacity Capacity

device_type Device Type

firmware_revision firmware_revision

fru Fru

hard_address HardAddress

instance Instance

logical_path logical_path

mounted_partitions Mounted Partitions

name Name

node-wwn NodeWwn

physical_path physical_path

port-wwn PortWwn

product_name product_name

revision revision

serial_number serial_number

status Status

alarmRules rpho406

vendor_name vendor_name
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TABLE C–12 Sun StorEdgeA5x00 Sena Power Supply Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

AC_status AC_status

DC-current DC-current

DC-voltage DC-voltage

ps-instance Ps-instance

status Status

alarmRules rpho402

temperature_status Temperature_status

alarmRules rpho409

type Type

TABLE C–13 Sun StorEdgeA5x00 Interconnect Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

eprom_failure Eprom_failure

fru Fru

status Status

alarmRules rpho405

TABLE C–14 Sun StorEdgeA5x00 Interface_boardTable

Property Description

interface_board-entry entry_no

sunSmTreeProp sunSmTreeProp
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TABLE C–14 Sun StorEdgeA5x00 Interface_board Table (Continued)
Property Description

sunSmNodeName Current Name

entry_no entry number

fru Fru

interface_board-instance Ib-Instance

loop Loop

loop0_fault Loop0_fault

loop1_fault Loop1_fault

status Status

alarmRules rpho400

temperature_status temperature_status

alarmRules rpho410

TABLE C–15 Sun StorEdgeA5x00 Loop –Gbic Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

fru Fru

loop-instance Gbic-Instance

status Status

alarmRules rpho413

loop_configuration_status Loop Configuration

TABLE C–16 Sun StorEdgeA5x00Rules

Rule Description

rpho414 Fibre Channel OFFLINE

rpho415 Fibre Channel CRC Error

rpho416 ASC 0x47

rpho417 Drive operationmarginal
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TABLE C–16 Sun StorEdgeA5x00Rules (Continued)
Rule Description

rpho418 Failure prediction

rpho419 Incomplete DMAXFER on sbus

rpho420 Offline Timeout

rpho421 soc lilpmap failed

SunStorEdgeT3ArrayModule
Thismodule enables you tomonitor the state of Sun StorEdge T3 storage devices and tomanage
alarms on these devices.

TABLE C–17 Sun StorEdge T3Module – Basic Properties Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

rowstatus Row Status

sysId id

sysVendor vendor

sysModel model

sysRevision firmware revision

sysStatus Status of the connection between the agent and the T300 storage box

sysIpAddr IP address

sysSubNet subnet mask

sysGateway gateway

sysBootMode bootmode

sysBootDelay boot delay

sysMpSupport multi-pathing support

sysHasVolumes has volumes
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TABLE C–18 Sun StorEdge T3Module –Advanced Properties Table

Property Description

t300name t300name

rowstatus Row Status

sysStripeUnitSize stripe unit size

sysCacheMode cachemode

sysCacheMirror cachemirror

sysReadAhead read ahead

sysReconRate reconRate

sysOndgMode ondgMode

sysOndgTimeslice ondgTimeslice

sysTftpHost tftp host

sysTftpFile tftp file

sysLastRestart ast restart time

sysDate date

sysTime time

sysTimezone time zone

TABLE C–19 Sun StorEdge T3Module – Statistical Properties Table

Property Description

t300name t300name

sysTotalRequests total requests

sysWriteRequests write requests

sysReadRequests read requests

sysTotalBlocks total blocks

sysBlocksWritten blocks written

sysBlocksRead blocks read

sysCacheWriteHits cacheWriteHits

sysCacheWriteMisses cacheWriteMisses

sysCacheReadHits cacheReadHits
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TABLE C–19 Sun StorEdge T3Module – Statistical Properties Table (Continued)
Property Description

sysCacheReadMisses cacheReadMisses

sysCacheRmwFlushes sysCacheRmwFlushes

sysCacheReconFlushes cacheReconFlushes

sysCacheStripeFlushes cacheStripeFlushes

clear-flag clear flag

TABLE C–20 Sun StorEdge T3Module –Unit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

unitType unit type

unitStandby standby

unitIsControllerUnit isControllerUnit

machine machine

platform platform

TABLE C–21 Sun StorEdge T3Module –Disk Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–22 Sun StorEdge T3Module –Disk Properties Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name
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TABLE C–22 Sun StorEdge T3Module –Disk Properties Table (Continued)
Property Description

unitId unit id

fruStatus status

alarmRules rple400

fruDiskRole disk role

fruDiskCapacity disk capacity

fruDiskTemp temperature

fruID

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

TABLE C–23 Sun StorEdge T3Module –Advanced Properties Table

Property Description

t300name t300name

unitId unit id

fruId fru id

fruDiskPort1State port1 state

fruDiskPort2State port2 state

fruDiskStatusCode status code

fruDiskVolId disk volid

fruDiskVolIndex disk volindex

fruDiskVolName disk volname

fruDiskIsRebuildable

fruDiskIsRoleData isRoleData

fruDiskIsRoleStandby isRoleStandby
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TABLE C–23 Sun StorEdge T3Module –Advanced Properties Table (Continued)
Property Description

fruDiskIsRoleUndefined sUndefined

fruDiskIsExpendable isExpendable

TABLE C–24 Sun StorEdge T3Module –Controllers

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–25 Sun StorEdge T3Module –Controller Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

alarmRules rple401

TABLE C–26 Sun StorEdge T3Module – Loopcards

Property Description

loopcards-entry entry_no

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name
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TABLE C–26 Sun StorEdge T3Module – Loopcards (Continued)
Property Description

entry_no entry number

TABLE C–27 Sun StorEdge T3Module – LoopCard Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

fruStatus status

fruLoopMode loopmode

fruLoopCable1State cable1 state

fruLoopCable2State cable2 state

fruLoopTemp temperature

alarmRules rple402

TABLE C–28 Sun StorEdge T3Module – Power CoolingUnit Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status
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TABLE C–28 Sun StorEdge T3Module – Power CoolingUnit Table (Continued)
Property Description

fruPowerPowOutput output state

fruPowerPowSource input source

fruPowerPowTemp temperature

fruPowerFan1State fan1 state

fruPowerFan2State fan2 state

fruPowerBatState battery state

fruPowerBatLife battery life

fruPowerBatUsed battery used

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

alarmRules rple403

TABLE C–29 Sun StorEdge T3Module –Midplane Table

Property Description

sunSmTreeProp true

sunSmNodeName Current Name

t300name t300name

unitId unit id

fruStatus status

fruId

fruState

fruVendor

fruModel
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TABLE C–29 Sun StorEdge T3Module –Midplane Table (Continued)
Property Description

fruRevision

fruSerialNo

fruErrors

fruId

fruState

fruVendor

fruModel

fruRevision

fruSerialNo

fruErrors

TABLE C–30 Sun StorEdge T3Module –Volume (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

volId volume id

volName volume name

volWWN volumeWWN

volStatus volume status

volCacheMode cachemode

volCacheMirror cachemirror

volCapacity volume capacity

volArrayWidth drive number

volRaidLevel RAID (RedundantArray of Independent/Inexpensive Disks) level for the volume

volDisabledDisk

volSubstitutedDisk
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TABLE C–30 Sun StorEdge T3Module –Volume (Basic Properties Table) (Continued)
Property Description

volInitRate

volVerifyRate

TABLE C–31 Sun StorEdge T3Module – Statistical Properties Table

Property Description

t300name t300name

unitId unit id

volId volume id

volTotalRequests total requests

volWriteRequests write requests

volReadRequests read requests

volTotalBlocks total blocks

volBlocksWritten blocks written

volBlocksRead blocks read

volSoftErrors soft errors

volFirmErrors firm errors

volHardErrors hard errors

volCacheWriteHits cacheWriteHits

volCacheWriteMisses cacheWriteMisses

volCacheReadHits cacheReadHits

volCacheReadMisses cacheReadMisses

volCacheRmwFlushes cacheRmwFlushes

volCacheReconFlushes cacheReconFlushes

volCacheStripeFlushes cacheStripeFlushes

clear-flag clear flag

TABLE C–32 Sun StorEdge T3Module – Ports

Property Description

sunSmTreeProp sunSmTreeProp
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TABLE C–32 Sun StorEdge T3Module – Ports (Continued)
Property Description

sunSmNodeName Current Name

entry_no entry number

TABLE C–33 Sun StorEdge T3Module – Port (Basic Properties Table)

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

portWWN portWWN

portStatus port status

portType port type

portFruId port fruId

portSunHost port sunHost

portFibreCount fibre count

portFibreAlpaMode ALPAmode

portFibreAlpa ALPA

TABLE C–34 Sun StorEdge T3Module – Statistical Properties Table

Property Description

t300name 300name

unitId Unit ID

portId Port ID

portTotalRequests Total requests (read requests plus write requests)

portWriteRequests Write requests

portReadRequests Read requests

portTotalBlocks Total blocks

portBlocksWritten Blocks written
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TABLE C–34 Sun StorEdge T3Module – Statistical Properties Table (Continued)
Property Description

portBlocksRead Blocks read

TABLE C–35 Sun StorEdge T3Module –Attachments Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–36 Sun StorEdge T3Module –Attachment Table

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

t300name t300name

unitId unit id

portId portId

attachId attach id

attachLun attach Lun

attachMode attachmode

attachVolId attach volid

attachVolName attach volname

TABLE C–37 Sun StorEdge T3Module – Loops

Property Description

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

entry_no entry number

TABLE C–38 Sun StorEdge T3Module – Loops Table

Property Description

sunSmTreeProp sunSmTreeProp
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TABLE C–38 Sun StorEdge T3Module – Loops Table (Continued)
Property Description

sunSmNodeName Current Name

t300name t300name

unitId unit id

loopId loop id

loopStatus loop status

loopMux loopmux

loopIsAvailable isAvailable

loopIsReserved isReserved

loopIsIsolated isIsolated

loopIsTop isTop

loopIsBottom isBottom

loopIsMiddle isMiddle

TABLE C–39 Sun StorEdge T3Module –Midplanes Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

TABLE C–40 Sun StorEdge T3Module – Powerunits Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

TABLE C–41 Sun StorEdge T3Module –Volumes Table

Property Description

entry_no Entry number

sunSmTreeProp sunSmTreeProp
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TABLE C–41 Sun StorEdge T3Module –Volumes Table (Continued)
Property Description

sunSmNodeName Current Name

TABLE C–42 Sun StorEdge T3Module – Logging Table

Property Description

t300name

sunSmTreeProp sunSmTreeProp

sunSmNodeName Current Name

rowstatus

logStatus

logPort

logTo

logLevel

TABLE C–43 Sun StorEdge T3Module – Rules

Rule Description

rple201 Controller Error

rple202 Power Cooling Unit Error

rple203 Loop Card Error

rple204 Disk Error

rple205 ControllerWarning

rple206 Power Cooling UnitWarning

rple207 Loop CardWarning

rple208 DiskWarning

rple209 DC error

rple210 Power supply unit disabled

rple211 Power supply off

rple212 Power supply error

rple213 Batterymissing

rple214 Loop cardmissing
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TABLE C–43 Sun StorEdge T3Module – Rules (Continued)
Rule Description

rple215 Interconnect cablemissing

rple216 Loop card disabled

rple220 Disk Error

rple221 Power Cooling Unit Error

rple222 Power Cooling Unit Error

rple223 ControllerWarning

rple224 Loop CardWarning

rple225 DiskWarning

rple226 DiskWarning

rple227 Power Cooling UnitWarning

rple400 FRU or disk. Use fruState and fruStatus to decide whether disk is normal.

rple401 FRU or controller. Use fruState and fruStatus to decide whether controller is
normal.

rple402 FRU or loop-card. Use fruState and fruStatus to decide whether loop-card is
normal.

rple403 FRU or power cooling unit. Use fruState and fruStatus to decide whether power
cooling unit is normal.

rple404 System or basic-table, basic-entry, or sysStatus rule. If sysStatus is not equal to OK, the
T3 array has a fault.

X86/X64ConfigReaderModuleVersion 1.0
The X86/X64 Config Readermodule enables you tomonitor a set of hardware-specific attributes and
displays them in theModule Browser. The family type exported by this module is
x86–Generic-i86pc.

The X86/X64 Config Readermodule has the followingmanaged objects:

� System table
� CPUUnits table
� NetworkDevices table
� Media Devices

The System table has the following properties:

� Name
� Operating System
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� Operating SystemVersion
� SystemClock Frequency
� Architecture
� HostnameOf The System
� Machine Name
� System Platform
� Serial Number
� Timestamp
� RawTimestamp
� Total Disks
� TotalMemory
� Total Processors
� Total Tape Devices

The CPUUnits table has the following properties:

� Name
� Clock Frequency
� CPUType
� Model
� Status
� Unit

TheNetwork Devices table has the following properties:

� Interface Name
� Device Type
� EthernetAddress
� InternetAddress
� Symbolic Name

TheMedia Devices table has the following properties:

� Name
� Device Id
� RemovableMedia
� Product Id
� Vendor Id
� Physical Path
� Hard Error Count
� Soft Error Count
� Transport Error Count
� Predictive Failure Count
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Operating System
The software provides several modules that monitor the operating system on your host.When the
followingmodules are loaded, thesemodules are found under the Operating System section of the
Module Browser tab in the Details window:

� “FileMonitoringModule Version 2.0” on page 359
� “IPv6 InstrumentationModule Version 1.0” on page 359
� “Kernel Reader (Simple)Module Version 1.0” on page 365
� “MIB-II InstrumentationModule Version 1.0” on page 377
� “MIB-II (Simple)Module Version 1.0” on page 385
� “NFS File SystemsModule Version 2.0” on page 387
� “NFS StatisticsModule Version 2.0” on page 388
� “Solaris Process DetailsModule Version 2.0” on page 389

FileMonitoringModuleVersion 2.0
Thismodule enables you tomonitor the files on a host. You can isolate any file or number of files and
monitor those files individually by loadingmultiple instances of the FileMonitoringmodule. This
module requires you to add rows for the data property tables. Formore information, see “ToAdd a
Row to a Data Property Table” on page 133.

The following table lists the FileMonitoring Status properties and their descriptions.

TABLE C–44FileMonitoringProperties

Property Description

Name Name of the file beingmonitored

Description Descriptive name provided for this file when added

Filename File beingmonitored

LastModified Date and time the file last changed

File Size (Bytes) Size of the file

Size Rate (Bytes) Number of bytes written per second

IPv6 InstrumentationModuleVersion 1.0
This section presents information on the IPv6 Instrumentationmodule, which comprises the groups
that are described in the following sections:

� “IPv6 IPGroup Properties” on page 360
� “IPv6 TCPProperties” on page 363
� “IPv6 UDPProperties” on page 363
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� “IPv6 ICMPProperties” on page 364

IPv6 IPGroupProperties
The tables that are in this section identify the IPv6 IPGroup properties.

The following table identifies the properties that are shown in the IPv6 IPGroup Table.

TABLE C–45 IPv6 IPGroupTable

Property Description

IPv6 Forwarding Number of forwards enabled

IPv6Default Hop Limit Hop limit (default 255)

IPv6 Interface Number of interfaces

IPv6 Route Number Route number

The following table identifies the properties that are shown in the IPv6 If Table.

TABLE C–46 IPv6 If Table

Property Description

IPv6 If Index Index

IPv6 If Descr Description

IPv6 If Lower Layer

IPv6 If EffectiveMtu

IPv6 If ReasmMax Size

IPv6 If Identifier

IPv6 If Identifier Length

IPv6 If PhysicalAddress

IPv6 IfAdmin Status

IPv6 If Oper Status

The following table identifies the properties that are shown in the IPv6 If Stats Table.
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TABLE C–47 IPv6 If Stats Table

Property Description

IPv6 If Index

IPv6 If Stats In Receives

IPv6 If Stats InHdr Errors Number of incoming headers that had errors

IPv6 If Stats In Too Big Errors Number of incoming packets that were too big

IPv6 If Stats In No Routes

IPv6 If Stats InAddr Errors

IPv6 If Stats In Unknown Protos

IPv6 If Stats In Truncated Pkts Number of incoming packets that were truncated

IPv6 If Stats In Discards

IPv6 If Stats In Delivers

IPv6 If Stats Out ForwDatagrams

IPv6 If Stats Out Requests

IPv6 If Stats Out Discards

IPv6 If Stats Out Frag OKs

IPv6 If Stats Out Frag Fails

IPv6 If Stats Out Frag Creates

IPv6 If Stats ReasmReqds Reassembled

IPv6 If Stats ReasmOKs

IPv6 If Stats Reasm Fails

IPv6 If Stats InMcast Pkts

IPv6 If Stats OutMcast Pkts

The following table identifies the properties that are shown in the IPv6Addr Prefix Table.

TABLE C–48 IPv6Addr PrefixTable

Property Description

IPv6 If Index

IPv6Addr Prefix Prefix for physical address
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TABLE C–48 IPv6Addr PrefixTable (Continued)
Property Description

IPv6Addr Prefix Length

IPv6Addr PrefixOn Link Flag

IPv6Addr PrefixAutonomous Flag

The following table identifies the properties that are shown in the IPv6Addr Table.

TABLE C–49 IPv6AddrTable

Property Description

IPv6 If Index

IPv6AddrAddress

IPv6Addr Pfx Length

IPv6Addr Type

IPv6AddrAnycast Flag

IPv6Addr Status

The following table identifies the properties that are shown in the IPv6 Route Table.

TABLE C–50 IPv6RouteTable

Property Description

IPv6 Route Dest

IPv6 Route Pfx Length

IPv6 Route Index

IPv6 Route If Index

IPv6 Route Next Hop

IPv6 Route Type

IPv6 Route Protocol

IPv6 Route Policy

IPv6 RouteAge

IPv6 Route Next Hop RDI
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TABLE C–50 IPv6Route Table (Continued)
Property Description

IPv6 RouteMetric

IPv6 RouteWeight

IPv6 Route Info

IPv6 Route Valid

The following table identifies the properties that are shown in the IPv6Net toMediaTable.

TABLE C–51 IPv6Net ToMedia Table

Property

IPv6IfIndex

IPv6NetToMediaNetAddress

IPv6NetToMedia PhysAddress

IPv6NetToMedia Type

IPv6IfNetToMedia State

IPv6IfNetToMedia LastUpdated

IPv6NetToMedia Valid

IPv6 TCPProperties
The following table identifies the properties that are shown in the IPv6 Conn Table.

TABLE C–52 IPv6ConnTable

Property Description

IPv6 Conn State Connectivity state

IPv6 Conn LocalAddress Connectivity local IP address

IPv6 Conn Local Port Connectivity local port number

IPv6 Conn RemAddress Connectivity remote IP address

IPv6 Conn RemPort Connectivity remote port number

IPv6UDPProperties
The following table identifies the properties that are shown in the IPv6UDPTable.
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TABLE C–53 IPv6UDPTable

Property Description

IPv6 Udp LocalAddress IP address

IPv6 Udp Local Port Port number

IPv6Udp If Index Index

IPv6 ICMPProperties
The following table identifies the properties that are shown in the IPv6 If ICMPTable.

TABLE C–54 IPv6 If ICMPTable

Property Description

IPv6 If Index

IPv6 If Icmp InMsgs Number of incomingmessages

IPv6 If Icmp In Errors Number of incoming errors

IPv6 If Icmp InDest Unreachs Number of unreachable incoming destinations

IPv6 If Icmp InAdmin Prohibs

IPv6 If Icmp In Time Excds

ivp6 If Icmp In Parm Problems

ivp6 If Icmp In Pkt Too Bigs

IPv6 If Icmp In Echos

IPv6 If Icmp In Echo Replies

IPv6 If Icmp In Router Solicits

IPv6 If Icmp In RouterAdvertisements

IPv6 If Icmp InNeighbor Solicits

IPv6 If Icmp InNeighborAdvertisements

IPv6 If Icmp In Redirects

IPv6 If Icmp InGroupMembQueries

IPv6 If Icmp InGroupMembResponses

IPv6 If Icmp InGroupMembReductions

IPv6 If IcmpOutMsgs
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TABLE C–54 IPv6 If ICMPTable (Continued)
Property Description

IPv6 If IcmpOut Errors

IPv6 If IcmpOut Dest Unreachs

Ipv6 If IcmpOutAdmin Prohibs

IPv6 If IcmpOut Time Excds

IPv6 If IcmpOut Parm Problems

IPv6 If IcmpOut Pkt Too Bigs

IPv6 If IcmpOut Echos

IPv6 If IcmpOut Echo Replies

IPv6 If IcmpOut Router Solicits

IPv6 If IcmpOut RouterAdvertisements

IPv6 If IcmpOut Neighbor Solicits

IPv6 If IcmpOut NeighborAdvertisments

IPv6 If IcmpOut Redirects

IPv6 If IcmpOut GroupMembQueries

IPv6 If IcmpOut GroupMembResponses

IPv6 If IcmpOut GroupMembReductions

Kernel Reader (Simple)ModuleVersion 1.0
The Kernel Reader (Simple) module generates a warning alarm if themodule finds any disk with an
increasing wait queue while busy.

Awarning alarm occurs when the disk is over 75% busy and the average queue length is over 10 with
an increasing wait queue. The warning alarm is on until the disk is not over 70% busy and the average
queue length is no longer than 8. Similarly, this module generates a warning alarm if 90% of swap
space is in use. The alarm remains open until the swap space in use is less than 80% of the total swap
space.

The following table provides default alarm thresholds for applicable Kernel Readermodules.

Operating System

Appendix C • SunManagement Center SoftwareModules 365



TABLE C–55 AlarmThresholds for theKernel ReaderModule

Alarm Threshold Message Condition

Error If file system kpctUsed is > 98

Warning If file system kpctUsed is > 90

Error If file system inode percentage is > 90

Warning If file system inode percentage is > 80

User Statistics Table
The following table provides a brief description of the properties for User Statistics.

TABLE C–56User Statistics Properties

Property Description

Console User User currently logged in on the console

Number Of Users Number of unique users currently logged in

Number Of User Sessions Number of currently active user sessions

Max Console User Login name of the user that logged into the system console the
most times since the last reboot

Interprocess Communication Tables
The following tables describe interprocess communication properties.

The following table describes the sharedmemory properties.

TABLE C–57 IPC SharedMemory Properties

Property Description

Total Shared
Memory Segments

Total number of sharedmemory segments initially available for use.

Available Shared
Memory Segments

Number of currently available sharedmemory segments.

SharedMemory
Segments Used

Sharedmemory segments used as a percentage of the total units.

The following table describes semaphores properties.
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TABLE C–58 IPCSemaphores Properties

Property Description

Total Semaphores
Available

Total number of semaphores currently available.

Semaphores Used Semaphores used as a percentage of the total.

The following table provides a brief description of the properties for System Load Statistics.

TABLE C–59 SystemLoad Statistics Properties

Property Description

1Min LoadAverage Load average over the last 1minute

5Min LoadAverage Load average over the last 5minutes

15Min LoadAverage Load average over the last 15minutes

Disk StatisticsManagedObjects Tables
The following tables provide a brief description of the properties for Disk Statistics.

The following table provides a brief description of the properties for Disk Details.

TABLE C–60DiskDetails Properties

Property Description

Disk Name Name of the disk, such as sd0

DiskAlias Name of the disk, such as c0t0d0

ReadOperation Per Sec Read operations per second

Writes Operation Per Sec Write operations per second

Operation Per Sec (read +write) Operations per second (read and write)

Number Of Bytes Read Number of bytes read

Number Of BytesWritten Number of bytes written

Number Of Bytes Transferred (read +
write)

Number of bytes transferred (read and write)

Average Number Of TransactionsWaiting Average number of transactions waiting

Average Number Of Transactions Running Average number of transactions running

The following table provides a brief description of the properties for Disk Service Time.
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TABLE C–61Disk Service TimeProperties

Property Description

Diskname Name of the disk , such as sd0

DiskAlias Name of the disk, such as c0t0d0

Percentage Of Time
There IsA
TransactionWaiting
For Service

Percentage of time there is a transaction waiting for service (wait queue length)

Percentage Of Time
TheDisk Is Busy

Percentage of time the disk is busy (transaction running)

AverageWait Service
Time

Average wait service time

Average Run Service
Time

Average run service time

Average Service Time Average service time

Rule 404 Meta Disk Rule

The following table provides a brief description of the properties for I/O error statistics.

TABLE C–62 I/OError Statistics Properties

Property Description

Device The name of the device in a descriptive format

Software Errors The total number of software errors

Hardware Errors The total number of hardware errors

Transport Errors The total number of transport errors

Total Errors Total number of errors

Under the I/O Error Statistics Table, there are the following two tables.

TABLE C–63Device ErrorTable

Property Description

Device The name of the device in descriptive format

Software Errors Total number of software errors
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TABLE C–63Device Error Table (Continued)
Property Description

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors

TABLE C–64TapeErrorTable

Property Description

Device The name of the device in descriptive format

Software Errors Total number of software errors

Hardware Errors Total number of hardware errors

Transport Errors Total number of transport errors

Total Errors Total number of errors

File SystemUsageTable
The following table provides a brief description of the properties for file system usage.

TABLE C–65File SystemUsage Properties

Property Description

Index Mount point index

Mount Point Mount point for the file system

Disk Name Name of the device (/dev/dsk/...)

Size (KB) Total size of the file system in Kbytes

Free (KB) Available disk space in Kbytes

Free KB (Non Root) Available disk space for non-superusers in Kbytes

Percent Used Percentage of disk space used

Total Inodes Total size of the file system in Kbytes

Available Inodes Available disk space for the file system in Kbytes

Percentage Of Inodes Used Percentage of inodes used
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Note – The FindAll Recent Files (>2 or >10Meg) probe commands for the UFS FilesystemUsage and
VXFS FilesystemUsage folders find only files that were created ormodified less than 24 hours ago.
The FindAll Files (>2 or >10Meg) probe commands for UFS FilesystemUsage andVXFS Filesystem
Usage find all files, regardless of the date/time they were created ormodified. Formore information
about the probe command, see “To Probe a Property” on page 135.

CPUStatisticsManagedObject Tables
The tables that are in this section provide a brief description of the properties for CPU Statistics
managed objects.

The following table provides a brief description of the properties for CPUUtilization.

TABLE C–66CPUUsageProperties

Property Description

CPUNumber CPU number

%CPU Idle Time Percentage of time spent by CPU on idlemode

%CPUUser Time Percentage of time spent by CPU on usermode

%CPUKernel Time Percentage of time spent by CPU on kernel mode

%CPUWait Time Percentage of time spent by CPU onwait mode

%CPUWait TimeOn I/O Percentage of time spent by CPU onwait mode for I/O

%CPUWait TimeOn Swap Percentage of time spent by CPU onwait mode for swap

%CPUWait TimeOn Pio Percentage of time spent by CPU onwait mode for Pio

Times Idle Thread Scheduled Percentage of idle time spent by CPU on threads scheduled

Rule 403 Meta CPURule

The following table provides a brief description of the properties for CPU processes.

TABLE C–67CPUProcessTable

Property Description

Processes in Run
Queue

Processes in run queue

ProcessesWaiting Waiting processes

Processes Swapped Swapped processes
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TABLE C–67CPUProcess Table (Continued)
Property Description

Total Number of
CPUs

Total number of CPUs

The following table provides a brief description of the properties for CPU I/O.

TABLE C–68CPUI/OProperties

Property Description

CPUNumber Central Processing Unit (CPU) number

Physical Block Reads Number of physical block reads

Physical BlockWrites Number of physical block writes

Logical Block Reads Number of logical block reads

Logical BlockWrites Number of logical block writes

Raw I/O Reads Number of raw I/O reads

Raw I/OWrites Number of raw I/Owrites

Bytes Read By Rdwr() Number of bytes read by Rdwr()

BytesWritten By Rdwr() Number of bytes written by Rdwr()

Terminal Input Characters Number of terminal input characters

Chars Handled In CanonicalMode Number of chars handled in canonical mode

Terminal Output Characters Number of terminal output characters

Physical BlockWrites Number of physical block writes

ProcsWaiting For Block I/O Number of processes that are waiting for block I/O

The following table provides a brief description of the properties for CPU Interrupts.

TABLE C–69CPUInterrupts Properties

Property Description

CPUNumber CPU number

Context Switches Number of context switches

Traps Number of traps

Device Interrupts Number of device interrupts

Operating System

Appendix C • SunManagement Center SoftwareModules 371



TABLE C–69CPU Interrupts Properties (Continued)
Property Description

InterruptsAs Threads Number of interrupts as threads

Interrupts Blocked/Preempted/Released Number of interrupts that were blocked, pre-empted or released

The following table provides a brief description of the properties for CPU system calls.

TABLE C–70CPUSystemCall Properties

Property Description

CPUNumber CPU number

SystemCalls Number of system calls

Read+Readv SystemCalls Number of read+ready system calls

Write+Writev SystemCalls Number ofWrite+Writev system calls

Forks Number of forks

Vforks Number of Vforks

Execs Number of executables

Msg Count Number of message count

Semaphore Ops Count Number of semaphore operation count

Pathname Lookups Number of pathname lookups

Ufs_iget()Calls Number of ufs_iget() calls

Directory Blocks Read Number of directory block reads

Inodes TakenWithAttached Pages Number of indexes taken with attached pages

Inodes TakenWithNoAttached Pages Number of indexes taken with no attached pages

Inode Table Overflows Number of Inode table overflows

File Table Overflows Number of file table overflows

Proc Table Overflows Number of process table overflows

The following table provides a brief description ofmiscellaneous CPU properties.
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TABLE C–71CPUMiscellaneous Properties

Property Description

CPUNumber CPU number

Involuntary Ctx Switches Number of involuntary context switches

Thread_create()s Number of thread_create()s

CpuMigrations By Threads Number of CPUmigrations by threads

Xcalls ToOther Cpus Number of Xcalls to other CPUs

FailedMutex Enters (adaptive) Number of failedmutex enters (adaptive)

RwReader Failures Number of read/write reader failures

RwWrite Failures Number of read/write write failures

LoadableModule Loaded Number of loadablemodule loaded

LoadableModule Unloaded Number of loadablemodule unloaded

Tries ToAcquire RWLock Number of tries to acquire read/write lock

The following table provides a brief description of the properties for CPURegwindow.

TABLE C–72CPURegwindowProperties

Property Description

CPUNumber CPU number

User Overflows Number of user overflows

User Underflows Number of user underflows

SystemOverflows Number of system overflows

SystemUnderflows Number of system underflows

SystemUser Overflows Number of system user overflows

The following table provides a brief description of the properties for CPU Pageinfo.

TABLE C–73CPUPageinfoProperties

Property Description

CPUNumber CPU number

Reclaims Number of reclaims
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TABLE C–73CPUPageinfo Properties (Continued)
Property Description

Reclaims From Free List Number of reclaims from free list

Pageins Number of pageins

Pages Paged In Number of pages that were paged in

Pageouts Number of pageouts

Pages PagedOut Number of pages that were paged out

Swapins Number of swap ins

Pages Swapped In Number of pages that were swapped in

Swapouts Number of swap outs

Pages SwappedOut Number of pages that were swapped out

Pages Zero Filled OnDemand Number of pages zero filled on demand

Pages Freed ByDaemon Number of pages fixed by daemon

Pages Examined By Pageout Daemon Number of pages examined by the pageout daemon

Revolutions Of The Page DaemonHand Number of revolutions of the page daemon hand

Times Pager Scheduled Number of times pager scheduled

The following table provides a brief description of the properties for CPU Faults.

TABLE C–74CPUFaults Properties

Property Description

CPUNumber CPU number

Minor Page Faults Via hat_fault() Number of minor page faults through hat_fault()

Minor Page Faults Via as_fault() Number of minor page faults through as_fault()

Major Page Faults Number of major page faults

Copy-on-write Faults Number of copy-on write faults

Protection Faults Number of protection faults

Faults Due To Software Locking Req Number of software locking faults

as_fault()s In Kernel addr Space Number of in kernel addr space

MemoryUsage Statistics Table
The following table provides a brief description of the properties forMemory Usage Statistics.
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TABLE C–75MemoryUsage Statistics Properties

Property Description

PhysicalMemoryAvailable (MB) Physical memory that is available inMbytes

PhysicalMemory InUse (MB) Physical memory in use inMbytes

PercentMemory Used Percentage of memory used

PhysicalMemory Free (MB) Physical memory that is free inMbytes

PercentMemory Free Percentage of memory that is free

SwapStatistics Table
The following table provides a brief description of the properties for Swap Statistics.

TABLE C–76 Swap Statistics Properties

Property Description

Available KB (AnonMemoryNot Reserved) Swap available. Total reserved swap space.

Reserved KB (AnonMemory Reserved But NotAllocated) Swap reserved

Allocated KB (AnonMemoryNot Free) Swap allocated

Used KB Swap used

Total KB (Used +Available) Swap total

Percent SwapUsed Percentage of swap used

Rule 405 Meta Swap Rule

StreamsStatisticsManagedObjects Table
The following section provides the various Streams Statistics properties for the followingmanaged
objects:

� StreamHead Cache
� Queue Cache
� StreamsMessages
� Linkinfo Cache
� Strevent Cache
� Syncq Cache
� Qband Cache

The following table briefly describes themanaged objects.
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TABLE C–77 Streams StatisticsManagedObjects

Properties Description

StreamHead Cache Kernel statistics for streams head cache

Queue Cache Kernel statistics for queue cache

StreamsMsgs Kernel statistics for streamsmessages

Linkinfo Cache Kernel statistics for link information cache

Strevent Cache Kernel statistics for streams event cache

Syncq Cache Kernel statistics for synoq cache

Qband Cache Kernel statistics for qband cache

All of the Streams Statistics managed objects have the same properties. The following table presents
these common properties.

TABLE C–78 Streams Statistics Table Properties

Property Description

TheNameOf The Cache Name of the cache

Current Usage (total - avail) Cache’s current usage

MaximumCapacity Maximum capacity of the cache

Cumulative Total OfAllocations Number of total cache allocations

Number ofAllocation Failures Number of allocation failures

Percent Used Percentage of cache used

SoftwareRules Table
The following table provides a brief description of the properties for Software Rules.

TABLE C–79 SoftwareRules Properties

Property Description

Rule rknrd105 Software rule (refer to rule rknrd105 in Appendix D

Rule rknrd106 Software rule (refer to rule rknrd106 in Appendix D)

Zones Table
The following table provides a brief description of the properties for zones.
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TABLE C–80ZonesProperties

Property Description

Zone ID Zone identification number

ZoneName Name of the zone

Status State of the zone

Root Dir Directory in global zone that is root directory for a non-global zone

IPAddress IP address of the zone

Autoboot Specifies whether the zonemust automatically reboot when the system reboots

MIB-II InstrumentationModuleVersion 1.0
This section presents information on theMIB-II Instrumentationmodule. TheMIB-II
Instrumentationmodule includes the property tables described in the following sections:

� “MIB-II SystemGroup Table” on page 377
� “MIB-II Interfaces Group Tables” on page 378
� “MIB-II IPGroup Table” on page 379
� “MIB-II ICMPGroup Table” on page 381
� “MIB-II TCPGroup Tables” on page 383
� “MIB-II UDPGroup Tables” on page 384

MIB-II SystemGroupTable
The following table provides a brief description of the properties forMIB-II SystemGroup.

TABLE C–81MIB-II SystemGroupProperties

Property Description

SystemDescription MIB-II system description or the description of the host (read-write)

SystemOID Object identifier or the Object ID (OID) of the software system

Time Since System Is Up Time inmicroseconds since the system booted

SystemContact The contact name for this system

SystemName The qualified host name onwhich the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered
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MIB-II InterfacesGroupTables
The following tables provide a brief description of the properties for theMIB-II Interface group.

The following table provides a brief description of the properties forMIB-II Interfaces Group.

TABLE C–82MIB-II InterfacesGroupProperties

Property Description

Number of Interfaces Number of interfaces to themachine, including the loopback

The following table provides a brief description of the properties forMIB-II Interfaces.

TABLE C–83MIB-II Interface Properties

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF LargestMTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF PhysicalAddress Physical address of the interface

IFAdmin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and running) when the
operational state has changed last time

IF InOctets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF InNonUnicast Pkts Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown Protos Number of packets with unsupported protocol that were received on the interface

IF Out Octets Number of octets that are transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out NonUnicast Pkts Number of non-unicast packets transmitted out on the interface
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TABLE C–83MIB-II Interface Properties (Continued)
Property Description

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because of errors

IF Out Queue Length Length of the output packet queue

IF Specific Reference to theMIB definitions specific to the particular media

MIB-II IPGroupTable
The following tables provide a brief description of the properties forMIB-II IP.

The following table provides a brief description of the properties forMIB-II IPGroup.

TABLE C–84MIB-IIGroupProperties

Property Description

IP Forwarding Indicates whether this entity is a gateway

IPDefault TTL Default Time-to-Live inserted into the IP headers

IP In Receives Number of datagrams received

IP InHeader Errors Number of input datagrams that are discarded because of errors in IP headers

IP InAddress Errors Number of input datagrams that are discarded because of errors in destination IP
address

IP Forwarded
Datagrams

Number of forwarded datagrams

IP InUnknown
Protos

Number of locally addressed datagrams that were discarded because of unsupported
protocols

IP In Discards Number of input datagrams that were discarded

IP InDelivers Number of input datagrams that were successfully delivered

IPOut Requests Number of datagrams that were supplied to IP for transmission

IPOut Discards Number of output IP datagrams that were discarded

IPOut No Routes Number of output IP datagrams that were discarded because no route destination was
found

IPReassemble
Timeouts

Maximum time in seconds for which the received fragments were held for reassembly

IPReassemble
Requireds

Number of IP fragments received that required reassembly

Operating System

Appendix C • SunManagement Center SoftwareModules 379



TABLE C–84MIB-IIGroupProperties (Continued)
Property Description

IP Reassemble OKs Number of IP datagrams that were successfully reassembled

IPReassemble Fails Number of failures detected by the reassembly algorithm

IP Fragmentation
OKs

Number of IP datagrams that were successfully fragmented

IP Fragmentation
Fails

Number of IP datagrams that have failed fragmentation

IP Fragmentation
Creates

Number of IP datagram fragments that were generated due to fragmentation

The following table provides a brief description of the properties for IPAddresses.

TABLE C–85 IPAddresses Properties

Property Description

IPAT IPAddress IP address to which this entry’s addressing information pertains

IPAT IfIndex Index in the interface table for the corresponding interface

IPATNetMask Subnet mask associated with the IP address

IPAT Broadcast
Address

Value of the least significant bit in the IP broadcast address

IPATReassemble
Max Size

Size of the largest IP datagram that can be reassembled by this entity

The following table provides a brief description of the properties for IP Route.

TABLE C–86 IPRoute Properties

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next hop of this route is
reached

IPRouteMetric1 Primary routingmetric for the route that is specific to the routing 1 protocol

IP RouteMetric2 Alternate routingmetric for the route that is specific to the routing 2 protocol

IP RouteMetric3 Alternate routingmetric for the route that is specific to the routing 3 protocol

IP RouteMetric4 Alternate routingmetric for the route that is specific to the routing 4 protocol
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TABLE C–86 IPRoute Properties (Continued)
Property Description

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routingmechanism through which this route was learned

IPRouteAge Number of seconds since the route was last updated

IPRouteMask Mask to be logical and with the destination address before being compared to the route
destination

IPRouteMetric5 Alternate routingmetric for the route that is specific to the routing 5 protocol

IP Route Info Reference toMIB definitions specific to the routing protocol

The following table provides a brief description of the properties for IPNetToMedia.

TABLE C–87 IPNetToMedia Properties

Property Description

IPN2M IfIndex Index of the interface in the interface table on which this entry’s equivalence is effective

IPN2MPhysAddress Media-dependent physical address

IPN2MNetAddress IP address corresponding to the physical address

IPN2MType Type ofmapping

MIB-II ICMPGroupTable
The following table provides a brief description of the properties forMIB-II ICMPGroup.

TABLE C–88MIB-II ICMPGroupProperties

Property Description

ICMP InMessages Number of ICMPmessages received

ICMP In Errors Number of ICMPmessages received with errors

ICMP InDest
Unreachs

Number of ICMPdestination unreachablemessages received

ICMP In Time
Exceeds

Number of ICMP time exceededmessages received

ICMP In Parameter
Problems

Number of messages received that describe ICMPparameter problems
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TABLE C–88MIB-II ICMPGroupProperties (Continued)
Property Description

ICMP In Src
Quenchs

Number of ICMP source quenchmessages received

ICMP In Redirects Number of ICMP redirect messages received

ICMP In Echos Number of messages received that describe ICMP echo requests

ICMP In Echo Reps Number of messages received that describe ICMP echo replies

ICMP In Timestamps Number of messages received that describe ICMP timestamp requests

ICMP In Timestamp
Reps

Number of messages that relate to ICMP timestamp replies

ICMP InAddress
Masks

Number of ICMP address mask request messages received

ICMP InAddress
Mask Reps

Number of ICMP address mask replymessages received

ICMPOutMessages Number of ICMPmessages that were attempted to be sent

ICMPOut Errors Number of ICMPmessages that were not sent due to problems

ICMPOut Dest
Unreachs

Number of ICMPdestination unreachablemessages sent

ICMPOut Time
Exceeds

Number of ICMP time exceededmessages sent

ICMPOut Parameter
Problems

Number of messages sent that relate to ICMPparameter problems

ICMPOut Src
Quenchs

Number of ICMP source quenchmessages sent

ICMPOut Redirects Number of ICMP redirect messages sent

ICMPOut Echos Number of messages sent that relate to ICMP echo requests

ICMPOut Echo Reps Number of number of messages sent that relate to ICMP echo replies

ICMPOut
Timestamps

Number of request messages sent for ICMP timestamps

ICMPOut
Timestamp Reps

Number of ICMP timestamp replymessages sent

ICMPOutAddress
Masks

Number of ICMP address mask request messages sent
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TABLE C–88MIB-II ICMPGroupProperties (Continued)
Property Description

ICMPOutAddress
Mask Reps

Number of ICMP address mask replymessages sent

MIB-II TCPGroupTables
The following tables provide a brief description of the properties forMIB-II TCP.

The following table provides a brief description of the properties forMIB-II TCPGroup.

TABLE C–89MIB-II TCPGroupProperties

Property Description

TCPRetransmission
Algorithm

Algorithm used to determine the timeout value to be used for retransmitting
unacknowledged octets

TCPRetransmitMin
Timeout

Minimum value permitted by TCP implementation for the retransmission timeout

TCPRetransmitMax
Timeout

Maximum value permitted by TCP implementation for the retransmission timeout

TCPMax
Connections

Limit on the number of TCP connections

TCPActive Opens Number of times TCP connections have transitioned to SYN-SENT fromCLOSED
state

TCPPassive Opens Number of times TCP connections have transitioned to SYN-RCVD from LISTEN
state

TCPAttempt Fails Number of times TCP connections have transitioned from SYN-SENT or SYN-RCVD
to COLSED state and from SYN-RCVD to LISTEN state

TCP
Established-to-Resets

Number of times TCP connections have transitioned from ESTABLISHED or
CLOSE-WAIT to CLOSED state

TCPCurrent
Established

Number of TCP connections for which the current state is ESTABLISHED or
CLOSE-WAIT

TCP In Segments Number of segments received

TCPOut Segments Number of segments sent

TCPRetransmitted
Segments

Number of segments retransmitted

TCP In Errors Number of segments that were received in error
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TABLE C–89MIB-II TCPGroupProperties (Continued)
Property Description

TCPOutWith Reset
Flag

Number of segments sent containing the RST flag

The following table provides a brief description of the properties for TCPConnections.

TABLE C–90TCPConnections Properties

Property Description

TcpConn State State of this TCPConnection

TcpConn LocalAddress Local IP address for this TCP connection

TcpConn Local Port Local port number for this TCP connection

TcpConn RemoteAddress Remote IP address for this TCP connection

TcpConn Remote Port Remote port number for this TCP connection

MIB-II UDPGroupTables
The following tables provide a brief description of the properties forMIB-II UDP.

The following table provides a brief description of the properties forMIB-II UDPGroup.

TABLE C–91MIB-IIUDPGroupProperties

Property Description

UDP InDatagrams Number of UDPdatagrams that were delivered to UDPusers

UDPNo Port
Datagrams

Number of received UDPdatagrams for which there is no application at the destination
port

UDP In Errors Number of received UDPdatagrams that could not be delivered

UDPOut Datagrams Number of UDPdatagrams sent

The following table provides a brief description of the properties for UDP.

TABLE C–92UDPProperties

Property Description

UDPLocalAddress The local IP address for this UDP listener

UDPLocal Port The local port number for this UDP listener
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MIB-II (Simple)ModuleVersion 1.0

Note – TheMIB-II (simple)module is used to identify a SunManagement Center agent. If this
module is not loaded, the agent can only be created as a ping host or as an SNMPhost.

The tables that are in this section provide a brief description of the properties for SimpleMIB-II
managed objects.

SystemGroup
The following table provides a brief description of the properties for SystemGroup.

TABLE C–93 SystemGroupProperties

Property Description

SystemDescription MIB-II system description or the description of the host (read-write)

SystemOID Object identifier or the Object ID (OID) of the software system

Time Since Up Time inmicroseconds since the system is up

SystemContact The contact name for the system

SystemName The qualified host name onwhich the agent is running (read-write)

System Location The physical location of the host (read-write)

System Services Sum integer value indicating the set of services primarily offered

InterfacesGroup
TheNumber of Interfaces group property indicates the number of interfaces to themachine,
including the loopback.Additional interfaces properties are described in the following table.

TABLE C–94 InterfacesTable

Property Description

IF Index Index of the interface in this table

IF Descr Description of the interface

IF Type Type of the interface

IF LargestMTU Size of the largest datagram that can be sent on the interface

IF Speed Bandwidth of the interface

IF PhysicalAddress Physical address of the interface
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TABLE C–94 InterfacesTable (Continued)
Property Description

IFAdmin Status Desired state of the interface

IF Oper Status Operational state of the interface

IF Last Change Value of sysUpTime (that is, time when the system is up and running) when the
operational state has changed last time

IF InOctets Octets received on the interface

IF In Unicast Pkts Unicast packets received on the interface

IF In nonUnicast
Pkts

Non-unicast packets received on the interface

IF In Discards Number of packets on the interface that are chosen to be discarded

IF In Errors Number of inbound packets on the interface that contained errors

IF In Unknown
Protos

Number of packets with unsupported protocol that were received on the interface

IF Out Octets Number of octets that are transmitted out on the interface

IF Out Unicast Pkts Number of unicast packets transmitted out on the interface

IF Out nonUnicast
Pkts

Number of non-unicast packets transmitted out on the interface

IF Out Discards Number of outbound packets on the interface that contained errors

IF Out Errors Number of outbound packets that could not be transmitted because of errors

IF Out Queue Length Length of the output packet queue

IF Specific Reference to theMIB definitions specific to the particular media

IPGroup
The IP Forwarding group property indicates whether this entity is a gateway.Additional IP route
properties are described in the following table.

TABLE C–95 IPRouteTable

Property Description

IP Route Destination Destination IP address of the route

IP Route IfIndex Index of the interface in the interface table through which the next hop of this
route is reached

IPRouteMetric1 Primary routingmetric for the route that is specific to the routing 1 protocol
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TABLE C–95 IPRoute Table (Continued)
Property Description

IP RouteMetric2 Alternate routingmetric for the route that is specific to the routing 2 protocol

IP RouteMetric3 Alternate routingmetric for the route that is specific to the routing 3 protocol

IP RouteMetric4 Alternate routingmetric for the route that is specific to the routing 4 protocol

IP Route NextHop IP address of the next hop of this route

IP Route Type Type of route

IP Route Proto Routingmechanism through which this route was learned

IPRouteAge Number of seconds since the route was last updated

IPRouteMask Mask to be logical and with the destination address before being compared to the
route destination

IPRouteMetric5 Alternate routingmetric for the route that is specific to the routing 5 protocol

IP Route Info Reference toMIB definitions specific to the routing protocol

The following table describes the IP address properties.

TABLE C–96 IPAddress Table Properties

Property Description

IPAT IPAddress IPAddress Table Entry IPAddress inMIB-II

IPAT IfIndex

IPATNetMask

IPAddTab RMaxSize

NFSFile SystemsModuleVersion 2.0
TheNFS File Systemsmodule enables you tomonitor the NFS file systems on hosts that are running
the Solaris 8, Solaris 9, or Solaris 10 operating systems. TheNFS File Systemsmodulemonitors the
amount of disk space occupied bymounted or unmounted file systems. Themodulemonitors the
amount of used and available space as well as the remaining total capacity.

When loading the NFS File Systemsmodule, you can define the file systems that you want tomonitor
by using patternmatching. Patterns can be used to filter whichNFS file systems aremonitored by file
system ormount point.

The following table provides a brief description of the properties for NFS File System usage.
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TABLE C–97File SystemUsage Properties

Property Description

NFS Filesys Name of the NFS file system

Size Total size of the NFS file system in Kbytes

Used Used disk space for the NFS file system in Kbytes

Available Available disk space for the NFS file system in Kbytes

%Used Percentage of NFS disk space used

Rate Percentage capacity change per second

Mount Point Mount point for the NFS file system

Entry Index Entry index of the NFS file system

NFSStatisticsModuleVersion 2.0
This section presents property tables for NFS Statistics:

� RPC Information Table
� NFS Information Table

You can use the NFS Statistics module tomonitor statistical information on the remote procedure
calls (RPC) and Sun’s distributed computing file system (NFS) calls. The number of RPC andNFS
calls that the client made and the server received are displayed in themain console window along
with the status of the transaction activity on the local host. The following tables list some of the
properties monitored by this module with both the server and the client statistics.

RPC Information Table
The following table provides a brief description of the properties for RPC Information.

TABLE C–98RPCServer andClient Information Properties

Property Description

RPCCalls Total number of RPC calls made by the host

Bad RPCCalls Total number of calls rejected by the RPC layer

Bad RPCCalls % Percentage of rejected calls compared to the total number of calls made (bad RPC
Calls/RPC calls)

RPCCall Rate Number of RPC calls that aremade per second
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NFS Information Tables
The following table provides a brief description of the properties for NFS information.

TABLE C–99NFS Server andClient Information Properties

Property Description

NFSCalls Total number of NFS calls sent by the host

BadNFS Calls Total number of NFS calls rejected

BadNFS Calls % Percentage of rejected NFS calls compared to the total number of sent calls (badNFS
calls/NFS calls)

NFS Call Rate Number of NFS calls that were sent per second

The following table provides a brief description of the properties for NFS server statistics.

TABLE C–100NFSServer Statistics

Property Description

Server NFS Calls Number of bad server NFS calls since the last init

Server BadNFS Call
%

BadNFS calls as a percent of the total NFS calls made

Server NFS Call Rate Rate at which server NFS calls are beingmade per second

The following table provides a brief description of the properties for NFS client statistics.

TABLE C–101NFSClient Statistics

Property Description

NFSCalls Client NFS calls

BadNFS Calls Number of bad client NFS calls since the last init

BadNFS% BadNFS calls as a percentage of the total NFS calls made

NFS Call Rate Rate at which client NFS calls are beingmade per second

Solaris ProcessDetailsModuleVersion 2.0
The parameters for the Solaris Process Details module are listed in the following table. This table is
displayed when you try to load themodule.
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TABLE C–102 Solaris ProcessDetails Parameters

Property Description

Module Name Name of themodule (not editable)

Module Description Description of themodule (not editable)

Version Version of themodule (not editable)

Enterprise SNMP enterprise in which themodule is loaded (not editable)

Module Type Type of themodule (not editable)

Number of Processes Number of processes that is obtained by themodule based on the selection criteria.
One of the given numbers can be selected by the user.

Selection Criteria Selection criteria by which the processes are sorted and selected. For example, the user
can select the top 10 processes using this function.

The following table provides a brief description of the properties for Solaris Process.

TABLE C–103ProcessProperties

Property Description

PS Process ID Process ID of the process

PS Parent Process ID Process ID of the parent of the process

PS User ID Login ID of the user of the process

PS User Name Login name of the user of the process

PS Effective User ID Effective user ID of the process

PS Group ID Real group ID of the process

PS Effective Group ID Effective group ID of the process

PS Session ID Process ID of the session leader of the process

PS Process Group ID Process ID of the process group leader of the process

PS TTY Controlling terminal for the process

PS Start Time Starting time of the process

PS Time Cumulative execution time of the process

PS State State of the process

PSWait Channel Address of an event for which the process is waiting

PS Scheduling Class Scheduling class of the process

Operating System

SunManagement Center 3.6.1 User’s Guide • May 2006390



TABLE C–103Process Properties (Continued)
Property Description

PSAddress Memory address of the process

PS Size Total size of the process in virtual memory

PS Priority Priority of the process

PSNice Nice value of the process, which is used for priority computation

PS Percent CPUTime Percent CPU time

PS PercentMemory Percentmemory

PS Command Base name of the executable file for the process

PS Command Line Full command name of the process, including the arguments

Local andRemoteApplicationModules
The software enables you tomonitor local and remote applications.An example of a local application
would be a print spooler.An example of a remote application would be anHPprinter that is
equipped with a JetDirect card.

When the followingmodules are loaded, they are found under the LocalApplications section on the
Module Browser tab in the Details window:

� “Agent StatisticsModule Version 2.0” on page 391
� “Data Logging RegistryModule Version 2.0” on page 396
� “LogviewACLVersion 1.0” on page 396
� “Print SpoolerModule Version 3.0” on page 397

When the followingmodules are loaded, they are found under the Remote Systems section on the
Module Browser tab in the Details window:

� “HP JetDirectModule Version 2.0” on page 398
� “MIB-II ProxyMonitoringModule Version 2.0” on page 399

The local and remote applicationsmodules are described in the following sections.

Agent StatisticsModuleVersion 2.0
This section presents the following information onAgent Statistics:

� “Object Statistics Table” on page 393
� “Commands Executed Table” on page 393
� “Transactions Performed Table” on page 394
� “SunManagement Center Process Statistics Table” on page 394
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� “SunManagement Center Total Process Statistics Table” on page 395

TheAgent Statistics modulemonitors the health of the agent installed on a host. This module
monitors the objects, processes, and execution of processes by the agent.

TABLE C–104Agent StatisticsMain Sections

Agent Statistics Tables Description

Object Section Displays data on the objects that are loaded onto the agent. Status field displays the
current status of the TOE and binary objects loaded into and used by the agent.

Execution Section Displays data on the number of Tcl or TOE commands invoked by the agent
interpreter.Also displays data on the number of asynchronous transactions initiated by
the agent. Status field displays a brief description of the current status of the objects
listed.

The following table provides a brief description of theAgent Statistics managed objects.

TABLE C–105Agent Statistics SectionProperties

Property Description

Object Statistics TOECount –Number of TOE objects loaded into the agent binary object buffer

Count –Number of binary object buffers used by the agent

Commands Executed Total – Total number of commands that have been executed by the agent

Rate (#/sec) – Number of commands executed by the agent per second

Transactions
Performed

Total – Total number of transactions performed by the agent

Rate (#/sec) – Number of transactions performed by the agent per second

PAProcess Statistics Process statistics pertaining to the PA

PATotal Process
Statistics

Total process statistics pertaining to the PA

The following lists default alarm thresholds for applicableAgent Statistics modules.

TABLE C–106Agent StatisticsAlarmThresholds

Agent Statistics Condition

Error If toeCount > 6000

Warning If toeCount > 5000

Error If bobcount > 1200
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TABLE C–106Agent StatisticsAlarmThresholds (Continued)
Agent Statistics Condition

Warning If bobcount > 1000

Warning If commands rate > 6000

Warning If transactions rate > 8

Error If process size > 35000

Warning If process size > 30000

Error If rss > 25000

Warning If percentage CPU time > 90

Warning If totalstats.count > 15

Error If totalstats.size > 40000

Warning If totalstats.size > 35000

Warning If totalstats.rss > 35000

The following sections describe the individual property tables forAgent Statistics.

Object Statistics Table
TheObjects section displays information about the Objects that are loaded onto the agent. The
Status field displays the current status of the TOE and binary objects loaded into and used by the
agent.

The following table provides a brief description of the properties for Object Statistics.

TABLE C–107Object Statistics Properties

Property Description

Total TOEObjects Number of TOE objects loaded into the agent

Total Bobs Number of binary object buffers used by the agent

Commands Executed Table
The following table provides a brief description of the properties for commands executed.
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TABLE C–108ExecutedCommandsProperties

Property Description

Total Commands Total number of commands that have been executed by the agent

Rate (/sec) Number of commands executed by the agent per second

Transactions PerformedTable
The following table provides a brief description of the properties for performed transactions.

TABLE C–109Transactions PerformedProperties

Property Description

Total Transactions Total number of transactions performed by the agent

Transaction Rate
(/sec)

Number of transactions performed by the agent per second

SunManagement Center Process Statistics Table
The softwaremonitors the SunManagement Center process statistics. The following table provides a
brief description of the properties for SunManagement Center process statistics.

TABLE C–110 SunManagement Center Process Statistics Properties

Property Description

Process ID Identification number of the process

Process Unique Id Unique identification number of the process

Process Name Name of the process

Process Status Status of the process

Process State State of the process

User ID User ID of the process

Virtual Size Total size of the process

Resident Set Size Resident size of the process

Start Time Seconds Startup time of the process in seconds since January 1, 1970

Start Date Startup date of the process

Start Time Startup time of the process

CPUTime CPU time used by the process

Local and RemoteApplicationModules

SunManagement Center 3.6.1 User’s Guide • May 2006394



TABLE C–110 SunManagement Center Process Statistics Properties (Continued)
Property Description

Percent CPUTime Percentage of CPU time used by the process

Context Switches Context switches of the process

SystemCalls System calls made by the process

Command Line Command line of the process

SunManagement Center Total Process Statistics Table
The softwaremonitors the total SunManagement Center process statistics.

The following table provides a brief description of the properties for total SunManagement Center
process statistics.

TABLE C–111 Total SunManagement Center Process Statistics Properties

Property Description

Number of Processes Number of agent and child processes

Total Virtual Size Total virtual size of agent and children

Total Res Size Total resident set size of agent and children

AgentUpdateModuleVersion 1.0
TheAgent Updatemodule enables you to update agents across your enterprise using a single feature.
When loaded, information about this module appears in the LocalApplications section of the
Module Browser window.

TABLE C–112AgentUpdateData Properties

Property Description of Value

Server Name Name of SunManagement Center server

HTTP Server Port Port number on which the web server is running

Update Image Name The name of the agent update image file on this server

Product Layers Installed Agent, Console, and Server as appropriate
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TABLE C–113AddonsList

Column Description

AddonName Name of SunManagement Center component

AddonVersion Version of component

Data LoggingRegistryModuleVersion 2.0
TheData Logging Registry consists of the registry table.

The following table provides a brief description of the properties for Data Logging Registry.

TABLE C–114Data LoggingRegistryProperties

Property Description

LogDestination State State of the logged file destination.

Module Name Module name for data value (data from this module is logged in the registry)

Instance Name Module instance name for data value.

Property Name Property name for data value

Logging Interval Logging interval for data value

File Logging File logging status.

Logging Destination The logging destination for data value.

Data Cache Data cache status

Cache Size (samples) Size of data cache

LogviewACLVersion1.0
The Logviewmodule creates a file list that allows you to specify which user or group can access this
file in the logviewer. This list provides the following information:

Instance name
File name
User name
Group name
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Print SpoolerModuleVersion 3.0
The Print Spooler modulemonitors the status of the printer daemon and print queue on the local
host as well as the printer devices installed on it.

� “Printer LPsched” on page 397
� “Printer Devices Table” on page 397
� “Printer Queues Table” on page 398

The following table describes the print spooler managed objects.

TABLE C–115Print Spooler Properties

Property Description

Lpsched Status Status of the lpsched process

Printer Devices Table lists information about the printer devices

Printer Queues Table lists information about the printer queue

Printer LPsched
The printer daemon section displays data on the LPRequest Scheduler. The Line Printer’s Schedule
(LPsched) state property describes the current status of the printer.

PrinterDevices Table
The Printer Devices table lists the printers that are already added to the table.

The instance name or alias of the printer is displayed in the Name field. The description of the
printer is displayed in the Description field. The name of the host on which the printer is installed is
displayed in the Host Name field. If you are running a console that shows datamonitored by an agent
on a print server host, the path name of the printer device is displayed in the Device field. The printer
state displays in the Printer State field.

The following table provides a brief description of the properties for Printer Devices.

TABLE C–116PrinterDevices Properties

Property Description

Row Status Status of the row

Printer name Name of the printer device

Description Description of the row

Host name Name of the host to which the device is attached
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TABLE C–116PrinterDevices Properties (Continued)
Property Description

Device name Alphanumeric device name

Device state State of the device

PrinterQueues Table
The Print Queues table lists the print queues on the local host and displays the status of each queue.
The following table provides a brief description of the properties for Printer Queues.

TABLE C–117PrinterQueues Properties

Property Description

Printer Queue Name Name of the printer queue

Printer Queue State Current status of the printer queue (values are “accepting” and “not accepting”)

# of Printer Queue
Jobs

Total number of jobs in the queue

Current Printer Job Number of jobs currently spooled in the queue

Printer Queue Size Total size (in Kbytes) of the jobs currently spooled in the queue

HPJetDirectModuleVersion 2.0
Agents canmonitor HPprinters that are equipped with a JetDirect card by proxy using the HP
JetDirect module. Multiple HPprinters can bemonitored by loadingmultiple instances of this
module.

The following table provides a brief description of the properties for Printer Status.

TABLE C–118General Printer Status Properties

Property Description

Status Display LED status display

SNMPGet Status Status of SNMPGet

For platform-specific information, see your supplement.
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MIB-II ProxyMonitoringModuleVersion 2.0
TheMIB-II ProxyMonitoringmodulemonitors theMIB-II parameters for remote systems. The
various categories that monitor theMIB-II parameters on remote systems are listed in the following
sections, which listMIB-II group tables:

� “MIB-II SystemGroup Table” on page 377
� “MIB-II Interfaces Group Tables” on page 378
� “MIB-II IPGroup Table” on page 379
� “MIB-II ICMPGroup Table” on page 381
� “MIB-II TCPGroup Tables” on page 383
� “MIB-II UDPGroup Tables” on page 384

Formore information about the properties of these parameters, see “IPv6 InstrumentationModule
Version 1.0” on page 359, which lists the properties for local systems. The same functionality is
applied on remote systems by theMIB-II ProxyMonitoringmodule. Formore information on the
definition ofMIB-II, see the standards documentation RFC1213 (Request For Comments 1213).

AdvancedSystemMonitoringModules
Advanced SystemMonitoring (ASM) is a licensed value-added software product. You choose to
install it when you install the SunManagement Center 3.6.1 software.ASMprovides additional
modules that support more complete systemmonitoring capabilities.ASM includes the following
modules, which are described in this section:

� “Directory SizeMonitoringModule Version 2.0” on page 399
� “FaultManagerModule Version 1.0” on page 400
� “File ScanningModule Version 2.0” on page 402
� “Hardware Diagnostic Suite Version 2.0” on page 404
� “HealthMonitorModule Version 2.0” on page 404
� “Kernel ReaderModule Version 2.0” on page 408
� “ProcessMonitoringModule Version 2.0” on page 408
� “ServiceManagement FacilityModule Version 1.0” on page 410

Directory SizeMonitoringModuleVersion 2.0
Thismodule enables you to isolate andmonitor the size of any directory and its subdirectories on a
host on which an agent is installed. The subdirectories and links can be viewed recursively using a
window that is accessible from themodules pop-upmenu.
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Note – Tomonitor several directories individually, either loadmultiple instances of the Directory Size
Monitoringmodule or add rows for additional directories in the properties table. See “ToMonitor
Directory Size” on page 132 formore information.

The following table provides a brief description of the properties for Directory SizeMonitoring.

TABLE C–119Directory SizeMonitoring Properties

Property Description

Instance Name Single word or alpha-character string that is used internally within the Sun
Management Center agent to identify uniquely a particular module or a rowwithin a
module

Directory Name Name of the directory beingmonitored

Directory Directory Existing Check

Directory Size (KB) Current size of the directory in Kbytes

Rate (KB/sec) Rate at which the directory is changing size in Kbytes per second

FaultManagerModuleVersion 1.0
The FaultManagermodule handles hardware and software faults effectively. This module also
displays a detailed fault report or amessage article for the selected fault.

The FaultManagermodule has the followingmanaged objects:

� FaultManagement Daemon table
� FMDConfiguration table
� FMDFault Events table

The following table provides a brief description of the properties for the fault manager.

TABLE C–120FaultManager Properties

Property Description

FaultManagement
Daemon

Shows the details of the FaultManagement Daemon.

FMDConfiguration Shows the details of themodules loaded.

FMDFault Events Shows the latest 20 faults with their message IDs.An alarmwill be generated for every
new fault.

The following table provides a brief description of the properties for FaultManagement Daemon.
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TABLE C–121FaultManagementDaemonProperties

Property Description

Property Properties of the FaultManagement Daemon. Properties are FMDprogram path, FMD
program version, and FMDprocess id.

Value Values of the properties of FaultManagement Daemon.

The following table provides a brief description of the properties for FMD configuration.

TABLE C–122FMDConfigurationProperties

Property Description

Module Name Name of the FMDmodule. Examples of FMDmodules are cpumem-diagnosis,
cpumem-retire, and fmd-self-diagnosis.

Version Version of themodule.

Status Status of themodule. The status can be active or failed.An alarm is generated for this
property when the value changes from active to failed.

Description Description of themodule.

The following table provides a brief description of the properties for FMD fault events.

TABLE C–123FMDFault Events Properties

Property Description

Time Time at which the diagnosis of the fault happened

UUID Unique ID for the fault event

SUNW-MSG-ID Message identifier that is used to access a corresponding knowledge article located at
http://www.sun.com/msg/

� ToViewaFault Report

Navigate through the topology or hierarchy view until you have accessed the FMD Fault Events table
of the Fault Manager module.

Select a fault for which you want to view a fault report.

Press mouse button 3 and choose Show Fault Report from the pop-up menu.

The Probe Viewer shows the detailed fault report for the selected fault.
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� ToViewaMessageArticle
Themessage article contains information such as the fault type, severity, description, impact, and
suggested action. This article helps the user to take appropriate action for a specific fault.

Navigate through the topology or hierarchy view until you have accessed the FMD Fault Events table
of the Fault Manager module.

Select a fault for which you want to view a message article.

Press mouse button 3 and, from the pop-up menu, choose Show Message Article at
http://www.sun.com/msg.

Abrowser opens with amessage article at the following site:

http://www.sun.com/msg/<SUNW-MSG-ID>

Where <SUNW-MSG-ID> is themessage identifier and is the last column of the FMDFault table.

Note – Themessage article does not open in the browser if the Java Console is not installed on your
system.

File ScanningModuleVersion 2.0
The File Scanningmodule scans files on a host for user-specified patterns.Multiple instances of the
File Scanningmodule can be loaded to scanmultiple files. This module requires you to add rows for
the data property tables. Formore information, see “ToAdd a Row to a Data Property Table”
on page 133.

The File Scanningmodule has the followingmanaged objects:

� File ID Table
� File Statistics Table
� Scan Table

The following table provides a brief description of the properties for file scanning.

TABLE C–124File ScanningProperties

Property Description

File ID Name of the pattern used in the file scan

File Stats State of the pattern listed

Scan Table Name of the pattern used in the file scan

The following table provides a brief description of the properties for file ID.
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TABLE C–125File IDProperties

Property Description

Filename Full path name of the file to be scanned

ScanMode Mode in which the file is being scanned

Start Time Time the file scan was first started

The File Statistics table displays summary information on the file that is to be scanned. The following
table provides a brief description of the properties for file statistics.

TABLE C–126File Statistics Properties

Property Description

Modification Time Date and time when the file was last modified

File Size Size of the file in bytes

Number of Lines Number of lines that are in the file

Lines Per Second Rate at which the file is changing in lines per second

The following table provides a brief description of the properties for scan.

TABLE C–127 ScanTable Properties

Property Description

Row Status Status of the row

Pattern Name Name of the pattern that was used in the file scan

Pattern Description Name of the pattern entry to be displayed in the name field of the Scan Results section.
To scan the fault messages in the syslog file, prefix the description with FMA:

Regexp Pattern Regular expression pattern to be used when scanning the file for entries. To scan the
fault messages in the syslog file, specify the pattern in this format: <token>:<value>,
where <token> is the fault parameter and <value> is the value of the fault parameter.

Pattern State State of the pattern listed (on/off). The off state indicates that the listed pattern is not
used in the file scan

Matches Number of lines that contain the pattern
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HardwareDiagnostic SuiteVersion 2.0
TheHardware Diagnostic Suite tests the system for hardware faults.When themodule is loaded and
theHardware Diagnostic Suite software is installed, theApplications tab on the Details window
allows you to initiate the tests. Formore information about the Hardware Diagnostic Suite, see Sun
Management Center Hardware Diagnostic Suite 2.0 User’s Guide.

HealthMonitorModuleVersion 2.0
TheHealthMonitormodulemonitors the health of your host.When alarm conditions occur, this
module offers suggestions, if necessary, on how to improve the performance of the system.

For example, this modulemonitors the swap space that is available, reserved, allocated, and used.
Sample alarmmessages, from lowest to highest severity, include:

� NoWorries: sufficient swap space available
� There is lots of unused swap space
� Notmuch swap left: perhaps add somemore
� Swap space shortage: add somemore now
� Dangerous swap space shortage: addmore immediately

This section describes properties of the followingHealthMonitormodulemanaged objects:

� Swap Table
� Kernel Contention Table
� NFS Table
� CPUTable
� Disk Table
� RAMTable
� KernelMemory Table
� Directory Cache Table

TheHealthMonitormodule tracks the system properties for the above as described in the following
table.

TABLE C–128HealthMonitor Properties

Property Description

Swap Details the swap space

Kernel Contention Monitors the kernel contention (mutex) properties

NFS Provides NFS client information

CPU Provides information on the power of the CPU

Disk Presents the disc I/O information
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TABLE C–128HealthMonitor Properties (Continued)
Property Description

RAM Random access memory (RAM) information

KernelMemory Information on kernel memory

Directory Cache Cache of the directory

SwapTable
The following table provides a brief description of the properties for Swap.

TABLE C–129SwapProperties

Property Description

SwapAvailable KB Swap space value available

Swap Reserved KB Swap space value reserved

SwapAllocated KB Swap space value allocated

SwapUsed KB Swap space value used

Swap Rule Rule for swap

Kernel Contention Table
The following table provides a brief description of the properties for Kernel Contention (mutex).

TABLE C–130KernelContentionProperties

Property Description

Spins OnMutexes Spins onmutexes (lock not acquired on first try) - Sum for all CPUs

Number Of CPUs Number of CPUs

Spins OnMutexes
Rule

Spins onmutexes (lock not acquired on first try) - Sum for all CPUs

NFSTable
The following table provides a brief description of the properties for NFS client information.

TABLE C–131NFSClient InformationProperties

Property Description

Calls Total number of RPC calls received
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TABLE C–131NFSClient Information Properties (Continued)
Property Description

Badcalls Total number of calls rejected by the RPC layer

Retrans Call retransmitted due to a timeout

Badxids Reply from server not corresponding to any outside call

Timeouts Call timed-out while waiting for a reply from server

Newcreds Number of times authentication information was refreshed

Badverfs Calls failed due to a bad verifier in response

Timers Number of times that calculated timeouts exceed theminimum specified timeout value
for a call.

Nomem Failure to allocatememory

Can’t Send Failure to sendNFS/RPC rule

NFS/RPCRule Value of the NFS/RPC rule

CPUTable
The following table provides a brief description of the properties for the central processing unit
(CPU).

TABLE C–132CPUProperties

Property Description

Processes In Run
Queue

Number of processes in run queue

ProcessesWaiting Number of processes blocked for resources

Processes Swapped Number of processes that can be run but swapped

CPUPower Rule CPU power rule

Disk Table
The following table provides a brief description of the properties for disk.

TABLE C–133DiskProperties

Property Description

Disk Name Name of the disk

DiskAlias Name of the disk, such as c0t0d0
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TABLE C–133DiskProperties (Continued)
Property Description

Percent DiskWait Average number of transactions waiting for service

Percent Disk Busy Percent of time disk is busy

Service Time (ms) Average service time inmilliseconds

Disk Rule Disk rule

RAMTable
The following table provides a brief description of the properties for random access memory (RAM).

TABLE C–134RAMProperties

Property Description

Handspread Value of hand spread (one of kernel parameters) pages

Scan rate Page scan rate

RealMemory rule Real memory rule

KernelMemory Table
The following table provides a brief description of the properties for KernelMemory.

TABLE C–135KernelMemoryProperties

Property Description

Total KernelAllocation Fails Value of kernel allocation failure

PhysicalMemory Free Value of free physical memory

KernelMemory Rule Value of kernel memory rule

Directory Cache Table
The following table provides a brief description of the properties for Directory Cache.

TABLE C–136NameCache Statistics Properties

Property Description

CacheHits Number of times a previously accessed page is found

CacheMisses Number of times a previously accessed page is missed
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TABLE C–136NameCache Statistics Properties (Continued)
Property Description

DNLCRule Directory name lookup cache rule

Kernel ReaderModuleVersion 2.0
The Kernel Readermodulemonitors kernel statistics and all kernel information including CPU
statistics, system load statistics, disk statistics, file system usage, and so on. This section includes
properties and their descriptions for all Kernel Readermanaged objects:

� User Statistics Table
� Interprocess Communication Tables
� Disk StatisticsManagedObjects Tables
� I/O Error Statistics Table
� FilesystemUsage Table
� CPU StatisticsManagedObject Tables
� MemoryUsage Statistics Table

ProcessMonitoringModuleVersion 2.0
The following section describes the ProcessMonitoringmodule parameters and their property
descriptions. This module requires you to add rows for the data property tables. Formore
information, see “ToAdd a Row to a Data Property Table” on page 133.

When amatching process is found, the %CPU and a count of the number of processes that match is
displayed. If you want to change themodule parameters, you can edit all the parameters except for
the entry name by accessing the pop-upmenu. See “ToAccess a Pop-UpMenu” on page 87 formore
information.

Process Statistics Table
The following table provides a brief description of the properties for Process Statistics.

Note – When you add a row to the process statistics table, youmust provide the information in the
first five rows in the following table. See “ToAdd a Row to a Data Property Table” on page 133 for
more information.

TABLE C–137Process Statistics Properties

Property Description

Entry Name Name of the process statistics table entry (must be a unique name).
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TABLE C–137Process Statistics Properties (Continued)
Property Description

Name Pattern Pattern tomatch the name of the binary for the process that you want tomonitor.

Argv Pattern Pattern tomatch the arguments of the command that executes the process.

User Specification User name that is executing the process.

Entry Description Description of the entry (required field).

Process Command Command used to initiate the process, if applicable.

Process Count Number of processes currently running that match the patterns.

% SystemCPUUsage Percentage CPU used by the system processes. This value is a time-weighted average
that is taken at different time intervals. Do not confuse this percentage with the value
that might result after you enter the UNIX ps command.

%User CPUUsage Percentage CPU used by the user processes.

Virtual Size Total size of the processes in Kbytes.

Resident Set Size Resident size of the processes in Kbytes.

Monitoring State Toggle between on (row is enabled) and off (row is disabled).When the row is disabled,
all the entries are displayed as 0 (zero).

Microstate Information Table
The following table provides a brief description of the properties forMicrostate Information.

TABLE C–138Microstate InformationProperties

Property Description

Entry Name Name of the entry (must be a unique name).

CPUwait time Percentage of time for CPUwait.

Text page fault time Percentage of time for text page faults.

Data page fault time Percentage of time for data page faults.

Major page faults Number of major page faults per second (text and data faults).

Characters in I/O Number of characters read and written per second.

Involuntary context
switches

Number of involuntary context switches per second.

CPU time for reaped
children

Percentage of CPU time used by child processes that have detached from their parent
processes.

User lock time Percentage of time spent for user locks.
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TABLE C–138Microstate InformationProperties (Continued)
Property Description

System trap time Percentage of time spent for system traps.

Total swaps Percentage of time spent on swaps.

Entry Description Description of the entry (required field).

Executable code Rule Rule that applies to executable code.

File access rule Rule that applies to file access.

Note – Youmight see extremely high percentages on a per-CPU basis if the following facts are true:

� Aparticular process has a number of n threads that are waiting to become active.
� User Lock Time is 100% times the number of n threads.

ServiceManagement FacilityModuleVersion1.0
The ServiceManagement Facility (SMF)modulemonitors and displays the services running on a
host. You can view the current state of a service. However, you cannot create, delete, or modify the
properties of a service. You can enable or disable a service when certain conditions aremet. For
details, see “Enabling or Disabling a Service” on page 411.

The SMFmodule describes the following details for each service.

TABLE C–139ServiceDetails

Field Description

FMRI FaultManagement Resource Identifier. This identifier identifies each service on
the system.

The syntax of FMRI is svc://host/category/service:instance

where host is the host name onwhich the service is running.

category is the category under which the service belongs. The category can be
application, device, milestone, network, platform, site, or system.

service:instance identifies the specific service.

An example of FMRI is svc://localhost/network/smtp:sendmail.

Time Date and time that the service starts.

Description Description of the service.
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TABLE C–139 ServiceDetails (Continued)
Field Description

Service State Current state of the service. The current state can accept one of the following
values:
� Online. The service is running.

� Offline. The service is not running or is available to run.

� Disabled. The service is not running.

� Maintenance. The service has encountered an error that an administrator
must solve.

� Degraded. Some of the dependency services are not running.

� Uninitialized. The service is not running. This state is the initial state for all
services.

Note – Even if the SMFmodule is disabled, you can change the state of a service.

Formore information about SMF, seeManaging Services (Overview) andManaging Services (Tasks)
in SystemAdministration Guide: Basic Administration.

� ToView theDetails of a Service
Navigate through the topology or hierarchy view until you have accessed the Service Management
Facility module.

The SMFmodule displays services based on their category. The details that are displayed for each
service are: start time of the service, state of the service, FMRI (FaultManagement Resource
Identifier), and description of the service.

Select a service.

Press mouse button 3 and choose Service Details from the pop-up menu.

The Probe Viewer appears that shows the service details, dependencies for the selected service,
services that depend on the selected service, and the processes in the selected service.

EnablingorDisabling a Service
You can enable or disable a service when the following conditions aremet:

� You are assigned the ServiceManagement profile in the /etc/user_attr file.
� You are given local access to the SMF module by using es-config -M smf -l <username>. For

more information about this, see Chapter 9, “SunManagement CenterAdministration,” in Sun
Management Center 3.6.1 Installation and Configuration Guide.
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� The FMRI of the selected service does notmatch the FMRI of the services in the
/var/opt/SUNWsymon/cfg/smf-excl-d.dat file. If this file is empty, you can enable or disable
any service.

Caution –By default, the /var/opt/SUNWsymon/cfg/smf-excl-d.dat file contains essential services
such as SunManagement Center services, Physical or Logical network services, Milestone services,
and Filesystem services. These services cannot be disabled through this module. You can delete the
relevant entries in the smf-excl-d.dat file to disable these services.

Note – If the /var/opt/SUNWsymon/cfg/smf-excl-d.dat file does not exist, you cannot enable or
disable any service.

� ToEnable orDisable a Service

Caution – Ensure that you disable the appropriate service. If you disable the agent service, the
applicationmight hang. You will have to restart the agent from the command line.

Navigate through the topology or hierarchy view until you have accessed the Service Management
Facility module.

Select a service.

To enable a service, select online from the Service State list.

To disable a service, select disabled from the Service State list.

� ToSetAlarms
You can set alarms on the Service State field.

Navigate through the topology or hierarchy view until you have accessed the Service Management
Facility module.

If a service has encountered an error that must be solved by the administrator, select maintenance
from the Service State list.

When the state of the service is changed tomaintenance, it generates alarms.
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SunManagement Center Software Rules

This appendix lists the SunManagement Center rules for the followingmodules:

� “Kernel Reader” on page 414
� “HealthMonitor” on page 415

Rules Concepts
Arule is an alarm checkmechanism that allows for complex or special purpose logic in determining
the status of amonitored host or node.

There are two types of rules:

� Simple rules are based on the rCompare rule, in whichmonitored properties are compared to the
rule. If the rule condition becomes true, an alarm is generated. For example, a simple rule can be
the percentage of disk space used. If the percentage of disk space used is greater than or equal to
the percentage specified in the rule, then an alarm is generated.

� Complex rules are based onmultiple conditions. For example, one complex rule states that an
alert alarm is generated when the following conditions aremet:
� The disk is over 75% busy
� The average queue length is over 10
� The wait queue is increasing

Note – Any user-customized Solstice SyMONTM 1.x rulesmust be ported to the SunManagement
Center environment before the rules can be used in SunManagement Center software.
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Kernel Reader
The following table lists the Kernel Reader simple rules.

TABLE D–1Kernel Reader Simple Rules

Property Description

avg_1min Load average over the last minute

avg_5min Load average over the last 5minutes

avg_15min Load average over the last 15minutes

cpu_delta Difference between the previous and current time

cpu_idle CPU idle time

cpu_kernel CPU kernel time

cpu_user CPU user time

cpu_wait CPUwait time

ipctused Percent of inodes used

kpctused Percent of Kbytes used

mem-inuse Physical memory in use (Mbytes)

numusers Number of users

numsessions Number of user sessions

swap_used Swap used (Kbytes)

wait_io CPUwait time breakdown

wait_pio CPUwait time breakdown

wait_swap CPUwait time breakdown

The following table lists the Kernel Reader complex rules.

TABLE D–2Kernel ReaderComplexRules

Rule ID Description Type of Alarm

rknrd100 This rule covers a transitory event. The rule generates an alert
alarmwhen the disk is over 75% busy, the average queue length
is over 10, and the wait queue is increasing. The alert alarm
remains until the disk is less than 70% busy and the average
queue length is less than 8.

Alert

Kernel Reader
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TABLE D–2Kernel ReaderComplex Rules (Continued)
Rule ID Description Type of Alarm

rknrd102 This rule covers a transitory event. The rule generates an alert
alarm if 90% of swap space is in use. The event causing the alarm
remains until swap space in use is less than 80% of the total swap
space.

Alert

rknrd103 This rule covers a transitory event. The rule generates an alert
alarm if swapping and paging is high for a given CPU. This
behavior indicates that a CPUmight be thrashing.An alert
alarm is generated when CPU exceeds 1 swap-out, 10 page-ins,
and 10 page-outs per second. The alert alarm stays on if CPU
exceeds 1 swap-out, 8 page-ins, and 8 page-outs per second.

Alert

rknrd105 File System Full error. This rule looks for a file system full error
message in the syslog (/var/adm/message).

Alert alarm that is
closed immediately

rknrd106 No swap space error. This rule looks for a no swap space error
message in the syslog (/var/adm/message).

Alert alarm that is
closed immediately

rknrd400 This rule checks for a continuous CPU load over six per CPU for
four hours.

Informational

rknrd401 This rule checks for disks that are busymore than 90% of the file
for x hours. The parameters field holds the last time CPU load
was below six, and is initialized to some date in the year 2001.

Informational

rknrd402 This rule checks if available swap space drops below 10% for x
hours. The parameters field indicates the last time that the CPU
load was below six. This field is initialized to some date in the
year 2001.

Informational

rknrd403 This rule is not currently supported. Informational

rknrd404 An informational alarm is generated if rule rknrd401 gets
triggered 4 times.

Informational

rknrd405 An informational alarm is generated if rule rknrd402 gets
triggered 4 times.

Informational

HealthMonitor
The following table lists the HealthMonitor complex rules.

HealthMonitor
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TABLE D–3HealthMonitorComplexRules

Rule ID Description Type of Alarm

rhltm000 This rule checks whether there is enough swap space. Critical,Alert,
Caution

rhltm001 CPU power is wasted each time a CPU has to wait for a lock to
become free. This event is counted because the kernel uses
mutually exclusive locks to synchronize its operation and to
keepmultiple CPUs from concurrently accessing critical code
and data regions.

Critical,Alert,
Caution

rhltm002 NFS remote procedure call timeouts may be associated with
duplicate responses after the call is retransmitted. These
timeouts indicate that the network is okay but the server is
responding slowly.

Critical,Alert,
Caution

rhltm003 The run queue length is divided by the number of CPUs because
every CPU takes a job off the run queue in each time slice.

Critical,Alert,
Caution

rhltm004 Abusy disk or a slow disk reduces system throughput and
increases user response times. This rule identifies the disks that
are loaded so that the load can be rebalanced.

Critical,Alert,
Caution

rhltm005 RAM rule based on residency time for an unreferenced page.
The virtual memory system indicates that the system needs
morememory when the system scans to look for idle pages to
reclaim for other uses.

Critical,Alert,
Caution

rhltm006 This rule refers to the problemwith kernel memory allocation
that occurs when login attempts or network connections fail
unexpectedly. There are two possible causes: Either the kernel
has reached the extent of its address space, or the free list does
not contain any pages to allocate. The repeated failures signify a
problem that might otherwise be overlooked.

Critical,Alert,
Caution

rhltm007 Aglobal cache of directory path name components exists. This
cache is called the directory name lookup cache (DNLC). If this
cache does not exist, directory entries must be read from disk
and be scanned to locate the right file.

Critical,Alert,
Caution

HealthMonitor
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AlternativeMethods forAccessing Java Console
Functions

You can use alternativemethods for accessing the Java Console. These alternativemethods are for
users with disabilities and are part of Sun’s compliance with the United States government’s Section
508 regulations. For example, users with vision impairmentmight use software to read the product
screens. Thus the product has descriptions of images, field names and screens. In addition, users,
who cannot use amouse, can use keyboard shortcuts to use the product.

The the following features enable you to performmanagement functions by using either a
command-line interface (CLI) or the Java Console:

� Associated tooltips for all images
� AssociatedAccessible Name for all fields
� AnAccessible Description for all screens

In addition, the Java Console enables you to perform functions by using your keyboard as well as
yourmouse.

This chapter describes the following features that are provided for the Java Console:

� “General KeyboardNavigation” on page 417
� “Keyboard Shortcuts” on page 418
� “Mnemonics” on page 419
� “Images andGraphs” on page 419

General KeyboardNavigation
The Java Console indicates the active window component, called the focus, by either a blinking
cursor or, in the case of buttons or check boxes, a blue border. On some screens, a default button
might be identified by a black border. To change focus or activate a button, use the appropriate
mechanism:

� Tomove the focus from field to field within a window, use the Tab key. Tomove the focus
backward through the fields, use Shift+Tab. If the focus is in an element such as a field that allows
tabs to be used, then use Ctrl+Tab and Ctrl+Shift+Tab tomove the focus through the fields.
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� Within a group of components, use the arrow keys tomove up and down. For example, after you
have tabbed to a particular list-item field, use the arrow keys tomove among the list items.

� To select a button on a window, change focus to the button, then use the spacebar to activate the
button.

� When a default button is identified on a window, press the Return key to activate that function.
� To navigate through a hierarchical topology, use the up and down arrow keys tomove between

levels. Use the left arrow key to expand a level and the right arrow key to collapse a level.

Keyboard Shortcuts
Keyboard shortcuts are keystroke combinations that activate amenu item from the keyboard even if
themenu for that command is not currently displayed. Keyboard shortcuts usually consist of a
modifier key and a character key, like Ctrl+Z, or a few special keys, such as F1 andDelete. Unlike
mnemonics, keyboard shortcuts do not displaymenus. They perform the indicated actions directly.

Table E–1 provides a list of the standard keyboard shortcuts that the Java Console supports.

TABLE E–1 Common JavaConsoleNavigation andActivationKeys

Keyboard Operation Action

Tab Navigates to the next focusable component.

Shift+Tab Navigates to the previous focusable component.

Control+Tab Navigates to the next focusable component. This navigation works even if the
component that previously had focus accepts tabs.

LeftArrow Moves focus left one character or component.

RightArrow Moves focus right one character or component.

Up arrow Moves focus up one line or component.

Down arrow Moves focus down one line or component.

Page Up Moves up one pane of information.

Page Down Moves down one pane of information.

Home Moves to the beginning of the data. In a table, moves to the beginning of a row.

End Moves to the end of the data. In a table, moves to the last cell in a row.

Return Activates the default command button.

Escape Dismisses amenu or dialog box without changes. Cancels a drag-and-drop operation in
progress.

Keyboard Shortcuts
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TABLE E–1 Common Java ConsoleNavigation andActivationKeys (Continued)
Keyboard Operation Action

Spacebar Activates the component that has keyboard focus.

Mnemonics
Mnemonics provide another keyboard alternative to themouse.Amnemonic is an underlined
alphanumeric character in amenu title, menu item, or other interface component.Amnemonic
reminds you how to activate the equivalent command by simultaneously pressing theAlt key and the
character key that corresponds to the underlined letter or numeral.

When the keyboard focus is not in a text element, you do not always need to use theAlt key. For
example, to choose the Exit command from the File menu, you can hold down theAlt key and press F
to display the File menu, then release theAlt key, and press X.

After you have displayed amenuwith a keyboard sequence, any subsequent keypress activates a
command only from that menu. For example, you can pressAlt+F to display the File menu and then
typeAto activate the SaveAs command.Alternately, you can pressAlt+E to display the Edit menu,
and then typeAto activate the SelectAll command.

All menu items in SunManagement Center 3.6.1 havemnemonics.Agiven letter might apply to a
different function, depending on themenu or the window.

Images andGraphs
Throughout the Java Console, images indicate screen navigation. These images contain alternative
text that you can display when youmove yourmouse over the image or use other similar technology.
In addition, some graphs also provide a text-only view of the data in tabular format. Look for this
feature on the graph windows.

Images andGraphs
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LinuxAgent Support

This appendix lists themodules, add-ons, and commands supported by the Linux agent.

SupportedModules
The followingmodules are supported by the Linux agent:

� Agent Statistics
� Agent Update
� FileMonitoring
� Volume SystemMonitoring
� Kernel Reader (Simple)
� MIB-II (Simple)
� Data Logging Registry
� MCPManager

Note – The FileMonitoringmodulemonitors the ext3 and raiser file systems. Thismodule is
implemented in the core software.

SupportedAdd-ons
The Linux agent supports only the Volume SystemMonitoring add-on.All the othermodules are
implemented in the core software.

FA P P E N D I X F

421



SupportedCommands
The following commands are supported by the Linux agent:

� es-start

� es-stop

� es-config

� es-dt

� es-inst (remote installation is not supported)
� es-uninst

� es-makeagent

� es-load-default

� es-platform

� es-run

� es-trapdest

� es-validate

� es-setup

Supported Commands
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Glossary

An arbitrary collection of hosts and networks that the SunManagement Centermonitors as a single
hierarchal entity. You can choose to divide your enterprise into several domains, each domain to be
managed by different users.

Asoftware process, usually corresponding to a particular local managed host, that carries out
manager requests.An agentmakes local system and application information available to remote
users.

An abnormal event that is detected by a SunManagement Center agent and that might indicate
current or impending problems. The agent passes information about the abnormal event to the Sun
Management Center server. The server passes this information on as an alarmwhen the abnormal
eventmatches a predefined alarm threshold.

SunManagement Center users can acknowledge alarms, indicating that the alarm does not represent
a serious problem or that the problem is being resolved.Acknowledged alarms take a lower priority
than unacknowledged alarms.

Awindow that provides information about the selected object. In addition, theAttribute Editor
enables you to customize variousmonitoring criteria for that object. Themonitoring criteria are
dependent on the type of object. There areAttribute Editors for domains, hosts, modules, and data
properties.

Agents that can work independently from each other.

Apoint-to-point network component. Used by the software to represent a network link to which
many other hosts can be connected.

Astring that is similar to a password and that is used to authenticate access to an agent’s monitored
data.

Acomplex alarm is based on a set of conditions being true. Unlike simple alarms, you cannot set
thresholds for complex alarms.

Hardware that hasmultiple instances of the Solaris operating environment running inside a single
chassis. These objects are “composites” from the SunManagement Center point of view because the
objects consist of several parts shown inside a group or container. These parts include the following:

administrative
domain

agent

alarm

alarm
acknowledgment

Attribute Editor

autonomous
agents

bus

community

complex alarm

composite object
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� One object for each instance of the Solaris operating environment
� Two objects that represent an active and backup system controller
� One object that represents the hardware chassis and related equipment such as fans and power

supplies

Agraphical user interface component of SunManagement Center software used to view information
and status formonitored hosts andmanaged objects and to interact with SunManagement Center
agents.All SunManagement Center functions are available from a Java Console. Some functions are
also available from aweb console.

Ademonstration environment in which developers can test customizedmodules designed to work
with the SunManagement Center software. See the SunManagement Center 3.6.1 Developer
Environment ReferenceManual for more information.

ASunManagement Center tool available from themain console window that is used to find hosts,
routers, networks, and Simple NetworkManagement Protocol (SNMP) devices that can be reached
from the SunManagement Center server.

ASunManagement Center agentmodule that can be loaded or unloaded at runtime, enabling
monitored properties to be displayed on themain console windowwithout having to restart the
console or agent.

Achange in the state of amanaged object.

The act of scanning a file, usually a log file, for certain patterns (regular expressions) that might be
indicative of problems or significant information. SunManagement Center agents use file scanning
to assist in themonitoring of systems and applications when these components do not provide direct
access to status information.

(FaultManagement Daemon).Adaemon process running on Solaris 10 that monitors hardware and
software faults in the system.

(FaultManagement Resource Identifier).Aunique identifier that identifies each service on the
system.

The graphical user interface, or GUI, is a window that provides the user with amethod of interacting
with the computer and its special applications, usually with amouse or other selection device. The
window usually includes such things as windows, an intuitivemethod ofmanipulating directories
and files, and icons.

Awindow view that defines objects in a hierarchy or tree relationship. Objects are grouped
depending on the rank of the object in the hierarchy.

The number of routers through which a packet goes before reaching its destination.

consolewindow

developer
environment

Discovery

dynamic
loadable
modules

event

file scanning

FMD

FMRI

graphical user
interface

hierarchy view

hop
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Asingle word or alpha-character string that is used internally within the SunManagement Center
agent to identify uniquely a particular module or a rowwithin amodule.

In SunManagement Center software, manage is defined as being able to observe (monitor) and
manipulate the object. For example, management privileges include acknowledging and closing
alarms, loading and unloadingmodules, changing alarm thresholds, and so on.Management
privileges are similar to read, write, and execute access.

(Module Configuration Propagation).MCP refers to the process of copying scripts andmodule
configuration files from one host to another host or group of hosts.

Management information base.AMIB is a hierarchical database schema that describes the data that
is available from an agent. SunManagement Center agents use theMIB to storemonitored data that
can be accessed remotely.

Asoftware component that can be loaded dynamically tomonitor data resources of systems,
applications, and network devices.

In SunManagement Center software, monitor is defined as being able to observe objects, alarms, and
properties. Monitoring privileges are similar to read-only access. Contrast withmanage.

(NetworkAddress Translation).Anetwork configuration feature that enables an IP address to appear
as a different IP address, often used for security or efficiency reasons.

Aworkstation or server.

Aparticular resource, such as a computer host, network interface, or software process, that Sun
Management Center software canmonitor ormanage.Amanaged object is an object that you can
manipulate. For example, you can acknowledge and turn off an alarm condition for an object that
you canmanage.Amonitored object is an object that you can observe but not acknowledge or
otherwisemanage.

One of two environments in which SunManagement Center software is deployed. The production
environment is a real environment (as opposed to a test environment) in which youmanage and
monitor your hardware.

Acollection of SunManagement Center agents and a particular server layer with which the remote
agents are associated.

The consolidation of duplicate outstanding requests that originated frommultiple consoles. This
strategy eliminates the execution of redundant requests.

An alarm checkmechanism that allows for complex or special purpose logic in determining the
status of amonitored host or node.

instance

manage

MCP

MIB

module

monitor

NAT

node

object

production
environment

remote server
context

request caching

rule
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The password used to generate the SunManagement Center security keys. The seed is an
alpha-numeric string of up to eight characters. This string is not necessarily a UNIX password. You
can select your own seed, or accept the default seed (maplesyr) provided by the SunManagement
Center software. If you select your own seed, be sure to record the seed for later reference.

An object that represents a network segment and that is used as a basis for a local network.

The collection of programs and processes (SNMP-based trap, event, topology, configuration, and
Java server) that work on behalf of a SunManagement Center user to helpmanage a particular set of
networks, hosts, and devices. The server usually sends requests to SunManagement Center agents,
accepts collected data from the agents, and passes the data to themain console window for display.

ASunManagement Center sever layer and its associated agents.

Alarms that are based on one condition becoming true. You can set alarm thresholds for simple
alarms.

(Simple NetworkManagement Protocol).Asimple protocol that enables networked entities (hosts,
routers, and so on) to exchangemonitoring information.

SNMPversion 2, user-based securitymodel security standards.

Avalid user on a server host. The superuser decides what the agents are in the context of the server.
By default, the superuser password is used as a seed for security key generation.

Members of the symon group in the /etc/group file.

The view that displays themembers of the object selected in the hierarchy view.

(UniformResource Locator).AURL is a textual specification that describes a resource that can be
accessed through the network.

Azone that does not inherit packages from the global zone.

Avirtualized operating system environment that you can set up for systems that run the Solaris 10
Operating System. Every Solaris system contains a global zone, the default zone for the system.

seed

segment

server

server context

simple alarm

SNMP

SNMPv2usec

SunManagement
Center superuser

SunManagement
Center user

topology view

URL

whole root zone

zone

Glossary
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Index

A
access control, 246, 250
accessing command-line interface, 310
accessing help for command-line interface, 310
accessing SystemManager server through SSH, 336-337
accessing SystemManager server through web

console, 336
accessing the command-line interface, 309-310
ACL, 246, 250
Actions tab, 149, 237-238
adding

application to Tools menu, 318-321
objects to administrative domains, 59-73, 75-84
property from graph clipboard, 139
row to a data property table, 132, 133, 134-135

Address process property, 101
administrative domain

creating, 51
default, 50
definition, 47
definition of, 37
deleting, 55
example, 48
hierarchy examples, 48
home, 49
initiating a discover objects request for, 77-80
listing, 88
members, 37
multiple, 47
populating, 51, 59-73, 75-84
remote, 55
security, 41
setting security for, 53
switching between, 88

administrative domain (Continued)
viewing, 52

agent
definition of, 34
detailed description of, 36
health, 156
interacting with console and server, 35
SNMP, 41

agent down alarm notification, 229
agent down notification, 183-184
agent layer, See agent
Agent Statistics

Configurationmanager, 313
Eventmanager, 313
SunManagement Center server, 313
Topologymanager, 313
Trap handler, 313

agent update task, 203-204
alarm limits, 148, 236
alarm threshold creation, 188-189, 231-232, 240-241, 252
alarms, 242-243

accessing fromDetails window, 177-178
accessing frommain console window, 176-177
accessing fromweb interface, 229-230
acknowledged, 172
acknowledging, 181
adding notes to, 182
adding suggested fixes, 182-183
alert, 173, 413, 415
black icon, 172
black splat, 173
blue icon, 173
categories of, 175, 228
caution, 415
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alarms (Continued)
caution indicator, 173
changing pending actions for, 186
complex, 40
critical, 415
critical indicator, 173
defining action scripts, 187-188
definition of, 39
deleting, 181-182
determining the severity of, 171
disabled indicator, 173
down indicator, 172
filtering the alarms table, 179-180
generation of, 413
gray icon, 173
icons, 172
indeterminate status indicator, 173
notifying users about agent status, 183-184
notifying users about host status, 183-184
off indicator, 173
pages, 237
red alarm icon, 171
red icon, 173
registering actions for, 185
runningmanual actions for, 186
seeing, 94, 220, 229
sending email when alarm occurs, 185, 186, 241-242,

242-243
severities, 94, 220, 229
severity levels, 172
simple, 39, 148-149, 236
simple rules, 413
sorting alarms table, 179
sorting in Domain Status Details window, 178
states, 175
threshold, 148-149, 236
unacknowledged, 172
updating alarms table, 179
viewing activity log, 180
viewing suggested fixes, 182-183
windows, 149
yellow icon, 173

Alarms tab in theAttribute Editor, 148-149, 236
Alarms tab in the Details window, 96
alternativemethods for users with disabilities, 417-419
applications, viewing specific information, 114

ARCHIVELOGMODE, 325-327
archiving the database, 325-327
Attribute Editor, 123

Actions tab, 149, 237-238
Alarms tab, 148-149, 236
definition, 147, 225, 235
History tab, 151, 238
Info tab, 148
module, 166-167
opening, 151, 152
Refresh tab, 150
Security tab, 253

attributes, changing, 70-71
auto-negotiate feature, 257
automatic notification of an alarm condition, 185,

241-242, 242-243

B
backing up database

cold, 325
offline, 327
online, 325-327
silent (non-interactively), 327

black splat, 173
Browser Details window, SeeDetails window
buttons

Hide Details, 105
ShowDetails, 105

C
changing, module parameters, 168
changing object attributes, 70-71
changing object name, 71
circular log files, 317
classA, B, and C networks, 329
Class process property, 101
CLI, See command-line interface
closing, SunManagement Center session, 50
cold backup, 325
command-line interface, 277

accessing help for, 310
accessing in Solaris or Linux, 309-310

Index
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command-line interface (Continued)
accessing inWindows, 310
alarm command parameters

ack, 298
command, 298
domain, 298
mgtObj, 298
note, 299
property, 299
propInst, 299
qualifier, 299
severity, 299
state, 299

alarm commands
ackAlarms, 299
delAlarms, 299
getAlarms, 300
runAlarmAction, 300
setAlarmAction, 300

aliases, 280
basic commands, 280

alias, 286
attrib, 287
browse, 287
cd, 287
clear, 287
data, 288
end, 288
exit, 288
goto, 288
help, 288
history, 290
kill, 289
list, 290
locate, 290
login, 290
logout, 290
more, 291
quit, 291
reset, 291
set, 292
status, 292
unalias, 292
unset, 293

command overview, 280
controlling output screen size, 311

command-line interface (Continued)
executing in background, 280
executing in foreground, 280
exiting from, 311
extended commands, 280
input from keyboard, 281
input from shell file, 281
interactionmodes, 278
module commands

disableModule, 294-295
enableModule, 294
getLoadedModules, 294
getModule, 294
getModules, 294
loadModule, 295
unloadModule, 295

object attribute command parameters
attributes, 296
mgtObj, 296
property, 296
propInst, 296
rowValues, 296
values, 296

object attribute commands
addRow, 296
delRow, 296
getAttributes, 297
setAttributes, 297

output format specifications, 281
output to background, 281
output to batchmode input file, 281
output to file, 281
output to screen, 281
parameters

a, 283
-about, 284
append, 284
-b, 283
bad syntax examples, 283
columns, 284
f, 284
general syntax, 282
good syntax examples, 282
-h, 283
height, 284
history, 284

Index
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command-line interface, parameters (Continued)
input file format, 283
log, 285
logmode, 285
m, 285
more, 285
ncols, 286
o, 285
overview, 281
prompt, 286
serverHost, 286
specified at startup, 282
specified in command, 282
specified in file, 282
style, 286
t, 286

recording commands in file, 311
recording output in file, 311
system requirements, 278
topology command parameters

agentPort, 301
arch, 301
domain, 301
domainmode, 302
family, 302
fullDesc, 302
isPolled, 302
mode, 302
nodemode, 302
pollType, 302
readInfo, 302
targetHost, 302
targetIP, 302
topoCfg, 302
topoType, 302
url, 303
validity, 303
writeInfo, 303

topology commands
createEntity, 303
createGroup, 303
delTopoObject, 304
export, 304
getAgentPort, 304
getAllTopoObjects, 305
getCurrentDomain, 305

command-line interface, topology commands (Continued)
getDomains, 305
getTopoObject, 305
import, 306
setCurrentDomain, 305

Command process property, 101
CommandLine process property, 101
commands

es-backup, 325
es-config, 325-327
es-restore, 327

complex alarms, 40
complex rule

alert alarm generation, 413
definition, 413

composite object
creating, 66-67
definition, 60

Config Reader, 96
special instructions for Details window, 116

Configurationmanager, 251
agent statistic, 313

configuring
ARCHIVELOGMODE, 325-327
Details Process display, 102, 115
online backup, 325-327

connecting objects, 68
console

alternativemethods for accessing, 417-419
definition of, 34
detailed description, 34
interacting with server and agent, 35
main window, 42
menus, 86-87
multiple consoles, 34
navigating, 90-91
overview, 86-88
pop-upmenus, 87
search, 88
starting, 45
tool tips, 87
viewing administrative domains, 88

console layer, See console
copying

data property to graph, 123
groups, 69-70
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copying (Continued)
module, 122
objects, 69
to graph clipboard, 139

CPU%process property, 101
CPU thrashing, 415
creating

amodule object, 64
administrative domains, 51
alarm threshold, 188-189, 231-232, 240-241
composite objects, 66-67
groups, 64-65
links between objects, 68
monitoredmodules, 64
nodes, 61-63
objects with Discoverymanager, 77-80
segments, 67-68
server component object, 314

creating graph template, 141
critical, alarms, 415
customizedmenu items, adding, 318-321
customizing alarm actions, 187-188, 242-243
cutting objects, 71-72

D
data

displaying, 130
probing, 130, 135
refreshing, 130-131

data property
Attribute Editor, 147, 225, 235
displaying, 130
graphing, 138
probing, 135
refresh interval, 152-153, 239
sampling points, 153-154
tool tip, 87

data property table
adding row to, 132, 133, 134-135
checkbox cell editor, 128
combo box cell editor, 128
editable cells, 128
large, 129
modules with user adjustments, 128

data property table (Continued)
multiple page, 129
noneditable cells, 128
row context menu, 129
selecting a row, 131
selecting adjoining rows, 131
selecting row ranges or groups, 131
sorting, 129
standard format, 128
text cell editor, 128

database, backup and recovery, 325-327
dataviews

copying to dataview clipboard, 211, 212
creating, 210
creating from context menu, 210
creating from optionsmenu, 211
definition of, 209
deleting, 213
example creating scalar, 214
example creating vector, 214-215
navigating dataviews window, 210
opening

empty window, 212
existing dataview, 213

saving, 213
scalar, 213
tables, types of, 213
vector, 214

default administrative domain, 50
default port numbers, 314
default privileges

overriding, 255
topologymanager, SunManagement Center default

security privileges, 249
defining a group job, 192-194
defining a job task, 196-197
defining an alarm action script, 187-188, 242-243
deleting

administrative domains, 55
discover request, 84
events from event database, 316
objects, 72-73

deleting a group job, 196
deleting objects, 71-72
Details page

Actions tab in theAttribute Editor, 237-238
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Details page (Continued)
Alarms tab inAttribute Editor, 236
History tab in theAttribute Editor, 238

Details Process display
configuring, 102, 115
selecting columns, 115

Details window
Actions tab in theAttribute Editor, 149
Alarms tab, 96, 98
Alarms tab inAttribute Editor, 148-149
Applications tab, 99
disk total, 103
Hardware information types, 102
History tab in theAttribute Editor, 151
Info tab, 96
Info tab inAttribute Editor, 148
memory hardware total, 103
Module Browser tab, 96, 97
ModuleManager tab, 98
monitoring logmessages, 112-113
moving columns in Process display, 115-116
overview, 95-108
Process Statistics window, 101
processors total, 103
Refresh tab in theAttribute Editor, 150
Solaris Process Details module, 99
sorting columns in Process display, 115
starting, 109-110
tape devices total, 103
View Logs tab, 98-99
View Processes, 99

developer environment, definition of, 44
developingmodules, 44
Directory SizeMonitoringmodule

adding table rows, 129
defining a directory, 132
list files, 130, 135

disabilities, alternativemethods for users with, 417-419
disabling

module, 122, 165-166
disabling SNMPv1 communication, 258-259
disabling SNMPv2c communication, 258-259
discovering hardware, 81-83
discovering objects by name, 81-83
discovering software, 81-83

discovery
deleting request, 84
filtering requests, 81-83
logs, 84
methods of, 78
modifying request, 83-84
overview, 75
request ID, 76
scheduling request, 83
server context, 79
setting preferences for, 80-81
starting, 77
starting request, 84
stopping request, 84
timeout, 80

DiscoveryManager, See discovery
disk

busy, 413, 414, 415
complex rules, 413
load, 416

disks, total in Details window, 103
displaying data, 130
document type declaration, 271
domain, See administrative domain
DomainManager, 51
DTD, see document type declaration, 271
Dynamic Reconfiguration, special instructions for Details

window, 116

E
editing

graph axes, 143
module, 122

EGroup process property, 101
enabling

module, 122, 165
enabling or disabling a service, 412
Entity Desc property, 97
Entity Event Destination property, 97
Entity Family property, 97
Entity Full Desc property, 97
Entity TrapDestination property, 97
es-backup command, 325
es-config command, 325
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es-restore command, 327
esadm, 249, 254
esadm, 246, 247
esdomadm, 247, 254
esdomadm, 246
esops, 254
esops, 246, 247
EUser process property, 100
Eventmanager, 251, 316

agent statistic, 313
events, deleting from event database, 316
exiting from command-line interface, 311

F
fault reports, viewing, 401
FileMonitoringmodule

adding row to table, 133
adding table rows, 129

File Scanningmodule, adding table rows, 129
file system full, 415
filtering, logmessages, 111-112
finding objects, 88
finding specific logmessages, 113

G
general group, 64
graph

applying template, 141
copying data property to, 123
data property, 138
editing axes, 143
historical data, 151, 238
multiple data properties, 139
opening, 140-141
overview, 43
sampling points, 153-154
saving, 141
template, 141

Group ID process property, 101
group operations, Seemanaging jobs
groups, 48

copying, 69-70

groups (Continued)
creating, 64-65
general and IP-based, 64
object definition, 60
pasting, 69-70
security, 41

H
hand icon, 104
hardware

modules relating to, 336
monitored by SunManagement Center software, 31
pathnames displayed, 104
platform-specific information, 46
resources displayed, 103
views of, 103-105

Hardware Diagnostics Suite, 96, 314
hardware information, 46
HealthMonitor rules, 415
helpful hints

displaying levels of details, 109, 119
Search function is case-sensitive, 106
searching inmultiple instances, 107
using tool tips, 87
viewing longmessages in table cells, 109

Hide Details button, 105
hierarchy view, 42, 88, 90-91
history interval, setting, 153-154
History tab, 151, 238
home administrative domain, 49

setting, 50
host

Details window, 95-108
security, 41, 124

host down alarm notification, 229
host down notification, 183-184
Hostname property, 97

I
ICMPping, See ping command
import/export utility

CLI interface, 265-270
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import/export utility (Continued)
definition of, 261
document type declaration, 271
file format, 270
files, 270-275
head information, 271
how used, 261
software structure, 262
starting, 263
starting import, 264-265

increasing virtual size, 315
indeterminate status, 173
Info tab

Entity Desc property, 97
Entity Event Destination property, 97
Entity Family property, 97
Entity Full Desc property, 97
Entity TrapDestination property, 97
Hostname property, 97
IPAddress property, 97
Netmask property, 97
Operating System property, 97
Target Hostname property, 97
Target IPAddress property, 97

Info tab in theAttribute Editor, 148
Info tab in the Details window, 96
installation, default administrative domain, 50
installing SunManagement Center, 44
Internet Explorer, 217
IPAddress property, 97
IP addresses within server contexts, 251
IP-based group, 64

J
Java console, See console
Java security classes, 245
job definition, 191

K
kernel memory allocation, 416
Kernel Reader

creating alarm, 188-189, 231-232, 240-241

Kernel Reader (Continued)
displaying data, 130
example data property display, 130
rules, 414

L
load, 416
loadingmodules, 122, 162-163
local applications, modules relating to, 391
log files, refreshing view, 114
log files, viewing, 110-111, 113, 114
logmessages

filtering, 111-112
finding specificmessages, 113

log view, 42
logical host configuration, 105-108
logical view, 105-108
lookup service, 314

M
main console, See console
main console window, 42
managed objects

composite, 60
group, 60
module, 60
node, 60
overview, 59
segment, 60
types of, 60

management information base, SeeMIB
managing jobs

creating a configuration task, 201-203
creating a data property task, 199
creating a filter, 205-207
creating amodule table task, 200
creating amodule task, 197-199
creating an agent update task, 203-204
defining a job, 192-194
defining a task, 196-197
deleting filters, 207
deleting jobs, 196
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managing jobs (Continued)
deleting tasks, 205
Manage Jobs window, 192
modifying filters, 207
modifying tasks, 204
removing job request, 196
setting schedules, 194-195
stopping current job, 195
suspending job, 195
updating the file set, 203
viewing job status, 194

masking of network addresses, 330
MCP, Seemodule configuration task
Memory% process property, 101
memory hardware, total in Details window, 103
menu, ViewColumns, 115
message articles, viewing, 402
messages, viewing, 42
MIB

modules, 38
SNMP, 321-322

modifying objects, 70-71, 71
Module Browser tab, overview, 119-124
Module Browser tab in the Details window, 96
module configuration task, 201-203
modules, 166-167

adjusting table rows, 128
Agent Statistics, 156, 392
Agent Update, 156
changing description, 168
changing parameters, 168
Config Reader, 156
copying, 122
creating amonitoredmodule, 64
current version, 336
Data Logging Registry, 157, 396
data properties, 147, 225, 235
data property tables, 128
definition, 119
definition of, 38
Details window, 95-108
developing, 44
Directory SizeMonitoring, 129, 157
disabling, 122, 165-166
displaying rules for, 167
dynamic, 39

modules (Continued)
Dynamic Reconfiguration, 157
editing, 122
enabling, 122, 165
FaultManager, 157, 400-402
FileMonitoring, 129, 157
File Scanning, 129, 157, 402-404
hardware, 336
HealthMonitor, 158, 404
HP JetDirect, 157, 398
icon formulti-instance, 156
in alphabetical listing, 336
Kernel Reader, 158, 408
Kernel Reader Simple, 158
loaded by default, 156
loading, 122, 162-163
loading a scheduledmodule, 164-165
local applications, 391
MIB, 38
MIB-II Instrumentation, 158, 377
MIB-II ProxyMonitoring, 158, 399
multi-instance, 156
NFS File Systems, 158, 387
NFS Statistics, 159, 388
number of instances loaded, 162
object definition, 60
operating system, 359
Print Spooler, 129, 159, 397
ProcessMonitoring, 129, 159, 408
remote systems, 391
rules, 167
schedule, 166-167
security, 41, 124, 166-167
security permissions, 166-167
ServiceManagement Facility (SMF), 159
Servicemanagement facility (SMF), 410-412
Solaris Process Details, 159, 389
testing, 44
that load automatically, 336
that loadmultiple times, 336
unloading, 122, 166
using ’Add Row’, 336
Volume SystemMonitoring, 160
X86/X64 Config Reader, 160

monitored hardware, 31
monitored software properties, 31, 39
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monitoring
logmessages, 112-113
objects, methods of, 62
real-world environments, 44
server components, 314

monitoring data properties, overview, 127
moving columns in Details Process display, 115-116
moving groups, 69-70
moving objects, 71-72
Mozilla, 217

N
navigating, administrative domains, 88
Netmask

ANDing, 330
property, 97

Netscape Navigator, 217
NFS remote procedure, 416
Nice process property, 101
node

creating, 61-63
object definition, 60

notifying you when a host or agent is down, 229
notifying you when an alarm occurs, 185, 241-242

O
objects

alarms, 94, 220, 229
copying, 68
creating automatically with Discoverymanager, 77-80
cutting and pasting, 71-72
delete, 72-73
Details window, 95-108
linking two objects, 68
modifying, 70-71
moving, 68, 71-72
pasting, 68
renaming, 71

octets in network addressing, 329
online backup, 325-327
opening

Attribute Editor, 151, 152

opening (Continued)
graphs, 140-141

operating system
modules relating to, 359
property, 97

P
paging, 190
pasting

groups, 69-70
objects, 69, 71-72

permissions, security, 245
pfiles process statistic, 101
PGroup process property, 101
physical view, 43, 103-105

refresh details, 105
pictures of system hardware, 103-105
PID process property, 100
ping command, 78
platform-specific information, 46
pldd process statistic, 101
pmap process statistic, 101
populating administrative domains, 51

manually, 52, 59-73
using Discovery, 52, 75-84
using Discovery at repeated intervals, 52

port addresses, within server contexts, 251
PPID process property, 100
Print Spooler module

adding row to table, 134-135
adding table rows, 129

printer monitoring, 159
Priority process property, 101
probe amonitored data property, 135
Process display, configuring, 102, 115
ProcessMonitoringmodule, adding table rows, 129
process property

Address, 101
Class, 101
Command, 101
CommandLine, 101
CPU%, 101
EGroup, 101
EUser, 100
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process property (Continued)
Group ID, 101
Memory%, 101
Nice, 101
PGroup, 101
PID, 100
PPID, 100
Priority, 101
Session ID, 101
Size, 101
Start time, 101
State, 101
Time, 101
UID, 100
User, 100
Wait Channel, 101

Process Statistics window, 101
processes view, 43
processors, total in Details window, 103
production environment, definition of, 44
property, See data property
pstack process statistic, 101

Q
queue length, complex rules, 413

R
rCompare rule, 40
recovery, of your database, 325-327
refresh data, 130-131
refresh interval

setting, 152-153, 239
Refresh tab, 150
refreshing log file view, 114
registry service, 314
relationships, inclusive, 249
remote administrative domains

definition of, 55
viewing, 57

remote server access, 251
remote server context, 36
remote systems, modules relating to, 391

rhltm000, 416
rhltm001, 416
rhltm002, 416
rhltm003, 416
rhltm004, 416
rhltm005, 416
rhltm006, 416
rhltm007, 416
rknrd100, 414
rknrd102, 415
rknrd103, 415
rknrd105, 415
rknrd106, 415
rknrd401, 415
rknrd402, 415
rknrd403, 415
rknrd404, 415
rknrd405, 415
router forwarding rule, 330
routing tables, 78
row

adding, 132, 133, 134-135
rule

alarms, 39
complex, 413
CPU power, 416
disk busy, 414, 415
disk loaded, 416
HealthMonitor, 415
kernel memory allocation, 416
Kernel Reader, 414
no swap space error, 415
overview, 36
rCompare, 40
run queue length, 416
simple, 413
Solstice SyMON 1.x software, 413
SunManagement Center software, 413
swap space, 415, 416
time for an unreferenced page, 416
user-customized, 413

run queue length, 416
running UNIX commands on data, 130, 135
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S
same server context, 36
sampling points for data property, 153-154
saving graph, 141
scalar dataviews, 213

creating, 214
scheduling a discover request, 83
search pattern, 112
Search window inDetails Logical view, 106
searching for specific logmessages, 113
Section 508, 417-419
security, 41

access control (ACL) categories, 246, 250
accessing on amodule, 253-254
adding user-defined group, 254
adding users, 252-253
deleting users, 255
granting administrator privileges, 254
specifyingACL, 250
using key functions, 252

default privileges
default privileges, 249

for amodule, 166-167
functions

administrator, 248
general, 248
operator, 248

host, 124
layers in SunManagement Center software, 245
module, 124
permissions, 245
remote, 55
setting for a host ormodule, 124-125
SunManagement Center users, 246
tab, 253

segment
creating, 67-68
object definition, 60

selecting alarm notification actions, 186
selecting columns in Details Process display, 115
server

access, 251
context, 251
context limitations, 252
definition of, 34
detailed description of, 35

server (Continued)
interacting with console and agent, 35
interaction with agents, 36
interacts withmultiple consoles, 36
remote access, 251

server component asmonitored object, 314
server context, 55

definition of, 36
discovery process, 79
limitations, 252

server layer, See server
service details, viewing, 411
Session ID process property, 101
setting

home administrative domain, 50
refresh interval, 152-153, 239

setting alarms, 412
setting group job schedules, 194-195
setting host security, 124-125
settingmodule security, 124-125
ShowDetails button, 105
silent backup, 327
simple alarms thresholds, 39
simple rules

alarm generation, 413
monitored properties, 413

Size process property, 101
Smart delete, 316
SMsystemCommand, 320
SNMP, 41

encryption, 255
MIBs for SunManagement CenterModules, 321-322

SNMP communication, 258-259
SNMP encryption, enabling, 257-258
SNMPping, See ping command
SNMPv1 communication, disabling, 258-259
SNMPv2c communication, disabling, 258-259
SNMPv3, 259
software, views of, 105-108
software properties monitored by SunManagement Center

software, 31, 39
Solaris Process Details module, 99
sorting columns in Details Process display, 115
splat, black, 173
Start time process property, 101
starting, 45
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starting (Continued)
Details window, 109-110
discovery, 77, 84

State process property, 101
statistics

Detail Process Statistics window, 101
pfiles, 101
pldd, 101
pmap, 101
pstack, 101

stopping discover request, 84
subnets, 330
SunManagement Center

agent, 34
architecture, 34
changes, 32-33, 33
component layers, 34
concepts, 37
console, 34
features, 31
getting started, 45
installing, 44
Java security classes, 245
monitoring, 62
overview, 31
remote access, 251
rules, 413
security layers, 245
server, 34

context limitations, 252
server access, 251
server agent statistic, 313
server context, 251
user functions, 248
user security, 246

SunManagement Center Session, closing, 50
SunMC, See SunManagement Center
suspending a group job, 195
swap space, 415, 416

error, 415
in use, 415

switching between administrative domains, 88
syslog, 415
SystemManager server

accessing through SSH, 336-337
accessing through web console, 336

T
tape devices, total in Details window, 103
Target Hostname property, 97
Target IPAddress property, 97
testingmodules, 44
text pattern includes UNIX regular expressions, 112
Time process property, 101
timeout, discovery process, 80
tool tips, 87
ToolsMenu, customizing, 318-321
Topologymanager, 251

agent statistic, 313
exiting, 315
function, 315-316
system resource requirement, 315-316
Virtual Size limit, 315-316

topology view, 42, 88, 91-94
Trap handler, 36, 251

agent statistic, 313
troubleshooting, 313-327

U
UID process property, 100
UNIX regular expressions in text patterns, 112
unloading

amodule, 122
module, 166

User process property, 100
users, 246

default functions, 248
using graph template, 141

V
var/adm/message, 415
vector dataviews, 214

creating, 214-215
view

hierarchy, 42
of administrative domain, 88
topology, 42

ViewColumns pull-downmenu, 115
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viewing
errormessages, 42
log files, 110-111, 113, 114

viewing administrative domains, 88
viewing application information, 114
viewing fault reports, 401
viewing group job status, 194
viewing hosts

hierarchy view, 90-91
topology view, 91-92

viewingmanaged objects, hierarchy view, 90
viewingmessage articles, 402
viewing service details, 411
virtual size, increasing, 315

W
Wait Channel process property, 101
web interface

accessing data property attributes, 239
alarm categories, 228
alarms status summary, 227-228
attribute editor, 225

Actions tab, 237-238
Alarms tab, 236
History tab, 238
Info tab, 236
Refresh tab, 238

browsers supported, 217
creating an alarm, 231-232, 240-241
defining alarm action scripts, 241-242
details

Browser tab, 224
displaying, 221-222
filtering alarms, 230
Info tab, 223
Log tab, 225

down alarm notification, 229
email notification for critical alarm, 241-242
main console, 218
modifying alarm actions, 243
module data properties, 235
setting a history interval, 240
setting a refresh interval, 239-240
starting, 220-221

web interface (Continued)
viewing alarm information, 229-230

Z
zone, 33
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